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Welcome to Specify 6

Over 250 years of botanical and zoological exploration have produced billions of biological

specimens in museums worldwide which document the distribution of life on earth. The Internet has

changed the way we catalog, computerize and discover those specimens, but we are just at the

beginning of utilizing the communication and computational power of the net. The goal of Specify 6

is to extend collections computing beyond simple specimen description, discovery and data

retrieval--to capabilities for integration and synthesis that will enable researchers to utilize collections

data for broader, quicker, research impact, in efficient, network-based collaborations.

Specify 6 is based on the same core collections concepts as Specify 5, but has been completely

rewritten in Java and can run on Windows, Mac OS X, and Linux. It is also greatly updated to allow

drag and drop and multi-tasking with only one open application.

Specify is an open source project and welcomes software collaboration.

Registration

The concept of software registration for Specify 6 has changed to align with commercial

software practice. A registration popup window request is activated in Specify whenever a

new collection database is created. Specify asks the administrator of the database for

identifying information such as the name of the collection, contact name and e-mail

address. Registration enables automatic updates of Specify software and adds the

registration contact email address to the Specify Project e-mail list for news and

announcements. Anyone may register a Specify collection: US or foreign, academic,

government or commercial, museum curator, graduate student, or member of the general

public. We also accept registrations from collections-based research projects which are not

collection catalogs but “virtual” collections of specimen records aggregated from multiple

sources for the purpose of supporting taxonomically or geographically-scoped research.

Registration is optional.

Specify will ask if you want to register the first time it opens and thereafter if you are not

registered.

You can also register by clicking Help > Software Registration. A message will appear

telling you that your institution is registered if you do not need to register.

Institutions that are not registered will not receive automatic updates for Specify 6.
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Services and Support

Institutional Support Agreements ("ISAs") are agreements set on paper with U.S. research

institutions to formalize a support relationship. With U.S. National Science Foundation

funding, U.S. collections institutions have access the Specify Project’s professional services

for data migration from a legacy systems, Specify customization and configuration support,

and miscellaneous other help desk services directly related to the installation and operation

of the program. (ISAs are equivalent to Specify 5 registrations.)

Projects which propose to create specimen or observation species occurrence databases with

data from various sources, i.e. virtual collections created for some specific research

objective, e.g. Ants of the World, Trees of Madagascar, a multi-institutional collaborative

Tree of Life Project, will be eligible to establish an ISA and receive support services from

the Project. These project databases are usually scoped systematically or geographically,

and are essentially virtual, special-purpose collections. This is an extension of our current

Sp5 policy to reflect Sp6’s enhanced schema for U.S. research project specimen databases.

To receive Services and Support:

1. Contact the Specify Project for the ISA form.

2. Once you have completed and signed the form, you will receive an ISA

Number.

3. In Specify, on the main menu click Help > Support Agreement.

4. Type your ISA Number in the dialog that appears.

Once your ISA is complete you will qualify for Specify Support and Updates.

Usage and Usability Statistics

Usage and Usability Statistics (UUS) communications is a new network feature in Specify

6, which returns information on the frequency of specific Specify component use and

information over the Internet to the Specify Project. Specify is instrumented with

checkpoints which log whether a particular module was successfully used or whether an

internal error (a handled exception) was encountered. This information is highly useful for
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assessing the usability of particular modules and for identifying engineering defects and

prioritizing fixes and enhancements. Our vision with the UUS facility is to connect to

Specify users to anticipate their troubleshooting needs by rapidly identifying error

conditions, and to prioritize software enhancements based on usage paths and frequency.

UUS communications can be turned on or off as a user preference.

Auto-updates

Auto-updates are an automatic software update delivery service built into Specify and

available to all registered users. It delivers and installs the latest Specify releases

automatically to registered installations over the Internet. When Specify is started, the

program checks with a Project server to see if there are any updates available and if there

are, the user is offered the opportunity to download the update software and install it within

Specify. Specify software updates can also be manually obtained at anytime through the

‘Check for Updates’ option on the Help menu. The online update service will update

versions of Specify compiled by the University of Kansas.

Users with computers that do not have internet access should turn off the 'Check for

Updates' function in the System section of User Preferences. For help performing this task

visit the System Preference help page.

Using Specify Help

The Specify Help system can be opened from anywhere in the application by typing the F1 key, or

function + F1 keys. The help system was designed to provide an overview of the modules within

Specify as well as a guide for a given task. This is referred to as context-sensitive help. When

performing a given task in the application, type F1 and Specify Help will open to the corresponding

documentation page. In the same sense, Specify Help is best read while viewing and using the

corresponding module in the application. A Table of Contents is also provided. Specify Help was

written in Java Help and includes full-text search capabilities by clicking on the (search)

button.

About Specify

Specific information about your instance of Specify can be found by choosing Specify > About

Specify. This information includes the Institution and Collection GUID.
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The system information in the About Specify dialog can be copied to the clipboard by clicking the

button.

Contacting the Specify Software Project

The Specify Software Project

Biodiversity Institute

The University of Kansas

1345 Jayhawk Blvd.

Lawrence, KS 66045-7561

USA

Phone: (785) 864-4400, 8 – 5 p.m. (UTC/GMT-6), Monday–Friday, or leave a message at

any time.

Fax: (785) 864-5335

Email: specify@ku.edu

Website: www.specifysoftware.org

Specify Login

When Specify is launched it automatically checks for updates and allows the user to choose to

download and install the update, then provides a login mechanism.

Types of Specify Logins

The security for Specify 6 uses both a Master username and password, which gains access

to the MySQL Database, as well as a User username and password, which in return gains

access to the Specify application. Specify uses only one Master username and password for

all users, but encrypts the Master password with the User information, creating an

encrypted string, or key. This allows the Master information to become unique for each

user.

Some of the administrative tasks in Specify, such as creating new disciplines or divisions,

require an IT password. The IT password refers to the password used to login to the

MySQL database manager. It has full administrator privileges within the MySQL database

manager. Specify is accessing these priviledges when it creates these changes and therefore

must login directly to MySQL.
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In review, there are four (4) different types of credentials in Specify:

• User username and User password

• Master username and Master password

• Master Key, (Encrypted username / password )

• IT username and IT password (used to gain access to the MySQL database manager)

Starting Specify for the First Time

The very first time a user is required to login to Specify they will need to know their User

username and password as well as their Encryption Key. An Encryption Key can be created

from within the Login tool; however, it requires that the user know the Master username

and password to create a new key.

The User credentials are stored on the users machine. This allows the Login tool to

automatically fill in the Username and Encryption Key for previous users. When opening

Specify the username will be pre-filled with the username last user to open Specify.

If you are accessing Specify on a new computer you will be required to fill in your User

username and password as well as a valid Encryption Key, just as you did when logging

into Specify for the first time.

Specify Login

The log in process includes dialog windows for entering all types of login information.

Login Dialog

Users with an existing Username and Password can simply log in using the correct fields.

Users that are logging in for the first time, or wish to login to a different database than they

were previously using must click the More Information button.
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Expanded Login Dialog

When the Specify database is created using the Specify Wizard the Database and Server
information should be included in the dialog. If the database and server information is not

included in the dialog you may type them into the drop-down menu box. If you do not

know the name of your database or server and you are running Specify on a local machine

please consult your IT administrator. If more than one database and server are available the

dialog will list all the choices for both.

If you are accessing a remote server, you will need to fill in the Database and Server name

(this can be an IP address if the IP is 'Static').

Users wishing to configure their server and firewall to use a Port other than the default

(3306) port may do so and type the new port number into the box provided. If your port has

not been reconfigured for a specific port the default port is 3306.

Users needing to create their encrypted Master Key should click the Configure Master Key
... button.

Dialog for creating the Encryption Key

The Master Source information refers to the location that the encryption is stored. At this

time Specify does not support obtaining an encryption key from a web service, so choose

Encryption key stored in local preferences.
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Encrypted Username / Password refers to the Encryption Key, or string that results when

the Master username and password are Encrypted using the User username and password.

This can be created by the IT administrator when a new user is created in the Specify

application and then given to the user, or it can be created by clicking the Generate Master

... button.

Creating the Encryption Key

Type in the information for both the User and Master credentials click the Generate button.

The Show Password button can be used to turn off the encryption characters and show the

actual textual password information.

The encrypted Master Username and Password now appears in the Encrypted box.

Completed Login Dialog

The first login dialog is now presented. Click the Login button to complete the process.
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Specify Setup

Specify's flexible design can accommodate a single user with a single collection, or multiple

collections representing multiple disciplines within an institution - all sharing the same database. This

is accomplished by creating relationships among collection data, as well as modeling how collections

are organized within institutions themselves, and then configuring components within Specify

specifically for each institutional level.

What this means for the user, is that Specify 6 can be configured to work congruently with existing

collection management procedures, but it requires a thoughtful setup process. This process may vary

depending on how Specify was installed. If you were a Specify 5 user and have worked with the

Specify staff to convert your data, many of the setup steps will have been performed for you.

However, it is still recommended that you read the help sections for each of the modules to better

understand how each module can be utilized for your specific needs.

If you installed Specify 6 and ran the Specify Setup Wizard to create a new, blank database, the

Specify 6 team recommends that you now perform the following procedures to customize the Specify

setup to your particular needs.

1. Add institutional levels (divisions, disciplines, collections)

Systems that were created by first running the Specify Setup Wizard will include one of

each of the institutional levels (institution, division, discipline, collection and user). Most

systems will require more than one of each of these institutional levels.

Add collections, disciplines and divisions in the System Configuration at System > System

Setup > Configuration.

2. Add users and set user permissions

Once these institutional levels are configured, users can be added to each of the collections.

Specify offers an extensive permission system which controls each user's access to both the

data and tools within Specify.

Add users and set user permissions using the Security tools found at System > System Setup

> Security Tools.

Once the institutional levels, users and permissions are complete, information specific to

each discipline can be configured.
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3. Check and/or set Tree Definitions

A Storage tree that can be accessed by the entire institution was created using the Setup

Wizard. Taxon, Geography, Lithostratigraphy and Chronostratigraphy (if applicable) trees

were also created, which are shared by each collection within the division.

The ranks in the trees as well as the Enforced ranks and Full Name configuration were also

created for each tree in a division. These are considered part of the Tree Definition, and it is

recommended that users check these Tree Definitions before entering data. Tree Definitions

are found by clicking the Tree button on the Tab Bar, then clicking the appropriate Tree

Definition button on the side bar.

4. Customize the Schema Configuration

A number of changes can be made to the fields and tables within Specify by using the

Schema Configuration tool:

• Hide Fields

• Change Captions

• Set Required Fields

• Change Table Format

• Change a Field Format

• Configure Table Aggregation

Editing the schema configuration allows users to customize fields and tables within Specify

for each of the disciplines. The Schema Configuration tool is found at System > Schema

Configuration.

5. Customize System Pick Lists and Preparation Types

A variety of System Pick Lists exist within the Specify form system as drop-down lists.

These can be edited in a System Configuration module, found at System > System Setup >

Configuration. System Pick Lists refer to fields that are denoted as Pick Lists within

Specify itself. Fields that are not denoted as Pick Lists by Specify are referred to as

User-Defined Pick Lists. User-Defined Pick Lists require a change to any forms that

include the field and should NOT be changed until the new form has been imported into

Specify.
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The Preparation Type pick list ships with specific data for each discipline, which can be

edited in the Configuration tool as well.

6. Create Reports

Reports can be created for use in Specify. Reports may include labels for specimens or

invoices for loans as well as reports for collection data. Each institution will have different

needs. It is helpful to have reports created before users start entering data into the database

that are based on your specific needs. Specify harnesses the power of iReport 3.0, an open

source report writing software package, by modifying the original iReport version to

interact with Queries created in Specify 6 and data supplied from the Specify 6 database.

SpecifyiReport is a separate application and must be launched separately from Specify.

SpecifyiReport is located in the Specify application bin directory.

7. Change Attachment Storage Location

Attachments are copied, renamed using a unique name, and stored in an Attachment

Storage location. Only the path to the attachment storage location is stored in the Specify

database. The Specify Setup Wizard sets a default storage location on the local drive but

this location can be changed in System Preferences:

• For Mac: Specify > Preferences > System > Attachment Storage Location.

• For PC and Linux: Choose Edit > Preferences > System > Attachment Storage

Location.

8. Customize the Backup and Restore function

A Backup and Restore tool ships with Specify as a separate application. It allows IT

personnel to backup and restore the database to the MySQL location on the server, or a

local disk. BackupAndRestore is located in the Specify application directory, in the bin file,

which stores the executable files for Specify.

Configuration Overview

The Configuration tool within Specify is found by clicking Configuration at System > System Setup >

Configuration. It offers many tools for setting up Specify for your specific institution as well as
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individual collections within the institution. The Configuration tool (and menu) is only available to

Administrators.

Side Bar Global Data

The side bar offers Institution, Division, Discipline and Collection forms for adding these

levels within Specify. Users that have run the Specify Setup Wizard have their Institution as

well as one Division, Discipline and Collection already configured within Specify. If more

of any of these Institutional levels are required within Specify they need to be added before

any data is entered. Directions for performing these tasks can be found at Adding

Collections, Disciplines and Divisions.

Side Bar Discipline Data

Preparation Types are Pick Lists that have an additional function; they determine if

specimens with specific preparations can be loaned. For this reason they have a form for

editing purposes. Simply click Preparation Type on the side bar to bring up the form. For

additional information please refer to Editing the Preparation Type.

Pick Lists that are included on the default Specify forms are referred to as 'System Pick

Lists' and can be edited for individual Disciplines within Specify. This is accomplished

using the Pick List Editor. System Pick Lists can also be imported and exported using

additional buttons on the side bar. Please refer to Editing System Pick Lists for additional

information.

Cleanup Syononyms, released with Specify 6.5, is a specially designed function for Specify

6 databases which have been created from data conversions from Specify 5. The taxon

synonym cleanup operations the tool performs will not affect collection databases created

for the first time in Specify 6, nor on Specify 6 databases converted from other legacy

systems. For Specify 6 databases converted from Specify 5, visit the Specify Project web

site (www.specifysoftware.org) and read the document entitled, Specify 6 Synonym Cleanup

Tool, before using this function.

Block Logins will block all other users from logging in to Specify. This feature is only

available to a Specify Administrator. While the logins are blocked the administrator that

blocked the logins can still login and use Specify in a normal capacity. This feature is often

helpful when maintenance tasks for the Specify database are being performed.
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Close Specify Database Button

When logins are being blocked the button will change to allow logins.

Open Specify Database Button

Any users that try to login to Specify while they are being blocked will be alerted

that they may not login until logins are allowed.

Activate Subform allows a Collection Object Attribute, Preparation and/or Determination

record to be automatically created at the same time a new Collection Object is created. If a

form has been edited to include a default value the new record will be created and include

the default value. For instance, if a collection uses only one Preparation and does not wish

to create a new Preparation each time a new Collection Object is added to their collection,

the Preparation form can be edited to include a default value and when a new Collection

Object is created a new Preparation will automatically be created for that Collection

Object.

Note: Preparation requires a default value to be set on the form before Specify will

automatically create a Prepation for each new Collection Object. If a default value has not

been set in the new Collection Object Attribute and/or Determination form a blank record

will be created.

Show Users Logged In displays a list of users currently logged in to Specify.

Adding Institutional Levels

The Specify data management levels mimic the common levels of hierarchy within institutions.

Access to information and Specify tools are set at the various levels both within the application itself

and through the User Permissions.

• Institution

o Division

- Discipline

- Collection
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- Users

The Divisions, Disciplines and Collections for each institution are added and edited in the System

Configuration module of Specify;Configuration at System > System Setup > Configuration. All tabs

need to be closed before opening the Configuration. This tool is available to Administrators only.

Collection information in Specify 6 databases is also organized at these institution levels to meet

requirements for data integrity and data sharing among collections. Some data elements are

commonly shared among all collections within an institution, while others are shared only among

collections in the same taxonomic discipline, i.e. "at the Discipline level" in Specify. Before creating

the institution levels it is imperative that an administrator also understand the data that is held at each

level to create the correct setup.

When using a database that was created using the Wizard any additional Division levels should be

added first, then Discipline and then Collection. Each is added at the level above it. For instance,

Divisions are added within the Institution form.

Edit Institution

Information for the Institution is edited in the Configuration tool; System > System Setup >

Configuration. There may only be one Instituation for each instance of Specify.

Open the Institution form by clicking Institution on the side bar.

• Name is the official name of the institution.

• Security can be turned on or off for the entire Specify application on the Institution

form by checking the box Is Security On. The status of security is shown on the status

bar with an icon; (security on), or (security off). It is recommended that most

instituations leave security on unless the application is being used by a single user.

• Alt. Name is typically used when more than one code is used by an institution.
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• The Code is typically an acronym, codon, abbreviation or short name for your

institution (not your collection), if you don't know of one, put in a placeholder, this can

be edited at a later date. Institution codes is a Darwin Core field used in DiGIR/TAPIR

web services.

• Min. Password Length allows a minimum password length to be enforced within

Specify. The Specify default is eight (8) characters.

• GUID Authority refers to the location of institution information for the unique GUID

number given by Specify. This is typically the url for the instition.

• IPR
• Copyright, Terms of Use and Disclaimer may be used for legal information

regarding the use of the name of the institution. This information can be queried and

included on reports.

• Remarks can be used for any additional information required regarding the institution.

Click on the Address button to edit the address of the institution.

Add/Edit Divisions

New divisions, disciplines and collections are added using the Configuration

tool;Configuration at System > System Setup > Configuration.

Divisions are added within a subform on the Institution form, and can be edited either from

the institution subform or the division form.

1. Click the Institution button on the side bar of the Configuration tool to edit the

institution or add a division.

At least one division should appear in the division sub form.

Name is the only required field and is used in any lists of divisions within Specify

as well as in the institution hierarchy.

Abbreviation refers to an existing abbreviation for the Division.

Alt Name provides another field for name. This is often useful when a particular

Division has changed names or uses a longer name than is applicable to the

Hierarchy list.

URI stands for Uniform Resource Identifier and refers to a resource on the

internet (a Division web site).
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Icon URI This is a field for ABCD field. This is the path to an icon on the

website that could be downloaded by another institution and displayed on their

website to indicate a partnership.

Description can be used to store further information about the Division.

2. Click the (add) button to add a division. A Wizard will appear to help you setup your

new division as well as one discipline and one collection within the division.

Create a Division

Division

This window is used to create a single division within your institutional hierarchy.

Additional divisions can be added later from within Specify.

The Name will appear on the division form and can be queried and used in

reports. A division is used to collectively name similar collections e.g. the

Division of Paleontology may include Vertebrate Paleontology, Invertebrate

Paleontology and Paleobotany collection. The Name is a field within the Specify

database and is displayed on the Institution form. It can be edited, queried and

used in reports.

The Code can be a short name, acronym, codon or abbreviation. If your division

does not have a code, put in a placeholder, (this is a required field), this can be

edited at a later date. Division codes are sometimes required for web services.
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Choose a Discipline Type

Discipline

Choose a taxonomic Discipline Type from the drop-down menu. Specify uses

this information to load the correct default data entry forms, trees and schema

(tables and fields) based on the predefined disciplines within Specify.

The Name will display within Specify and can be any user specific variation of

the discipline type. It can be edited, queried and used in reports.

Configure the Taxon Tree

Taxon Tree
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This table will create the tree definition for the taxon tree. The taxon tree operates

at the discipline level and can be used by all collections within the discipline you

created in the last window. Nodes to the taxon tree can be added later in the

Wizard as well as from within Specify.

• The Level column displays the available levels. This name can be edited

from within Specify. Click the Include box to place the level in the tree.

• Include places the level in the tree definition. Levels that are not included

can not be Enforced or added to the full name.

• Is Required is not editable, but an indication of the tree levels that are used

by Specify as a system requirement. These are automatically added to the

tree and can not be deleted on this screen or later.

• Is Enforced ensures that the level can not be skipped when adding nodes

lower down the tree.

• Is in Full Name includes the level when building a full name expression for

any associated Collection Objects (which appears in the Taxon Full Name

field of the taxon table). The full name is also displayed in the Preferred

Taxon field on the determinations form and is useful when running queries

and reports when the full name is desired. The full name generally includes

at least the binomial genus and species fields together with any levels below

species (if used) . Create the full name by checking the desired boxes.

At least one level for Full Name must be checked before the Next button will

become enabled.

• Separator refers to the character that separates the levels when displaying

the full name. This can be any single character, such as a comma (,) or a

space. To make the separator a space simply double click inside the column

and delete the comma, then press your spacebar one time.

• Full Name Order will reverse the full name as shown in the Full Name
Example.
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Preload Taxon Records/Nodes

Pre-Load Taxon Authority File

The Wizard not only defines the taxon tree but also allows loading of an authority

file for the discipline you are creating. Authority files were created using data

from the Catalog of Life Project for some of the disciplines within Specify. If this

window does not appear, there are no existing authority files for your chosen

discipline.

If you choose to load the data into your tree the Taxon tree will be populated with

hundreds of taxon nodes and all associated data. Then, when adding Collection

Objects into your database you can simply choose a taxa from the Taxon field

rather than adding each individually as needed.

Please note that loading the Taxon tree will also affect the tree definition. If you

load the provided Taxon authority file for your discipline the accompanying tree

definition may include Levels that were not defined by you in the previous

window, but are necessary to include all the predefined Taxon information.

Additional discipline-specific trees can be loaded from within Specify at the time

new disciplines are created.

Click the Choose button for a list of taxon files for the discipline you are creating.

Not all disciplines offer more than one taxon file. Once the taxon file is chosen,

information will display in the Source, Coverage and Description fields for that

file.

Specify Help - Adding Institutional Levels

23 / 391



Note: Botany and Entomology authority files are partial due to the size

of these files. Contact the Specify team at specify@ku.edu for

additional authority files.

The Downloadable File section in this window allows you to choose taxon files

from your hard drive. The Setup Wizard can only install files that were

downloaded from the Specify website. The Specify team is currently in the

process of creating more of these files.

Configure and Load Geography Tree

Geography

The Geography tree operates at the Discipline level and is used by all Collections

within the Discipline. Nodes to the Geography tree can be added later in the

Wizard as well as from within Specify

• The Level column displays the available levels. This name can be edited from

within Specify. Click the Include box to place the level in the tree.

• Include places the Level in the tree definition. Levels that are not included can

not be Enforced or added to the Full Name.

• Is Required is not editable, but an indication of the tree levels that are used by

Specify as a system requirement. These are automatically added to the tree and

can not be deleted on this screen or later.

• Is Enforced ensures that the level can not be skipped when adding nodes lower

down the tree.
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• Is in Full Name includes the level when building a full name expression, which

can be queried and used in reports. Create the full name by checking the desired

boxes.

At least one level for Full Name must be checked before the Next button will

become enabled.

• Separator refers to the character that separates the levels when displaying the full

name. This can be any single character, such as a comma (,) or a space. To make

the separator a space simply double click inside the column and delete the

comma, then press your spacebar one time.

• Full Name Order will reverse the full name as shown in the Full Name
Example.

The Wizard will automatically load data for the Geography tree, including

Continents, Countries, and States throughout the world as well as Counties within

the United States. Data for the Geography tree was converted from the online

website of the World Gazetteer. Unwanted or unneccessary nodes can be deleted

later from within the Tree tool.

Create a Collection

Collection

Enter the Name and internationally recognized Collection Code to create a single

Collection within the Discipline. This is the name that will appear within Specify

on the Collection form and can be queried and used in reports.
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The Code should be your standard collections community assigned code for your

collection. This Code will be used in data exports and web interfaces in upcoming

releases of Specify.

Create a Catalog Number Format

Catalog Number Format

Specify is able to accept data for collection objects or observations without

assigning a Catalog Number. But when Catalog Numbers are used, they must be

unique for each lot, specimen or observation. Many collections routinely assign

catalog numbers to incoming specimens, perhaps as part of the accessioning

process. These numbers may require a format with specific sections for data such

as Institution Code and year or they may simply use an incrementing number.

Catalog Numbers can either be unique to each Collection, shared by several

collections or be used throughout the Institution. The Catalog Number chosen at

this time will not affect where it is used relative to other collections, this will be

configured from within the Specify application. The Catalog Number format for

this collection can not be edited once it is chosen.

Several formats are also available within this drop-down menu list:

• Format offers several choices in the drop-down menu list:

None is the default setting, which is a 60 character string field.

Create allows you to create your own format. Choosing Create

will open the Field Formatting Editor. Click HERE for the Field

Formatting Editor help page.
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CatalogNumber (2009-######) The year will appear

automatically in the first section (2009) of the format, and can also

be manually edited inside Specify. The '###' section of the format

is a number that is six digits in length. This section can be

automatically incremented when Auto Numbering is turned on in

Specify or manually entered when Auto Numbering is turned off.

These two sections are separated by a dash.

CatalogNumberAlphaNumByYear (2009-######) The year will

appear automatically in the first section (2009) of the format, and

can also be manually edited from within Specify. The '###' section

of the format is a number that is six digits in length. This section

can be automatically incremented when Auto Numbering is turned

on in Specify or manually entered when Auto Numbering is turned

off. These two sections are separated by a dash.

CatalogNumberNumeric (#########) This is a nine digit

number that is automatically incremented when Auto Numbering

is turned on in Specify or manually entered when Auto Numbering

is turned off.

CatalogNumberString (XXXXXXXXXX) This is a ten digit

string that can include numbers, alphabet or characters

• Is Numeric will display a 'yes' if the format is numeric.

• Pattern displays the pattern used to create each format (these are explained

in further detail above).

• Is Auto Incremented displays a 'yes' if the format is automatically

incremented.

Collections that do not use one specific format for their Catalog Number may

wish to choose CatalogNumberString from the list, this will allow any format to

be entered as long as they are all of the chosen character length.

Note: Auto incrementing will not work with the Catalog Number

format.
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Create an Accession Number Format

Accession Numbers

Note: If you chose to manage your Accessions globally your accession

number format will already be the same for each division and this

screen will be inactive. If this is the case, simply click on the Next

button to proceed in the Wizard.

Accession Numbers may require a format or may simply use a number. Choose

None to leave the Accession Number as a text field on the Accession form.

Accession Number formats are not editable once data has been entered in the

database.

• Format offers several choices in the drop-down menu list:

None is the default setting, which is a 60 character string field.

Create allows you to create your own format. Choosing Create

will open the Field Formatting Editor. Click HERE for the Field

Formatting Editor help page.

Accession Number (2009-AA-###) The year will appear

automatically in the first section (2009) of the format, and can also

be manually edited. The 'AA' section of the format is alphanumeric

and accepts both characters a through z and numbers. The ###

section of the format is a number that is automatically incremented

when Auto Numbering is turned on in Specify and manually

Specify Help - Adding Institutional Levels

28 / 391



entered when Auto Numbering is turned off. This format offers

two alphanumeric characters and three incremented numbers.

AccessionNumberByYear (2009-AA-AAA) The year will appear

automatically in the first section (2009) of the format, and can also

be manually edited. The 'A' sections of the format are

alphanumeric and accept both characters a through z and numbers.

This format offers two alphanumeric sections, the first is two

characters in length and the second is three characters in length.

AccessionStringFormatter (AAAAAA) This is a single

alphanumeric format that accepts characters a through z and

numbers. The Accession number would be seven characters in

length.

• Pattern displays the pattern used to create each format (these are explained

in further detail above).

• Is Auto Incremented displays a 'yes' if the format is automatically

incremented.

Summary Window

Summary

Congratulations! You have finished the Specify Setup Wizard. This last screen

displays all the data that has been created using the information provided in the

preceding windows. If edits are required simply click the Back button until the

desired window displays and re-enter the information.
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Add/Edit Disciplines

New Divisions, Disciplines and Collections are added using the Configuration

tool;Configuration at System > System Setup > Configuration.

Click the Division button on the side bar. The Divison form includes a Discipline

subform for adding or editing a discipline.

Edit the discipline information on the division subform:

• Data Type
• Specify uses the Type information to load the correct default data entry Forms, Trees

and schema (tables and fields) within Specify.

• The Name will display within Specify and can be anything you wish. It can be queried

and used in reports.

The Division form includes information for each of the existing Divisions. The new

Discipline will be added in the Division that is currently displayed in the work space. Use

the navigation control at the very bottom of the window to step to the Division that will

include the new Discipline.

Navigation Control

In the Discipline sub form click the (add) button to add a Discipline.

It is important to note that Specify will require users to shut down and reopen the

application after adding a Discipline.

A Discipline Wizard will walk you through adding not only a Discipline, but a Collection

within the Discipline as well as Taxon and Geography Tree Definitions and nodes (names

of Taxa and Geographical locations) and Catalog and Accession number. Each of these

windows is explained below.
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Choose a Discipline Type

Discipline

Choose a taxonomic Discipline Type from the drop-down menu. Specify uses

this information to load the correct default data entry forms, trees and schema

(tables and fields) based on the predefined disciplines within Specify.

The Name will display within Specify and can be any user specific variation of

the discipline type. It can be edited, queried and used in reports.

Configure the Taxon Tree

Taxon Tree
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This table will create the tree definition for the taxon tree. The taxon tree operates

at the discipline level and can be used by all collections within the discipline you

created in the last window. Nodes to the taxon tree can be added later in the

Wizard as well as from within Specify.

• The Level column displays the available levels. This name can be edited

from within Specify. Click the Include box to place the level in the tree.

• Include places the level in the tree definition. Levels that are not included

can not be Enforced or added to the full name.

• Is Required is not editable, but an indication of the tree levels that are used

by Specify as a system requirement. These are automatically added to the

tree and can not be deleted on this screen or later.

• Is Enforced ensures that the level can not be skipped when adding nodes

lower down the tree.

• Is in Full Name includes the level when building a full name expression for

any associated Collection Objects (which appears in the Taxon Full Name

field of the taxon table). The full name is also displayed in the Preferred

Taxon field on the determinations form and is useful when running queries

and reports when the full name is desired. The full name generally includes

at least the binomial genus and species fields together with any levels below

species (if used) . Create the full name by checking the desired boxes.

At least one level for Full Name must be checked before the Next button will

become enabled.

• Separator refers to the character that separates the levels when displaying

the full name. This can be any single character, such as a comma (,) or a

space. To make the separator a space simply double click inside the column

and delete the comma, then press your spacebar one time.

• Full Name Order will reverse the full name as shown in the Full Name
Example.
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Preload Taxon Records/Nodes

Pre-Load Taxon Authority File

The Wizard not only defines the taxon tree but also allows loading of an authority

file for the discipline you are creating. Authority files were created using data

from the Catalog of Life Project for some of the disciplines within Specify. If this

window does not appear, there are no existing authority files for your chosen

discipline.

If you choose to load the data into your tree the Taxon tree will be populated with

hundreds of taxon nodes and all associated data. Then, when adding Collection

Objects into your database you can simply choose a taxa from the Taxon field

rather than adding each individually as needed.

Please note that loading the Taxon tree will also affect the tree definition. If you

load the provided Taxon authority file for your discipline the accompanying tree

definition may include Levels that were not defined by you in the previous

window, but are necessary to include all the predefined Taxon information.

Additional discipline-specific trees can be loaded from within Specify at the time

new disciplines are created.

Click the Choose button for a list of taxon files for the discipline you are creating.

Not all disciplines offer more than one taxon file. Once the taxon file is chosen,

information will display in the Source, Coverage and Description fields for that

file.
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Note: Botany and Entomology authority files are partial due to the size

of these files. Contact the Specify team at specify@ku.edu for

additional authority files.

The Downloadable File section in this window allows you to choose taxon files

from your hard drive. The Setup Wizard can only install files that were

downloaded from the Specify website. The Specify team is currently in the

process of creating more of these files.

Configure and Load Geography Tree

Geography

The Geography tree operates at the Discipline level and is used by all Collections

within the Discipline. Nodes to the Geography tree can be added later in the

Wizard as well as from within Specify

• The Level column displays the available levels. This name can be edited from

within Specify. Click the Include box to place the level in the tree.

• Include places the Level in the tree definition. Levels that are not included can

not be Enforced or added to the Full Name.

• Is Required is not editable, but an indication of the tree levels that are used by

Specify as a system requirement. These are automatically added to the tree and

can not be deleted on this screen or later.

• Is Enforced ensures that the level can not be skipped when adding nodes lower

down the tree.
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• Is in Full Name includes the level when building a full name expression, which

can be queried and used in reports. Create the full name by checking the desired

boxes.

At least one level for Full Name must be checked before the Next button will

become enabled.

• Separator refers to the character that separates the levels when displaying the full

name. This can be any single character, such as a comma (,) or a space. To make

the separator a space simply double click inside the column and delete the

comma, then press your spacebar one time.

• Full Name Order will reverse the full name as shown in the Full Name
Example.

The Wizard will automatically load data for the Geography tree, including

Continents, Countries, and States throughout the world as well as Counties within

the United States. Data for the Geography tree was converted from the online

website of the World Gazetteer. Unwanted or unneccessary nodes can be deleted

later from within the Tree tool.

Create a Collection

Collection

Enter the Name and internationally recognized Collection Code to create a single

Collection within the Discipline. This is the name that will appear within Specify

on the Collection form and can be queried and used in reports.
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The Code should be your standard collections community assigned code for your

collection. This Code will be used in data exports and web interfaces in upcoming

releases of Specify.

Create a Catalog Number Format

Catalog Number Format

Specify is able to accept data for collection objects or observations without

assigning a Catalog Number. But when Catalog Numbers are used, they must be

unique for each lot, specimen or observation. Many collections routinely assign

catalog numbers to incoming specimens, perhaps as part of the accessioning

process. These numbers may require a format with specific sections for data such

as Institution Code and year or they may simply use an incrementing number.

Catalog Numbers can either be unique to each Collection, shared by several

collections or be used throughout the Institution. The Catalog Number chosen at

this time will not affect where it is used relative to other collections, this will be

configured from within the Specify application. The Catalog Number format for

this collection can not be edited once it is chosen.

Several formats are also available within this drop-down menu list:

• Format offers several choices in the drop-down menu list:

None is the default setting, which is a 60 character string field.

Create allows you to create your own format. Choosing Create

will open the Field Formatting Editor. Click HERE for the Field

Formatting Editor help page.
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CatalogNumber (2009-######) The year will appear

automatically in the first section (2009) of the format, and can also

be manually edited inside Specify. The '###' section of the format

is a number that is six digits in length. This section can be

automatically incremented when Auto Numbering is turned on in

Specify or manually entered when Auto Numbering is turned off.

These two sections are separated by a dash.

CatalogNumberAlphaNumByYear (2009-######) The year will

appear automatically in the first section (2009) of the format, and

can also be manually edited from within Specify. The '###' section

of the format is a number that is six digits in length. This section

can be automatically incremented when Auto Numbering is turned

on in Specify or manually entered when Auto Numbering is turned

off. These two sections are separated by a dash.

CatalogNumberNumeric (#########) This is a nine digit

number that is automatically incremented when Auto Numbering

is turned on in Specify or manually entered when Auto Numbering

is turned off.

CatalogNumberString (XXXXXXXXXX) This is a ten digit

string that can include numbers, alphabet or characters

• Is Numeric will display a 'yes' if the format is numeric.

• Pattern displays the pattern used to create each format (these are explained

in further detail above).

• Is Auto Incremented displays a 'yes' if the format is automatically

incremented.

Collections that do not use one specific format for their Catalog Number may

wish to choose CatalogNumberString from the list, this will allow any format to

be entered as long as they are all of the chosen character length.

Note: Auto incrementing will not work with the Catalog Number

format.

Specify Help - Adding Institutional Levels

37 / 391



Create an Accession Number Format

Accession Numbers

Note: If you chose to manage your Accessions globally your accession

number format will already be the same for each division and this

screen will be inactive. If this is the case, simply click on the Next

button to proceed in the Wizard.

Accession Numbers may require a format or may simply use a number. Choose

None to leave the Accession Number as a text field on the Accession form.

Accession Number formats are not editable once data has been entered in the

database.

• Format offers several choices in the drop-down menu list:

None is the default setting, which is a 60 character string field.

Create allows you to create your own format. Choosing Create

will open the Field Formatting Editor. Click HERE for the Field

Formatting Editor help page.

Accession Number (2009-AA-###) The year will appear

automatically in the first section (2009) of the format, and can also

be manually edited. The 'AA' section of the format is alphanumeric

and accepts both characters a through z and numbers. The ###

section of the format is a number that is automatically incremented

when Auto Numbering is turned on in Specify and manually
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entered when Auto Numbering is turned off. This format offers

two alphanumeric characters and three incremented numbers.

AccessionNumberByYear (2009-AA-AAA) The year will appear

automatically in the first section (2009) of the format, and can also

be manually edited. The 'A' sections of the format are

alphanumeric and accept both characters a through z and numbers.

This format offers two alphanumeric sections, the first is two

characters in length and the second is three characters in length.

AccessionStringFormatter (AAAAAA) This is a single

alphanumeric format that accepts characters a through z and

numbers. The Accession number would be seven characters in

length.

• Pattern displays the pattern used to create each format (these are explained

in further detail above).

• Is Auto Incremented displays a 'yes' if the format is automatically

incremented.

Summary Window

Summary

Congratulations! You have finished the Specify Setup Wizard. This last screen

displays all the data that has been created using the information provided in the

preceding windows. If edits are required simply click the Back button until the

desired window displays and re-enter the information.
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Add/Edit Collections

New Divisions, Disciplines and Collections are added using the Configuration

tool;Configuration at System > System Setup > Configuration.

Click the Discipline button on the side bar to edit a Discipline or add a Collection.

The Discipline information will appear at the top of the form with a Collections sub form

underneath. The new Collection will be added in the Discipline that is currently displayed

in the Workspace. Use the navigation control at the bottom of the window to step to the

desired Discipline before adding the new Collection.

Navigation Control

Click the (add) button to add a Collection.

It is important to note that Specify will require users to shut down and reopen the

application after adding a Collection.

A Collection Wizard will step you through the process of adding a collection as well as a

Catalog Number format and Accession format (if applicable).

Create a Collection

Collection
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Enter the Name and internationally recognized Collection Code to create a single

Collection within the Discipline. This is the name that will appear within Specify

on the Collection form and can be queried and used in reports.

The Code should be your standard collections community assigned code for your

collection. This Code will be used in data exports and web interfaces in upcoming

releases of Specify.

Create a Catalog Number Format

Catalog Number Format

Specify is able to accept data for collection objects or observations without

assigning a Catalog Number. But when Catalog Numbers are used, they must be

unique for each lot, specimen or observation. Many collections routinely assign

catalog numbers to incoming specimens, perhaps as part of the accessioning

process. These numbers may require a format with specific sections for data such

as Institution Code and year or they may simply use an incrementing number.

Catalog Numbers can either be unique to each Collection, shared by several

collections or be used throughout the Institution. The Catalog Number chosen at

this time will not affect where it is used relative to other collections, this will be

configured from within the Specify application. The Catalog Number format for

this collection can not be edited once it is chosen.

Several formats are also available within this drop-down menu list:
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• Format offers several choices in the drop-down menu list:

None is the default setting, which is a 60 character string field.

Create allows you to create your own format. Choosing Create

will open the Field Formatting Editor. Click HERE for the Field

Formatting Editor help page.

CatalogNumber (2009-######) The year will appear

automatically in the first section (2009) of the format, and can also

be manually edited inside Specify. The '###' section of the format

is a number that is six digits in length. This section can be

automatically incremented when Auto Numbering is turned on in

Specify or manually entered when Auto Numbering is turned off.

These two sections are separated by a dash.

CatalogNumberAlphaNumByYear (2009-######) The year will

appear automatically in the first section (2009) of the format, and

can also be manually edited from within Specify. The '###' section

of the format is a number that is six digits in length. This section

can be automatically incremented when Auto Numbering is turned

on in Specify or manually entered when Auto Numbering is turned

off. These two sections are separated by a dash.

CatalogNumberNumeric (#########) This is a nine digit

number that is automatically incremented when Auto Numbering

is turned on in Specify or manually entered when Auto Numbering

is turned off.

CatalogNumberString (XXXXXXXXXX) This is a ten digit

string that can include numbers, alphabet or characters

• Is Numeric will display a 'yes' if the format is numeric.

• Pattern displays the pattern used to create each format (these are explained

in further detail above).

• Is Auto Incremented displays a 'yes' if the format is automatically

incremented.

Collections that do not use one specific format for their Catalog Number may

wish to choose CatalogNumberString from the list, this will allow any format to

be entered as long as they are all of the chosen character length.

Note: Auto incrementing will not work with the Catalog Number

format.
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Create an Accession Number Format

Accession Numbers

Note: If you chose to manage your Accessions globally your accession

number format will already be the same for each division and this

screen will be inactive. If this is the case, simply click on the Next

button to proceed in the Wizard.

Accession Numbers may require a format or may simply use a number. Choose

None to leave the Accession Number as a text field on the Accession form.

Accession Number formats are not editable once data has been entered in the

database.

• Format offers several choices in the drop-down menu list:

None is the default setting, which is a 60 character string field.

Create allows you to create your own format. Choosing Create

will open the Field Formatting Editor. Click HERE for the Field

Formatting Editor help page.

Accession Number (2009-AA-###) The year will appear

automatically in the first section (2009) of the format, and can also

be manually edited. The 'AA' section of the format is alphanumeric

and accepts both characters a through z and numbers. The ###

section of the format is a number that is automatically incremented

when Auto Numbering is turned on in Specify and manually
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entered when Auto Numbering is turned off. This format offers

two alphanumeric characters and three incremented numbers.

AccessionNumberByYear (2009-AA-AAA) The year will appear

automatically in the first section (2009) of the format, and can also

be manually edited. The 'A' sections of the format are

alphanumeric and accept both characters a through z and numbers.

This format offers two alphanumeric sections, the first is two

characters in length and the second is three characters in length.

AccessionStringFormatter (AAAAAA) This is a single

alphanumeric format that accepts characters a through z and

numbers. The Accession number would be seven characters in

length.

• Pattern displays the pattern used to create each format (these are explained

in further detail above).

• Is Auto Incremented displays a 'yes' if the format is automatically

incremented.

Summary Window

Summary

Congratulations! You have finished the Specify Setup Wizard. This last screen

displays all the data that has been created using the information provided in the

preceding windows. If edits are required simply click the Back button until the

desired window displays and re-enter the information.
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Edit Collections

Collections can be edited on the Collection form which will open by clicking the Collection

button on the Configuration side bar.

• The Collection Name will be used on any Specify Collection lists as well as in the

Institution Hierarchy.

• Add Collecting Event Automatically creates a new, unique Collecting Event record

for each Collection Object. This is required for Collections that include a one-to-one

relationship between their Collecting Event and Collection Object on their Collection

Object form. When using the default Specify forms all Collections except those in an

Ichthyology Discipline will need to check this box.

• ABCD Schema Fields is a sub form for adding this information to the Collection.

Field Formatting Editor

If you have chosen to Create a new Catalog Number or Accession Number format from either the

Specify Setup Wizard or Configuration window in Specify you are now seeing the Field Formatting

Editor.

Field Formatting Editor

Field Formatting Editor

A format allows a field to include sections for different data, such as static text, a date or an

incremented number.
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The table, field and field length information is located on the top left.

• Name is used within the application files. It should be text only and will not be displayed to the

user anywhere else in the application.

• Title will be displayed in any application format lists that are presented to the user.

• Reset Counter Every Year will become enabled when a Numeric section that 'Is Incremented'

is added to the format (this is explained in more detail in the following text). Checking this box

will start a new count each year.

A format can be made up of one or many sections.

1. Begin creating a format by clicking the (add) button on the right side of the editor to

add a section.

2. Next, choose the type of section to add.

Field Format Section Types

• Numeric may only be numbers and can be auto incremented by checking the 'Is

Incrementer' box and using Auto Numbering when entering data. When auto

numbering Specify will start incrementing from the highest number present for the

section within the database. A numeric section can be set between 1 and 10 characters

in length. To start a new count for each year, check the Restart counter every year box.

It is important to remember that different field formats are implemented at different

levels and that formats that include a section that 'Is Incremented' will include a

numbering scheme that may be shared. For instance, an Accession number can be

implemented at either an Institution or Division level. An Accession number

implemented at a Division level configured with 'Is Incrementer' checked will

increment in all collections and disciplines for that division. In other words, they share

a numbering scheme.
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Collection Numbers are implemented at a Collection level and increment

automatically for single collections only. Users that wish to increment Collection

Numbers between more than one collection should contact the Specify team at

specify@ku.edu for help setting that paramater.

• Alphanumeric may use both alphabetic characters a through z and numbers. A length

field will appear which allows the section to be set between 1 and 10 characters in

length.

• Alpha may only be alphabetic characters a through z. A length field will appear which

allows the section to be set between 1 and 10 characters in length.

• Separator refers to a character that separates the various sections. Separator choices

include - . / ' ' _ and are one character in length.

• Year will automatically add the current year on a form, but can be edited.

• Any char(acter) allows any alphabetic characters a through z, any number or any

other keyboard character. A length field will appear which allows the section to be set

between 1 and 10 characters in length.

• Constant refers to any section that will remain constant and is not editable on a form.

This type of section is useful when an institution code is part of a format. Type the

characters for the constant in the text field labeled Text located under the Type box.

3. Once the section information is configured correctly add it to the format by clicking the

button.

The section will appear in the window with the appropriate information in each of the

columns.

• Type refers to the Type of section that was chosen from the pick list.

• Value shows the character used to represent the segment in the Sample at the bottom

of the window.

• Size refers to the number of characters chosen for the section. This is not applicable to

the Separator or Year section types.

• Is By Year refers only the Year section type.

• Is Incrementer refers only to the Numeric section type that is incremented. On the

Wizard's Collection Number window, it will display in the Is Numeric section.
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4. Reorder sections by clicking the (reorder up) and (reorder down) buttons on the

right side of the editor.

5. Delete unwanted sections by clicking the (delete) button.

6. Continue adding sections until the format is complete and displays correctly in the

Sample window at the bottom of the editor.

Note: When manually entering a formatted number field, it is paramount that

numbers be padded with 0's. For example, if 3 numbers are available in a

numbering scheme (###) and the desired number is 1, then 001 must be entered.

If only 1 is entered, then Specify will read this as 100. This will produce incorrect

results in searches, queries and reports.

Once the format is complete click HERE to return to the Catalog Number in the Setup Wizard help.

Once the format is complete click HERE to return to the Catalog Number in the EZDB Setup Wizard

help.

Once the format is complete click HERE to return to the Accession Number in the Setup Wizard help.

Once the format is complete click HERE to return to the Accession Number in the EZDB Setup

Wizard help.

System Pick Lists

Any field in which data is limited to a controlled vocabulary is called a Pick List. Specify ships with

many fields already formatted as pick lists and populated with choices. For example, the Agent Title

field is pre-populated with the choices of Asst. Director, Curator, Dr., Mr., Mrs., and Ms.

Pick lists that are predefined within Specify are called System Pick Lists. New pick lists created by

the user are referred to as User Defined Pick Lists. The following text explains the steps needed to

edit a System Pick List. For information about adding or editing User Defined Pick Lists please refer

to User Defined Pick Lists.

Pick Lists are part of the form system and therefore shared within a collection.
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Editing System Pick List

System Pick Lists can not be deleted or added within Specify, but can be edited in a limited

capacity. Only Pick Lists with definable items can be edited. The name and type of system

pick list can not be edited.

Editing is performed in the Pick List Editor.

Choose System > Collection Setup > Configuration then click on Pick List Editor in the

side bar menu. The Configuration tool (and menu) is only available to users in a Manager

group.

• Choose a Pick List from the System Pick Lists at the top of the dialog.

• Click the (edit) button at the bottom of the list.

A second dialog will open for configuring the Pick List. The Pick List items are located at

the bottom of the dialog.

• Click the (plus) button to add an item.

• Click the (delete) button to delete an item.

• Click arrow buttons in the Navigation Controls to navigate through the items.

• Type a Title will appear in the pick list.

• Type a Value is stored in the data base. It is a good practice not to use spaces in the

Value and to abbreviate where possible. The Value exists so that at a later date the

Title can be edited without needing to change the Value in the data base. Values

should not be edited.

• Click the Save button.

Import/Export System Pick List

Updated System Pick Lists can be shared with other collections or colleagues by exporting

them from the originating colleciton and importing them into a different collection. This

task is completed in the Configuration tool: System > System Setup > Configuration.

Export a Pick List
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Click on the Export Pick List button on the side bar to export a Pick List.

Next, choose a Pick List(s) to export from the dialog list.

Choose Pick Lists to Export

Next, a system dialog will appear to name the file and choose where it will be

saved in your file system.

Import a Pick List

Click on the Import Pick List button to import a Pick List.

Next, choose the Pick List file from your system directory.

The Pick List(s) will be updated in the current collection.

Note: User Defined Pick Lists should not be imported using this

method UNLESS the Data Entry forms for the collection have been

updated to include the pick list(s). Importing a User Defined Picklist

without first editing the forms will cause Specify to work improperly.
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User-Defined Pick Lists

Any field in which data is limited to a controlled vocabulary is called a Pick List. For example,

Specify ships with the Agent Title field limited to the choices of Asst. Director, Curator, Dr., Mr.,

Mrs., and Ms.

New user-defined pick lists can be created for existing fields but the field on the affected form will

not be updated until the form itself has been edited. For this reason pick lists should NOT be defined

until the new form containing the pick list has been imported into Specify. If pick lists are defined

without being included in the existing form, data entered into the existing form will not be saved in

the database.

At this time Specify 6 does not include a Form Editor, as was found in Specify 5. It is important to

note that the forms have been created programmatically to be extremely flexible and can be exported

as XML and either edited locally by an experienced XML editor, or emailed to the Specify staff for

customization assistance. To export a form please refer to Importing/Exporting. If you have an ISA

agreement and wish to have a member of the Specify team edit the form please contact them at

specify@ku.edu.

Pick lists that are defined within Specify are called system pick lists. New pick lists created by the

user are referred to as User- Defined Pick Lists. The following text describes the steps to create a

user-defined pick list. For information about system pick lists, please refer to System Pick Lists.

Any pick list changes are reflected in the current collection only. The release of Specify 6.3 allowed

pick lists to be exported and imported, allowing quick sharing among collections and collecting

communities. This feature also allows the Specify team to create and share pick lists at the same time

they create custom forms. More information about importing and exporting Pick Lists can be found in

the text below.

Creating and Editing User Defined Pick Lists

Any string field can be configured as a pick list.

Add, delete and edit the pick lists in the Pick List Editor found in System > Schema

Configuration. The Schema Configuration tool is only available to users in a manager or

administrator group.

• Choose English as the language.

• Click the Edit a Schema button.

The Schema Configuration tool will open.
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• Choose a table from the list of tables.

• Choose a field from the list of fields.

• Choose pick list from the format type combo box.

The following combo box and button appears:

Field Format Type

The second combo box is used to link the newly created pick list to the field. The (...)

button opens the Pick List Editor.

Add a Pick List

To add a new pick from within the pick list editor, leave the second combo box as 'none'

and click the (...) button.

• Choose the (add) button.

A second dialog will open to configure the pick list. There are three types of pick lists, all

with different configurations:

1. User Defined Items is a predefined list. Items in this type of pick list are either created by

the user (controlled vocabulary) or created when values are typed into a field.

A Pre-defined pick list is very useful to control the exact data entered into a field.

A good example of this is Type Status Name in the determinations form. Anyone

entering determinations is limited to the same set of data choices.

To create a predefined list of items:

• choose User Defined Items from the Type drop down menu.

• Type a name in the Name text box.

• Check the Read Only check box.

• click the (add) button in the Items section.

• Type a Title will appear on the form.

• Type a Value is stored in the data base. It is a good practice not to use

spaces. The Value exists so that at a later date the Title can be edited without

needing to change the value in the data base.
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Use a pick list that is created as values are typed into the field when a controlled

list is required but but it is also necessary to allow users to enter new values.

To create a pick list that is created from entered data:

• Use the steps above, but Do Not check the Read Only box.

• Size Limit field - limits the number of values in the pick list. Once the list

has reached this number of values the oldest value will be dropped from the

list.

2. Entire Table allows all values in a formatted table to be listed. This is a useful tool when

the field needs to link to an entire record but the list of values is small and a Query Combo

box is not necessary.

To create an Entire Table list:

• Choose Entire Table from the Type combo box.

• Type a name for the pick list in the Name text box.

• Choose a Table from the Table Name combo box.

• Choose a Formatter from the Formatter box; this typically will offer only a

single choice.

3. Field From Table uses the values from a field within a table. Creating a pick list from a

field is only feasible when there will be a small number of values. If the number exceeds 12

it is suggested that the field be linked to a Query Combo Box within the form rather than a

pick list.

To create a Field From Table list:

• Choose Field From Table from the Type combo box.

• Type a name for the pick list in the Name box.

• Choose a Table from the Table Name combo box.

• Choose a Formatter from the Formatter box -- in most cases there will not be

more than one choice for this.

• Choose a field from the Field Name combo box.

Once the pick list has been created, it will need to be linked to the field.

• Click the second combo box (currently displaying 'None').

• Choose the pick list name from the list.
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Edit a Pick List

To edit a pick list from within the Pick List Editor:

• Click the (...) button to open the Pick List Editor.

• Click the (edit) button.

• Use the same information in Add a Pick List to change the configuration of an existing

pick list.

Import/Export a Pick List

Pick list definitions in a collection can be exported as an xml file and imported for use in a

new collection. In this way, pick lists can be shared within an institution, collecting

community, or between the Specify staff (who are creating custom forms) and users.

The Import and Export function is only available in the Pick List Editor found in the

Schema Configuration tool.

Note: If a pick list of the same name already exists, the imported pick list will

replace the existing one.

Note: The values within a pick list will not be imported in the Entire Table or

Field From Table pick list types. Only the pick list definition will be imported for

these types of pick lists.

Import

1. Click the Import button.

2. Choose the pick list xml file you wish to import from the file manager.

3. Click the Open button.

The pick list will either be added to the list of User Defined Pick Lists or replace

the existing pick list.

Note: Forms must be edited to show pick lists. If you import a new pick

list but do not edit the field on your form you will not see the pick list.

For help editing your forms please contact Specify at specify@ku.edu
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Export

1. Click the Export button

2. Select the pick list(s) you would like to export by checking them in the

dialog.

Select All will select all the pick lists in the dialog. Deselect All will

deselect all the pick lists in the dialog.

1. Click the OK button.

2. Choose a location for the pick list file from the file manager.

3. Click the Save button.

Note: The pick list will be saved as:

'disciplinename'_'collectionname'.xml

Editing the Preparation Type

Choose System > System Setup > Configuration to edit the Preparation Type.

When entering a Collection Object within a form the Preparation Type is a Pick List that is derived

from the Preparation Type table. Since there are no forms for this Table the Preparation Type has its

own editing function.

• Click on the (Preparation Type) icon

• Click the (add) icon to add a Preparation Type

or

• Edit an existing Prep Type by using the (Navigation Control) to find the

desired Preparation Type. The Navigation Control is found at the bottom of the work space

window.

• Click the Save button to save changes

Check the Is Loanable box to allow the Preparation Type to be available within the Loan form. Not

checking the box will ensure that the Preparation Type is not made available when creating a loan.

If a non-loanable Preparation Type is selected when creating a loan a warning dialog will appear

informing the user that the chosen specimen(s) are not loanable.
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Adding Users and Setting Permissions

Specify includes a highly flexible Security module that allows a system administrator to add users,

then limit their operations within, and access to, the various tables and tools within Specify. These

essentially constitute the User Permissions.

To access the Security tool click System > System Setup > Security Tools. Security tools are only

available to users in a Manager or Administrator group.

Users are added to Specify based on their Institutional Level and User Group.

Security can be turned on or turned off. An icon at the bottom right of the status bar alerts users as to

the status of security.

Security is ON

Security is OFF

Institutional Levels

Specify mirrors the common levels of hierarchy within institutions. This hierarchy is viewed in an

Institution Tree on the left side of the Security window.

• Institution

o Discipline

- Collection

- User Group

- User

At this time users are added at the Collection level only. The lowest level, collection, can access data

within a specific collection (Wet Collection, Teaching Collection). Specify opens in a collection or at

a collection level (in a multi-collection database), therefore, users added to only one collection can

not access other collections.

Users can belong to more than one collection.
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Adding Institutional Levels

If the desired Institutional level is not present in the Institution Tree, it can be added in the

System Configuration module by choosing System > Collection Setup > Configuration and

following the instructions for Adding Institutional Levels.

User Groups

Specify adds users within an existing user group. The groups are editable and can be

established according to levels of access to data and tools within Specify per institution.

Each group has a set of default privileges. Users entered into the group acquire the default

privileges of that group. The user privileges can then be edited based on the exact privileges

the individual user will require.

User groups also have their own system of levels:

The default permissions in Specify include:

• Guest users can view the data within a collection and use the WorkBench, but may not

Upload data from the WorkBench into the Specify database.

• Limited Access users are granted full access to all data and tools except Backup and

Restore, Schema Configuration, Resource Import/Export, Configuration, WorkBench

Schema Configuration and Security.

• Full Access users are granted full access to all data and tools except Backup and

Restore, Schema Configuration, Resource Import/Export, Configuration, WorkBench

Schema Configuration and Security.

• Managers have full permissions to all data and tools within Specify.

Users can be added to different groups within different Collections. For example, user A

could be added at a Managers level for collection A but at a Limited Access level in

collection B.

An Administrator group also exists outside the Institutional Hierarchy. An Administrator is

automatically given full access to all data and tools inside Specify. Administrators are the

only users with access to the Backup and Restore, Schema Configuration, Resource

Import/Export, Configuration, WorkBench Schema Configuration and Security tools. At

this time an Administrator must also belong to a collection inside the Institutional Hierarchy

for the purpose of opening Specify to a collection and creating an associated Agent in that

collection. If Specify was originally configured by running the Specify Setup Wizard the
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original user was placed in both the Administrator group and Manager group in the

collection that was created by the Wizard.

Buttons for adding and deleting users are found on the bottom left of the work space under

the institution tree.

Adding Users

Existing User

Click the desired group (within the desired collection), then click the Add an Existing User

to Group button. A list of existing users will appear, choose the desired user from the list

and click the OK button.

New User

Click the desired group (within the desired collection), then click the Add a New User to

the Group. The Specify User form will pop-up for user information to be entered.

• Name refers to the username the user will use to login to Specify. Once the username

is saved it may not be edited.

• Password is the password the user will use to login to Specify. Passwords can be

edited at a later date either in Security Tools or by choosing Help > Change Password.

Users should choose strong passwords with varying characters and capitalization. A

strength bar exists for judging the quality of the entered password.

• Password Strength offers checkboxes with the best suggestions for a strong

password. The Password Minimum Length is the only password strength item that is

enforced. The default length is eight (8) characters, but can be changed using the

Institution form.

• Master Key refers to the encrypted Master username and password. Simply fill in all

the information within the form and click the Generate New Key button. The key can

not be created without the Name and Password information. The key is stored locally

and will therefore need to be given to the user and entered by the user at the time of

their first login to Specify.

Once the user information has been entered, a dialog will appear asking if you wish to

search for an Agent or create a new Agent. All users in Specify must also be Agents within

a collection. If you think a user may already exist as an Agent, click on the Search button. If

you know the new user is not a current Agent in the database click the Create button.
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If you chose to search for an agent, a form will appear entering search information.

If you chose to create an agent, a form will appear to add an agent.

Delete a User

Click on a User to delete them from the collection.

Delete User from Group will delete the user from the specified group only. The user

will be deleted from within the Security tool, but their information will remain in the Agent

table.

Permissions

Setting User Permissions

Specify 6.0 grants default permissions to each User Group within Specify when

security is turned on. These permissions are then passed down to each User

within the Group. The permissions for the individual user can either be left

unchanged and therefore remain exactly like the Group, or be edited for that user.

When editing permissions for individual users permissions for tables and tools

can be added, but not removed. In other words, permissions inherited from the

Group can not be edited. To change these permissions the Group itself must be

edited.

Group Permissions

Permissions can be removed and added at the Group level, but keep in mind that

Specify will update all the Users in the group with the changed permissions.

Changing permissions for a Group will only affect that Group's collection.

Specify limits the Backup and Restore, Schema Configuration, Resource

Import/Export, Configuration, WorkBench Schema Configuration and Security
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tools to Administrators only, but permissions for all other data and tools are

configurable per Group and per User.

Setting Permissions

Click on a User or Group to view both their information and permissions in the

work space. The permissions open in the bottom half of the work space and

include a tab with three permission categories:

• Tools refer to anything used to manipulate data within Specify.

Click on a Tool in the list to display the permissions options. Configuration,

Data Entry, Information Request, Interactions, Plugins, Record Sets,

Reports, Security Tools, Simple Search, Statistics have these permissions:

o View allows a user to view data within a tool.

o Add allows a user to add a record within the context of the tool.

o Modify allows users to edit data within the context of the tool.

o Delete allows users to delete data within the context of the tool.

Backup and Restore, Query, Resource Import and Export, Schema

Configuration, WorkBench and WorkBench Schema Configuration allow

tools to be enabled only.

• Tables refers to each of the tables in Specify. Permissions can be set for

each individual table within the Specify schema.

Click a Table in the list to display the options for the permissions:

o View allows a user to view table data.

o Add allows a user to add a record.

o Modify allows users to edit table data within a record.

o Delete allows users to delete table data within a record.

• Preferences lists the modules in the actual Preferences module. Each can be

set for View, Add, Modify and Delete.

How Permissions affect the Specify Application

When Specify starts up, it checks the user permissions and loads various Specify

tools accordingly. Therefore, users who are not given permission to use modules

in Specify will not see the corresponding buttons that connect users to that

module. For instance, users who are not given permission to view trees will not
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have a tree button on the task bar or have the ability to add the tree button in the

user preferences tool.

Similarly, users who are not given permission to delete or add data will not see

the add or delete buttons.

If a user has questions about their permissions they can view it by clicking System

> System Setup > Security Summary.

It is extremely important to note that even though permissions are listed

separately for each table and tool, many of these work in unison and should have

similar settings. For instance, for a user to have access to a Collection Object

form for data entry purposes the user will need to have View, Add and possibly

Modify privileges for ALL the tables on the Collection Object form (Collection

Object, Determinations, Collecting Event, Taxon, Preparations, Collection Object

Attribute, Collectors and Collection Object Attachments) IN ADDITION to the

Form tool itself. For instance, in this example if permission was not given for a

user to Add or Modify the Preparations table, the user would not be provided with

the (add) or (delete) button on the Preparations sub form within the

Collection Object form. For this reason a good practice may be to set the same

level of permissions for all the Tables within a tool with the same level of

permissions being set for the Tool itself.

A good approach to setting permissions may be to decide what Tables and Tools

a particular user should not have access to and then change the permissions

accordingly.

Security Summary

Click System > System Setup > Show Security Summary to view a summary of your current

security settings.

Editing the Schema Configuration

Schema refers to the many tables and fields that systematize the many dimensions and relationships

of the data within biological collections. The Schema Configuration module is a highly functional,

Specify Help - Editing the Schema Configuration

61 / 391



though somewhat complex, set of tools created to configure the Specify schema for individual

discipline needs. Changes made in the Schema Configuration tool will affect all collections within a

discipline and can be used to individualize Specify for each discipline.

Changes made within the Schema Configuration tool affect some very sensitive areas of the database

and may require the Specify application to shut down. For this reason, it is a good idea to save all

changes and close all tabs before opening the Schema Configuration tool. If Specify does require a

restart, you will be prompted to save all changes within any open tabs before Specify closes.

The tools in the Schema Configuration provide the following functions:

• Change the captions, or display names, of tables and fields in Specify. These are displayed on

forms and in searches. The names in the database are not editable, but the captions can be edited.

• Hide unused tables or fields from the query tool. Hidden tables and fields will not be hidden on

the forms.

• Edit descriptions (usage notes) for tables and fields. These can be viewed from within a form by

double-clicking on the caption.

• Create a format for a table. This allows one or more fields to represent a table in a search result.

For example, an Agent is sometimes represented by the last name and first name fields,

separated by a comma.

• Create or edit an aggregatation for a table. A related table with a one-to-many relationship to the

primary table combines records into a single record typically separated by semi colons.

• Designate a field as being required. This is reflected on forms and in the WorkBench uploader.

A record can not be saved unless all required fields containing data.

• Format a field as a pick list, web link or field format.

Open Schema Configuration

1. Close all tabs and save any changes before opening Schema Configuration (you will be

prompted). Open Schema Configuration by clicking System > Schema Configuration. The

Schema Configuration tool (and menu) is only available to users in a Manager or

Administrators group.
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Open Schema Configuration

2. In the resulting dialog choose English in the Available Locales. The 6.3 release of

Specify has been translated into Portugese. To use the Portugese version of Specify please

contact Specify at specify@ku.edu. Because the Specify project is Open Source, any third

parties that are interested in translating Specify can easily do so, but are required to send the

changes to the Specify project. If you are interested in translating Specify, please contact

the Specify Project at specify@ku.edu.

Note: The Export, Import and Remove a Schema buttons allow schema

configurations to be shared with other Specify users. Importing a schema will

replace your existing schema. Be sure that you are using a complete, valid

Specify schema file when importing a schema. DO Not use the Schema

Configuration tool to import third-party schemas. This is accomplished using the

Schema Mapping Editor.

3. Next, click the Edit a Schema button in the Tasks section of the dialog. Future releases of

Specify will allow schemas to be both imported and exported. This would allow

communities to share common schema configurations. A collection manager who has both

the schema configuration and the forms changed to manage their discipline could share both

with the entire community, allowing all Collection Managers to have the exact same set-up

for their collection data.
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Schema Configuration Tool

The Schema Configuration tool opens with the schema listed on the left side and the tools

on the right. The top left pane titled 'Tables' lists all the tables in the Specify schema. The

bottom left pane titled 'Fields' lists the fields for each table. Click a table to display the

available fields. Many of the fields listed are related fields, which belong to other tables.

This will be discussed in more detail later.

The available tools for the Tables are listed on the top right and the tools for Fields are

listed on the bottom right.

Common Tools

The following tools within the Schema Configuration interact the same for both tables and fields.

Change a Caption for a Table or Field

The first tool is Caption and is available for both Tables and Fields. Simply select

a table or field from the appropriate list and type the new name into the Caption

field. The new caption will appear on forms, in the list of Query Creators and the

Simple Search Configuration tool.

Note: Only fields that are included on existing forms will reflect these

caption changes.
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Hide Unused Tables and/or Fields

Tables and fields that are not used by a particular discipline can be hidden. This

will remove them from the Query Creators list and Simple Search Configuration

choices. This will not remove fields from forms. Data can still be added to the

forms in the hidden field and will be saved in the database. This tool is mainly

used to simplify the lists presented for creating queries and simple searches by

removing fields that are not used. The hidden tables and fields will not be

removed from previously saved queries or reports.

Tables will not be removed from any side bar configurations. To remove tables

from the side bar click Tabs > Configure Side Bar, then select the name from the

list and click the (delete) button.

Edit Table / Field Description (Usage Notes)

Both the Tables and Fields have a description. This is useful when describing

how fields and tables are used within individual disciplines. This is an editable

field. These can be viewed as usage notes in a form by double clicking on a field

caption.

Table Tools

Tools for tables are available on the top section of the Schema Configuration tool. The following

tools are available for tables only.

Table section of the Schema Configuration tool

Specify Help - Editing the Schema Configuration

65 / 391



Format a Table

Tables can be represented in search results and in reports by one or several fields

within the table. Most tables are represented by only one field, (Collection Object

shows the Catalog Number), but some are best represented by more than one field

(Agent may be formatted to display Last Name, First Name, Middle Initial).

It is important to note that Preferred Taxon, Geography, Chronostratigraphy and

Lithostratigraphy fields use the full name as their format. This is configured in the

tree definition.

Open the Table Formatting Editor by first choosing a table to format from the

Tables list, then clicking the ... (dialog) button next to the Table Format field.

The initial dialog screen displays a list of saved table formats for editing

purposes.

Available Table Formats

Buttons at the bottom of the dialog offer the following:

• (checkmark) selects the saved format as the default, which will be used

by the application.

• (edit) opens the format editor for editing a saved format.

• (delete) removes the format.

• (add) opens the format editor for creating a new format.
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Clicking the or button opens the Table Format Editor dialog.

Table Format Editor

• Name is used when storing the format in the database. This name should be

short.

• Title is the name of the format and will appear in any table format lists (in

the first format editor dialog and the Display Format Pick List). This will

link to the shorter name in the database and can be more descriptive.

There are two types of Table Formats, a 'Single display format' that links to one

or more fields and a 'Display depends on value of field', which allows for

different formats based on the value in a conditional field.

Single table format
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The Single display format allows users to select fields from

the Available Fields window to be used in the table format.

1. First, click the Single table format button.

2. Next, select a field from the Available Fields window

by either double clicking on a field or selecting the field

and clicking the Add Field button. The Available Fields

lists related tables and their fields. Simply click on the

file folder of a related table to display the available fields

for the table.

3. Then select a Separator. These can be any character.

Display depends on value of field:

This type of format is useful when the data in one field sets a

condition for another field. A good example is a Current

Determination in Ichthyology. A Collection Object can have

many Determinations, but only one can be marked as Current.

Rather than displaying all Determinations the table can be

formatted to display only the Current Determination.

First choose the 'Display depends on value of field' button.

The window will change to include a Field Value and Display

Format.

Then choose a conditional field by clicking the button on

the Pick List and choosing a field from the list.

Next, click the (add) button at the bottom of the dialog. A

... (dialog) button will appear in the window.

Click the ... (dialog) button. The Format Editor described

above will appear.

1. Select a Separator. This can be any character.

2. Next, select a field from the Available Fields window

by either double clicking on a field or selecting the field

and clicking the Add Field button. The Available Fields

lists related tables and their fields. Simply click on the

file folder of a related table to display the available fields

for the table.
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3. Once the Display Format has been saved, type the Field

Value into the box. These will vary depending on the

table and fields for the format. In the above example, the

Field Value for Current would be true and false. The

Field Value can also be set to the Value of fields in a

Pick List (a good example of this is Agent).

Once a Table Format has been created it will need to be selected from the pick list

next to the Display Format caption.

Choose a Table Format

Aggregate a Table

Tables with a one-to-many relationship to the primary table could potentially link

multiple records to the primary table. The only method of displaying these in a

single line (e.g. for results or reports) is to aggregate them. Aggregating the

related table will use the table format for each individual record and group them

together into one record using a separator of your choosing. For example, a

Collection Object can have many Preparations. The results of a query on

Collection Objects containing any field in the Preparation table (for Collection

objects with multiple Preparations) will return multiple rows for that Collection

Object. However, selecting the aggregated and formatted table name in the query

tool will return a single record with the Preparation information formatted and

aggregated into a single string.

Open the Aggregation Editor by first choosing a table to aggregate from the

Tables list, then clicking the ... (dialog) button next to the Aggregation field.

The initial dialog displays any saved aggregation formats for editing and selection

of the default format.
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Available Table Aggregations

Buttons at the bottom of the dialog offer the following:

• (checkmark) selects the saved aggregation as the default, which will be

used by the application.

• (edit) opens the aggregation editor for editing a saved aggregation.

• (delete) removes the aggregation.

• (add) opens the aggregation editor for creating a new aggregation.

Clicking the (edit) or (add) button opens the following editor dialog.

Table Aggregation Editor
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Table lists the name of the table being aggregated.

• Name is used when storing the aggregation in the database. This should be

short so as not to take up too much space.

• Title is the name of the aggregation and will appear in any aggregation

format lists (in the first aggregation editor dialog and the Aggregation Pick

List). This will link to the shorter name in the database, allowing the title to

be more descriptive.

• Display offers a Pick List of formats for the table. The ... (dialog) button

opens the Format Editor for creating a new format or editing an old one.

• Separator refers to the character that will separate the individual records

from one another.

• Count refers to the number of records you wish to display. The limit is 10.

• Ending is required when choosing a Count. It is a text field for typing in the

words that will be placed at the end of the record to indicate that more

records are present but are not being displayed. Examples include et al, &,

etc.

• Sort by offers a Pick List of fields in the table for sorting the returns.

Once the Aggregation has been created, it will need to be selected from the

Aggregation pick list next to the Aggregation caption.

Choose an Aggregation

Web Links

At this time web links that are configured in the Schema Configuration also need

to be added to individual forms by exporting the form set and editing the xml file

for the form. Please refer to Web Links.

Field Tools
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Field section of the Schema Configuration tool

Fields have several properties that tables do not.

• Type indicates the type of field and is not user editable.

• Length indicates the length of the field. This can be useful to indicate how

much text can be added to a particular string or text field.

• Is Required refers to the required fields on forms. When entering data into a

form with required fields the form changes can not be saved until all the

required fields contain data. Any system required fields can not be edited.

Other fields can be changed.

• Field Format Type offers choices for altering string fields into either a

Formatted (described below), Pick List or Web Link.

At this time User-Defined Pick Lists that are configured in the Schema Configuration also

need to be added to individual forms by exporting the form set and editing the xml file for

the form. Please refer to User-Defined Pick List. System Pick Lists are already included in

the Specify forms and can be edited. Please refer to System Pick Lists.

Creating a Formatted Field and editing an existing System Pick List will immediately be

reflected within other Specify modules, such as queries and forms which include the edited

field.

New, or User Defined Pick Lists and Web Links will not be automatically reflected within

the forms in Specify. The User Defined Pick List and Web Links must be configured in the

Web Links or Pick List editors. Forms will then need to be exported, edited in XML to

include the Pick List and Web Link, then imported back into Specify. Please refer to

Import/Export Forms for more details.

Format a Field
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Overview

Accession and Catalog Number formats are configured during the institution

setup, but users may have other fields that require either a number scheme or a

format. A format allows a field to include various data components, such as static

text, a date or an incremented number. Gift Number and Loan Number often have

a unique format within collections. These can be formatted in the Schema

Configuration tool, which will change the format for the entire discipline. In other

words, if a Gift Number is formatted in the schema configuration all the

collections within the discipline will be required to use the new format, which

will display on the Gift form.

Catalog and Accession Numbers may not be edited in the Schema Configuration

tool. At this time they may not be edited once they have been created. Field

Formats that are created in the Schema Configuration tool may NOT be edited

once data resides in the database.

Field Formats can not be changed if data exists within the database in the format.

In other words, before changing a field format all data using the old format must

first be deleted.

Field formatting functions are configured using the Format Type section at the

bottom of the Schema Configuration tool.

Choose Formatted from the pick list next to the Format Type caption.

Format Type

If a format exists choose it from the middle drop-down list.

List of existing Field Formats

Actions

1. Click the ... button to open the initial Field Formatting Editor.
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Available Field Formats

Buttons at the bottom of the dialog offer the following:

• (checkmark) selects the saved format as the default, which will be used

by the application.

• (edit) opens the Field Formatting Editor for editing a saved format.

• (delete) removes the format.

• (add) opens the Field Formatting Editor for creating a new format.

Clicking the (edit) or (add) button opens the following editor dialog.

Field Formatting Editor

The table, field and field length information is displayed on the top left.

• Name is used within the application files. It should be text only and will not

be displayed to the user anywhere else in the application.

• Title will be displayed in any application format lists that are presented to

the user.

• Reset Counter Every Year will become enabled when a Numeric section

that 'Is Incremented' as well as a 'Year' are included in the format (this is

explained in more detail in the following text). Checking this box will start a

new count each year.
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A format can be made up of one or many sections. Begin creating a format by

clicking the (add) button on the right side of the editor to add a section.

2. Choose the type of section to add.

Choose a Type

• Numeric consists of numbers only and can be auto incremented by checking the 'Is

Incrementer' box and using Auto Numbering when entering data. Specify will

increment from the highest number present in the database. The length of the section

can be set between 1 and 10 characters. For formats which also include a year, the

number can restart the count every year by clicking the Restart counter every year box.

• It is important to remember that field formats are implemented at a Discipline level

and that formats that include a section that is incremented will include a numbering

scheme that is shared by all Collections within the Discipline.

• Alphanumeric can contain both characters a through z and numbers. A field will

appear which allows the section to be set between 1 and 10 characters in length.

• Alpha may only be alphabetical characters a through z. A length field will appear

which allows the section to be set between 1 and 10 characters in length.

• Separator refers to a character that separates the various sections. Separator choices

include - . / ' '(space) _ and are one character in length.

• Year will add the year on the format. The current year will automatically be entered

into this field on the form, but can be edited.

• Any char(acter) allows any keyboard character. A field will appear which allows the

length to be set between 1 and 10 characters.

• Constant refers to any section that will remain constant and is not editable on a form.

This section is useful for an institutional code. Type the characters for the constant in

the field labeled Text located under the Type box. The length of the Constant section is

only limited by the number of characters remaining in the 50 character field length.

3. Fill in the remaining information for the chosen section.

4. Once the section is configured correctly add it to the format by clicking the button.
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The section will appear in the window with the appropriate information in each of

the columns.

• Type refers to the Type of section that was chosen from the pick list.

• Value shows the character used to represent the segment in the Sample at the

bottom of the window.

• Size refers to the number of characters chosen for the section. This is not

applicable to the Separator or Year section types.

• Is By Year refers only to the Year but also allows incremented numeric

sections to be renumbered every year.

• Is Incrementer refers only to the Numeric section type that is incremented.

5. Reorder sections by clicking the (reorder up) and (reorder down) buttons on the

right side of the editor.

6. Delete unwanted sections by clicking the (delete) button.

7. Continue adding sections until the format is complete and displays correctly in the

Sample window at the bottom of the editor.

Note: For data entry purposes, when manually entering a formatted number field,

it is paramount that numbers be padded with 0's. For example, if 3 numbers are

available in a numbering scheme (###) and the desired number is 1, then 001

must be entered. If only 1 is entered, then Specify will read this as 100. This will

produce incorrect results in searches, queries and reports.

8. Choose a Field Format

Once a field format has been configured it will need to be selected from the center

pick list on the main Schema Configuration window.

Choose a Format

Configure Collection Relationships
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Collection relationships in Specify allow specimens to be associated with either specimens in another

collection or with a taxonomic name in another collection. Some examples of these types of

relationships are tissue and voucher, plant and pollinator and host parasite, etc. Specify allows

collection objects in two different collections to be related to one another for the purpose of

documenting these types of relationships. The collections may be in different disciplines, but are

required to use the same catalog number format.

Collection relationships require that one collection be the 'Source' and the other the 'Destination'. In a

single relationship, a source may have many destinations, but a destination may only have one source.

This is important to remember when choosing which collection will be the source and which will be

the destination. For instance, if a bee polinates several flowers the bee collection would be the source

and the flowers would be the destination.

Collection relationships can either associate two collection objects (cataloged specimens) or a

collection object from a source collection with a taxonomic name in a destination collection. A

relationship that associates two collection objects is called an Object Relationship and a relationship

that associates a collection object with a taxonomic name is called a Host Taxon ID.

Two steps are required to create collection relationships:

1. The relationship must be configured and named using the Collection Relationship tool in Specify

2. Forms must be edited to include controls which allow the source collection object to be

associated with the destination collection object or taxonomic name. Please contact Specify at

specify@ku.edu to request forms that include either of these relationships.

The collection relationship tool is only available to users at the system administrator level.

Configure Collection Relationships

To open the collection relationship tool choose System > Configure Collection Relationships.
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Existing Collection Relationships

If collection relationships exists within any of the collections in the institution the first

window will display those existing relationships. Existing relationships can be edited or

added using available buttons.

Select the (Edit) button to edit a relationship.

Select the (Delete) button to delete a relationship.

Note: Collection relationships with associated collection objects may not be

deleted. To delete a collection relationship all collection object associations must

first be removed.

Select the (Add) button to create a collection relationship.
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Choose a Source Collection

1. Choose a source collection from the list of collections in the current discipline and

click the Next button. The collections available are limited to those that you have

permission to access.

Note: If a collection relationship exists for the current collection the first

dialog will list the collection relationships. Either choose a current collection

relationship to edit or click the (Add) button to add a new collection

relationship.

Choose a Destination Collection

2. Choose a destination collection from the list of acceptable collections in Specify.

Associations may not exist between collections with different catalog number formats.

The collections available are limited to those that you have permission to access and

use the same catalog number format as the source collection.

Name the Collection Relationship

3. Name the Collection Relationship. The remarks field is available for describing the

relationship, which can be valuable information for colleagues or future users.
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Associating Collection Objects using a Collection Object Form

The default forms in Specify must be edited to include fields for creating relationships.

Two relationship fields are available to add to forms:

• Object Relationship
• Host Taxon ID

Object Relationship

An object relationship associates a collection object in a source collection with a

collection object in a destination collection. The object relationship field is added

to the collection object form.

One Source associated with One Destination

Click on the (Search) button and type in a catalog number from the

destination collection. Specify will search the destination collection and

show results in the dialog. Choose the correct value from the list to

complete the relationship.

One Source associated with Many Destinations

Click on the (Search and Add) button and type in a catalog number

from the destination collection. Specify will search the destination

collection and show results in the dialog. Choose the correct value from

the list to add the relationship to the list.
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Select the (Remove) button to remove a relationship from the list.

Host Taxon ID

A host taxon id associates a collection object with a taxonomic name in a

destination collection. It is not necessary for the destination collection to include

cataloged specimens. The host taxon ID field is added to the collecting event

attribute form.

Host Taxon ID Field on a Collecting Event Attribute Form

Select the (Edit) button to edit a relationship.

Select the (Add) button and type the first few letters of a taxonomic

name. A drop-down list of taxonomic names from the destination

collection will display to choose from.

Simply click on the (Search) button and type in all or part of a

taxonomic name. Specify will search the destination collection and

show results in the dialog. Choose the correct name from the list to

create the relationship.

Web Links

Many web sites currently offer services that Collection Managers find useful when entering or

evaluating data within a collection. Specify includes a Web Link Editor that configures links to web

addresses. A button can then be placed on a form that will launch a browser and connect to the web

address.

At this time web links can not be inserted into forms automatically without editing the form manually.

To do this the form will need to be exported out of Specify, edited and imported back into Specify.
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For this reason, Web Links should NOT be defined until the new form containing the Web Link has

been imported into Specify. For help inserting the web links on a form please contact the Specify

team at specify@ku.edu.

There are 4 types of web links:

1. A Global web link is not linked to a table or field, but offers a prompt for a value before

launching.

2. A Field link sends values from an existing field to a web service, causing it to open to a

specific page based on those values.

3. A New Field link creates a new field (not included in the Specify Schema) and launches

the web site to a specific page based on the data in that field when the Web Link button is

pushed. This link would require that a field be added to a form next to the web link button.

4. A URL Field link allows a URL to be entered into a field, then launches a browser and

connects to the URL by clicking the web link button. This link would require that a field be

added to a form next to the web link button.

Web links are configured using the Web Link Editor. It is highly recommended that the description

(Desc) field in the Web Link Editor contain a description of exactly how the web link should work.

This will be very useful when editing a form to include the web link as well as for future reference.

Web Link Editor

Web links are available for both Tables and Fields.

Table (System > Schema Configuration), choose a table from the Tables list and click the ...

(dialog) button next to the Web Links button. This editor can create a Global, Field or New

Field link.

Field (System > Schema Configuration), choose a table from the Tables list and a field from

the Fields list.Then, in the Field pane, click Field Format Type button and choose Web Link

from the resulting list. This editor can create any of the web link types and is the only editor

that can complete the creation of the URL Field link.

Once a web link is created it will display in the Pick List next to the ... (dialog) button.

When creating a Global, Field or New Field web link the name of the web link will need to

be chosen from the pick list to link to the field. When you create a URL Field link, the pick

list will need to say 'none'.
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Global Web Link

A global link is useful when a field does not exist for the information required by a web

service. It can be created in the System Configuration (System > Collection Setup >

Configuration) or the Schema Configuration (System > Schema Configuration).

1. Open the Web Link Editor by one of the methods above.

Buttons at the bottom of the dialog offer the following:

• (edit) opens the Web Link Editor for editing a saved web link.

• (delete) removes the web link.

• (add) opens the Web Link Editor for creating a new Web Link.

2. Click the (add) button to add a web link, or the (edit) button to edit a web link.

• Name refers to the Name of the web link.

• Type the URL into the Base URL field.

• Type the name you wish the prompt to use at the end of the url with brackets on each

end. Example; <climate>

The name of the prompt will appear in both a Name and Title field in the editor. The Title is

editable and will display for the prompt. The Name will appear in the web link lists.

More than one prompt can be added by simply adding brackets; they do not require a

separator.

Field Link

A Field Link is used to link to web services that return data based on values from within the

Specify database. For instance, FishBase returns information about a particular specimen

based on the current genus and species information. This web link would be configured to

include the genus and species field from a record and launch to the exact page rather than

the Fish Base home page.

Open the Web Link Editor by one of the methods above.
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• Buttons at the bottom of the dialog offer the following:

(edit) opens the Web Link Editor for editing a saved web link.

(delete) removes the web link.

(add) opens the Web Link Editor for creating a new Web Link.

Click the (add) button to add a web link, or the (edit) button to edit a

web link.

• Name refers to the Name of the web link.

• Type the URL into the Base URL field.

*Type the name of the field to be included in brackets in the correct part of

the URL. Example <genus>.

* Each web service will require the field name in a specific place and in a

specific way. This information should be included on the web service site.

When creating a web link using the Field Format Type an extra step exists. Once the web

link is created it will be added to a pick list of web links in the Format Type field and must

be selected from the pick list in order to be linked to the field.

New Field Link

Create a New Field Link by following the steps above (Field Link), with one variation,

Rather than typing the name of a field into the brackets type <this>. The name <this> will

appear in the Fields window. This link is useful when a field for required link information is

not included in the Specify Schema. This link would require that a field and button be

added to a form. Users would type the information into the field, then click the button and

launch the site to a particular page based on data sent to the site.

When creating a web link using the Field Format Type an extra step exists. Once the web

link is created it will be added to a pick list of web links in the Format Type field and must

be selected from the pick list in order to be linked to the field.

URL Field
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The URL Field web link can only be created using the Schema Configuration Field editor.

Once the Web Link Editor is open fill in a name for the web link.

In the Base URL text field type type <this>. 'this' will appear in the Name field of the Fields

window. Specify will then know to take whatever is typed into the box and use it as an URL

to launch a web site.

The most important step to remember when creating an URL Field web link is to choose

none as the web link pick list (middle button) next to the Web Link Format Type.

Using Backup and Restore

The Backup and Restore tool that ships with Specify as a separate application allows IT personnel to

backup and restore the database to the MySQL location on a server, or local disk. BackupAndRestore

is located in the Specify application directory, in the bin subdirectory, which stores the executable

files for Specify. Double click BackupAndRestore to launch the tool. Users are required to login using

their IT (MySQL) Username and Password.

Backups can also be created in Specify > Preferences > MySQL on the Mac, or Edit > Preferences >

MySQL on Windows, but the Restore function is only possible in the Backup and Restore tool.

Using Backup and Restore

First, set MySQL information for the backup and restore function. These paths should only

be edited by the MySQL administrator, or a designated person with the necessary privileges

in Specify and MySQL.

MySQL Preference Result Action

mysqldump Points Specify to the needed mysqldump

(mysqldump.exe on Windows) file for

backup purposes. This path will point to

a server when accessing Specify from a

server, and be local when Specify is run

locally.

Note: A typical storage place on a pc

computer is on your Local Disk

C:\Program Files\MySQL\MySQL

Click on the browse button

and find the path to the

command-line tools for

MySQL.
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Server 5.1\bin. A typical storage place

on a Macintosh is in Users >

{Username} > Downloads > MySQL.

mysql Points Specify to the needed mysql

(mysql.exe on Windows) file for backup

purposes.This path will point to a server

when accessing Specify from a server,

and be local when Specify is run locally.

Click on the browse button

and find the path to the

command-line tools for

MySQL.

Backup Location Specify will write the backup file in the

chosen location.

Click on the browse button

and choose a path for

backup file(s).

Backup (button) The entire database will be backed up to

the specified location.

Click the Backup button.

Restore (button) The entire database will be restored to

the specified location.

Click the Restore button.

The Backup and Restore functions are NOT limited to single collections, but backup and

restore the entire database. This is vital to understand when setting up an institutional

backup and restore strategy.

Collections that maintain separate databases in MySQL, within an institution, will create

collection-specific backups. This type of arrangement will restore the specific, single

collection database only.

Note: Attachments are not stored in the database (only the path to the attachment storage is

stored in the database) and will not be included in the Specify backup.

Setting Specify Preferences

• For Mac: Choose Specify > Preferences .

• For Windows and Linux: Choose Edit > Preferences.
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Specify includes preference options that apply to each Specify user. These include preferences for

font, font sizes and application icons as well as settings for components such as attachments and

plugin preferences.

Preferences are stored on the local machine and will not appear on any other machine on the network

using the same instance of Specify. When changing machines users will need to reset their

preferences for the new machine.

It is important to note that the Login Preference clears the intended lists the moment that the Clear

button is clicked. The Cancel button will undo the Clear process and the list will be cleared.

Attachments Preferences

• For Mac: Choose Specify > Preferences > Attachments.

• For Windows and Linux: Choose Edit > Preferences > Attachments.

Attachments Preference

Use Attachment Path - Check this box when storing attachments on a local drive or using a shared

attachment repository on a network drive.

File Path - Attachments will be copied, renamed and stored in this location. Only the path to the

attachments is stored in the Specify database. The Specify Setup Wizard sets a default storage

location on the local drive. This does not allow attachments to be shared or viewed by other

users on other workstations. To allow attachments to be shared it is recommended that this

storage area (attachment repository) be on a shared network drive that all users have been given

Read/Write/Delete permissions to use. Once the storage location has been created on the

network drive all users must change the Attachment Storage Location path in their system

preferences. (Enter the path for an attachment repository or click the browse button and use the

file system dialog to build the path.)
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Note: Specify creates a default storage directory named 'originals' for the attachment, and a

directory named 'thumbnails' for the thumbnail files it creates.

Use Attachment Web Services - Check this box when using an Attachment Server for storing

attachments.

URL - type in the URL string that indicates the location of the XML file containing the

URL templates for interacting with the Attachment Web Server (AWS) for performing all

the necessary I/O functions. This URL should come from your IT administrator. For more

information regarding the Web Attachment Module please refer to the Web Attachment

Module document found on the Specify Project website: specifysoftware.org.

Key - the key is created by the IT personnel when the attachment server is configured.

Email

Setting up an email account with Specify is useful for sending information that has been requested by

colleagues. The requested records can be saved as a Record Set, dropped onto an Information Request

in the Interactions side bar and emailed with the click of a button.

• For Mac: Choose Specify > Preferences > Email.

• For Windows and Linux: Choose Edit > Preferences > Email.

Email Preference

Setting your Outgoing Email
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1. Cick the Account Type button and choose In Use. When the Account Type is Not In Use the

information in the dialog is retained, but the email function is turned off.

2. Next, fill in the following information:

• SMTP (server)

• Port

• Security (type)

• Email username

• Email password

• Email (address)

This information can be retrieved from your email or network administrator. Be sure to

input information for your Outgoing Mail Server settings.

Once the account information has been entered, select the Send Test Email button to verify

that the email feature is working properly. This will send a test email to your account.

When using a gmail account the test email may not transmit, as gmail is problematic when

sending emails to the same account that is receiving the email.

Note: The Specify email feature is not used for receiving or checking email. The

information provided must be for the Outgoing Mail Server.

Formatting Preferences

• For Mac: Choose Specify > Preferences > Formatting.

• For Windows and Linux: Choose Edit > Preferences > Formatting.
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Formatting Preference

Formatting allows the customization of display information. Changes made in the Formatting

Preferences will display immediately on the side bar and task bar but will not automatically update

within the work space. The changes will display in new work space windows.

Formatting
Preference

Result Note Action

Screen Date
Format

This will set the date

format for all date fields

on all forms.

Changes to the date

format may require that

Specify be shutdown

and relaunched to

appear in the word

space.

Choose a format

from the drop

down menu.

Error Color Fields with incorrect or

incomplete data will be

designated with this

color.

Specify also puts a

colored box around

formatted text boxes

when information is

incorrectly entered.

Click the Error

Color rectangle

and select a new

color from the

resulting tile box.

Click anywhere

outside the color

tile box to cancel

it.
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Required Field
Color

Required Fields within a

form must be complete

before Specify will allow

the information to be

saved. These fields are

designated with a color.

Specify defaults to blue.

Required Fields within a

form must be complete

before Specify will

allow the information to

be saved. These fields

are designated with a

color. Specify defaults

to blue.

Click the Required

Field Color

rectangle and

select a new color

from the resulting

tile box.

Click anywhere

outside the color

tile box to cancel

it.

View Field Color A View Field is one that

is filled in automatically

and can not be edited.

Specify defaults to a

white text box for the

View Fields.

When forms are in View

mode all fields are View

Fields and will be this

color.

When forms are in View

mode all fields are View

Fields and will be this

color.

Click the View

Field Color

rectangle and

select a new color

from the resulting

tile box.

Click anywhere

outside the color

tile box to cancel

it.

Form Font Required fields are

programmed within

Specify to display with a

bold label. If the Form

Font is changed to a font

that does not support bold

then required fields will

not be displayed with a

bold label.

Select a font from

the list box. Font

choices are based

on the local system

fonts.

Form Layout Forms have been created

with varying layouts on

the Mac, PC and Linux

operating systems. The

small, medium and large

fonts are static pages that

do not expand for larger

The 'Small Font' is

recommended for use

on Windows, the

'Medium Font' is

recommended for use

on Linux and the 'Large

Font' is recommended

Choose a format

style from the list.

Specify Help - Formatting Preferences

91 / 391



screens. The 'Elastic

Layout' will expand to

accomodate larger

screens or manual

changes in font sizes.

for use on Macintosh

machines.

Size The new font and size

will display as 'This is a

Test' in the text box next

to the Font Size list box.

The new font size will be

reflected in any new sub

panes that are opened in

the Workspace only, not

on the Sidebar list or

Taskbar menus.

Select a font size

from the list box.

Reset Default Font Resets the font and font

size to Specify default

settings.

Click the button.

Discipline Icon The icon used to signify

the discipline and

Collection Object will

change. These icons are

used in a variety of

Specify modules such as

Permissions, forms,

Queries and Simple

Search.

Choose an icon

from the

predefined set of

discipline specific

icons.

Application Icon Specify only accepts jpg,

png and gif image

formats. The

recommended size for the

icon is 32 x 32 at a

resolution of 72 dpi.

Click the Clear Icon

button to reset the

Application Icon back to

Choose the Set

Icon button, then

select an image

file from the

resulting file

system dialog.

Choose the Clear

button to default
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the Specify 6 icon.

The Application Icon

appears on the Task Bar

and a variety of Specify

dialogs.

back to the Specify

icon.

Results Bar
Banner

Creating a Query or

Simple Search, or

viewing a Record Set will

produce a colored results

bar and list of records.

The size of the colored

results bar will increase

vertically with a larger

pixel size and decrease

vertically with a smaller

pixel size.

Click on the

Combo Box and

choose a pixel size

from the list.

Google Earth Preferences

• For Mac: Choose Specify > Preferences > Google Earth.

• For Windows and Linux: Choose Edit > Preferences > Google Earth.

Google Preference

Specify plots locality records (or associated Collection Objects or Collecting Events) in Google Earth

based on latitude and longitude data provided in the locality form. All associated data is stored in a

KML file which is launched within Google Earth upon clicking the Google Earth icon on the locality

form, or dropping a Record Set on Google Earth in the Plugins side bar.

Specify Help - Google Earth Preferences

93 / 391



Related data within Specify is included in an information balloon. This data varies depending on the

type of Record Set that is uploaded to Google Earth. Specify also allows the insertion of two web

service links for inserting additional information within the information balloon.

Google Earth must be installed on the local machine for the Specify Google Earth integration to work.

• Icon Image Path
Google Earth plots localities on a map using a Specify icon. Users can replace the Specify icon

with a custom icon by clicking the browse button and choosing an image from their hard drive.

• Use Original Excel Headers
Specify stores the original headers from imported Excel files (from the WorkBench) and will use

them inside the information balloon when this box is checked.

• Balloon BG Color
Change the background color of the information balloon by clicking the color square and then

choosing a color from the resulting tile box.

• Balloon Text Color
Change the color of the text used in the information balloon by clicking the color square and

then choosing a color from the resulting tile box.

• Primary URL
This is the URL for the first web service linking to more information for the genus and species

of each Collection Object. This URL will depend upon the requirements of the web service.

Specify uses %s as the identifying markers for both genus and species. Within the URL the first

%s will link to the genus and the second %s the species. For example; the fishbase URL is

http://www.fishbase.org/Summary/speciesSummary.php?genusname=%s&speciesname=%s.

• Primary URL Title
Each web service is identified by an URL title within Google Earth, the title acts like a button

and launches the web service from within Google Earth. A small, two-letter title is

recommended.

• Secondary URL
This is the URL for the second web service linking to more information for the genus and

species of each Collection Object. This URL will depend upon the requirements of the web

service.

Specify uses %s as the identifying markers for both genus and species. Within the URL the first

%s will link to the genus and the second %s the species. For example; the fishbase URL is

http://www.fishbase.org/Summary/speciesSummary.php?genusname=%s&speciesname=%s.

• Secondary URL Title
Each web service is identified by an URL title within Google Earth, the title acts like a button

and launches the web service from within Google Earth. A small, two-letter title is

recommended.

GEOLocate Preferences
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• For Mac: Choose Specify > Preferences > GEOLocate.

• For Windows and Linux: Choose Edit > Preferences > GEOLocate.

GEOLocate Preference

The GEOLocate preference allows features in GEOLocate to be turned on or off when using it to

georeference data from Specify.

• Include Highway Crossings - When enabled, GEOLocate will search the locality string for the

names of rivers and streams. If one is found, GEOLocate will snap the calculated points to the

nearest point on the waterbody. This feature only works for U.S. localities and requires county

data.

• Include Water Bodies - When enabled, GEOLocate will search the locality string for bridge

crossing information and attempt to pinpoint the locality at the intersection of the river and

highway. This feature only works for U.S. localities and requires county data.

• Restrict to Lowest Administrative Unit - When enabled limits results found by GEOLocate to

points within the lowest administrative unit in the locality description.

• Return Uncertainty Radius in Meters - When enabled GEOLocate will calculate and return

the uncertainty radius, if one exists.

• Return Error Polygon - When enabled GEOLocate will calculate and return the error polygon,

if one exists.

• Displace Error Polygon - When enabled GEOLocate will use any distance value referred to in

the Locality Description to displace the GEOLocate Error Polygon value (if one exists). For

instance, if 10 miles North of Lawrence is in the Locality Description, but the Error Polygon in

GEOLocate is a 30 mile radius around the center of Lawrence, GEOLocate will move the 30

mile radius 10 miles North of the center of Lawrence.

• Use GEOLocate's Map Server - When enabled GEOLocate's map server is used, when

disabled the WorldWind map server is used.

• Language Key - tells GEOLocate what language to use to interpret the Locality Description.

Loans
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Default settings for fields on the Loan form can be set in the Loan Preference. New loans will include

the default values, which are editable.

• For Mac: Choose Specify > Preferences > Loans.

• For Windows and Linux: Choose Edit > Preferences > Loans.

Loans Preference

• Due in Months can be set between one and 60 months.

• Shipment Method choices are:

o By Hand

o DHL

o Fed Ex

o UPS

o USPS

The Shipment Method list is a System Pick List and can be edited using the pick list editor.

• Shipped By is a Query Combo Box to the agent table. This allows data to be searched and

chosen from the agent table, not typed directly into the box. It is possible to type data directly

into the box, but the box will not accept the data; the data must first be added to the table by

clicking the (add) button and creating a new record.

Search for an existing agent

Using a Query Combo Box

1. Type the first letter, or first few letters of the name in the box, then

either click on the button or use the down-arrow key on the keyboard.

A list of agent matching the typed letter(s) will appear.
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If Specify can not find a match based on the typed letters then an

button will appear. Click the button or press the enter

key to add a new record.

If the required name is not in the resulting list, either press the

enter key when 'Add ...' is in focus, or click the (add) button, to

add a new record.

Pressing the esc (escape) key will cancel the list box.

Note: Type more letters into the box to reduce the results

and expedite the search.

Using the Search button (these buttons are not available with keystroke

entry):

1. Click on the (Search) button. A search dialog will appear.

2. Type in either the entire name or the first few letters of the search

followed by an asterisk (*).

3. Select a record from the results.

Add a new agent:

1. Click on the (add) button and enter data into the resulting dialog.

Edit an existing agent record:

1. Choose a record from the list.

2. Click the (edit) icon to open the table in an editable dialog.

Login Dialog Preferences

• For Mac: Choose Specify > Preferences > Login Dialog.

• For Windows and Linux: Choose Edit > Preferences > Login Dialog.
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Login Preference

Specify automatically creates a pick list of all usernames and database names that are in use for the

login dialog. The following buttons delete the names in these pick lists and they will need to be

re-entered to be used again.

These caches are cleared the moment that the Clear button is clicked. The Cancel button will undo

the Clear process and the list will be cleared.

• Username List will delete the entire list of usernames from the login dialog (local machine).

• Database Name List will delete the entire list of database names from the login dialog (local

machine).

• Server Name List will delete the name of the server from the server list.

MySQL Preferences

• For Mac: Choose Specify > Preferences > MySQL.

• For Windows and Linux: Choose Edit > Preferences > MySQL.

MySQL Preference

The MySQL preference sets the pathway for the Specify backup files. The backup function can also

be performed in this preference. Restore functions are performed using the BackupAndRestore tool,
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which is a separate tool located in the specify application directory within the subdirectory labeled

bin.

Users must be part of a manager group or higher to have access to the MySQL preference.

Set MySQL information for the backup and restore function. These paths should only be edited by the

MySQL administrator.

• mysqldump - Points Specify to the needed mysqldump (mysqldump.exe on Windows) file for

backup purposes. This path will point to a server when accessing Specify from a server, and be

local when Specify is run locally.

(Click on the browse button and find the path to the command-line tools for MySQL.)

• mysql - Points Specify to the needed mysql (mysql.exe on Windows) file for backup

purposes.This path will point to a server when accessing Specify from a server, and be local

when Specify is run locally. (Click on the browse button and find the path to the command-line

tools for MySQL.)

• Backup Location - Specify will write the backup file in the chosen location. (Click on the

browse button and choose a path for backup file(s).)

• Backup (button) - The entire database will be backed up to the specified location.

The Backup function will back up the entire database; for this reason it requires a high-level

permission to use. In other words, if an institution uses one database for all collections in all

disciplines, the backup function will backup all collections. This will be a huge file, and the backup

function should be implemented by a MySQL administrator.

If collections within the museum maintain their own databases then the backup will be

collection-specific.

To Restore from a backup run the BackupAndRestore Specify application found in the Specify Bin

directory.

Specify automatically checks for backups every 7 and 30 days. If a backup file is not found Specify

gives a prompt to allow or decline a backup.

Note: Specify automatically includes the default MySQL locations for Mac OS X and

Linux in the MySQL Preference text boxes, but MySQL locations for Windows are

user-specified and therefore will need to be provided.
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Network Preferences

• For Mac: Choose Specify > Preferences > Network Dialog.

• For Windows and Linux: Choose Edit > Preferences > Network Dialog.

Network Preference

If your institution is using a proxy to access the internet webservices, including GEOLocate and

World Wind, may not work correctly. Fill-in the Network information for webservices access the

internet through the proxy. Contact your IT administrator for the Network values.

Task Bar Preferences

Add and/or remove tools from the Specify task bar.

• For Mac: Choose Specify > Preferences > Task Bar.

• For Windows and Linux: Choose Edit > Preferences > Task Bar.

Task Bar Preference
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• Add Interactions - Places an Interactions button on the task bar which enables use of the

Interactions tools such as Accession, Permit, Loan, Gift, Exchange In, Exchange Out, Borrow

and Information Request. Users that are not using these tools can remove the button from the

task bar.

• Add Plugins - Places a Plugins button on the task bar, which allows individual records or

Record Sets to be utilized when using the Plugin services. Google Earth and GEOLocate are

available on the Locality form and will remain usable if the Plugins button is removed from the

task bar. (Uncheck Plugins if not using GoogleEarth or GEOLocate other than in the Locality

form.)

• Add Attachments - Adds an Attachment button to the task bar which enables attachment tools

such as the Attachment Browser, Import Attachments and Import Attachment Index.

• Add Welcome - Adds a Welcome button to the task bar which opens an abbreviated statistics

page when clicked.

Tree Preferences

This preference window is used to customize the appropriate hierarchical Trees, (Storage, Taxon,

Geography, Chronostratigraphy and Lithostratigraphy), in Specify 6.

• For Mac: Choose Specify > Preferences > Trees.

• For Windows and Linux: Choose Edit > Preferences > Trees.

Trees Preference
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This page is used to customize the appropriate hierarchical Trees, (Storage, Taxon, Geography,

Chronostratigraphy and Lithostratigraphy), in Specify 6.

• Restore Expansion State - Trees will open to the last node that was selected. If the tree is

expanded, but no node is selected the tree will open to the default setting.

• Prompt to Replace Taxon with Preferred Taxon - When creating a Determination for a

Collection Object, Taxon names can be chosen from an existing authority file list, accessed

through a Query Combo Box. Synonymized names are included in the list. Checking this box

will prompt you each time a Taxon that is a synonym is chosen from the list and ask you if you

wish to use the synonym or the preferred name.

• Show Counts Below - Determines the level to which counts, (X,Y), are shown in the trees.

Counts display next to the corresponding node in the Trees. X refers to the number of Collection

Objects for the node only. Y refers to the number of Collection Objects for the node (parent) and

all nodes beneath it (child nodes).

• Column Color #1 - Changes the background color of odd columns of the tree. (Click the color

square and choose a color from the resulting tile box.)

• Column Color #2 - Changes the background color of even columns of the tree. (Click the color

square and choose a color from the resulting tile box.)

• Synonymy Color - Changes the color of synonymized Tree nodes. (Click the color square and

choose a color from the resulting tile box.)

System Preferences

• For Mac: Choose Specify > Preferences > System.

• For Windows and Linux: Choose Edit > Preferences > System.
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System Preference

These changes are limited to the local application/computer only, they will not appear on any other

machine on the network.

• Ask me before closing tabs - Specify allows 10 tabs to be open at one time. Once this number

has been reached Specify can either automatically close the oldest tab or give a prompt asking

the user to either close the oldest tab or close all tabs. (Check the box to give a prompt. If the box

is not checked Specify will automatically close the oldest tab.)

• Background Image - Replaces the Specify image on the Welcome screen and Workspace image

with the custom image.

Specify only accepts jpg, png and gif image formats.The recommended size for

the icon is 700 x 400 at a resolution of 72 dpi.

Delete the path to use the default Specify icon.

• Attachment Storage Location

o Use Attachment Path - Check this box when either story attachments on a local drive or

using a shared attachment repository.
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- Attachment Storage Location - Attachments to records will be stored in this

location.The Specify Setup Wizard sets a default storage location on the local drive.

This does not allow attachments to be shared or viewed by other users. To allow

attachments to be shared it is recommended that this storage area (attachment

repository) be on a shared network drive that all users have been given

Read/Write/Delete permissions. Once the storage location has been created on the

network drive all users must change this Attachment Storage Location path in their

system preferences. (Enter the path for a attachment repository or click the browse

button and use the file system dialog to build the path.

o URL - type in the URL string that indicates the location of the XML file containing the

URL templates for interacting with the Attachment Web Server (AWS) for performing all

the necessary I/O functions. This URL should come from your IT administrator. For more

information regarding the Web Attachment Module please refer to the Web Attachment

Module document found on the Specify website.

• Report Images Location - Images used in reports that are not attachments can be stored in this

location.

• Locale - At this time Specify 6 has not been translated. If you are interested in helping with a

translation please contact the Specify team at specify@ku.edu. (Choosing one of the English

locales will change labels and dialogs to the local dialect.)

• Cache - Clears the Cache within Specify 6. The cache is a temporary storage area used by

Specify when interacting with external web services. Clearing the cache will free this disk space.

• Version Checking - Specify has an automatic update feature that allows the application to use

the Internet to check for updates and download them. If the computer using Specify is not

connected to an online source it is recommended that users turn off this feature as it will

lengthen the start-up process.

• Anonymous Anonymous UUS - Specify will automatically send usage statistics to the Specify

team. These statistics include usage statistics only; no Collection data, and are used to evaluate

usage of various aspects of the package to inform future development.

• Send ISA/IA UUS - Specify will automatically send anonymous institutional statistics such as

counts on collection data to the Specify team. The Specify team will use this data to demonstrate

the significance and use of Specify throughout the community when communicating to NSF for

funding.

US collections must enter into an ISA Agreement with Specify to receive support.

Clicking this box will associate institution statistics with the sending institution.

An institution may not receive support without an ISA number and active ISA

statistics.
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Introduction to Specify

Specify's user interface has been designed to provide easy access to data and to the various processing

features and functions of the application. Our target was to make everything easily accessible

regardless of the function that you are performing within the application, through the use of a Menu

Bar and Task Bar at the top of the Specify window, a Side Bar on the left, and Tabs at the bottom of

the Specify workspace. Up to 11 work space windows can now be opened at one time. Tabs allow

quick, one-click navigation among data forms, trees and other Specify pages. The figure below shows

the various screen components of the Specify window with definitions that follow.

Components in Specify

A. Main Menu B. Task Bar C. Side Bar D. Work Space E. Trash Can F. Tab Bar /

Tabs G. Status Bar

Main Menu

The menu bar across the top organizes commands and modules under menus and

sub menus. Clicking on a module will open a list of its components in the side

bar.

Task Bar
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The task bar located at the top of the Specify application is a set of buttons that

launch a task-related module. The task bar can be moved by clicking on the two

vertical lines found on the left side of the task bar and dragging it away from the

application. To move the task bar back to the application, click the close button.

Clicking on a task bar button will open a list of its components in the side bar.

Side Bar

The side bar allows a list of components for each module to be activated in the

work space. The list typically consists of the actions (print, import) and data

(types of forms) available within a module. The side bar will change to reflect the

tools available within the active module.

Resize the side bar by guiding the mouse over the line separating the side bar

from the work space until a crossbar appears, then click and drag the line to the

desired size.

Work Space

The work space is the area in which tasks are completed. Clicking a module

component from the side bar list opens it in the work space. Multiple work space

windows can be open at the same time, but only one can be active.

Trash Can

The trash can allows a saved item (Record Set, Query, Report or Information

Request) listed on the side bar to be deleted by dragging and dropping it onto the

trash can icon.

Tab Bar / Tabs
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Tabs on the tab bar allow work space windows to be activated and closed. More

than one window can be open at a time, but only one may be active in the work

space. These windows are shown as tabs on the tab bar under the work space.

Click a tab to activate the window.

The tab bar allows 11 tabs to be opened, but not all can be viewed at the same

time. When the tabs move off the tab bar, arrows ( ) become available for

viewing and selecting tabs.

Tabs are labeled with an icon and module name. If two of the same modules are

open, the tab will reflect the number of modules that are open.

Example:

A Tabs menu on the Specify 6 menu bar gives the following shortcuts:

• Close Current

• Close All

• Close All Except Current

Close tabs by clicking the (close) button on the right side of the tab.

Status Bar

The Status Bar at the bottom of the application displays the current User,

Discipline and Collection name. A security icon is also displayed to show when

security is on ( ), or off ( ). When appropriate, the status bar also displays

messages such as "Invalid Data Entry" and the status of a search.

Levels within Specify

Specify 6 is designed to store all the data for an institution in one database. This may

include many divisions, disciplines, and collections. Each of these levels within an

institution has unique data needs; therefore, many of the tools within Specify, such as forms

and trees, are also unique to each level. Specify must open to a specific collection, and users

Specify Help - Introduction to Specify

107 / 391



access collection object information based on that collection. For more information

regarding levels within Specify please refer to Adding Institutional Levels.

Change Collections

If you have access to more than one colleciton in Specify you will prompted to choose

which collection to open each time you launch Specify.

To change from one collection to another from within Specify, choose File > Change

Collection, then choose a collection from the resulting dialog.

Change Collection Window
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When changing collections, the application first shuts all windows. This closes the user out

of the collection, and a new collection must be chosen before the Change Collections dialog

will close.

Available collections are based on the user permissions; therefore, if the current user does

not have permission to view or edit a collection, that collection will not be included in the

dialog list.

Specify 6 displays the current collection name on the right side of the Status Bar.

Note: Selecting Change Collection closes the current collection as well as all

open tabs. Also, when a Configuration tab is open in the work space, the Change

Collection menu item will be disabled. To enable Change Collection simply close

the Configuration tab.

User Permissions

Specify includes a highly flexible security module that allows a system administrator to add

users, then limit their operations within and access to the data in Specify. Some tools

described in the documentation may not be available to you if you have not been given

permission to use them. If you can not access a table or tool please check with your Specify

Administrator to verify that you have been given permission to use them.

Terms used in the Documentation

Windows that open outside the work space are referred to as Dialogs.

A right-button click that results in a list box is referred to as a Context Menu.

Statistics

Specify includes two statistics pages for a quick analysis of institutional collection data. The first

opens on the Welcome page, which is viewed each time Specify is opened. The Welcome page can

also be accessed by clicking the Welcome button on the task bar.
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The second, more in-depth, statistics page opens by clicking the Statistics button on the task bar.

Graphical statistics are also listed on the side bar and include two bar charts and a pie chart. Simply

click on a name in the side bar to open one.

Using Forms in Specify

A form is a window in which data can be viewed, entered, or edited. Specify categorizes forms as

Data forms, which are used to enter collection data, and Interactions, which are used to record

transactions of either data or collection objects. Each discipline has access to a set of forms for both

data and interactions, specific to their discipline. The following sections describe basic concepts for

using the form system. A separate section of help exists for both Data and Interactions forms.

Note: At this time, Specify 6 does not include a Form Editor, as was found in Specify 5. It

is important to note that the forms have been created programmatically to be extremely

flexible and can be exported as xml and either edited by on-site staff or emailed to the

Specify staff. The original forms should not be edited from the hard drive, they must be

exported and then reimported! Forms are exported via the Importing/Exporting tool, which

exports an entire form set. Form sets reside at the Discipline level in Specify, which means

that all Collections within a Discipline access the same forms, but form sets can then be

reimported at any institutional level. For instance, the default form set for a discipline could

be exported, edited, and reimported at a collection level, allowing all users in that collection

to use the new set of forms. If you wish to have a member of the Specify team edit the form

and have an ISA with Specify, please contact them at specify@ku.edu.

The names of tables and fields used for display within Specify, (labels), can be edited using the

Schema Configuration tool.

Specific forms have been created for each of the operating systems. These include varying font sizes

as well as static versus stretchy forms. The form layout can be chaged in the user preferences:

• For Mac: Choose Specify > Preferences > Formatting.

• For Windows and Linux: Choose Edit > Preferences > Formatting.

Permissions

Specify includes extensive controls for limiting access to data for each user. When starting

up, Specify reads the permissions for the user based on their login information, then loads
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the correct tables and tools based on these permissions. For this reason, some of the controls

and/or data may not be available. For example, users that belong to the Guest group and

only have permission to view tables and forms will not have access to data through the Data

module. They must first Query to find records, then view the data in a form.

Also, if a user has permission to view forms, but does not have permission to view a

particular table or tables included within the form, they will be advised that the data is

restricted. For instance, in the example below the user has permission to view a Collection

Object form, but not a Preparations form. When opened, the Preparations subform does not

have permission to view any Preparations data, but it does have View permission for both

the form system and Collection Object table.

Form with Restricted sub form

Restricted Data

The default permissions that Specify ships with allow Guest users to View the forms, but

not modify, add or delete them. All other users can use forms in their entirety.

Related Information

Forms are categorized for the data that resides in each table (Collection Object, Taxon,

Geography, etc.); however, much of the data within the tables is also linked to related

tables. This prevents users from needing to retype the same information and assures that
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information is entered only one way (for example John Smith is not also entered as J. Smith

or John Smyth). Separating data into fields within tables with relationships also allows data

to be searched in a more precise way.

Many-to-One

A relationship involving a primary and related table in which many primary

records are linked to a single related record in the related table is referred to as

having a many-to-one relationship. For example, many Collection Object records

might be linked to the same Locality record because the specimens were all found

at the same location.

Related tables with a many-to-one relationship to the primary table are

represented on the form as a formatted field with buttons to edit, add and search

for a record within the table. The field format typically consists of one primary

field within the table, but may be represented by more than one field typically

separated by a comma.

One-to-Many

A relationship involving a primary and related table in which a single primary

record links to many related records in the related table is referred to as a

one-to-many relationship. For example, several Collection Object records would

be linked to a single record in the Collection Event table because all the

specimens were collected during the same event.

Sub Forms

Related tables with a many-to-one relationship display on a form as a Query Combo Box.

Control buttons next to the Query Combo Box; (edit), (add), and (search), allow

single records to be searched, added or edited in a pop-up sub form.

Related tables with a one-to-many relationship to the primary table are included on the form

as a sub form with navigation controls.
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Data is added and edited in sub forms the same way that it is added and edited to forms.

Boxes are used in the same way and required fields have a bold label.

Form Controls

Specify's forms use a variety of boxes, buttons, and panels to enter and display data, called

controls.

Buttons

Button Definition Result

Incomplete Opens a dialog listing the incomplete fields that are required.

Note: The shield only appears once a change has been made inside

the form and will disappear once all required fields contain data.

Warning Opens a dialog listing fields with incorrect data.

Note: The shield will only display when fields on a form contain

incorrect data.

Collapse Hides the form/sub form.

Expand Opens the form/sub form.

Add Opens a new form or sub form to adds a new record.

Delete Deletes the record. A Collection Object can not be deleted if it links

to any other records.

Edit Opens the related record in a sub form.

Search Opens a search dialog to search for a record. Fields for the table will

be available to search, but this search is not inclusive of criteria; it

treats all criteria independently. For example, when searching for an

agent 'John Smith' entering 'John' into the first name field and 'Smith'
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into the last name field will return results for all last names of 'Smith'

and all first names of 'John' rather than limiting the search to only

'John Smith'.

Clone New in Specify 6.3! The clone tool is only available on the collection

object form in the locality field by default. It is used to clone an

existing record for editing and saving as a new record. It will open a

locality form with all the information from the existing locality.

Changes can be made to the form and a new locality record will be

created. This will not change the original record, but merely makes a

clone of the original record.

The tool can be implemented on other forms that include Query

Combo Boxes but requires a redesign of the applicable form; please

contact the Specify team at specify@ku.edu for more information.

Information Opens more information either in a associated form or descriptive

text box.

Preferences This is unique to the locality form. It allows the default longitude and

latitude information to be set on the form.

View Form Displays the table as a form for view only.

View Grid Displays the table as a grid for view only.

Edit Form Displays an editable table in form view.

Edit Grid Displays an editable table in grid view.

Boxes

Main Form Control

Specify Help - Using Forms in Specify

114 / 391



• Click the (collapse) button to collapse the form/sub form. (This

can not be performed by keystroke)

• Click the (add) button, or press the spacebar when the add button

is in focus to add a record. A sub form will be disabled until this

button is clicked.

• Click the (delete) button, or press the spacebar when the delete

button is in focus, to delete a record.

Navigation Control is found at the bottom of each form. Navigation is

also present on sub forms that are part of the main form, but only when

viewed as a Form, not as a Grid.

Step through records by clicking on the appropriate arrow (first,

previous, next, last) or choose Data > (first, previous, next, last), or

press the spacebar when the appropriate button is in focus.

Also, double click within the box and enter a page number in the

resulting dialog to jump to the desired page.

Number Box

Number boxes accept any numerical input. Simply click in the box or

use the tab key to apply focus in the box, then type in the numerical

data. The box will not accept characters.

Text Box

Text boxes accept any type of input. Simply click in the box or use the

tab key to apply focus in the box, then type in the data.

Note: To change the length of a Text and/or Number Box choose

System > Schema Configuration.
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Query Combo Box

A Query Combo Box represents a many-to-one relationship with

another record in another table. Data for each record in the table is

formatted to display enough fields within the table for the desired

record to be recognized within a list of records. A Query Combo Box

used to represent the Taxon (shown above), Geography, Storage,

Lithostratigraphy and Chronostratigraphy tables will use the format for

the Full Name, which is configured in the Taxon Tree Definition. Other

queries and resulting lists are configured in the system and are not

editable at this time.

The Query Combo Box allows data to be searched and chosen from a

related table, not typed directly into the box. Data chosen from the list

links the current record with a record in a related table. This eliminates

the need to retype data. It is possible to type data directly into the box,

but the box will not accept the data; the data must first be added to the

table by clicking the (add) button and creating a new record.

Choose data from a list:

• Type the first lette, or first few letters of the term you wish to use

in the box, then either click on the button or use the down-arrow

key on the keyboard. A list of data starting with the typed letter(s)

will appear.

• If Specify can not find a match based on the typed letters, then an

button will appear. Click the button or press the enter

key to add a new record.

• If the required data is not in the resulting list, either press the enter

key when 'Add ...' is in focus, or click the (add) button, to add a

new record.

• Pressing the esc (escape) key will cancel the list box.

Note: Type more letters into the box to reduce the results and

expedite the search.

Search for existing data (these buttons are not available with keystroke

entry):
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• Click on the (search) button. A search dialog will appear.

• Type in either the entire name or the first few letters of the search

followed by an asterisk (*).

• Select a record from the results.

Enter a new record:

• Click on the (add) button and enter data into the resulting dialog.

Or edit an existing record:

• Choose the record in the list.

• Click the (edit) button to open the table in an editable dialog.

Combo Box

Combo boxes are used to display Pick Lists, which allow data to be

chosen from a predefined set of options, not typed directly into the box.

• Click the button, or press the down-arrow ( ) key to open the

list.

• Click on data to select it or press the enter key when the desired

data is in focus.

Note: Edit/add options to these lists in the Pick List Editor at

System > Collection Setup > Configuration. Then click on the

Pick List Editor button on the side bar and refer to the

directions for the Pick List Editor. Preparation Type can be

edited by clicking the Preparation Type icon on the same side

bar.

Text Combo Box
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Text combo boxes are used to display Pick Lists which are created from

entered data.

• Type a new term into the box and press the return or tab key.

Or

• Click the button, or activate the box and press the down-arrow (

) key to open the list.

• Click on data to select it or press the enter key when the desired

data is in focus.

Note: A Pick List can be changed from a Combo Box to a

Text Combo Box or vice versa in the Pick List Editor at

System > Collection Setup > Configuration.

Date Field

Date fields require a formatted date and give a prompt for the accepted

format.

Type the date as shown in the box.

Remarks Field

The Remarks field is a text field, typically 4096 characters in length.

Text can be typed directly into the text box on the form, or for a larger

text box of text click the edit button, which will open a sub form for

entering text.

Unique Field Boxes
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Other Date Fields

Date Type/Partial Dates

Click the combo box for date type options.

Collecting Event Start, Collecting Event End, Cataloged Date,

Determination Date and Preparation Date can be entered as partial dates

by clicking on the Date combo box and choosing one of the partial date

types from the list.

• Choose Date for complete dates.

• Choose Mon / Year* for incomplete dates which include the month

and year.

• Choose Year* for incomplete dates which include just the year.

* Partial dates need to be stored as valid dates in the database (as day,

month and year, Specify will use 01 for any missing data. For example,

a partial date that displays as 07/2007 is stored in the database as

01/07/2007 and a partial date of 2007 is stored in the database as

01/01/2007. Therefore, if an exact date of 01/01/2007 is queried the

partial date (2007) will be included in the return data.

Cataloged Date

In most Collection Object forms the Cataloged Date is editable, but if it

is left blank it is automatically set to the current date upon saving the

record.

Cataloger

In most Collection Object forms, the Cataloger field is editable in the first new

record, then automatically added and not editable in any additional forms created

by clicking the add ( ) button. To enter a new Cataloger simply click the Data

Entry icon in the Taskbar to open a new Collection Object form.
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Formatted Number Fields

Any string can be formatted to a numbering scheme in System > Schema

Configuration. Typical fields that are formatted with a numbering scheme are

Catalog Number, Accession Number, Loan Number and Gift Number. Once these

fields are formatted, they can either be entered manually or auto increment using

Auto Numbering.

Note: When manually entering a formatted number field, it is

paramount that numbers be padded with 0's. For example, if 3 numbers

are available in a numbering scheme (###) and the desired number is 1,

then 001 must be entered. If only 1 is entered, then Specify will read

this as 100. This will produce incorrect results in searches, queries and

reports.

Timestamp Modified

Timestamp Modified is found at the bottom of the Collection Object form for

most Disciplines, and is the date the . This is not an editable field on a form but it

is important to note that it is a searchable field.

Field Uses

Data Entry Fields

Fields that accept data are Data Entry fields. These fields may also be required.

View Fields

Fields that are View only (not editable) automatically load pre-determined information.

Examples of these fields are the Collection Name field in the Collection Object form and

the Children fields in the Geography, Taxon, Storage, Lithostratigraphy and

Chronostratigraphy tables which are also displayed/edited as Trees.
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Required Fields

Fields that are required, have a bold label and text areas that are shaded blue (shown in the

above Query Combo Box). Records can not be saved (the save button for the form will not

become enabled) until all required fields contain proper data. A (incomplete

information) button will appear at the bottom of any form with incomplete required fields.

Click the button for a list of these fields.

Note: The shaded color can be changed in Specify Preferences.

• For Mac: Choose Specify > Preferences > Formatting.

• For Windows and Linux: Choose Edit > Preferences > Formatting.

Form Tools

Keyboard Functions/Shortcuts

Specify adopts the standard keyboard functions for entering data on forms via

keyboard entry. Examples of keyboard strokes for the form controls are described

in the control section. The following are a few guidelines:

Tab moves the focus to the next field.

Spacebar activates a button.

Down-arrow ( ) opens a combo box and moves focus to the next item

in the box.

Esc. (escape key) closes a combo box.

Return selects a highlighted item within a list.

Cntl/Cmd + S will save a record or Query.

Cntl/Cmd + C will copy data within a field.
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Cntl/Cmd + V will paste data into a field.

Cntl/Cmd + X will delete and copy the data.

Cntl/Cmd + Z will undo the last action.

Cntl/Cmd + Y will redo the last action.

Cntl/Cmd + Q will exit Specify.

Cntl/Cmd + E will toggle from view mode to edit mode and back.

Cntl + Enter activates the OK button.

Cntl + W closes the current tab (on Windows only).

Cntl + Shift + W closes all tabs (on Windows only).

F1 opens Help.

Forms that include a list of records have the following keyboard functions on

Windows and Linux:

Alt + Up Arrow will go to the first record.

Alt + Down Arrow will go to the last record.

Alt + Left Arrow will to go to the previous record.

Alt + Right Arrow will go to the next record.

Forms that include a list of records have the following keyboard functions on the

Macintosh computer:

Alt + Home will advance to the first record.

Alt + End will advance to the last record.

Alt + Page_Down will move to the previous record.

Alt + Page_Up will advance to the next record.
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Note: If the keyboard functions are not working properly, try to click

somewhere else in the application and change the 'focus'. The operating

system does not coordinate keyboard functions in some of the more

intricate tools in Specify.

Carry Forward

Specify 6 allows values in specific fields to be copied from the current record into

new records using Carry Forward.

To use Carry Forward

1. Enter data into a form and click Save.

2. Configure Carry Forward (Data > Configure Carry Forward).

Carry Forward automatically turns on after being Configured.

When Carry Forward is already configured, it can be turned on by choosing Data

> Carry Forward or right-button clicking within the form and choosing Carry

Forward in the context menu. A checkmark will appear next to the name Carry

Forward in both the drop-down and context menus.

To disable Carry Forward choose Data > Carry Forward or right-button click

within the form and choose Carry Forward in the context menu. The checkmark

will disappear from both the drop-down and context menu.

Note: When Carry Forward is disabled in the Data or context menu, it

will need to be Configured before becoming enabled.

Configure Carry Forward

1. Choose Data > Configure Carry Forward or right-button click within the form and choose

Configure Carry Forward in the context menu.
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2. Choose individual fields or click the Select All button and then the OK button in the

resulting dialog.

Sub forms that represent a one-to-many relationship to the primary table do not carry

forward EXCEPT the Determinations table for Collection Objects, Collectors for

Collecting Events and Citations for Collection Objects. These three will carry forward

all the associated records. For example, if a Collection Object has 6 Determinations

associated with it and Carry Forward is enabled all 6 of the Determinations will carry

forward into the new record.

Note: Fields that are check boxes, or use an auto-formatter will not carry

forward. However, auto-formatted fields will still update using Auto

Numbering. For instance, Catalog Number is a field that is always formatted

for a numbering scheme. If the Catalog Number (C#)is 1234 and Carry

Forward is turned on but Auto Numbering is turned off then the the next

record will not include a C# (one will need to be entered manually). If the

C# is 1234 and Carry Forward and Auto Numbering are both turned on then

the next record added will include a C# of 1235.

Auto Numbering

Fields that have been formatted for a numbering scheme automatically increment

their numbering scheme using Auto Numbering. These are typically the Catalog,

Accession, Gift and Loan Number fields, but any field that is a string can be

formatted using the Schema Configuration tool (System > Schema

Configuration). Forms open with Auto Numbering on. Turn off Auto Numbering

by choosing Data > Auto Numbering.

Once Auto Numbering is turned off it will stay off until the Workspace window is

closed; however, new windows will open with Auto Numbering turned on. For

instance, if a Collection Object (CO) form is opened and Auto Numbering is

turned off, it will remain off while new CO's are entered using the same window.

If a new CO form is opened in a new window (creating a new tab) it will open

with Auto Numbering turned on.

When Auto Numbering is not on, formatted numbers must be manually assigned.

This is useful when entering legacy data. When manually entering a formatted
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number field, it is paramount that numbers be padded with 0's. For example, if 3

numbers are available in a numbering scheme (###) and the desired number is 1,

then 001 must be entered. If only 1 is entered, then Specify will read this as 100.

This will produce incorrect results in searches, queries and reports.

Series Data Entry

Now available in Specify 6.3! Series Data Entry allows users to create multiple

collection objects with consecutive catalog numbers and pre-filled values with a

single Save operation.

To use Series Data Entry you must have the following:

• A catalog number that includes a numeric string that is an 'incrementor'

• For users creating a new database with version 6.3 Series Data Entry is

included by default only for entomology. For all other disciplines it is turned

off by default. For these and all existing databases contact the Specify team

Specify team to have this feature included on your forms.

To use Series Data Entry:

1. Turn off Auto Numbering by choosing Data > Auto Numbering in the main

menu.

2. Configure Carry Forward by choosing Data > Configure Carry Forward in

the main menu.

A right facing arrow button will appear next to the catalog number

field.

Catalog Number field with an Expand button.

3. Click the button to expand the catalog number field.

A second box will appear on the form.

Catalog Number fields for Series Batch Entry
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4. Enter the starting number in the series into the first catalog number box and

the ending number in the series into second catalog number box. Make sure

to follow the format for both numbers.

The series can not include more than 500 records.

Note: Series Data Entry has a 500 record limit.

5. Complete the data for the first collection object that you wish to carry

forward. Depending on how carry forward has been configured, all or part of

the fields and tables selected in the series will be copied to all records in the

series.

6. Click the Save button.

Specify automatically creates a record set of the collection objects that were

created. The record set will be named with the first and last number in the series

and appear on the side bar.

To open the collection object records in the work space simply click on the record

set located on the side bar.

Batch Identify

New in Specify 6.3! Batch Identify allows users to create and/or update the

determination information for several collection objects at one time.

If several collection objects will be updated it is recommended that you create a

record set of the collection objects before launching Batch Identify.

1. Choose Data > Batch Identify in the main menu.

A dialog will appear asking for either catalog numbers or record

sets (if applicable).

2. Choose to either enter catalog numbers, separated by commas, or choose a

record set.

A determination form will appear as well as a table listing the

catalog numbers of the affected records.

3. Fill in the appropriate information in the determination form and click 'Save'.
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A new determination will be created for each of the collection objects and it will

be made current. If no determination exists, a determination will be created.

Using Barcodes

As in Specify 5, Specify 6 works with a bar code reader. Specify treats the bar code reader

as an ordinary data entry device. No special configuration within Specify is necessary.

Refer to your bar code reader documentation for instructions on how to install and

configure the bar code reader. Once the bar code reader is successfully installed and

configured, it should work automatically in Specify 6.

Data Entry

• Activate the Catalog Number field within the Collection Object form by

clicking in it.

• Scan the bar code.

Search

• Activate the Search box by clicking in it.

• Scan the bar code.

Interactions

• Activate a Loan, Gift or Information Request by choosing it in the

Interactions Sidebar, this will activate a Catalog Number dialog.

How Editing Affects Related Records
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Records that are related, or linked, to other records can not be deleted. For example, a

Preparation that is linked to specific Collection Objects can not be deleted while the link

and/or Collection Object exists. To delete the Preparation, first edit each Collection Object

record and remove the Preparation.

When related records are edited, the data changes in each record that references that data.

For example, if the spelling of a name in the Last Name field is changed in the Agent

record, the spelling will also change in the Deaccession Agents, Loan Agents, Authors and

other records.

Note: Only users with add and edit privileges will be offered the add and edit

button on their form.

Deleting Records

Multiple records can be entered within a single tab in Specify. Records can also be deleted

from within that original tab. Once the original tab has been closed, the record will need to

be searched and reopened within a form to delete it from the database. The following

example shows the steps to delete a Collection Object record with Catalog Number 100.

1. Use Simple Search or the Query tool to find Catalog Number 100.

Simple Search results with results for Catalog Number 100

1. Double click the Catalog Number (100) to open the record in a form.

1. Click the (edit) button at the bottom of the form to edit the form.
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1. Click the (delete) button at the top of the form to delete the record.

Edit Collection Object form

Data Entry in Data Forms

Data forms are used for entering, editing and viewing collection data. Because Specify uses related

fields to link information, most data can be entered using the Collection Object form, however it may

be useful to enter background information, such as Agents and Collecting Events before entering

Collection Objects.

Access data forms by clicking the (Data ) button. A list of forms will appear in the side bar.

Each discipline has access to a specific set of forms for viewing, entering and editing data. Specify

ships with the most frequently used forms listed on the side bar. Less common forms are found by

clicking (More Forms) in the side bar and choosing a form from the pop-up dialog.

A Side Bar Data Form Configuration tool gives access to less frequently used forms and also

allows the side bar and More Forms lists to be interchanged and rearranged:

Right-click an open section of the side bar to activate the button or choose

Tabs > Configure Side Bar from the top menu bar.

• Use the ,and (reorder) buttons to change the order in which the forms appear in

the side bar and More Forms list.
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• Use the , and (move) buttons to move a side bar item to the Extra Forms list and

vise versa.

• Click the (add) button for a list of additional forms that can be moved into either the

side bar or More Forms list.

• Click the (delete) button to remove forms from either the side bar or More Forms

list; this will put them back into the master list.

Deleting a form from the More Forms list also removes the represented table from any

searches.

Deleting a form from either the side bar or Extra Forms will place it back in the master list

which is accessed by the (add) button.

Unique Data Forms

Working with Forms and Trees

Specify represents Taxon, Geography, Storage, Lithostratigraphy and Chronostratigraphy

data in both trees and forms. When entering data using a form, keep in mind that Carry

Forward is not available for the Parent field and entering Child Nodes via the tree can save

time and energy.

When adding, editing or viewing data as a tree, users can also access forms for individual

nodes by clicking either the edit ( ) button or the add ( ) button. Trees are not accessible

when using the form system.

Note: Tables can not be edited simultaneously in both the Tree and Form mode,

or by multiple users. For example, if a user is editing the Taxon Tree and wants to

open a Taxon Form, it will open as View Only. In addition, if another user tries to

open either the Taxon Tree or Taxon Form, a dialog will pop-up stating that the

Tree is locked and will open in View Only mode.

Containers

New in Specify 6.3! Containers allow collection objects to be permanently 'grouped'

together. Containers can be substrates or physical containment objects within a collection.
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For example, a microscope slide upon which one or more algal specimens (collection

objects) are mounted can now be assigned a catalog number and be linked to the algal

collection object records. Containers can hold specimens or other containers. A lichen

specimen on the bark of a wood sample, might need to be cataloged as a collection object,

with the piece of wood cataloged as a Container. A Container might also be a box of

specimens (Collection Objects) that needs to be cataloged as a traceable collection artifact.

A container must be linked to a collection object to be cataloged in a collection. For a more

indepth explanation of the container concept in Specify please read the document,

Containers and Storage Concepts, found on the Documentation page of the Specify

website.

Containers can be either physical or logical. The above examples are all physical

containers. A logical container is one in which only associations are made. For example, a

skin, jawbone and tail of an animal may exist in different storage units in a collection. Each

of these is a separate collection object record in Specify but require a logical association. A

named container can be created and each of the objects associated with the container.

Containers should not be confused with nodes on a storage tree. Containers can be

associated with a node on a storage tree but are not the actual node. The box in the example

above would not be listed in the storage tree, but may be stored on a shelf in a particular

room. The shelf and room are part of the storage tree.

Note: Containers and their associated collection objects must be within the same collection

Cataloged Containers

Containers can be cataloged by first creating a collection object and then

associating it with a container.

Subcontainers

A container that is contained in another container is called a subcontainer.

Subcontainers may not be cataloged.

Containers are created using a container form or a collection object form. The collection

object form must be edited to include the container controls before containers can be

created or associated through it. For more information about editing forms please contact

Specify at specify@ku.edu.
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Container Form

Container Form

Container forms can be added to the side bar using the Side Bar Data Form

Configuration tool.

Note: At this time a container may not be deleted if collection objects are

associated with it. To delete a container you must first remove all collection

objects associated with the container.

Note: A collection object that is associated with a container may not be

deleted. To delete the collection object the container association must first be

removed.

• Name the container.

• Type is a pick list that you may configure, this may include sheet, folder, box, etc. For

more information please refer to system pick lists.

• Parent is used when the container is a subcontainer. It is the name of the parent

container

• Collection Object is used to catalog the container. The collection object must already

exist.

Select the (Edit) button to edit a relationship.

Click on the (Search) button and type in all or part of a catalog number. A

matching list of available catalog numbers will display to choose from.

• Collection Objects in this Container lists all the collection objects associated with

the current container.
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Select the (Remove) button to remove a collection object from the list (it

does not delete the collection object).

Click the (Search and Add) button and type in all or part of a catalog

number. A matching list of catalog numbers will display to add to the list.

• Subcontainers of this Container lists all containers that are held in the current

container.

Select the (Remove) button to remove a container from the list (it does

not delete the subcontainer).

Click the (Search and Add) button and type in all or part of a container

name. A matching list of containers will display to add to the list.

Containers on a Collection Object form

Collection Object forms can be edited to include a container control. For more

information about editing forms please contact Specify at specify@ku.edu.

Container Control

• Select This Collection Object belongs to Container if the collection object is

associated with this container, or in other words, the collection object is 'inside' the

container.

• Select This Collection Object is the Container if the collection object is the physical

container or primary collection object used to describe the container.

Buttons provide several capabilities.

Select the (Edit) button to edit a container.

Select the (Search) button and enter all or part of a container

name. A matching list of container names will display to select

from.
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Select the (Add) to create a new container.

Taxon Form

The Taxon form includes fields from the Taxon table such as Name, Parent, Rank,

Common Name, Source (of the Taxa), Author (this is often the person that described the

particular taxa), synonym information, Child Taxa and Taxon Citations.

It also includes information for Hybrids by combining the Hybrid Parent 1 field and the

Hybrid Parent 2 field.

Determinations Form

The Determinations form includes many fields that may not be immediately recognizable.

Field Label Field Usage

Preferred Taxon This is a view only field that represents the preferred name of

any synonym entered into the Determined Taxon field. If a

preferred name is entered into the Determined Taxon Name

field then this will represent a duplication of that name.

Current A check box to indicate whether a given determination is

current for this specimen.

Current Determination is a Required Field but only one can

exist for each Collection Object. Therefore; to change the

Current Determination one must first open the old

Determination and uncheck the Current box.

Taxon This field is the determined name of the specimen in question.

Names can be chosen from the existing authority file from a

Query Combo Box, or added to the Table. Synonymized
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names are included in the Query Combo Box, but if chosen a

prompt will indicate that the name is a synonym and ask which

name to use. This prompt can be turned on by choosing Specify

> Preferences > Trees on a Macintosh or Edit > Preferences

>Trees on Windows or Linux and checking the Prompt to

Replace Taxon with Preferred Taxon box.

This field operates as an “either/or” condition with Alternate

Name; both cannot be entered in a single Determination.

Qualifier A term to qualify the identification of the taxon name when

doubts have arisen as to its identity or as a comparison to a

given name (e.g. "cf." or "aff.").

Addendum A Pick List suffix element added to the taxon name to indicate

a concept or citation for that name. For example; sensu lato.

Type Status Name A pick list of all available type designations; Holotype,

Paratype, Neotype. Specify ships with predetermined values

which are editable for users.

Botany and Entomology Taxon forms will also have these two fields:

Alternate Name A free text field for insertion of a name (scientific or common) not

recognized in the taxon tree authority. This field operates as an “either/or”

condition with Preferred Taxon; both cannot be entered in a single

Determination.

Name Usage User customizable pick list used to describe the context of the name

entered into the taxon or Alternate name fields. Taxon field - if a synonym

name is used, it could denote a “shelved by” name. Alternate name field -

could denote the appropriate authority the alternate name was taken from

(e.g. Flora of Nebraska).

Locality Form
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The Locality form introduces unique latitude and longitude information represented by a set

of buttons.

• Choose a latitude/longitude format from the Combo Box

Decimal/Degrees

Degrees/Decimal/Minutes

Degree/Decimal/Seconds

• Click the appropriate button(s) to enter the latitude and longitude information.

Top Button Bottom Button Explanation

Single Point

Beginning/Ending Point on a Line

Note: this requires latitude and longitudes for both points

Beginning Point

End Point

Beginning/Ending Point on a Bounding Box

Note: this requires latitude and longitudes for both points

Beginning Point

End Point

• Type the appropriate degrees for latitude and longitude

• Choose either North (N) or South (S) for latitude

• Choose either East (E) or West (W) for longitude
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When a lat/long is entered the format is captured and displayed in the (Source) field. This

field remains constant when formats are changed, but if the lat/long numbers are changed

then the (Source) field will update to the new lat/long entry.

Note: Specify does not track versions of the latitude and longitude and does not

keep a verbatim field.

Other data on the Locality form include a Geo Referencing Determination By and Date.

These are for documenting how and when a georeference for the Locality occurred.

A (Preferences) button is available on the latitude and longitude panel. Click this button

to set the following defaults:

• Latitude North or Logitude West

• Point, Line or Triangle

• Decimal Degrees, Degrees Minutes Decimal Seconds or Degrees Decimal Minutes

GEOLocate

The GEOLocate project has created software and services for translating textual

locality descriptions associated with biodiversity collections data into geographic

coordinates. It uses a description of a Locality and geography fields, such as

County, State and Country, to find Latitude and Longitude coordinate values.

This is referred to as georeferencing.

The Specify and GEOLocate teams have collaborated to create a GEOLocate

module inside Specify. In Specify 6.4 and newer GEOLocate has been upgraded

to plugin version 2.0.

Requirements for Georeferencing US localities:

Column Heading Data Needed

Locality Name Yes

Country Yes

State Yes

County No, but will improve results.
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Note: County is required when including waterbody and highway

crossing in the GEOLocate search.

Latitude1 No

(this is a results column)

Longitude1 No

(this is a results column)

Requirements for Georeferencing localities outside of the US:

Column Heading Data Needed

Locality Name Yes

Country Yes

Child Node of Country No, but will improve results.

Latitude1 No

(this is a results column)

Longitude1 No

(this is a results column)

Note: A complete list of acceptable countries is available on the

GEOLocate website.

Once the locality information is complete, the GEOLocate button will become

enabled.

Click the button to send locality information to the GEOLocate

service. A message will either display the number of records GEOLocate found

results for, or state that no results were found.
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View GEOLocate Results

Results will display in the GEOLocate Results Chooser tool.

GEOLocate

Locality Information displays the Locality Description, County, State and

Country values in your current record.

Correction (Green) Marker Properties include the values for the most accurate

result among the GEOLocate results returned. These values are also displayed

visually on a map.

GEOLocate results can be edited using either the Correction Marker Properties

form or the map elements. Changes made on the map are automatically

recalculated and updated in the corresponding fields on the form. Updated values

in the Correction Marker Properties form are automatically represented in the

corresponding map element.

Note: As you move your mouse within the map the corresponding

latituted and longitude values display in the lower right corner under the

map.

Specify Help - Data Entry in Data Forms

139 / 391



Position represents the Latitude and Longitude of the GEOLocate

result, visually depicted on the map as a green marker. These results

can be edited.

Edit the Position using the Marker Properties form:

1. Type new values in the Latitude and/or Longitude box.

2. Click the Apply button to accept the changes and update the location of

the green marker on the map.

Edit the Position using the map:

1. Click on the green dot on the map and drag it to a new position. The

latitude and/or longitude values on the form will automatically update.

Uncertainty Radius represents the error due to the uncertainty of the

locality information provided. It is shown as a grey circle around the

green point marker on the map. The Uncertainty Radius can also be

edited.

Note: At this time in Specify the Uncertainty Radius values

are not written in a Specify database field.

Edit the Uncertainty Radius using the Marker Properties

form:

1. Click the Uncertainty Radius button. The text

box will change to accept numeric values, and

a large arrow will appear on the map next to

the Uncertaintly Radius point.

2. Type a new numeric value into the box and

click the Apply button to accept the changed

value in the GEOLocate tool and update the

Uncertainty Radius on the map.

Note: If GEOLocate does not find an Uncertainty

Radius the text box will open ready to accept

numerical values and the Apply button will be

available.
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Edit the Uncertaintly Radius using the map:

1. Click the Uncertainty Radius button. The box

will change to accept numeric values, and a

large arrow will appear on the map next to the

Uncertaintly Radius point.

2. Click in the center of the arrow and drag to

reset the Uncertainty Radius on the map as

well as the numeric value in the form. As you

move your mouse within the map the

corresponding Uncertainty Radius, and

latituted and longitude values display in the

lower right corner under the map.

Note: If GEOLocate does not find an Uncertainty

Radius the text box will open ready to accept

numerical values and the Apply button will be

available. You must type a value into the text box

and click the Apply button before the arrow will

appear on the map.

Error Polygon is a polygon which encompasses the entire area of

uncertainty.

Results which include an Error Polygon will display the vertex values

in the form and a red polygon on the map. Not all results include an

Error Polygon. If the results do include an Error Polygon the vertex

values in the form must be cleared by clicking the Clear Polygon button

before the Error Polygon can be edited.

Note: At this time in Specify the Error Polygon values are not

written in a Specify database field.

Edit the Error Polygon using the Marker Properties form:

1. Click the Draw Polygon button. The box will change to accept numeric

values. Type in latitude and longitude values, separated by commas.

2. Click the Apply button to accept the values in the GEOLocate tool and

draw the polygon on the map.

Edit the Error Polygon using the map:
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1. Click the Draw Polygon button. A blue circle will appear around your

mouse in the map area.

2. Left-click on the map to add a vertex point.

3. Continue adding points until the polygon is complete.

4. Double click on the last vertex point to finish the polygon and exit the

draw polygon mode. The vertex values will be updated in the form.

OR, Right-click on the map to cancel the

vertex and exit the draw polygon mode.

Note: If there are vertex values included in the Error Polygon

field the values must be cleared by clicking the Clear Polygon

button before new values can be entered or drawn on the map.

GEOLocate Results displays the GEOLocate results in grid form. If multiple

results are returned they are numbered and sorted with the most accurate listed

first. The active result is highlighted in blue on the form. Other GEOLocate

results are represented by red markers on the map.

Click on either a record in the GEOLocate Results form or a red point

on the map to make it the current, or active result. The fields in the

Correction Marker Properties box will be filled in and the green marker

will represent the current result until you manually make corrections.

• Number represents the order of GEOLocate returns both in the

form and in a corresponding point on the map.

• Latitude represents the latitude to the hundredth degree.

• Longitude represents the longitude to the hundredth degree.

• Pattern, or pattern identifier, is a text description of the pattern or

keyword used to determine a GEOLocate result. Single locality

strings often include multiple patterns, producing multiple

GEOLocate results.

• Precision is an indication of the quality of locality information.

Each GEOLocate result is given a score between 0 and 100 which

represents the probability of it being a match. That score is then

placed within a 'low', 'medium' and 'high' ranking to indicate

precision. Results are then ordered according to their probability
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number, which allows results within the same rank to include the

most accurate matches first.

• Error Polygon is a polygon which encompasses the entire area of

uncertainty.

• Uncertainty represents the error due to the uncertainty of the

locality information provided.

Other Map Controls

Zoom In/Out

Slide the slider down to zoom in, up to zoom out.

Click the button to zoom in, the button to zoom out.

Turn the wheel on your mouse up to zoom in, down to zoom

down.

Double click to zoom in, right-click to zoom out.

GEOLocate Web Button

Click the button to open the web-based version of GEOLocate in

your default browser and plot the current result set on the map.

Accept Results

Click the Accept button at the bottom of the GEOLocate tool to write the values

of the GEOLocate result in the appropriate fields in Specify.

If a batch of records was processed in GEOLocate the next record will display in

the GEOLocate Results Chooser.

Skip Record

Single records are displayed in the GEOLocate Results Chooser. Use the Skip

button to skip the current record.
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More information about GEOLocate can be found at

http://www.museum.tulane.edu/geolocate/.

WorldWind

The link to NASA World Wind is always available on the

Locality form. A text box at the top of the World Wind dialog allows either a

Latitude and Longitude or a Locality Name to be entered. The location is then

displayed on a World Wind map. If either a Latitude and Longitude or Locality

Name exists in the Locality form World Wind will automatically plot the location

on the map once the button is clicked.

World Wind requires a 3D video card with updated drivers to work properly.

Several default controls are available from within World Wind.

Mouse with scroll wheel:

Pan Left-click & drag - all directions

Left-click once to center the view.

Zoom Use the scroll wheel on the mouse

or Left or Right-click & drag

Tilt Right - click & drag - up and down

or use "Page Up" and "Page Down" on the keyboard.

Rotate Right-click & drag - left and right

Note: Crossing the top and bottom half f the screen while rotating will

change direction.

Stop Spacebar

Reset Heading N

Rest All R

Single button mouse:
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Pan Left - click & drag - all directions

Left - button click once to center view.

Zoom Hold "Ctrl" on the keyboard and

Left - click & drag - up and down.

Tilt Hold "Shift" on the keyboard and

Left - click & drag - up and down

Rotate Hold "Shift" on the keyboar and

Left - click & drag - left and right.

Stop Spacebar

Reset Heading N

Rest All R

More information about World Wind can be found at

http://worldwind.arc.nasa.gov/java/.

A web link button to Google Earth is also included on the

Locality form. Localities with Latitude and Longitude data can be plotted on

Google Earth by simply clicking this button. Google Earth must be properly

installed on the local machine for Specify to display in Google Earth.

For more information or to download and install Google Earth visit

http://earth.google.com/.

For more information about the GEOLocate or Google Earth plugins please refer

to the Plugins documentation.

Collecting Event / Time and Place

One of the important curatorial decisions to be made early on is the use of “Collecting

Events” in a collection. This is also named 'Time and Place' on some Data Type forms. A

collecting event is described by the date and time of the collection together with collector

names and a number associated either with all specimens collected at that date and time or a

number associated with each individual specimen.
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In the first case (traditionally used in lot based collections) the number is associated with

the Collecting Event itself (and all its associated data) in the form of a Station or Field

Number and is therefore associated with one or many specimens or collection objects

collected at the same time and place by the same collectors e.g. ACB 09-01. The Station or

Field number thus describes all specimens or Collection Objects collected at that time and

place. There is a many-to-one relationship between specimens, or Collection Object and

"Collecting Events". In this instance, the Collecting Event form is usually expressed as a

Query Combo Box on the Collection Object form so that values can be searched, and the

same collecting event can be used (based on the Station/Field Number) for entering

information for multiple specimens without having to enter it repeatedly. The data

displayed within the Query Combo Box is then formatted using the Schema Localizer to

display a textual string representing the different data elements of the Collecting Event

(Field Number, Date, Geography and Locality information). The lookup function of the

Query Combo Box will also display this format to aid in selecting the correct Collecting

Event for subsequent specimens.

In the alternate case (used by all other disciplines) the number is associated with each

individual specimen or Collection Object in the form of a Collector number - a unique

number given to every specimen collected and usually including the Collectors acronym

e.g. ACB 12345, while the remaining data is still bound to the Collecting Event table. There

is a one-to-one relationship between specimens and Collecting Events. In this instance the

Collector number would be a field on the Collection Object form and all other fields would

be associated with the Collecting Event which would not include a Station/Field Number

and would be expressed as an embedded sub form on the Collection Object form and would

not be able to be reused for subsequent specimens.

Disciplines traditionally use one of these two methods.

A method should be chosen before data is entered, uploaded, or migrated into your database

by our staff. To facilitate our set up of forms for evaluation, we have set defaults for

collection types and Specify ships with all Disciplines except Ichthyology using Collection

Event as a one-to-one relationship. If the default form does not represent the way you

process collections, and you are unable to change the setting after following the

instructions, you should contact us for setup instructions, rather than altering your workflow

or introducing a new process or number.

If forms are changed from a one-to-one relationship to a one-to-many relationship the

checkbox for 'Add Collecting Even Automatically' on the Collection form (System >

System Setup > Configuration) will need to be unchecked after importing the new form.

Agent Form
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An Agent is not limited to single individuals. The Agent Type field on the Agent form

allows an agent to be the following:

Agent Type Usage

Person This is an individual with field options of first, middle and last

name, abbreviation, email and multiple addresses and

attachments.

Organization This is often an Institution with name, abbreviation, email and

multiple addresses and attachments.

Group Using a group option allows multiple agents to be associated

with one name entity. This type of Agent includes name,

abbreviation, email and links to individual Agents that are a part

of the group. This option is useful when it is necessary to search

by the group name.

Other Other is used when the other three options do not apply. Name

and attachments are the only fields for this agent type.

It is also important to note that Agents are shared throughout a Division. In other words, if a

division has two disciplines (A and B) and division A creates an Agent, division B, as well

as all collections within the two divisions, will also have access to that agent.

Preparation Form

It is important to note that the Is on loan checkbox is for display purposes only.

This information is updated when a loan is created or edited.

The Preparation Type field is a Pick List. To edit the Pick List choose System >

Collection Setup > Configuration and click on the Pick List button in the Side

Bar. For more information on editing a Pick List please refer to the System Pick

Lists documentation.

Attachments Form
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Many tables in Specify 6 allow Attachments. When a file is attached, Specify

creates an attachment record in the database with the original name, mime-type

and most importantly, the path to the file in the repository, or attachment location.

Specify also makes a copy of the attachment, renames it with a unique name, and

stores it based on a path specified in the User Preferences.

The Specify Wizard creates a default path and location for the copied

attachments, but it is recommended that the user create a unique location by

editing the default path within the System Preferences. The attachment storage

can either be located on a local drive, a server or an attachment server. To create

and/or alter the attachment location, go to:

• For Mac: Specify > Preferences > System > Attachment Storage Location.

• For PC and Linux: Choose Edit > Preferences > System > Attachment

Storage Location.

Note: if the attached file is an image, Specify also creates and stores an

icon for the image in the Attachment Storage Location.

If a path does not exist or Specify is not able to connect to the path, the

Attachment button will become disabled on the forms.

Accepted Attachment files include:

• text

• audio

• binary

• pdf

• image (jpg, png, gif, tiff)

• html

• spreadsheet

• video

Note: Specify can accept images in a tiff format, but they may not

display on the Windows and Linux operating systems.

Attach Files

Attach files to a record by clicking the Attachment button ( ) on the form. An

Attachment sub form will open.
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1. Click the (add) button.

2. Click the Browse button and use the file system dialog to find the path to the

file.

3. Type a name in the Title text box. Specify will use the file name as a default

title if this box is left blank.

4. Click the Accept button.

5. Click the (add) button to add another attachment, or click Done to close

the sub form.

Note: If a table does not have an attachment button, it does not accept

attachments.

Note: For versions of Specify 6.5 and newer the default Collection

Object form includes an attachment window, rather than a subform, for

adding attachments. This allows attachments to be dragged and dropped

from the file directory to the attachment window.

View/Edit Attachment

Once Attachments have been saved to a record they can be

viewed/edited in form, grid, or icon mode. Each mode allows

different functions.

Choose a mode by clicking the (expand) button and

selecting a mode.

Form Mode

• Use the Navigation Control to view each Attachment.

• Click the (add) button to add an Attachment.

• Click the (delete) button to delete an Attachment.
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• Click the Browse button to change an Attachment path.

• Edit the Title of an Attachment in the Title text box.

Icon Mode

• Click the (add) button to add an Attachment.

• Click the (delete) button to delete an Attachment.

• Click the (edit) button to edit the Attachment path in

the Form Mode.

• Double Click the Attachment button to open the

Attachment in its native application.

Grid Mode

• Click the (add) button to add an Attachment.

• Click the (delete) button to delete an Attachment.

• Click the (edit) button to edit the Attachment path in

the Form Mode.

• Click the (reorder) buttons to reorder the

Attachments.

GUID

As of Specify 6.5, GUIDs are generated using a 128-bit Universally Unique Identifier, or

UUID (example: bf3066d2-c088-47c8-b279-e7941463a65f0). The Specify 6.5 update does

not overwrite any existing data in Specify's GUID fields. The update checks for data in

GUID fields and if it finds some in any record, it passes over the data table and no UUIDs

are assigned to it. However, new collection data records will be assigned UUID values in all

tables with GUID fields (except for Geography and Taxon) when they are created.

Collections which previously utilized Specify's GUID data fields for other purposes should

contact the Project for assistance to accommodate that data.

Specify automatically creates GUIDs in the GUID field of the following tables:

• Agent

• Attachment
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• Collection

• Collecting Event

• Collection Object

• Determination

• Geologic Time Period

• Institution

• Journal

• Litho Stratigraphy

• Locality

• Reference Work

Using a GUID to identify information allows it to be shared and recognized globally. As

more biological information systems use GUID/UUID's it will become possible to instantly

recognize when globally exchanged information has been updated or duplicated.

Interactions Forms

The interactions forms in Specify help users create and manage loans, gifts, borrowed items, permits,

shipments, accessions, and information requests. As an example, a collection manager may respond to

a request for a loan of from an institution for research. By creating a new loan record in Specify. This

would include the list of specimens to be loaned, along with other required loan information. When

the loan is returned, the manager would then update the loan record to note the date of the return and

which specimens were returned.

Access Interaction Forms by clicking the Interactions button. A list of forms will appear in the

side bar.

Note: If an Interactions button is not available on the task bar choose Specify > Preferences

> Task Bar, then click the Interactions checkbox.

Specify 6 ships with the most frequently used forms listed on the side bar.

A Side Bar Interaction Form Configuration allows the available Interaction forms listed on the

side bar to be rearranged and hidden:

Choose Tabs > Configure Side Bar in the main menu.
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• Use the , and (reorder) buttons to change the order in which the forms appear in

the side bar and More Forms list.

• Use the , and (move) buttons to show or hide an available side bar item.

Interactions forms can be activated by clicking them in the side bar. Gifts, Loans or

Information Request are also activated by dropping a Collection Object record set onto

them in the side bar.

Note: The Side Bar Configuration tool can also be opened by

right-button-clicking in the right side of the side bar to open the Form

Configuration tool, then click on the button.

Accessions

Accessioning is the formal process by which a specimen or object is legally accepted and

recorded as a museum item and differs from cataloging. This usually entails proof of

ownership (in the form of a signed deed of gift) and legal collection (in the form of all

associated permits - collecting, import and export). Accessioning and its numbering system

is usually a policy adopted as a museum-wide policy but is not used by all museums. An

accession usually covers an entire field trip and multiple catalog items could be included

within a single accession. Within the database there is a one-to-many relationship between

Accessions and Collection Objects. Accessions can be created through the Interactions

menu or directly from the Collection Object being entered.

Note: Accession number is one of the fields that can be formatted through the schema

localizer. The accession numbering system can also be associated at the Collection level for

individual collection use or the Institution level where a single numbering system is adopted

by all collections within an Institution.

All associated agents and permitting information can be entered in a one-to-many

relationship within the accession.

Gifts and Loans
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Loans and Gifts document items leaving the Institution, and Collection Objects are linked

to the Loan/Gift through preparations. The first step in creating a Loan or Gift is choosing

the specimens (as preparations) to add to the transaction.

• Click either Loan or Gift in the side bar to start the process.

If any record sets have been saved, a dialog appears prompting the user to either Enter

Catalog Numbers or use an existing record set. The Record set method would be easiest

when using large sets of data.

• Enter Catalog Numbers by typing the catalog numbers into the text dialog,

separating multiple numbers with commas (100, 105, 152))

• Enter a range of catalog numbers, with a slash as a separator for the range, for

example: 12012-12020

OR, if the catalog number includes a dash a slash can be used, for example:

2011-0001/2011-0010

• Select a record set from the list. If only one record set exists, it will be used by

default. This can also be accomplished by dragging and dropping the record set onto

the Information Request item in the sidebar.

Note: If a non-loanable Preparation Type is selected a warning dialog will

appear informing the user that the chosen specimen(s) are not loanable.

Next, a dialog listing all preparations for each Catalog number will appear.

Create Loan from Preparations

Each checkbox represents a Collection Object and is labeled with Catalog Number and

determination. Specimen counts reflect the number of specimens that are currently on

available to be loaned. An indication is also given if any additional specimens are

associated with previous open loans or gifts. In these cases the total number of available
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specimens would be reduced by this number. The (information) button links to the loan

or gift in question for further information.

• Select specimens by typing the number of specimens of each preparation being sent

on loan into the dialog or use the arrow keys. If multiple preparations for a single

Collection Object are present, they will be listed together under the same

checkbox. All preparations can be selected at once by clicking the Select All button.

All preparations can be selected at once by clicking the Select All button. The number of

specimens available to be loaned is indicated next to the arrow keys to select a number. An

indication is also given if any additional specimens are associated with previous open loans

or gifts. In these cases the total number of available specimens would be reduced by this

number. The (information) links to the loan or gift in question for further information.

Click the OK button to accept the preparations and progress to the Loan/Gift form where all

additional information pertaining to the Loan or Gift can be added.

Gift/Loan Invoices

Once preparations have been added to the Loan or Gift, a Generate Invoice on

Save check box becomes available on the form. If checked and the necessary

query and Report have been constructed, the Report associated with this Loan or

Gift will be created automatically once the Save button has been clicked.

A sample invoice for each Discipline is included with Specify and will print

automatically if a custom invoice has not been created. When creating a custom

invoice in SPiReport save the report/invoice as an 'invoice'. Once an invoice has

been saved checking the Generate Invoice on Save check box will display your

invoice in a list and allow you to print it.

Returning Loans

When returning loans, a Loan Return Prep record is created for each preparation lent out.

There are three values associated with each Loan Return preparation:

Quantity - the number of each preparation lent out.
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Quantity Returned - the number of preparations returned. This may not equal

the quantity sent out in cases of partial returns and/or lost/damaged specimens not

returned (see resolved below).

Quantity Resolved - used to increase the number resolved to correspond to the

quantity lent. This is used in the case where specimens are lost or damaged and

are no longer associated with the collection. It us often helpful to use the remarks

field to describe the circumstances of this discrepancy.

For the loan to be closed, the quantity lent must equal the quantity resolved. In the case of a

full return of a loan, all three numbers would be identical for each preparation.

When returning all, or a large proportion of the items in a loan it is easiest to use the Return

Loan button at the bottom of the loan form. This method offers a Select All feature for

automatically returning all preparations. Clicking Select All will make the quantity returned

and quantity resolved equal to the quantity sent out for each preparation and automatically

check the Is Closed checkbox in the loan, thereby closing the loan. The Return Loan button

will also change to All Returned. If any of these numbers are altered at any stage, thereby

reopening the loan, this button will revert to Return Loan. For partial returns, or when

some items are resolved but not returned, due to loss or damage, the quantity returned and

quantity resolved can be manipulated and remarks inserted.

Loan Return Prep's can also be individually altered using the Loan Return Prep button

on the Loan Preparation form.

Note: The quantity, quantity returned and quantity resolved cannot be manually

edited on the Loan Preparation form.

Note: The Is Closed check box is editable only when the quantity returned and

quantity resolved do not equal each other i.e. when the loan is NOT closed.

Loan w/o Preps

There may be instances when specimens are lent before they are cataloged. To create a loan

that is not dependent on a Preparation Type, choose the Loan w/o Preps button on the side

bar. These loans function in much the same way as the regular loans described above.
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Information Requests

Collection Managers are often called upon to share data records with users of the collection,

other collections or in-house staff. In most cases this is accomplished by attaching an Excel

spreadsheet to an email message. The information shared is usually in the form of

Collection Objects. Specify 6 contains an automated function to handle this type of request

electronically.

Click Information Request in the side bar to start the process.

If any record sets have been saved, a dialog appears prompting the user to either Enter

Catalog Numbers or use an existing record set. The Record set method would be easiest

when using large sets of data.

• Enter Catalog Numbers by typing catalog numbers into the text dialog, separating

multiple numbers with commas.

• Select a record set from the list. If only one record set exists, it will be used by

default. This can also be accomplished by dragging and dropping the record set onto

the Information Request item in the sidebar.

The Collection Objects will be added to the Information Request form. Once they are

added, the Send Email on Save check box becomes available on the form. If checked and a)

the recipient has an email address associated with their agent name in the database and b)

the necessary email settings have been entered in Preferences > Email, an email will

automatically be sent to the designated recipient once the Save button has been clicked.

The attached Collection Objects will appear in the main portion of the email and also

attached as a CSV file.

Unlike queries, Information Requests are only saved on the side bar and not in the database

and are not searchable. Saved Information Requests listed on the side bars can be deleted

by dragging and dropping them onto the trash can. No record will be kept in the database

of an Information Request once it has been deleted.

It is possible to send an information request via email at a later date or resend it if it has

been saved.

• Click on the Information Request button in the side bar to open it in the work space.

• Click the (edit form) button at the bottom of the work space to edit the Information

Request.

• Make a change to the Information Request (this could simply be retyping part of the

date).

• Check the Send Email on Save button.
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• Click the Save button.

Borrows

Specimens that are on loan from another collection can be tracked in Specify by creating a

Borrow. Borrows never become part of your collection and therefore the forms and data

will not be entered into any Collection Object fields or related fields. Borrows must be

given an Invoice Number.

Exchange In / Exchange Out

The Exchange In / Exchange Out feature of Specify 6 is intended to give certain disciplines

the facility to track incoming and outgoing specimens against each other.

New is Specify 6.3 - Exchange In / Exchange Out are now connected to preparations for the

exchanging of cataloged items. Functionality follows that of Gifts and Loans above. Forms

can also be modified or augmented to incorporate the exchanging of non-cataloged items

much like in Loans without Preps.

Repository Agreements

A repository agreement is similar to an accession but does not transfer ownership of the

specimens. This is most frequently entered into with countries that do not wish to lose claim

to their biodiversity but will allow museums to house their specimens and, in some cases, is

the only method of legally collecting in some countries. Repository agreements can entail

multiple accessions i.e. multiple field trips, and thus there is a one-to-many relationship in

the database between repository agreements and accessions and a method for linking many

accessions to a single repository agreement.

All associated agents and permitting information can be entered in a one-to-many

relationship within the repository agreement.

Deaccessions
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Deaccessions are not implemented in the first release of Specify 6, but we are committed to

providing this capability and will be including it a future release.

Attachments

Specify allows several file types to be attached to records:

• text

• audio

• video

• binary

• pdf

• image (jpg, png, gif, tiff)

• html

• spreadsheet

• others

Attach Files

Files can be attached to records via the Form system, WorkBench Uploads, and, new in

Specify 6.5, Attachment Tools.

View Attachments and Associated Information

Attachment Tools enable users to browse thumbnail representations of all attachments

associated with a collection in a workspace window. The browse can also be limited to

show only image attachments.

Attachments associated with a single record can be viewed using the Form system.

Double clicking an image attachment thumbnail in either a form or the attachment browser

will open the file in a Specify tab. Double clicking a non-image attachment will open it in

the appropriate application on the workstation. If Specify can not find the appropriate

application it may be necessary to export the attachment and open it from within the

application itself.
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The Attachment Tools can be used to view/browse a limited set of attachments by first

creating a query in the Query Builder, then clicking the Attachment button located on the

Query Results Tool Bar.

Note: thumbnails are created for jpg, png and most pdfs. Other file types are

represented by a default thumbnail based on their file type.

Information associated with the attachment can be viewed in the Attachment Tools,

including associated record information and any available metadata.

Store Attachments

Attachments are copied, renamed using a unique string, and stored in an Attachment

Storage location. Only the path to the attachment storage location is stored in the Specify

database. The Specify Setup Wizard sets a default storage location on the local drive but

this location can be changed in System Preferences:

• For Mac: Specify > Preferences > System > Attachment Storage Location.

• For PC and Linux: Choose Edit > Preferences > System > Attachment Storage

Location.

Attachments can be stored on a local hard drive, network drive or an attachment server.

When storing attachments on a local or network drive, Specify creates a directory named

'originals' for storing the attachment files, and a directory named 'thumbnails' for storing the

thumbnails it creates. These directories are created within the specified attachment storage

directory.

When storing attachments on a local drive attachments may not be shared with other

workstations. For example, if User 1 attaches an image and stores it on their local drive and

User 2 logs into their instance of Specify on another workstation, User 2 will not be able to

access the attachment.

Storing attachments on a network drive allows the attachments to be shared. In the example

above, storing the attachments on a network drive will allow User 2 to view, open and

export attachments.

Museums with access to IT personnel may consider storing attachments in an attachment

server. This is an alternative to storing attachments on a network drive and allows a web

server to directly access the attachment location.
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Note: all collections within the same division must share a directory in the storage

location. If a directory is not shared, tables which share data will not have access

to attachments. For instance, within Specify two collections in the same divison

share Agent information. If each collection stores its attachments in unique

directories in the storage location and an attachment is added to an Agent record

in Collection 1 information within the Agent record will be accessible for users in

Collection 2, but the Agent Attachment will not be available and will show a

status of missing.

Change Computer/Backup Attachments

Attachments are not stored in the database and therefore are not included in a backup of a

database. Only the path to the attachment storage location is included in the database.

Attachments stored on a local hard drive should be backed up as part of the local system

backup procedure.

To access attachments on an alternate computer when the attachment storage location is on

a local hard drive will require the attachment directory to be copied to the alternate

computer. Copy the attachment storage location/directory into the exact same path on the

new computer. For example: If John Smith is using machineA but upgrades to machineB

and his attachment storage path is c:/users/john/myattachments he will need to copy the

entire myattachments directory from machineA to machineB and place the myattachments

directory in c:/users/john.

To access attachments on an alternate computer when the attachment storage location is on

either a shared network drive or attachment server, simply change the attachment path in

the System Preferences on the new computer.

Attachment Tools

Attachment tools offer the following functionality:

1. View/browse all attachments in the work space

2. View/browse all images in the work space.

3. View attachment information and metadata

4. Open an associated record in a form view
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5. Add single, or multiple attachments in a single action

6. Export attachments from the work space

Open the Attachment Tools by clicking the Attachment button on the task bar.

If Attachment Tools is not available on the task bar add it by choosing Specify > Preferences > Task

Bar for Macintosh,

or Edit > Preferences > Task Bar for Windows and Linux,

then checking the Add Attachments checkbox.

Four functions appear on the sidebar:

1. Show All Attachments

2. Show All Images

3. Import Images

4. Import Image Index

1. Show All Attachments

Click Show All Attachments in the side bar to browse thumbnail representations of all

attachments relevant to the current collection.

Note: the Attachment tools are limited to files in an 'Attachment' table, not files linked to

records using a Linking Field display.

Note: thumbnails are created for jpg, png and most pdfs. Other file types are represented by

a default thumbnail based on their file type.

Attachment Levels (multiple collections in the same database)

Attachments are stored at the same institutional level as their associated table and

are displayed based at this level. For example, the Collecting Event table is at the

Discipline level and a pdf attached to a Collecting Event record will display for

all collections within the discipline.

Attachment Table Institution Level

Accession Either Institution or Division (user choice)

Agent Division

Borrow Collection

Collection Event Discipline

Collection Object Collection
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Conservation Description Division

Conservation Event Division

DNA Sequence Collection

DNA Sequencing Run Collection

Field Notebook Discipline

Field Notebook Page Discipline

Field Notebook Page Set Discipline

Gift Division

Loan Divison

Locality Discipline

Permit Institution

Preparation Collection

Reference Work Institution

Repository Agreement Same scope as Accession

Taxon Discipline

To Open an Attachment or Display a larger image:

• Double click an individual image thumbnail to display it larger in a new tab in the

workspace.

• Double click a non-image file to open it in its native program (example: .xls opens the

file in Excel).

Note: windows users must set their default media/video player to VLC media

player for Windows Media Player video files to open when double-clicked from

within Specify.

Available Buttons

Button Location Action

next to thumbnail Display information about the associated record, also allows record to be opened in

form view.
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next to thumbnail Open associated record in form view. Also indicates the table to which the

attachment is linked.

bottom of workspace Display associated record information, will display latitude and longitude

information on a map.

bottom of workspace *Display attachment metadata when available.

bottom of workspace Opens help page for the Attachment tools.

|< bottom of workspace Go to first record.

>| bottom of workspace Go to last record.

2 of 6 bottom of workspace Double click within the box and enter a page number in the resulting dialog to jump

to the desired page.

< bottom of workspace Go to previous record.

> bottom of workspace Go to next record.

Note: Some file types such as png, bmp and gif contain little or no metadata information.

Note: Metadata captured at the time a digital photo is taken may include the date, and

latitude/longitude. The metadata information may be stripped from the file when the image

is loaded into an outside program such as a web-based image storage facility.

Export Attachment

Right-click on the thumbnail and click the Export Attachment button.

2. Show All Images

Click Show All Images in the side bar to browse thumbnail representations of jpg, tiff, bmp

and gif image types, in the current collection.

The Show All Images tool includes the same functionality as Show All Attachments. Please

see section 1 of this document for more information about using Show All Images.

Note: the Attachment tools are limited to files in an 'Attachment' table, not files linked to

records using a Linking Field display.

Note: Specify is unable to create and display thumbnail images of tiff files at this time, but

tiff images can still be attached and viewed in Specify.
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3. Import Attachments

The Import Attachments tool allows multiple attachments to be associated to records by

matching attachment names within a directory to a unique field within an existing record.

For example, if records within the Collection Object table include unique values for field

number, simply rename attachment files to match the field numbers in existing records. If

the attachment names already match the field numbers in existing records, no changes are

necessary.

Table Unique Field Value File Name Example

Collection Object Catalog Number

(example: 2009-00001)

2012-00001.jpg

Collection Object Field Number

(example: 00000034)

00000034.pdf

Collection Object Alternate Catalog Number

(example: KU - 00001)

KU - 00001.exe

Collecting Event Collector Number

(example: 00012a)

Note: this field may also be labeled Field Number.

00012a.doc

Taxon Full Name

(example: Tursiops truncatus)

Tursiops truncatus.png

When the unique field uses a format, multiple attachments can be associated to the same

record by adding a character to the end of the attachment file name. The character can be a

letter or a number must be distinctive. For example, add a number to a format ending in a

letter but add a letter to a format ending in a number.

Unique Field Value Multiple Attachment File Name

Numeric only (example:2000) 2000a.jpg, 2000b.jpg

Alphanumeric (example:1325A) 1325A1.png, 1325A2.png

Alphanumeric (example:KU-0001548) KU-0001548a.pdf, KU-0001548b.pdf
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When using the default, auto-incrementing, numerical format for catalog number

an abbreviated version of the catalog number may be used when naming the

attachment file. For all other numeric formats the entire length of the format must

be used.

Field Format Multiple Attachment File Name

Default 9-digit Numeric (example:125) 125a.jpg, 125b.jpg

Created 5-digit Numeric (example:00125) 00125a.pdf, 00125b.pdf

Note: the tables in this section list only a few available formats, Specify supports

all field formats when attaching files.

Click Import Attachments located on the Attachment side bar.

Choose which unique table/field will be used to attach the files.

Choose whether you wish to import an individual file or entire directory.
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Choose the directory/file to import.

Specify will display a message once the upload is complete.

4. Import Attachment Mapping File

The Import Image Mapping File tool allows multiple files to be attached to records in

Specify by associating the files with unique field values within specific tables. This type of

importing of multiple attachments is often prefered when desired attachment files have not

been pre-named to match a unique field in existing records.

Table Unique Field Value

Collection Object Catalog Number

Collection Object Field Number

Collection Object Alternate Catalog Number

Collecting Event Collector Number

Note: this field may also

be labeled Field Number.

Taxon Full Name

An Import Image Mapping is used to create the association. The file must first be created in

a spreadsheet program, then saved as either a tab delimited or csv file.

The spreadsheet/mapping file must contain 2 columns, the first column includes the unique

field value within a record and the second column includes the name of the attachment file.

The unique field value and file names must match existing values and names exactly and

the mapping file must be located in the same directory as the attachment files.

Note: more than one attachment can be associated with the same unique identifier.

Note: attachment files are not required to be named using the unique identifier.

Unique Field Value Attachment File
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2000A tuna_right_side.jpg

2000A tuna_left_side.jpg

2000B notes.doc

2000C 2000C.pdf

Unique Field Value Attachment File

2009-KU-0001 pollinator.png

2009-KU-0001 Helianthus_annuus.png

2013-KU-0035 page5.doc

2012-KU-0100 100.pdf

Note: the spreadsheet examples above show only two available formats, Specify

supports all field formats when attaching files.

Once the attachment mapping file is created, click Import Attachment Mapping

File located on the Attachment side bar.

Choose the unique table/field used to attach the files.

Choose the attachment mapping file in the file directory.
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Specify will display a message once the upload is complete.

Errors when Uploading

If any files were not able to upload Specify will display additional information in a web

browser window.

Trees in Specify

Specify 6 visually presents some data types in hierarchical tree displays. These data types include the

Taxon, Geography, (Specimen) Storage, Chronostratigraphy and Lithostratigraphy tables. These data

types, or tables, are also included in the form system, but the tree offers a more broader visual

glimpse of the data. Data can be viewed, added and edited using both the form and tree system.

The Taxon, Geography, Chronostratigraphy and Lithostratigraphy trees (and tables) are scoped at the

Discipline level, meaning that all collections within a discipline share the same tree. Collection

Objects that are associated with the nodes on the tree are only available for the collection (these are

accessed from the tree by right-clicking the node and choosing Associated Collection Objects from

the ensuing context menu.)

The Storage tree is scoped at the institution level, but as with the other trees only collection objects

for the current collection will be shown when right-clicking on the node and choosing Associated

Collection Objects from the context menu.

The default permissions that Specify ships with allow Guest users to View the trees, but not modify

them in any way. All other users can use trees in their entirety.

Specify Tree Terminology
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The various Trees show relationships in a hierarchical structure. All hierarchies are referred

to as ranks. All nodes immediately under a rank are referred to as children. Any node with

a child is referred to as a parent.

Ranks are shown in columns on the tree. tree column colors can be set in Preferences >

Tree. See also Preferences.

Building Ranks

Each tree is visualy displayed as heirarchical levels. The Levels must first be defined in a

tree definition, then nodes can be added. Levels are defined through the use of either the

Specify Setup Wizard and the Add a Discipline Wizard. Levels are edited, enforced in the

Tree Definition tool. The full name is also configured in the tree definition tool.

Building Trees

All Trees can be defined and loaded into Specify through either the Specify Setup Wizard

or the Add a Discipline Wizard. Data in these trees include:

• Converted Taxon authority files for each of the Disciplines from the Catalog of Life.

• Converted Geographic authority files from online website of the World Gazetteer,

which includes Continent, Country, and States throughout the world as well as County

data for the United States.

• Chronostratigraphy authority files for five ranks in the North American System as

converted from the Geological Society of America.

• Four predefined ranks for Lithostratigraphy.

• Ranks for the Storage tree.

Users who do not wish to build their trees through a Specify Wizard may build their own

trees in the following ways:

• Manually by adding one record at a time. This will be necessary for the Storage tree,

as it is unique to each Institution and Collection.

• Dynamically from an existing user database. This may include a conversion from

Specify 5 or other type of database, which the Specify team can help with, or a data

import through the WorkBench.

• Dynamically by downloading and importing an authority file from an authority source.
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Using Trees

Trees are available through a tree button on the task bar. The task bar is configurable in

Preferences. Users that do not have the tree button included on their task bar can add it by

clicking Edit > Preferences > Task Bar on Windows, or Specify > Preferences > Task Bar

on the Mac, then checking the Trees box.

Tree and Task Bar preferences are only available to users with permission to use the trees.

Click Trees on the task bar to open the tree tool. Trees are grouped by their task on the

side bar.

View Tree lists the Trees available to view. Click on a tree to open it in View

mode in the work space.

Edit Tree lists the Trees available for the collection. Click a tree to open it in the

work space.

Open Tree Definition lists the Definitions for each tree. This tool defines the

ranks available in a tree as well as with how these ranks are enforced in data entry

and used in aggregating the full name. Before adding nodes to an empty tree, the

tree Definition must be completed. Please refer to Tree Definitions.

Unlock a Tree is only available to users with appropriate permission.

Simultaneous editing of a tree or tree definition and the corresponding form is also not

permitted by a single user. Multiple users can edit tree data in a form but a tree, or tree

definition, and corresponding form may not be open at the same time. Trees are available

for viewing, searching or querying simultaneously, but not editing. A second user may only

edit a tree or tree definition after the first user closes their tree.

If your project requires multiple users to add data to a Geography, Taxon, Storage,

Lithostratigraphy or Chronostratigraphy table, they will need to use the related form.

When a tree is being edited by a user (A) and another user (B) opens the tree, a prompt will

notify user (B) that the tree is in use by user (A) and will open in View mode. Then the tree

will open to view.

When a tree Definition is open and the same user opens the corresponding tree, the tree

Definition does not need to be closed, the tree will display in the tree tab. The Definition is

not available to View and those without editing privileges may not access it.

Specify Help - Trees in Specify

170 / 391



In the event that a tree becomes locked and the user of that tree can not be located, (which

may occur due to improper shutdowns of the application, or someone leaving their desk

without closing a tree), the tree can be unlocked, by clicking it under the 'Unlock a Tree'

heading if you have the necessary permissions. This action will remove the original user

from the tree.

Tree Tools

Expand a Node

Click the (expand) icon to expand nodes on the tree.

Expand a Tree Column

1. Mouse over the header column until a crossbar appears.

2. Right-click and drag to expand the column.

Toolbar Buttons

Button Definition Result

Move Column Left Shifts the entire tree to the left, closing the

highest rank.

Move Column Right Shifts the entire tree to the right, opening the

highest rank.

Select Parent Walks up the tree selecting the parent node.

Split Screen Creates two simultaneous mirror images of the

tree. This allows different sections of the tree to

be viewed and edited, which is useful when trees
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are large. Changes made to one of the Trees will

be updated in the second tree.

Single Screen Reverts the tree display to a single screen.

Edit Node Opens a form for editing the node.

Add Child Opens a form for adding a child to the selected

parent.

Delete Child Deletes the child. The table below shows the

instances in which nodes may not be deleted.

Sync Split Screens Syncs the split screen views to display the same

section of the tree on each screen.

Nodes on specific trees can only be deleted if the following trees are not used in

the specified ways:

Tree Use

Taxon • not used in a Determination.

• not included in a Taxon citation.

• not a parent node of a Hybrid.

• not a preferred name of a Synonym.

• not a parent Node.

Geography • not used in a Locality.

• not a preferred name of a Synonym.

• not a parent Node.

Storage • not used in a Preparation.

• not a preferred name of a Synonym.

• not a parent Node.
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Chronostratigraphy • not used in a Paleo Context.

• not a preferred name of a Synonym.

• not a parent Node.

Lithostratigraphy • not used in a Paleo Context.

• not a preferred name of a Synonym.

• not a parent Node.

If deletions are required, the condition or conditions preventing the

deletion must first be eliminated. For example, open the related

Collection Object record and delete the determination before deleting

the tree node.

It is important to remember that the Institution tree is shared by all

collections in an Institution and all other trees are shared by all

collections within a single Discipline. Nodes that are not being used by

your collection may have associations in other collections and therefore

can not be deleted.

Note: Any edits/additions to large trees may take several

minutes to save.

Dragging and Dropping to Move, Synonymize or Merge nodes in a Tree

Nodes can be dragged and dropped onto other nodes within a tree. When the screen is split,

nodes can be dragged and dropped within the same screen or into the opposite screen.

While dragging a node a highlight box will appear around any nodes that can accept the

node being dragged (the hightlight will appear when the node being dragged is over the top

of the accepting node). Dragging and dropping is used to:

Move a node (and its child nodes) to a new parent. This is useful when a data entry error

has occurred, or a new node has been introduced while uploading from the WorkBench.
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Nodes may be moved between ranks, but enforced ranks may not be skipped. Moves may

only occur when a node Does Not have any children.

Synonymize the node (in the Geography and Taxon trees only). The node that is dragged

and dropped becomes a synonym of the accepting, or target node. The target node is then

the Preferred node. Changes in taxon are reelected in fields in the Determinations table.

Collection object determinations are captured in the Taxon and Preferred Taxon fields.

When a taxon is not a synonymy these fields will both refer to the same taxon (A). If taxon

(A) becomes a synonymy of taxon (B) the Taxon field will still reflect Taxon (A) but the

Preferred Taxon will change to Taxon (B).

Child nodes can not be added to a synonymized node and, in the same instance, parent

nodes can not be synonymized unless their child nodes are first synonymized.

In the Taxon tree, nodes at the species level and below can be synonymized within and

between ranks, but any node higher than species can only be synonymized within the same

rank. In other words, a family level node may only be synonymized to another family level

node.

Synonyms are differentiated from non-synonyms by their text color. Synonym text color

can be set in Preferences. Synonyms also show as a tool tip on the node. Tool tips are

displayed by holding the mouse over a rank.

To undo a synonymy, right-click on the node, then click Undo Synonymy in the resulting

Context Menu.

Note: When taxa are synonymized in the Taxon tree, the Preferred Taxon field on

the determination form is updated.

Merge parts of the tree. This is typically performed to correct parts of the tree that are

duplicated. For instance; if the country of the United States of America were entered as

both United States and US and both included a large number of children, a correction would

require many moves. In version 6.3 and newer a Tree Merge function has been added to

allow users to combine all the child information and choose the accepted form of a parent.

The children of the node being dragged (unwanted node) will merge with those included in

the node being targeted (remaining node) and the unwanted node will dissappear. For

example, if in the example above the United States included the states of Kansas and South

Dakota and the US included the states of California and Hawaii and the user dragged the

US node and droppped it onto the United States node the tree will have only the United

States as a country (parent) with the states (children) California, Hawaii, Kansas and South

Dakota. If both nodes contain Kansas with various counties these will be combined into a

single node and all counties accumulated or merged as required.
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Once the node is dropped onto the accepting node a dialog will appear asking if the user

would like to perform the appropriate task; i.e. synonymize the node (when applicable),

move the node (when applicable) or merge the node and children (when applicable).

Select Cancel on the dialog to place the node back in its original position.

Collection Object Counts

Counts of collection objects associated with each node can be enabled for all trees. This

feature requires data processing and therefore is not enabled by default. Enable Collection

Object Counts on a tree by choosing Preferences > Tree. See also Preferences.

Counts are displayed next to the Node as two numbers (X,Y):

• X represents the number of Collection Objects for the Node only.

• Y represents the number of Collection Objects for the Rank and all nodes beneath it.

The last node on the tree will only show the X value, as there are no nodes beneath it.

More Options (Context Menu)

A right-mouse click on the node offers the following choices:

Option Result

Move columns left Shifts the entire tree to the left, closing the highest rank.

Find Next Finds the next usage of the exact name. For instance, Johnson

may be used as the name of a county in different states. This

would find the next 'Johnson' in the Geography tree.

Edit ... (View) Opens the taxon form for the node. When editing the tree, the

Edit option will appear, when viewing the tree, the View

option will appear.

Delete Deletes the node. See the table above for deletion

requirements.
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Add Child Opens a form for adding a child.

Undo Synonymy Restores the node as a preferred taxon name. This is only

available on the Geography and Taxon trees.

Associated Collection
Objects

Opens any associated Collection Objects in Collection Object

forms for the active collection only.

Lifemapper Opens the Lifemapper tool with all the specimens for the

current species included on an interactive map. For more

information please refer to the Lifemapper documentation.

Find

Click Cntl + F to open the Find tool (which opens under the tree Workspace). This is

particularly useful to expand the tree to the end Nodes.

Button Result

Find Searches for the search term.

Next Searches for the next use of the search term.

Searches the upper tree.

Searches the lower tree.

Searches both trees.

Exact Checking this box will allow Specify to search the exact search term as

entered. Specify by default uses a wildcard at the end of a search term.

Checking this box will terminate the wildcard and search only the term as

entered into the search text box.

The arrow icons refer to the view that is appropriate for the search when using a split

screen. When using a single screen simply use the (Upper) button.
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Find and select a node by typing a few letters in a single term, or a single term, into the

Find text box and clicking the Find button. Full taxon names are not accepted, so enter a

name from a single rank, such as genus.

By default, Specify places a wildcard at the end of a search term. Specify will also

recognize an astrisk (*) as a wildcard when typing a search term when typed in front of, or

in the middle of each search term. For instance, Joh*n could be used to search for Johnson

County in the Geography tree.

Click the Next button to find the next usage of the term in the tree. For instance, if Johnson

is the name of a county in different states, typing the term in the find text box and clicking

the Find button will find the first instance of Johnson in the tree. Clicking the Find button a

second time will find the next instance of 'Johnson' in the Geography tree.

Editing a Tree Definition

The Tree Definition tool defines the levels, or ranks available in a tree as well as how these ranks are

enforced during data entry, and used in aggregating the full name. Tree Definition tools are available

for each of the trees. Nodes can not be added to a tree unless the rank isincluded in the tree definition.

The Tree Definition is configured during both the Specify Setup Wizard and the Discipline Wizard

that is run when a Discipline is added. The Tree Definition can be edited from within Specify as well.

Click the Trees button on the task bar, then select a tree from the side bar list under Open Tree

Definition.

The resulting window displays a hierarchical list of included Ranks in a grid view.

A tree and corresponding form may not be open at the same time. If either a tree or form is open, the

other will only be available in view mode. For example, if user A is editing the Taxon tree, user B

will not be allowed to edit a Taxon form.

Also, a tree and tree definition representing the same table can not be open at the same time. If the

tree definition is open and the tree is selected the tree will replace the tree definition in the same tab,

therefore closing the tree definition. The tree definition is not available to View and those without

editing privileges may not access it.

Edit a Tree Title
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Click on the (edit) button next to the tree title to edit the title of the tree. This is also the

name that will be given to the first node in the tree.

Edit / Add / Delete Ranks

Buttons for editing ( ), and adding ( ), deleting ( ) ranks are located at the bottom right

of the Workspace window.

Select a rank, then either double click to edit the rank or select edit or add to open the Rank

Properties dialog. New ranks will be added below the selected rank; therefore, select the

parent of the rank you wish to add.

• Name refers to the name of the rank used internally by Specify but not visible to the

user.

• Title is the name of the rank displayed to the user in the tree, queries and reports.

• Remarks allows remarks to be entered regarding the rank.

• In Full Name will use the rank when displaying the full name for any associated

Collection Objects (which appears in the Taxon Full Name field of the taxon table).

The Full Name is also displayed in the Preferred Taxon field on the Determinations

form and is useful when running queries and reports when the full name is desired.

• Enforced ensures that the Rank can not be skipped when attaching children.

Click the delete button to delete a rank. Ranks may NOT be deleted if nodes are associated

with them. It is important to remember that the Institution tree is shared by all collections in

an institution and all other trees are shared by all collections within a single Discipline.

Ranks that are not being used by your collection may have associated nodes in other

collections and therefore can not be deleted.

Once the change is saved the tree will update. If the tree is extremely large, this may take

several minutes.

Update Trees

Any time a tree is edited it is also updated within the database. If this process is interrupted,

the tree will need to update when Specify re-launches. A prompt will appear notifying the

user that the tree is updating. A manual update can also be performed by clicking System >

Trees > Update (tree type) Tree.
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Predefined Ranks

Taxon, Chronostratigraphy, Geography and Lithostratigraphy include predefined ranks for

the tree definitions. The Geography, Chronostratigraphy and Lithostratigraphy predefined

ranks are also active within the tree definition. The Taxon tree includes many ranks that are

not active and are offered via a Predefined Ranks dialog when adding a Rank. If the list

does not include the desired Rank, one can be added by clicking the Custom button and

naming the rank in the ensuing Edit Rank Properties dialog.

If predefined ranks are deleted from the tree definition, they will be added back into the

Predefined Ranks list in the dialog.

Whenever possible, it is highly recommended that users choose a predefined rank rather

than create a custom rank.

There is a limit to the number of custom ranks available between each predefined rank.

When custom ranks can no longer be added between the predefined ranks, the status bar

message Unable to assign Rank will appear.

Note: Ranks must be defined in the tree definition before they can be entered as

nodes in either a tree or form. For example, the city of Lawrence can not be added

under Douglas County in a Geography tree if the tree definition does not include

a rank for City.

Searching Data

Specify 6 has two search functions for searching fields as well as related data:

1. Simple Search enables quick searches on pre-indexed fields within Specify.

2. Query is a more traditionally structured database search that will dredge anything out of the

database with complete precision to your exacting specification.

Queries can be used to create reports in SpecifyiReport then opened in Specify and either viewed in

the work space or printed.

Simple Search
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Simple Searches have been pre-configured in Specify 6 from pre-indexed fields. The purpose of the

Simple Search is to eliminate the need to create a complex Query for commonly executed searches.

Simple Search is not the Express Search tool found in Specify 5. The tables in Simple Search do not

need to be rebuilt in order to function, and Simple Search offers a broader range of fields and table

configurations. Simple Search also does not offer the same grid view as was available in Express

Search.

Simple Search can be configured to use the minimum number of fields needed for a search, which

will produce faster results.

Simple Search can also be configured to show results from indexed fields in other tables, or Related

Searches. For example, a search for an Agent name can display the name in the Agent table, as well

as all Determinations owned by that agent in the Determinations table. At this time the Related

Searches are already built into Specify and can only be activated or deactivated.

To configure a more complicated search and choose from all the fields in Specify 6 use the Query

tool. Please refer to Query.

Simple Search can be used by all users but can only be configured by users in a Full Access, Manager

or Administrator group. Full Access users can add or modify, but not delete.

Note: Simple Search results work best when a wild card, or asterisk, (*), is used.

Using Simple Search

Simple Search is located in the upper right corner of Specify 6. Click the (down arrow) to display a

menu of available tables. For information about adding tables to the menu and configuring

preferences refer to Configure Simple Search.

Execute a Simple Search:

1. Either leave as All or choose a specific table from the drop down menu. All will search

all the tables that have been configured in Simple Search Configuration. Choosing one

table from the list will search that table first and then all related tables.

2. Type in either one or two words as search criteria.

3. Press the Return key.
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Simple Search Wild Cards

More than one term can be used in a search specification, but the results will vary

depending on the use of wild cards and delimiters. For example, if the search

string is Clinton Lake, Simple Search results will include records which have

either Clinton OR Lake in any search field. Records which contain the phrase

Clinton Lake in one field will also be found.

A wild cards and delimiter can be used in Simple Search criteria. An asterisk, (*),

used as a wild card allows the criteria to be found as part of a string. Single or

double quote, (' or "), delimiters allow two or more words to be searched as a

string rather than separate criteria. The wild card and delimiter can also be used

together to further limit the search.

*Clinton Returns any string with Clinton at the end.

Clinton* Returns any string that begins with Clinton.

*Clinton* Returns any string that includes Clinton anywhere in the string.

*Clinton Lake* Returns any string that begins with Lake or ends with Clinton.

"Clinton Lake" or 'Clinton

Lake'

Returns any string where Clinton Lake is the entire string.

*"Clinton Lake"* or

*'Clinton Lake'*

Returns any string that includes Clinton Lake anywhere in the

string.

Criteria Notes:

Numbers are searched in both the number and string fields in the

configured tables.

When the criteria is a 4-digit number between 1000 and 3000 and date

fields are included in the search configuration, Simple Search will

search the year portion of all the date fields.

When searching for a loan that uses a number scheme that includes a

date plus a number, e.g. (2003-001), enter 2003* for the search criteria

to find all 2003 results.
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Results are completely affected by the Simple Search Configuration. If

results are not as expected, check the configuration and make sure the

desired fields are included in the Simple Search Configuration.

Simple Search Results

Results from the chosen primary table are designated with a blue ( ) header bar

Results from related tables are designated with an aqua ( ) header bar

Results can be viewed by clicking the (Expand) button or double clicking the header bar.

Results are displayed as a Grid.

Click on the title bar at the top of the column to sort the column. Dates should be in a

MM/dd/yyyy format to sort correctly.

Using Simple Search Results

Choose one, several or all the records using the methods below, then click a button from the

results bar.

• Click a record to select a singe record.

• Cntl (PC) or Command (Mac) Click to select or deselect several non-consecutive

individual records.

• Click the Select All/Deselect All button at the bottom of the results list to select all

records.

• If no records are selected, all records will be used.

Button Result

Create a Record Set from the selected records.

Displays associated attachments as thumbnails in an Attachment

Tool tab in Specify. Information about the attachment and associated

record is also available in the attachment tool.
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Open records;

• To open a specific result record, first choose the record then

click on the button.

• To open select records, select them by Command + Click (for

Mac) or Ctrl + Click (for PC) each record, then clicking on the

button.

• To open all the records, select the button without choosing a

specific record.

Print the results Grid.

Export the grid to MS Excel.

Display a report from the returned records. This button only displays

if reports are available for the type of query that was searched.

Clicking the button will result in a dialog listing all available reports

for the query type. Choose a report from the resulting list for the

report to display in Specify.

Search results can also be used to add records to an existing Record Set.

Click the (Record Set) button at the bottom of the results window. The Choose a Record Set

dialog will appear:

• Select a Record Set name in the list and click the OK button to add the selected records to the

existing Record Set.

• Click the New button to create a new Record Set

• Click Cancel to close the dialog.

Or, select the records for the (Record Set) button to enable, then drag the button to an existing

record set on the side bar to add the records to the existing record set. The existing record set and the

new records must be from the same table to be compatible. As the button is dragged toward the side

bar any existing record sets that can accept the new records will display a colored band.

Configure Simple Search

Simple Search can be configured to use the minimum number of fields needed for a search, which

will produce faster results.
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Simple Search can also be configured to show results from indexed fields in other tables, or Related

Searches. For example, a search for an Agent name can display the name in the Agent table, as well

as all Determinations owned by that agent in the Determinations table. At this time the related

searches are already built into Specify and can only be activated or deactivated.

Click the (down arrow) button in the Search box and choose Simple Search Configuration from

the drop-down menu to open the Simple Search Configuration dialog. The default permissions that

Specify ships with do not allow Guest users to configure Simple Search.

The Simple Search Configuration dialog houses three separate tools; Search Fields, Related Searches

and Results Ordering. All are accessible through tabs at the top of the dialog window.

Configuring Search Fields

The Search Fields tab enables fields within tables to be selected or deselected for both searches and

display results. The Search Fields tool is divided into 4 sections.

• Available Tables provides a list of available tables for Simple Search. Click a table to display

available fields in both the Search Fields and Display Fields window.

• Search Fields offers fields available to be searched. Choose fields by checking the box.

Uncheck the box to remove the field from the search. Sorting determines whether the selected

field will be sorted in results. Available options are Ascending, Descending or None (default).

The ordering of fields may have a bearing on the sort order if more than one field is selected to

be sorted.

• Click the or (reorder keys) to move a selected field up or down in the ordered list.

• Display Fields offers fields to be included in the results of the Simple Search, but not searched.

• Fields To Be Searched provides the full list of the fields to be included, (and their associated

table icon), in the Simple Search. This list will update as new fields and tables are chosen. To

remove an entire table from the list, all fields must be deselected in the Search Fields section of

the editor.

Configuring Related Searches

The Related Searches tab enables various fields that are related to the Search Fields to be selected as

part of the search configuration. The Related Searches tool is divided into 3 sections.

• Related Searches lists the related tables available for Simple Search.

• Check or uncheck the Activate check box to add/remove the table to the Simple Search

configuration.
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• A Description text box gives a description of the relationships between the related primary

tables.

For optimal Simple Search performance, configure Simple Search to search only the fields that are

needed.

Configuring Results Ordering

The Results Ordering tab allows the primary and related tables to be ordered.

• Choose a Search field.

• Click the or arrow to move the selected table up or down in the list. This determines the

order on the Simple Search results page.

Query Builder

One of the benefits and goals of entering data into the Specify database is to be able to retrieve the

data in an organized manner. Specify's Query builder offers a flexible interface for defining and

running searches. Queries are a precise request for information retrieval and can restrict the type of

returned records based on the contents of almost any of Specify's data fields.

These queries can then be used to create Record Sets or Reports.

Open the query builder by clicking the (Query button) on the Taskbar.

The side bar displays a list of frequently used tables to begin the query configuration. Less common

tables are found by clicking (More Tables) in the side bar and choosing a table from the pop-up

dialog.

A Query Creators Configuration tool gives access to less frequently used tables and also allows the

side bar and More Tables lists to be interchanged and rearranged:

Choose Tabs > Configure side bar from the Menu bar or right-button-click an open section

of the side bar to activate the Context Menu and choose Configure Query Creators to open

the Configure New Queries dialog.

• Use the or (reorder) button to change the order in which the forms appear in the

side bar and More Forms list.

• Use the or (move) button to move a side bar item to the Extra Forms list and vise

versa.
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• Click the (add) button for a list of additional forms that can be moved into either the

side bar or More Forms list.

• Click the (delete) button to remove forms from either the side bar or More Forms

list; this will put them back into the master list.

Note: deleting a table from either the side bar or More Tables will place it back in

the master list which is accessed by the (add) button.

A Configure Saved Queries tool allows saved queries to be rearranged on the side bar. Choose Tabs

> Configure side bar from the Menu bar or right-button-click an open section of the side bar to

activate the Context Menu.

Choose Configure Queries to open the Configure Queries dialog.

• Use the or (reorder) buttons to change the order in which the forms appear in the

side bar and More Forms list.

• Use the or (move) buttons to move a saved query from the Favorite Queries side

bar list to the Other Queries list and visa versa.

Choose a table from the side bar list to begin building the query.

Note: Because of the way Specify combines related information, almost every

field can be found from within most tables. This will determine the data elements

to be returned i.e. searching from Collection Objects (CO) will return CO records.

Choose Fields

A list of fields available in the chosen table, as well as other related tables, appears in a list

box at the top of the query work space.

To display fields in other tables, simply click a table in the list box. Fields and other related

tables display in a new list box.
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Choose fields and/or tables for the query from within the appropriate list boxes by either

selecting the field/table and clicking the (add) button or double clicking on the

table/field.

By selecting fields to include in the search users can restrict the type of returned records

based on the contents of almost any of Specify's 2500 data fields.

There is no limit on the number of fields added to a query, but larger, more complex queries

will take a longer amount of time to run.

Specify 6 does not include default fields in a query as was found in Specify 5. For a column

to appear in the results it must first be represented by a field in the query. Users who wish

to always see a particular set of columns in their query results are encouraged to create a

query with those fields and save the query. When creating a future query, simply click on

the saved query first, then add to it to create the new query.

Specify 6 offers a grid view of results only.

Note: The Query Builder tool includes extra fields for Cataloged Date; Cataloged

Date (Day), Cataloged Date (Month) and Cataloged Date (Year). This allows

users to easily search for a specific Cataloged day, month or year.

Choose Tables

Select a related table to be part of the search criteria by double clicking it in the list box.

Tables are either formatted or aggregated, depending on their relationship to the primary

Table and do not offer any other search criteria. Most tables in Specify have a default

format and aggregate setting. Formats and aggregates can be edited, created or deleted in

System > Schema Configuration.

Many-to-One (Formatted Data)

A many-to-one relationship involves a primary and related table in which many primary

records are linked to a single related record in the related table. For example, many

Collection Object records might be linked to the same Locality record because they were all

found at the same location.

Tables with a many-to-one relationship are designated by an ( ). Tables with many-to-one

relationships are formatted to be represented by at least one field. Most tables are

represented by only one field, (Collection Object shows the Catalog Number), but some are
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best represented by more than one field (Agent may be formatted to display last name, first

name, middle initial). Query results use this format when returning results.

One-to-Many (Aggregated Data)

A one-to-many relationship involves a primary and related table in which many related

records are linked to a single primary record in the related table. For example, several

Collection Object records would be linked to a single record in the Collection Event table

because all those specimens were collected during the same event.

Tables with a one-to-many relationship are designated by an icon ( ) and return aggregated

data. For example, a Collection Object can have many Preparations. The results of a query

of Collection Objects with Preparations will return Preparations aggregated together in one

column, separated by colons or semi colons.

When returning aggregated data, it is possible that a field may first be formatted.

Query Expressions

Create Query Expressions to narrow the results.

Query Expression Box

Note: Not all fields include Criteria. For instance, a Check Box does not have

searchable Criteria and needs only an Operator.

Heading Choices Result
Available for
Field Type

Not Switches the operator into its opposite.

(example not =)

All

Operator Finds all contents for which the selected

field is Yes, No or Empty.
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= Finds records for which the selected

field is equal to the specified criterion.

Number, Date,

Text

> Finds all records for which the selected

field is greater than the specified

criterion.

Number, Date

< Finds all records for which the selected

field is less than the specified criterion.

Number, Date

> = Finds all records for which the selected

field is greater than or equal to the

specified criterion.

Number, Date

< = Finds all records for which the selected

field is less than or equal to the specified

criterion.

Number, Date

Between Finds all records for which the selected

field is between the specified criterion.

Number, Date

In Finds all records for which the selected

field is included in the list of criteria.

(example criteria; Northern, North, No.

or 32, 35, 36, 39)

Number, Text

Like Allows a wildcard character (*). Finds

all records for which the selected field

matches the specified pattern expression.

(example; *ist)

Text

Contains Finds all records for which the selected

field contains a specified character

sequence.

Text

Empty It is important to note that Empty is a

Condition and not the same as a

Condition left blank. A Condition that is

left blank will be included in the results

but not in the search. A Condition that is

set to Empty will only return records that

Number, Check

Box, Text
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contain an empty field.

True The field is a Boolean (Check Box) and

is True.

Check Box

False The field is a Boolean (Check Box) and

is False.

Check Box

Criterion Criteria are entered into this box. If the

operator is 'Between' two boxes will

display to enter both criteria.

Date, Number,

Text

Sort Allows the results to be sorted.

It is often useful to sort duplicate data so

that results are easier to read and the

information may be grouped on a report.

For example, if a report is desired that

lists Collection Objects according to

their Taxon Name then the query must

be created with the Taxon Name sorted

and then grouped in the Report.

All

Do not sort.

Sort in descending order.

Sort in ascending order. See above.

Show Includes the field in the results. All

Prompt This will provide a 'prompt' dialog

which allows the query expression to be

customized each time a Report is run on

the query.

All

Always Includes the query Condition when

running a Report by dropping a Record

Set onto it (in the Report side bar). If

'Always' is not checked then the

All
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resulting Report will include all record

ID's rather than only those matching the

query Condition. This is particularly

useful when searching Prep Types and

Current Determinations.

Delete the expression from the query.

When editing a Saved query any

expressions used in a report may not be

deleted.

All

Using Wild Cards

The operator Like allows a search to be restricted to a specific pattern of letters or symbols

or both in a designated field. The wildcard character is an asterisk (*).

*Clinton Returns any string with Clinton at the end.

Clinton* Returns any string that begins with Clinton.

*Clinton* Returns any string that includes Clinton

anywhere in the string.

When it is necessary to use an asterisk (*) as part of the literal search criteria, precede it

with a "\". For example; when it is desired to find Cli*nton enter the search criteria as

*Cli\*nton*.

Other Controls

The order of the condition row determines the order in which fields will be sorted as well as

the arrangement of the fields in the results panel. If a query includes both Taxon Name and

the Last Name of the Collector and both are sorted but Taxon Name is ordered first, Specify

will sort Taxon Name first, then Last Name of the Collector.
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Side Buttons Function Result

Reorder Down Move the field down in order. The

order determines how they will

display in the results window.

Reorder Up Move the field up in order. The

order determines how they will

display in the results window.

Bottom Controls Result

Search Synonyms
(checkbox)

Includes synonyms in the query and query

results.

Distinct (checkbox) Returns unique results only (no duplicates).

When the Distinct button is used in a query, the

query can not be used to create record sets, view

results in data entry forms, or run reports.

When both Distinct and Sort are used in a Query

the database may need to create its own Sort

priorities due to the way that MySQL retrieves

data.

Count (checkbox) Gives a count of the results in a pop up dialog in

the query work space only. No results will

display when the Count feature is in use.

Search (button) Engages the query. Pressing the Enter key will

also engage the query.

Save / Save As
(toggle button)

Click the Save button to save the query as the

same name or click the (toggle) button to

choose Save As and rename the query. Saved

queries appear in the side bar and can be reused.
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Editing a Query

Click on a saved query in the side bar to display it in the workspace window. Expressions

can be edited using the controls above. Expressions that are used in a report may not be

deleted.

Using Query Results

Query results are limited to 20,000 records. A return count can include more records, but

Specify can not display more than 20,000 result records. Use the Count checkbox if only a

count of results is desired, or break a query into sections if it is too large.

Query results display as a grid in a query Results window. They are designated by a green (

) results bar.

Click on the title bar at the top of the column to sort the column. Dates should be in a

MM/dd/yyyy format to sort correctly.

Results can be manipulated and utilized in various ways using the buttons on the results bar.

Button Result

Create a Record Set from the selected records.

Displays associated attachments as thumbnails in an Attachment

Tool tab in Specify. Information about the attachment and associated

record is also available in the attachment tool.

Open records;

• To open a specific result record, first choose the record then

click on the button.

• To open select records, select them by Command + Click (for

Mac) or Ctrl + Click (for PC) each record, then clicking on the

button.

• To open all the records, select the button without choosing a

specific record.
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Print the results Grid.

Export the grid to MS Excel.

Display a report from the returned records. This button only displays

if reports are available for the type of query that was searched.

Clicking the button will result in a dialog listing all available reports

for the query type. Choose a report from the list for the report to

display in Specify.

Note: Individual records opened from the query results will open in View mode.

To edit the records click the (Edit) button.

Query results can also be used to add records to an existing Record Set.

Click the (Record Set) button at the bottom of the results window. The Choose a Record

Set dialog will appear:

• Select a record set name in the list and click the OK button to add the selected records

to the existing record set.

• Click the New button to create a new record set

• Click Cancel to close the dialog.

Or, select the records for the (Record Set) button to enable, then drag the button to an

existing record set on the side bar to add the records to the existing record set. The existing

record set and the new records must be from the same table to be compatible. As the button

is dragged toward the side bar, any existing record sets that can accept the new records will

display a colored band.

Saved Query Menu

Right-button-Click on the side bar to open the Query Context Menu:

Menu Option Result
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Configure Query
Creators

Opens a Configuration tool for adding, removing or reordering

the primary tables in either the side bar or More Tables lists. This

is explained Query Creators Configuration.

Configure Queries Opens a Configuration tool for including the saved Queries in

either the side bar or Other Queries lists. This configuration tool

is explained in Configure Queries.

Import Queries Opens a file directory to find the query in the local file system.

Export Queries Opens a save dialog to save the query in a location on the local

file system.

The configure tools can also be accessed by choosing Tabs > Configure side bar from the

Menu bar.

Import / Export Queries

Queries are imported and exported as a group of queries contained in a file. Even when only

one query is being exported, Specify writes the query to a file.

The exported query file will be saved as an xml file.

Import

1. Right-button-Click in the side bar, then choose Import Queries in the context menu.

2. Choose the file from the resulting file menu dialog

3. Choose the queries to import from the resulting dialog list (of queries contained in the

import file).

Note: When importing queries that have the same name as existing queries,

Specify will simply add a number (2) to the import query name.

Export
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To export a query:

1. Right-button-Click in the side bar, then choose Export Queries in the context menu.

2. Choose the queries to export from the resulting dialog list and click the Save button.

3. Name the file and choose a storage location for the file in the resulting file menu

dialog, then click the Save button.

Delete a Query

Queries can be deleted by dragging and dropping them onto the Trash Can in the side bar.

A prompt will ask the user if they are sure they want to delete the Query.

Queries that are used in Reports may not be deleted.

Query Examples

Higher Level Taxonomic Searches

A special table of fields has been added to the schema to allow for the construction of a

query that returns a list of nodes included in a particular level of a tree or a unique list of

nodes currently used in a collection. This is available for the taxon, geography, storage,

lithostratigraphy and chronostratigraphy tables/trees.

Taxonomic Rank Query Example

The query is shown above. The steps for creating the query include:

1. Select either the taxon table for a list of nodes for a level of the tree or collection

object table for a list of all unique nodes associated with a collection.
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If you wish to include all items in a rank (independant of whether they are used by

objects in your collection), choose the Name field from the taxon table.

If you wish to only include items used in your collection, then select the approporiate

rank field from the taxon table within determinations.

2. Select Taxonomic Rank > Name and add it to the query.

3. Type the level you wish to query in the Criteria text box.

4. Uncheck the Show box.

5. Click the Sort box to sort the results in ascending order (if required).

6. Check the Distinct box at the bottom of the work space if you wish to produce a

unique list.

7. Click the Search button.

Record Sets

Both Simple Search and Query may return groups of records. These returns can be named and saved

as a Record Set, by clicking the (Record Set) button in the results bar.

The default permissions that Specify ships with allow Guest users to View the record sets, but not

modify, add or delete them. All other users can use record sets in their entirety.

Creating a Record Set

Record sets are created from the records in a results window of a Query or Simple Search.

From within the results window:

• Click a single record, then click the (Record Set) button to create a record set with a

single record.

• Command (for Mac) or Cntl (for PC) + click several records, then click the (Record

Set) button to create a record set that includes the selected records.

• Click the (Record Set) button without selecting any records, (or click the Select All

button at the bottom of the results,) to create a record set from all the records.

Adding records to a Record Set
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Drop a record set onto another record set to merge them. Any duplicate records will be

automatically removed.

Records can be added to a record set by selecting them from a results window and clicking

the (Record Set) button at the bottom of the results. The Choose a Record Set dialog will

appear:

• Select a record set name in the list and click the OK button to add the selected records

to the existing record set.

• Click the New button to create a new record set

• Click Cancel to close the dialog.

Or, select the records to enable the (Record Set) button, then drag the button to an

existing record set on the side bar to add the records to the existing record set. The existing

record set and the new records must be from the same table to be compatible. As the button

is dragged toward the side bar any existing record sets that can accept the new records will

display a colored band.

New record sets can also be created by selecting one or multiple records within a record set

and clicking the (Record Set) button from the results bar at the top of the results work

space.

Using Record Sets

Record sets can also be dragged and dropped on other side bar items. Slightly drag the

record set within the side bar, and any form, Interaction or Plugin that can accept the record

set, will display a colored outline. When the record set has been dragged to the correct spot

over the side bar item a triangle will appear within the outline. Items that can accept a

record set will vary depending on the record set type. For example:

• In Data Entry the record set type must match the form type to open the records. For

example, a Collecting Event record set dropped on the Collecting Event side bar

button will open a Collecting Event form that includes all the records in the record set.

The records can then be stepped through using the navigation control at the bottom of

the form.

• In Interactions a Collection Object record set can be dropped on a Loan, Gift or

Information Request. This will activate a dialog for choosing Prep Types from the

record set to include in the Loan, Gift or Information Request.
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• In Plugins a Locality record set can be dropped on GEOLocate to georeference the

records, or on Google Earth to plot the records on a map.

Record Set Context Menu

Right-button-click on a record set to perform the following functions:

• Rename activates a text field for the record set name in the side bar. Type the new

name into the text field, then type the Return key to deactivate the text field.

• Delete will delete the record set and remove it from the side bar.

• View opens a new results window listing the records in the set. The record set view

will not be a duplicate of the original search results window, but is meant to provide a

list of the records in the record set. The results window status bar offers additional

functionality.

Button Function

Create a new record set by selecting records and clicking the Record

Set button.

Open records in form view.

Export the grid to MS Excel.

Print the results Grid.

Records can also be selected within the window and added to another record set by clicking

the (Record Set) button at the bottom of the results window and choosing a record set

from the resulting dialog or dragging the (Record Set) button and dropping it on the

desired record set in the side bar.

Export a Record Set
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New in version 6.3 of Specify, users may now export a record set through the WorkBench.

The record set will export as an Excel spreadsheet. Exporting a record set is a three-step

process:

• Create a mapping for the record set/data set or identifying a mapping to reuse

• Create a data set from a record set

• Export the data set

The export is performed in the Specify WorkBench. To open the WorkBench click on the

(WorkBench) button.

Before a record set can be converted to a data set, a mapping must exist. If a data set

already exists with the same fields required by the record set you may skip this step and go

to Create a Data Set from Record Set. If a data set with a duplicate mapping does not exist,

then a mapping must be created by creating a data set.

Create a Mapping/Data Set

1. Click the New Data Set button on the side bar.

A mapping 'maps' the tables and fields from the Specify schema to the columns they

will occupy in the data set. A Help page for creating a mapping can be found in the

New Data Set documentation.

Once the Data Set mapping has been created and saved as a data set, it will appear on

the side bar.

Create a Data Set from a Record Set

1. Click the Create Data Set from Record Set button

2. Choose a record set from the dialog and click the OK button

The next dialog lists the available data sets.

1. Choose the data set/mapping that you require.

2. Click the OK button.

In the next dialog name the new data set.
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Note: When the data set opens the validation for invalid fields will be turned on.

If the data set contains catalog number they will be marked as invalid and

highlighted in red because Specify recognizes them as duplicates. The validation

can be turned off by unchecking the Highlight Invalid Cells checkbox in the

validation panel at the bottom of the work space.

Validation Panel

Note: The mapping of a data set that was created from a record set may not be

edited.

Export the Data Set

Now you may export the data set by clicking the Export Data Set button. A

Help page for exporting a data set can be found in the Export Data Set

documentation.

Reports and Labels

Specify has utilized the power of iReport 3.0, an open source report writing software package, by

changing the original iReport version to interact with Queries created in Specify 6 and the Specify 6

database. The resulting application is called SpecifyiReport.

The following documentation discusses the Report components on the reports side bar and assumes

that reports have already been created using SpecifyiReport. To access these click the Reports

button on the task bar.

When reports are created they can be saved at either a User or Discipline level, limiting access to the

User only or making the report available to all Collections within the Discipline. Reports can also be

exported and reimported at a different level, thus granting a greater access and use of the report.

Please refer to Importing and Exporting Resources for more information.
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The permissions for Report includes SpecifyiReport. The default permissions that Specify ships with

allow Guest users to View the reports, but not modify, add or delete them. All other users can use

forms in their entirety.

Side Bar Items

It is important to note that the distinction between reports and labels in Specify 6 is purely an

organizational function allowing users to list these items separately on the Sidebar. Reports and labels

are created in exactly the same way in iReports and run and print the same from within Specify.

Actions

Run Report also refers to labels and invoices.

• Drag a report, label or invoice and drop it on this button or click the button

to open a dialog and choose a report/label/invoice from the resulting dialog,

or drag a record set onto a report/label/invoice in the side bar.

• If the Prompt box was selected in the report query a dialog will open

allowing the query expressions to be edited before running the report.

• The report will display in the Workspace. A tool bar at the top of the

Workspace offers buttons for saving, printing and view.

A. Save the report to disk. This will offer a file system dialog to choose the path for saving

the report. Several file formats are offered for saving the report, but a PDF is recommended.

Reports can be saved as:

• PDF (.pdf); this file format has the best output.

• RTF (.rtf); this format is typically read in a text viewer.

• ODT (.odt)

• HTML (.html); this will view on a web site, but depending on the layout of the report a

PDF may provide a better display of the report.

• Single Sheets MS Excel (.xls)

• Multiple Sheets MS Excel (.xls)
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• CSV (.csv)

• XML (.xml)

• Jasper Reports (.jrprint); this is an intermediate file format created by iReport.

• Embedded XML Images (.jrpxm); this format is created by iReport.

B. Print

C. Refresh is sometimes necessary when resizing the report view.

D. Navigation Controls for jumping to the first page, going back one page, going forward

one page and jumping to the last page.

E. Page Number displays the page number and allows users to type a page number into the

field and press the return key to view the desired page.

F. Actual size

G. Fit Length

H. Fit Width

I. Zoom In

J. Zoom Out

K. Zoom Ratio displays the ratio of the display compared to the actual size of the page. This

is a drop-down menu as well as a number field. Simply click on the arrow and choose a

zoom ratio from the list, or type the desired ratio into the number field and press the return

key.

Refresh

Reports created in SpecifyiReport are saved in the database and will not

automatically appear on the Reports side bar. Click the Refresh button

to add recently saved reports to the side bar.

Reports
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Saved Reports are listed under this heading.

• Click on a report, then select to either run the report on a Record Set or first

run the query then run the report with the results from the resulting dialog.

• Drag and drop a record set onto a report to run it.

• Drag and drop a report on a record set to run the report.

Labels

Reports can be saved as Reports, Labels, or Invoices. Labels are listed under this

heading. Specify also provides a basic label report.

• Click on a label, then select to either run the report on a record set or first

run the query then run the report with the results from the resulting dialog.

• Drag and drop a record set onto a label to run it.

• Drag and drop a report on a record set to run the label report.

Record Sets

Reports can be executed by dragging and dropping a record set onto the name of

the report in the side bar. Reports that can accept a record set will include a

colored outline. An arrow will also appear within the outline when the record set

can be dropped onto the report.

Reports and labels can also dragged and dropped onto a record set to execute the

report/label.

SpecifyiReport

A report is used to present the results of a Query in an attractive and reader-friendly arrangement,

either on paper or on screen as a report preview.

Specify harnesses the power of iReport 3.0, an open source report writing software package, by

modifying the original iReport version to interact with Queries created in Specify 6 and data supplied

from the Specify 6 database. Once within SpecifyiReport, the interface is identical to that of iReport.
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For in-depth documentation we recommend the book The Definitive Guide to iReport, which is

available from Amazon.

The following documentation is meant to explain how to bring a Specify Query into the Specify 6

version of iReport, then create a simple report.

The Specify staff also provide limited report-writing services for all Specify users with an ISA. To

benefit from their expertise please contact them at specify@ku.edu.

SpecifyiReport ships with Specify but is a separate application and must be launched separately from

Specify. SpecifyiReport is located in the Specify application bin directory, which stores the

executable files for Specify. Double click the SpecifyiReport executable to launch SpecifyiReport. As

with Specify, you will be prompted for login information. In a multiple collection scenario you will

also be prompted for the collection in which you would like to create the Report.

Reports can also be written directly in MySQL and then imported into Specify using the Resource

Import/Export tool. The Report needs to include this Report Query "where" clause: "where

co.collectionobjectid $P!{itemnum} . Also include a parameter named "itemnum".

Reports are viewed and printed from within Specify. SpecifyiReports does not include a preview.

However, users can have both Specify and SpecifyiReport open at the same time and switch between

the two to preview the report or changes being made in Specify. You will need to click the Refresh

button in the Specify Reports sidebar for changes to be updated. For information on printing reports

from within Specify, see Reports.

Creating a Report from a Query

Reports are generated by report definitions, which in turn are based on Specify Queries.

Therefore, the first step in creating a Report is to create and save a Query within Specify.

When constructing the query, remember that checking the Prompt box for a query field will

ensure the option to change the criteria for the field before running a report.

Report Components

The following text is meant to familiarize the user with the basic components of

SpecifyiReport and will lead the user through the set-up wizard, adding conditions and

saving the report.
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Choose File > Report Wizard from within SpecifyiReport and choose a saved query to

associate with the report.

A Report Properties dialog will appear allowing for basic report set-up.

Report Name is the name that will appear associated with the report in the

Specify side bar. Ensure that you name the report appropriately according to its

function for optimal use.

Page Size designates the area assigned to the report. Choose a predefined size or

create a custom size.

Page Margin delineates the non-printing margins around the page.

Columns can be used to create multiple labels per page or columns of data

Scriptlet Classes are Java classes that can be used to execute special events

during printing. Users that are familiar with Java can include custom scriptlets in

this tab.

More includes choices for printing title, summary, column footer, pagination,

print order and how to handle no data.

i18n allows special Java classes, bundles and encoding to be implemented for

printing formatted fields, internationalizing a report and saving source files.

Report Bands

Once the preliminary set-up is complete, an empty report template will appear.

iReport separates reports into sections, or bands. Data is then printed according to

the band definition. For example, a title is printed once, but detail is repeated for

every record. Bands can be resized by holding the mouse on the separator line

until cross hairs appear, then clicking and dragging the line. Bands can also be

removed if not needed by dragging the lower edge of the band onto the upper

edge (thereby making its height zero).

Report Band Description

title Only created once in the report and can be its own page.
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page header Appears on all pages (except title and summary pages that are included as

their own page) in the same position.

column header Printed at the beginning of each detail column.

detail Corresponds to every record that feeds the report.

column footer Appears at the end of every column.

page footer Appears on every page that includes a page header.

last page footer Creates a unique footer for the last page.

summary Allows fields to be inserted for ending statements such as total

calculations or means.

Text can be added to the report by clicking the (static text) button in the Tool

Bar, then clicking and dragging a box in the desired band. These are handy for

creating captions, titles, headers and footers. Lines, shapes, images and barcodes

can also be added using buttons on the tool bar. Simply mouse-over a button for a

tool tip displaying its function. These elements are added as static text fields.

Once in a band, fields can be moved by dragging with the mouse or using the Ctrl

and arrow keys while fields can be resized by pulling any of the edge or corner

handles of an object. Objects can also be manipulated by using the Top, Left,

Height and Width commands in the common section of the Properties pane (see

below).

Report Panes

Menus on the side and bottom of the Workspace in iReport are called Panes. It is

helpful to have three main panes open: Document Structure, Properties and

Library. These can be opened/closed in View > Docking Panes. Any item within

these panes can be dragged and dropped into a band. When the item is dropped

into a band, the expression that represents it is displayed in a Text Field.

Right-button-click on an object within the panes to display a context menu with

choices for Edit, Add, Move, Cut, Copy, Paste, Delete, Add a Group and Refresh.
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Note: Objects within the panes can also be manipulated via a grid by choosing

View > (Fields, Parameters or Variables).

Document Structure pane

The Document Structure typically opens on the left side and is

organized into 3 sections:

• Parameters are the programmatic values created by Specify to

print reports from SpecifyReport.

• Fields lists the fields in the Query available for inclusion in the

report.

• Drag and drop a field into the detail band for inclusion in the

report. The field will display as a 'textField' in the report structure.

This refers to the data, or text, that will occupy the field when the

report is run. Do not add or delete text inside a text field.

The size of the field can be changed by clicking on the field to

produce an outline, then grabbing one of the boxes on the outline

and dragging it.

Change the font or font size for the field data in the Properties

pane, or by clicking on it to select it and using the font list box and

font size list box in the Tool Bar located at the top of

SpecifyiReport.

SpecifyiReports are created from Queries and limited to the fields

included in the query. Although it is possible to click the (text

field) button and add a text field with an expression, it will not be

recognized when running the report in Specify.

• Variables lists the elements included in each band along with their

horizontal and vertical position on the page.

Cut, Copy, Delete and rearrange the order of elements in these panes by

right-clicking on them and choosing the appropriate item in the

resulting context menu.

Properties pane

Objects from the Document Structure that are placed into bands display

their properties in this window. The Properties pane includes three

sections:
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• Common lists properties for the band such as size, background

color, and printing expressions.

• Text/Graphic offers properties for the text or graphic as well as

line spacing.

• The third section is object specific (Barcode for barcodes, Image

for images) and includes some useful expressions. An expressions

is a combination of variables, constants, and functions linked by

operation symbols. It may be easier to think of an expression as a

formula within a report. Expressions are edited using an

Expression Editor which can be opened by clicking the ... button

next to expression in the list.

The properties pane also includes some useful pre-programmed

expressions for text.

• Stretch with Overflow to ensure that long records print correctly

without losing text. The field will increase in size based on its

contents. This however has implications for closely situated fields

as they may be overwritten or overlap.

• Blank when null will not print the word 'null' for blank records in a

report.

Library (sometimes referred to in other documentation as the Object Library)

The library window contains a set of default stored procedures useful to

perform common tasks such as Page Number, Total Pages, Page X of

Y, Total, Current Date and Percentage.

Task Examples

Combining Fields, or creating a concatenated string, is often useful in a report.

1. Add the first field in the concatenated string to the proper band (by dragging and

dropping) and keep it active (a colored box will appear around the field).

2. In the Properties pane scroll down to the Text Field section. Find Expression in the list.

Click the ellipses (...) button on the right hand side.

3. The Expression Editor will appear. The original field will be included in the top

window as an expression. There are 3 boxes under the window, make sure the first box
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has Fields selected and find the next field in the second box and double click to add it

to the top window.

4. Each combination of fields requires a linking argument in the following format: + "x "

+ where x is the text string required to link the two fields. 'x' can also be omitted if no

linking text is require i.e. + "" +

Note: Typing (+ " " +) between two field expression in this dialog will include

whatever text is between quotation marks to appear on the report.

Report Groups

Groups allow users to structure the records in a report to better organize the

content. A group is defined by an expression and a new group is started when the

results of the expression change. A group will only function if the results of a

query have been sorted correctly. SpecifyiReport reads the data and 'groups'

similar data together as they are ordered. The report can then be structured based

on the content of the report.

1. Click View > Report Groups to open the Group editor.

2. Click the New button and give the group a Name in the box provided by the

Add/Edit dialog.

3. In the Group Expression window click the Edit button. Click that button to

open the Expression Editor.

4. Click Field in the bottom left panel and double click the desired field in the

list (displayed in the middle panel). The field name should appear in the

expression window. Click the Apply button.

5. The field should now show in the Group Expression window of the Add/Edit

dialog.

6. Designating a field as a Group allows choices for each data grouping:

7. • Start A New Column will place each data group in its own column.

• Start A New Page will put a page break at the end of each data group.

• Reset Page Number starts each data group at page 1.

8. Print Header on Each Page prints the group header on each page.

Creating a Group will add a Group band and Group Footer band to the report.
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Including Barcodes

When creating or editing a report in SpecifyiReport it is often necessary to include a

barcode. Includes a barcode in a string field of a report by following these steps:

1. Click the (barcode) button on the tool bar.

2. Click and drag an outline for the barcode field in the detail band of the report.

3. In the Properties pane, click the ... button for the Barcode exp. (at the bottom of the

pane under Barcode).

4. The Barcode Expression Editor dialog will appear.

5. Delete anything that appears in the top box.

6. Click Fields in the bottom left pane.

7. Double click on the appropriate field in the middle box. It should appear in the top

box.

8. Click the Apply button.

SpecifyiReport supports the following barcodes:

2of7 Code128B EAN13 SCC14Shipping APCA

3of9 Code128C Global Trade Shipment Identifier UPC3

Bookland Code39 Int2of5 SSCC18 UPC4

Codabar Code39(extended) Monarch Std2of5 USPS
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Code128 EAN128 PDF417 UCC128

Saving a Report

Once a report is created to satisfaction, it can be saved by choosing File > Save. A Report

Properties dialog will appear:

1. Type a Name for the Report

2. Choose the Report Type:

• Report or Label are separate report types for purely organizational purposes.

Choosing Label will list the report under the Label heading on the reports side bar

and choosing Report will list the report under the Report heading.

• Invoice reports are listed under Reports in the reports side bar. These are

typically created to capture an interaction such as Loan, Gift or Borrow. Reports

created from a Loan query are made available when a Loan is saved by checking

the 'Print Invoice on Save' box on the Loan form.

3. Save For refers to level of access given to the report. Discipline will allow all

collections within the Discipline access to the report and User will limit the access to

the current User only.

4. Choose a Repeats variable:

• Once will create one report/label.

• Constant duplicates each record in the report/label and offers a number field for

selecting the number of times for the repeat.

Saved reports can be opened from within SpecifyiReport to view and edit by choosing File

> Open and selecting either the label or report from the list. It is important to remember

when editing a report that reports are created from Queries; therefore, new fields may not

be added to a report that are not present in the query. Fields may be removed.

Plugins

Specify 6 interfaces with the Google Earth and GEOLocate web services. Choose System > Plugins.

It is also possible to place a Plugins button on the Task Bar by choosing Specify > Preferences >

Taskbar for the Macintosh or Edit > Preferences > Taskbar for Windows and Linux, then checking

the Add Plugins checkbox.
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These web services can be launched by:

• Clicking the relevant icon in the side bar and choosing a Catalog Number or Record Set.

• Dragging and dropping a Collection Object, Locality or Collecting Event Record Set on the web

service icon from within the side bar. These Records Sets must include the Locality data listed

below for each service.

Plugins that can accept a Record Set display a colored outline as the Record Set is dragged within the

sidebar. An arrow will display within the outline when the Record Set can be dropped onto the

Plugin.

Specify is not responsible for the integrity or accuracy of any of the results of these web services.

Specify is integrated with these services as a service to the community. For more information about

these plugins, visit their web sites; GEOLocate or Google Earth.

Google Earth

The Google Earth Plugin is used as a means of visualizing Collection Object records from

Specify in Google Earth.

The full version of Google Earth 4.3 must be installed on the local machine for the Specify

Google Earth integration to work, not the Beta version. Go to earth.google.com for a free

download.

Specify plots locality records (or associated Collection Objects or Collecting Events) in

Google Earth based on latitude and longitude data provided in the locality fields. All

associated data is stored in a KML file which is launched within Google Earth upon

clicking the Google Earth icon on the sidebar, or by dropping a Record Set on Google Earth

from within the Plugins Sidebar.

Collection Object information is shown within the Google Earth information balloon.

Specify also allows the insertion of two web service links for genus and species within the

information balloon by configuring Google Earth with URLs to the web services in Specify

> Preferences > Tools.

Google Earth can also be launched from within a Locality form by clicking the Display

in Google Earth icon.

Locality data Requirements

• Latitude and Longitude
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Google Earth is also available for use in the WorkBench

GEOLocate

The GEOLocate project has created software and services for translating textual locality

descriptions associated with biodiversity collections data into geographic coordinates. It

uses a description of a Locality, together with geography fields, such as County, State and

Country, to find Latitude and Longitude coordinate values. This is referred to as

georeferencing.

The Specify and GEOLocate teams have collaborated to create a GEOLocate module inside

Specify. In Specify 6.4 and newer GEOLocate has been upgraded to plugin version 2.0.

Requirements for Georeferencing US localities:

Column Heading Data Needed

Locality Name Yes

Country Yes

State Yes

County No, but will improve results.

Note: County is required when including waterbody and highway

crossing in the GEOLocate search.

Latitude1 No

(this is a results column)

Longitude1 No

(this is a results column)

Requirements for Georeferencing localities outside of the US:

Column Heading Data Needed
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Locality Name Yes

Country Yes

Child Node of Country No, but will improve results.

Latitude1 No

(this is a results column)

Longitude1 No

(this is a results column)

Note: A complete list of acceptable countries is available on the GEOLocate

website.

Click on the side bar and select either Collection Objects or Record Sets to

send to the GEOLocate service. Or, drag and drop a Record Set onto on the

side bar.

A message will alert you to the status of the GEOLocate search requirements in regard to

your records.

GEOLocate Requirement Status
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Note: Latitude and Longitude values present in Specify records will be replaced

by those found in GEOLocate if GEOLocate results are accepted.

Once GEOLocate has finished processing another message will either display the

number of records for which GEOLocate returned results, or state that no results

were found.

View GEOLocate Results

Results will display in the GEOLocate Results Chooser tool.

GEOLocate

Locality Information displays the Locality Description, County, State and Country values

in your current Specify record.

Correction (Green) Marker Properties include the values for the most accurate result

among the GEOLocate results returned. These values are also displayed visually on a map.

GEOLocate results can be edited using either the Correction Marker Properties form or the

map elements. Changes made on the map are automatically recalculated and updated in the

corresponding fields on the form. Updated values in the Correction Marker Properties form

are represented in the corresponding map element.
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Note: As you move your mouse within the map the corresponding latituted and

longitude values display in the lower right corner under the map.

Position represents the Latitude and Longitude of the GEOLocate result, visually

depicted on the map as a green marker. These results can be edited.

Edit the Position using the Marker Properties form:

1. Type new values in the Latitude and/or Longitude box.

2. Click the Apply button to accept the changes and update the location of the

green marker on the map.

Edit the Position using the map:

1. Click on the green dot on the map and drag it to a new position. The latitude

and/or longitude values on the form will automatically update.

Uncertainty Radius represents the error due to the uncertainty of the locality

information provided. It is shown as a grey circle around the green point marker

on the map. The Uncertainty Radius can also be edited.

Note: At this time in Specify the Uncertainty Radius values are not

written in a Specify database field.

Edit the Uncertainty Radius using the Marker Properties form:

1. Click the Uncertainty Radius button. The text box will

change to accept numeric values, and a large arrow will

appear on the map next to the Uncertaintly Radius point.

2. Type a new numeric value into the box and click the

Apply button to accept the changed value in the

GEOLocate tool and update the Uncertainty Radius on

the map.

Note: If GEOLocate does not find an Uncertainty Radius, or

your User Preferences are not set to include Uncertainty

Radius, the text box will open ready to accept numerical

values and the Apply button will become available.

Edit the Uncertaintly Radius using the map:

Specify Help - Plugins

217 / 391



1. Click the Uncertainty Radius button. The box will

change to accept numeric values, and a large arrow will

appear on the map next to the Uncertaintly Radius point.

2. Click in the center of the arrow and drag to reset the

Uncertainty Radius on the map as well as the numeric

value in the form. As you move your mouse within the

map the corresponding Uncertainty Radius, and latituted

and longitude values display in the lower right corner

under the map.

Note: If GEOLocate does not find an Uncertainty Radius the

text box will open ready to accept numerical values and the

Apply button will be available. You must type a value into the

text box and click the Apply button before the arrow will

appear on the map.

Error Polygon is a polygon which encompasses the entire area of uncertainty.

Results which include an Error Polygon will display the vertex values in the form

and a red polygon on the map. Not all results include an Error Polygon. If the

results do include an Error Polygon the vertex values in the form must be cleared

by clicking the Clear Polygon button before the Error Polygon can be edited.

Note: At this time in Specify the Error Polygon values are not written in

a Specify database field.

Edit the Error Polygon using the Marker Properties form:

1. Click the Draw Polygon button. The box will change to accept numeric

values. Type in latitude and longitude values, separated by commas.

2. Click the Apply button to accept the values in the GEOLocate tool and draw

the polygon on the map.

Edit the Error Polygon using the map:

1. Click the Draw Polygon button. A blue circle will appear around your mouse

in the map area.

2. Left-click on the map to add a vertex point.

3. Continue adding points until the polygon is complete.

4. Double click on the last vertex point to finish the polygon and exit the draw

polygon mode. The vertex values will be updated in the form.
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OR, Right-click on the map to cancel the vertex and

exit the draw polygon mode.

Note: If there are vertex values included in the Error Polygon field the

values must be cleared by clicking the Clear Polygon button before new

values can be entered or drawn on the map.

GEOLocate Results displays the GEOLocate results in grid form. If multiple results are

returned they are numbered and sorted with the most accurate listed first. The active result

is highlighted in blue on the form. Other GEOLocate results are represented by red markers

on the map.

Click on either a record in the GEOLocate Results form or a red point on the map

to make it the current, or active result. The fields in the Correction Marker

Properties box will be filled in and the green marker will represent the current

result until you manually make corrections.

• Number represents the order of GEOLocate returns both in the form and in

a corresponding point on the map.

• Latitude represents the latitude to the hundredth degree.

• Longitude represents the longitude to the hundredth degree.

• Pattern, or pattern identifier, is a text description of the pattern or keyword

used to determine a GEOLocate result. Single locality strings often include

multiple patterns, producing multiple GEOLocate results.

• Precision is an indication of the quality of locality information. Each

GEOLocate result is given a score between 0 and 100 which represents the

probability of it being a match. That score is then placed within a 'low',

'medium' and 'high' ranking to indicate precision. Results are then ordered

according to their probability number, which allows results within the same

rank to include the most accurate matches first.

• Error Polygon is a polygon which encompasses the entire area of

uncertainty.

• Uncertainty represents the error due to the uncertainty of the locality

information provided.

Other Map Controls

Zoom In/Out
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Slide the slider down to zoom in, up to zoom out.

Click the button to zoom in, the button to zoom out.

Turn the wheel on your mouse up to zoom in, down to zoom down.

Double click to zoom in, right-click to zoom out.

GEOLocate Web Button

Click the button to open the web-based version of GEOLocate in your

default browser and plot the current result set on the map.

Other Buttons

Button Result

Help Opens the Specify Help Window

Accept Stores the latitude and longitude values in the appropriate cells of

the record.

Skip Ignores all results obtained for a given record, and displays the

results for the next record.

Done Accepts the currently selected row and closes the GEOLocate

Results Chooser dialog.

The dialog will close when all the records have been displayed. Results that were accepted

will be written in the Latitude 1 and Longitude 1 columns of the record. Any data already

in these columns will be overwritten.

More information about GEOLocate can be found at http://www.museum.tulane.edu/geolocate/.

Importing and Exporting Resources
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Both forms and reports can be exported and imported into Specify using the Importing and Exporting

Resources tool. Forms can be exported, changed in XML and then reimported back into Specify.

Reports can be exported then imported back into Specify at a different level. In this way reports can

be shared within an institution. This ability also allows both forms and reports to be consistent within

an entire community of collectors.

When editing a form in XML, pick lists and web links can be added. When the new forms are

imported back into Specify the pick list and/or web link will also need to be defined within Specify

using the Pick List Editor and Web Link Editor.

Note: Other resources can be exported in Specify using other tools. For information

regarding exporting a particular resource simply click it in the list below:

• Queries

• Record Sets

• Pick Lists

Import/Export Forms and Reports

At this time Specify 6 does not include a Form Editor, as was found in Specify 5. The forms have

been created to be flexible and can be exported as XML and either edited by on-site staff or emailed

to the Specify staff for assistance with form editing and customization. Forms are imported and

exported using the Resource Import/Export tool. Forms are exported as a set of forms, or form set,

and are imported back into Specify as a form set as well.

Reports can also be imported and exported through the use of the Resource Import/Export tool.

Reports are created from a query and export as a file that contains both the report and query. Reports

are typically exported so they may be shared with other users within the community.

Users that can program in MySQL can create their own report for inclusion in Specify 6. Create the

Report including this Report Query Where clause: "where co.collectionobjectid $P!{itemnum}, and

include a parameter named "itemnum".

Importing and exporting is based on the same levels that are found within the institution, with the

addition of a System level:

• System
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o Institution

- Division

- Discipline

- Collection

- Group

- Users

For each level the imported resource (form or report) is made available to other users at and below it.

This is based on the permissions for the person importing. Resources imported at the bottom (User)

level will be made available to the user only. At the User Type (Group) level the resource is

accessible to all users within the collection that are part of the same Group as the individual user.

Forms are named for the Table they represent. For instance, the Collection Object form is named

CollectionObject. As stated above, forms are imported and exported as a form set. When the Form tab

is active the window splits to show the name of the form set on the left and the individual forms that

are included in the set on the right. Imported forms will replace existing forms if they share the same

name. To add forms simply name the form set a unique name. Specify walks up the tree starting at the

User level when loading forms for display within Specify. In other words, if a CollectionObject form

is located at both the User level and the Discipline level, Specify will find and display only the User

level form.

Resources can not be imported or exported from the System level. It holds the set of resources that

Specify ships with and can be used to restore the resources if needed.

Choose System > Resource Import/Export to open the Import/Export tool. This Import/Export tool

(and menu) is only available to Administrators.

Import/Export Tool

You will receive a warning dialog informing you that the changes will require Specify to

shut down and restart.

You will then see this dialog:
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Choose a User

Changing Forms for Another User

If you wish to import forms for a single user other than yourself click the Different User

button. A dialog containing a list of users for the current division will be provided. If you

wish to import forms for a user in another division you must first Change Collections to a

collection in the desired division.

Changing Forms for Yourself

If you wish to change your forms click the My Resources button.

Resource Import/Export

Resource Import/Export Tool
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The Resource Import/Export tool will open.

A prompt at the top of the tool displays the name of the user chosen to receive the

imported form or report.

You must then choose the level at which you wish the resource to be imported

into and accessed by:

User - only the person displayed at the top of the tool.

User Type - entire group the user belongs to within the current

collection.

Collection - all users within the current collection.

Discipline - all users within the current discipline (including all

collections within the discipline).

Institution - all Specify users currently active in Specify.

A tab at the top of the tool allows the choice of importing/exporting either a Form

Set or Report.

Next, simply choose a Form Set/Report Resource from left pane and click the

Import button to import a resource.

Or; choose a Form Set/Report Resource from the right pane and click the Export

button to export a resource.

Revert

Revert will delete ALL files that have ever been imported. The Uploader tool remembers

the files that Specify shipped with at each level and reverts back to those files. If the

Uploader recognizes imported files the Revert button will become enabled.

Lifemapper
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Lifemappper is a biodiversity geospatial data modeling, visualization and analysis platform consisting

of multiple web services for systematics, biogeographical and macroecological research. Lifemapper

has been integrated into Specify to allow users to view their own specify distribution data as well as

compare their data to a GBIF/Lifemapper cache.

Click on the button on the Task Bar to launch Lifemapper.

Lifemapper Tool

Species Name searches the GBIF/Lifemapper cache and returns Species Names in Species Name box

located below the Species Name text box.

Enter at least the first three letters of a Species name in the Species Name text box and

press the Return key or click the Search button. Matching Species Names in

GBIF/Lifemapper will be displayed in the Species Name box. The number in parentheses

next to the species name indicates the number of occurrence points, or collection objects, in

the Lifemapper/GBIF cache.

Choose a name from the box. Lifemapper will add red markers on the maps representing

the GBIG/Lifemapper occurrence points, or Locality Descriptions, for the species. The

World Overview map offers an overview of all the occurrence points in the world. The

Interactive map zooms into a location that includes a high concentration of occurrence
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points. It is possible to move the zoom location of the interactive map by click and dragging

within the map.

Search My Data adds species occurrences in your Specify database to the Interactive map as green

markers by clicking the Show My Data button.

Type a new species name into the Search My Data textbox to replace the Specify species

occurrences on the Interactive map.

Using the Interactive Map

Turn the wheel on your mouse up to Zoom In.

Turn the wheel on your mouse down to Zoom Out.

Click and drag your mouse within the map to move the map North, South, East or West.

Launching Lifemapper from within the Taxon Tree

Lifemapper can also be launched from within the Taxon Tree.

Right-click on a Species node in the Taxon Tree to bring up a Context Menu and choose

Lifemapper from the menu.

Lifemapper will open with the specimens from that species in your current collection placed

on the map with a green marker.

Exporting Data for a Web Portal/Third Party

The 6.5 release of Specify facilitates the creation of a web portal by using the Apache Solr search

platform. Specify data can also be shared with third parties, such as GBIF, FIshnet, HarpNet, Mnis or

OBIS. Both instances of data sharing require two steps to create an index file. First, the schema of the

web portal/third party must be mapped to the Specify schema using the Schema Mapping Editor

Specify Help - Exporting Data for a Web Portal/Third Party

226 / 391



inside Specify. Next, the data file needs to be created and/or updated using the Data Exporter

stand-alone application (found in the bin directory within the Specify application directory).

Creating a Web Portal using exported Specify data and Solr

Specify 6.5 harnesses the search capabilities of Apache Solr to provide a full-featured web

interface for public access to specimen data and images.

Creating a web portal using Specify data and Solr requires several steps:

1. Apache Solr and a server must be installed on the computer that will be serving data to

the internet.

2. Create and Export a Schema Mapping file from within Specify.

3. Use the Data Exporter, a separate Specify tool, to create (build) an index of the data

and other configuration files.

4. Integrate the exported web portal files with Solr

Each of these steps is explained in a web portal document accessible on the Specify Project

website: specifysoftware.org.

Publishing Specify data through IPT

Specify takes advantage of the Global Biodiversity Information Facility's (GBIF) Integrated

Publishing Toolkit (IPT) to publish Specify data to the web. IPT is an open-source, Java

web application designed to publish biodiversity data on the Internet. The IPT creates an

HTML web site on your web server and starts a network service that publishes your

collection's data with the TAPIR data communications protocol. The third party web

publisher can then be notified of the existence of your IPT server to make first contact and

integrate your data into their cache. You will be assimilated. Specify no longer uses its own

web interface software nor the DiGIR protocol for serving XML encoded data. See

http://ipt.gbif.org for additional information regarding IPT.

Using the Integrated Publishing Toolkit to display and publish, Specify collection data

requires several steps.

1. Install Tomcat on the computer that will be serving data to the internet.

2. Map Specify data to a schema authority, such as Darwin Core, from inside Specify.

3. Use the Data Exporter, a separate Specify tool, to create (build) the data file for IPT.

4. Setup IPT to display Specify data.
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Each of these steps is explained in the pdf document, Publishing Specify Data with IPT,

found on the Specify website documentation page at

http://specifysoftware.org/content/documentation.

The current document explains how to define, or 'map', the Specify fields for data export. Please refer

to the Data Exporter page for documentation about generating the export data file.

Schema Mapping Tool

The Schema Mapper is a powerful tool for organizing data which need to be exported. The schema

mapping tool is used to create a query, referred to as a map, for exporting data from Specify to a web

publishing platform, i.e. GBIF, or a Specify Web Portal. When publishing to a third party, such as

GBIF, the map also creates relationships between the fields in Specify and the predefined field types

and column headings in required.

Open the Schema Mapping Tool by choosing System > Schema Mapper.

Two actions are available in the side bar:

• Create New Mapping

• Import Schema

Any existing mapping files are also listed on the side bar.

Import Schema

Schema refers to the many tables and fields that systematize the many dimensions and

relationships of the data within biological collections. When preparing data in Specify to be

published by a third party it is often necessary to use a predefined schema to ensure all

necessary data files are included in the data export.

Specify ships with the following schema file preloaded in the Specify/Config

directory:

• TDWG_DW_Core.xsd - Darwin Core 1.4 - draft standard under discussion

(used in GBIF, and recommended to use in GBIF)
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Note: earlier versions of Specify included other schema files that may

also be available in the Import Schema tool when upgrading to Specify

6.5.

1. If a schema other than Darwin Core is desired, it must first be downloaded (preferably

into the same Config directory) and saved into the file system as an .xsd definition

file.

Three examples of predefined schemas that require importing into

Specify are:

OBIS - http://www.iobis.org/obis/obis.xsd

PaleoPortal -

http://data.paleoportal.org/schema/conceptual/1.0/paleoportal.xsd

ABCD - http://rs.tdwg.org/abcd/2.06/ABCD_2.06.xsd

Note: Currently all schema mappings are assumed to be

specimen-based, i.e: the elements described in the

schema definition are assumed to refer to biological

specimens. This means the mapping is based on a

CollectionObject query by default.

2. Next, click Import Schema and choose the file from the resulting system dialog. The

schema will be added to the list of predefined schemas available when using the Create

New Mapping tool.

3. The imported schema requires a Title and Version. The two entries will be joined, or

concatenated, together and used to identify the schema mapping in the external tool.

The concatenation will also be used for the name of the database table which holds the

cache.

To delete a schema from the available list (and your Specify/Config directory) right-click in the side

bar (in an empty space), then choose Delete Schema in the resulting context menu. You may also

delete the file directly from your Specify/Config directory.

Create New Mapping

Mapping files can be created by either choosing to edit a predefined schema or by selecting the

desired fields from within Specify to create a custom mapping file.
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Click Create New Mapping on the side bar. The resulting dialog lists the available predefined

schemas and a no schema choice.

Create New Mapping from a Predefined Schema

Click Create New Mapping from the side bar, then choose a predefined schema from the

list. A mapping editor opens with a list of Specify fields in the top section and a list of data

types, referred to as Schema Concepts, in the bottom section.

Specify automatically matches a Schema Concept from the predefined schema to a field in

Specify.

Remap a term by simply clicking the list box ( ) and selecting a new schema

concept from the list. Only unmapped schema concepts are available from the list.

Add a term by selecting a field from the Specify list and clicking the button.

The Schema Concept will be defined as 'Not Mapped'. Choose a schema Concept

from the drop down list to map the new field.

Note: it is not necessary to include attachment fields in mappings,

attachments are automatically included in mapping files.

Delete a term by selecting it from the list and clicking the (remove field) button.

Query Expressions can be used to narrow the results. These function similarly to

the Query Builder. For additional help creating/editing query expressions please

refer to the Query Builder help page.
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Add Conditions to Eliminate Duplicate Records

IPT and Specify require that all uploaded records be unique. Due to the

one-to-many relationships contained in Specify databases it may be

necessary to add certain conditional fields to the schema to ensure this

e.g. adding the Determination Current field and setting it to Yes will

eliminate multiple determinations. One can also select a table to take

advantage of the formatted and aggregated value for that table e.g.

selecting the Collectors table will add all collectors on a single line.

Fields can also be added to eliminate certain records from the resulting

index.

Note: uncheck the Show checkbox to hide the schema concept in the

exported data cache.

Create New Mapping by choosing Specify Fields

Click Create New Mapping from the side bar, then click 'no schema' from the list. A

mapping editor opens with a list of Specify fields at the top of the work space. Fields are

mapped to a schema concept, which represents the name included in the exported data

cache. The schema concept can be edited by simply typing into the text box.

Add a term by selecting a field from the Specify list and clicking the button.

The schema concept will match the name of the Specify field and can be edited

by simply clicking in the text box and typing a new name for the term.

Note: it is not necessary to include attachment fields in mappings,

attachments are automatically included in mapping files.
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Delete a term by selecting it from the list and clicking the (remove field) button.

Remap a term by simply clicking in the schema concept text box and typing a

new name for the term.

Query Expressions can be used to narrow the results. These function similarly to

the Query Builder. For additional help creating/editing query expressions please

refer to the Query Builder help page.

Add Conditions to Eliminate Duplicate Records

IPT and Specify require that all uploaded records be unique. Due to the

one-to-many relationships contained in Specify databases it may be

necessary to add certain conditional fields to the schema to ensure this

e.g. adding the Determination Current field and setting it to Yes will

eliminate multiple determinations. One can also select a table to take

advantage of the formatted and aggregated value for that table e.g.

selecting the Collectors table will add all collectors on a single line.

Fields can also be added to eliminate certain records from the resulting

index.

Note: uncheck the Show checkbox to hide the schema concept in the

exported data cache.

Check a Schema Mapping

1. Click the Preview button in the lower right corner to display a 120 record sample of

the mapping in a query results display. If your data contains duplicate records, you will

be alerted and will need to correct this problem by adding conditions to the query

before continuing. Once successful, Specify will display a dialog message asking you

to use the external tool to export the data.

2. If all the mappings are correct, save the schema mapping by clicking the Save button.

Name the mapping in the reulting dialog. The mapping will be saved as an xml file.

The new mapping will be listed on the side bar.
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Edit a Schema Mapping

Click a mapping on the side bar to open it in the mapping editor. The schema concept in the

resulting editor will display differently dependent upon the way in which the mapping file

was created. Mapping files created from a predefined schema will include a list of all

availabe field types for the schema concept. Mapping files created by choosing fields within

Specify will include an editable text box for the schema concept.

Note: Whenever a schema mapping is edited, a full rebuild of its cache (in the separate

Schema Exporter tool) will be required.

Import/Export a Mapping

Import

1. Right-click in the side bar (in an empty space), then choose Import Mappings in the

resulting context menu.

2. Choose the file to import from the resulting file menu dialog

Note: When importing mappings that have the same name as existing queries,

Specify will simply add a number (2) to the import query name.

Export

1. Right-click in the side bar (in an empty space), then choose Export Mappings in the

resulting context menu.

2. If multiple mappings are available a dialog will appear to choose the desired mapping

to export.

3. Name the file and choose a storage location for the file in the resulting file menu

dialog, then click the Save button.

Delete a Mapping

Right-click on the side bar (in an empty space) then choose Delete Schema or drag and drop

a mapping onto the Trash Can in the side bar to delete it
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Note: Mappings that are deleted from within Specify will no longer be available

for data file updates in the Data Exporter tool.

To generate the Data file see the documentation page Data Exporter.

Data Exporter

The Data Exporter application is used to build, update and export data files for use by IPT or a web

portal. The term 'build' refers to the process Specify uses to load data into the skeleton, or schema, of

a database. Before a data file can be built, a 'schema map' must first be created using the Schema

Mapping Editor inside Specify. If you have not created a schema map you will need to close the Data

Exporter tool, reopen Specify and create the schema map using the Schema Mapper tool. For

documentation explaining how to create a schema map please refer to Web Publishing.

The Data Exporter tool actually creates a table, or cache, in the database containing all relevant data,

based on the map that was created from inside Specify. This table of data is then indexed and

exported, along with other relevant files, for use in a web portal. Or, the cache is exported as a tab

delimited text file for importing into IPT.

The Data Exporter application is located in the bin directory within the Specify application directory,

which stores the executable files for Specify. Double click DataExporter (or select it from

Start/Program Files/Specify on Windows) to launch the tool. Users are required to login using their

Specify Username and Password.

The Data Exporter application opens as a three column table with action buttons.
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Data Exporter Tool

• The Mapping column of the table indicates the name of both the mapping and table.

• The Last Update column lists the date and time of the last update of the cache.

• The Status column indicates whether the cache has ever been build, up to date, orout of date. If

the cache is out of date, it also indicates the number of rows which require updating. The number

of out of date rows includes the number of rows that have been deleted from the database, edited

in the database and added since the last update. This information reflects the database contents at

the time the exporter was launched; it will not reflect changes to the database that occur while

the exporter is running.

Available Actions

• Show SQL - Click this button for a mapping whose cache has been completed to generate a

dialog showing an SQL select statement that can be copied and used when defining database

connections to the cache for IPT or other data providers.

Note: the SQL is based on the current cache structure. If the cache needs to be rebuilt

and mappings have been changed, the SQL statement generated will not reflect the

changes until the cache is updated.

• Build/Update - This will update the cache. When the cache is built or updated it is writing to the

database; therefore, the username and password for the database is required before Specify can

complete the task.

For caches that do not need to be built, only out-of-date rows are updated. This is

significantly faster than an initial build which can take a long time. Updates are not

allowed for mappings that are being edited or updated by another user; therefore, users

should close all schema mappings before updating.

Note: building/updating the cache will require the IT (MySQL) Username and

Password.

• Export - This exports the current contents of the cache to a tab-delimited text file for IPT.

• Export for Web Portal - Files for Solr and the web portal will be generated and exported.

Cancelling an Operation - You can cancel an update or export by clicking the (close) button to

close the application window. You will be asked to confirm the cancellation. If you cancel, you will

need to start from the beginning the next time you perform the operation.
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Note: If you cancel an update that required a rebuild, the pre-existing cache will have been

deleted.

Stand-Alone Specify Applications

Several stand-alone applications have been created to perform specific tasks which integrate with

Specify.

Data Exporter is used to build, update and export data files for use by third parties.

Import File Splitter will spilt large MS Excel files into multiple files which contain 4000

records and can be imported into the WorkBench.

Specify Backup and Restore allows IT personnel to backup and restore a Specify database

to a MySQL location on a server or local disk.

Specify Database Security Wizard verifies the IT and Master credentials, fixes Master

privileges and allows a Master to be reset.

Specify iReport utilizes the power of iReport 3.0 for use with Specify queries.

Specify Setup Wizard walks you through the creation of a Specify database including the

insertion of a schema within MySQL, the creation of an administrative level Specify user,

and the initialization of the database structure.

Specify Setup Wizard

The Specify Setup Wizard is required to customize the necessary components in MySQL for

communication with Specify. It walks you through the creation of a database including; the insertion

of a schema within MySQL, the creation of an administrative level Specify user, and the initialization

of the database structure. It also allows you to download the start of Taxon and Geography authority

files.
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Before running the Specify 6.5 Setup Wizard to create a blank database for the full Specify

application, MySQL must be installed. MySQL must include an administrative (root) login account

with all MySQL permissions.

The Setup Wizard should NOT be run if a collection data already exists in Specify. It creates a new,

blank database and will permanently erase all existing data. The Wizard should only be run one time,

for the initial Specify installation and setup, then can be deleted from your computer. If Specify will

be installed on a network server and run on several computers, the Setup Wizard should only be used

to setup the database on the Network. DO NOT use the Setup Wizard on other computers, they only

need to have Specify installed.

Fields within the Wizard that must contain data before continuing to the next step in the Wizard are

displayed in bold font.

MySQL requirements for creating a Specify database and Master credentials using
the Specify Wizard

The first Wizard window creates a blank Specify database within MySQL and inserts the schema

(empty tables, fields and relationships) for the database. The second Wizard window creates a Specify

Master username and password. The Specify Wizard can NOT be used to perform these two tasks if:

I. The default data management engine for an existing MySQL installation is NOT InnoDB.

II. The Specify Setup will be on a dedicated server, or desktop computer accessed by other

desktops.

III. You wish to create your own database rather than use the Wizard to create the Specify database

and insert the schema.

I. The default data management engine for an existing MySQL installation is NOT InnoDB.

1. If your default MySQL engine is not InnoDB it can be changed using the guidelines

found on the Specify website at:

http://specifysoftware.org/content/changing-default-mysql-engine-innodb.

OR

If you are unable to change your default MySQL engine, you will need to create a

blank Specify database with MySQL's software tools and insert a Specify schema

before running the Specify Setup Wizard. The Specify team provides both an

explanation and script for performing these tasks from within MySQL on the Specify

website at: http://specifysoftware.org/content/creating-specify-database-within-mysql.

Note: The MySQL step-by-step installation guide, located on the Specify

web site, prompts users to designate InnoDB as the default data storage

engine. Institutions with legacy installations of MySQL may have originally
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configured their system for a different data engine and may not be able to

change the default storage engine to InnoDB; in this case, do not run the

Wizard you have created a black Specify database using MySQL software

tools and inserted a Specify schema.

2. Once a Specify database is created using the MySQL software tools and a schema

inserted by running the provided script, run the Specify Wizard to create other

necessary components of the database.

3. When running the Specify Wizard, rather than creating the database and inserting the

schema in the first Wizard window, you will verify that Specify can access your

existing database and schema in the Advanced section by clicking on the Test IT Login

button.

4. When accessing the database locally, the Wizard can be used to create the Specify

Master by clicking the Create Master User on the second Wizard window.

OR

When accessing the database remotely please follow the steps in procedure #2 below.

II. The Specify Setup will be on a dedicated server, or desktop computer accessed by other

desktops.

1. If the Specify database will be accessed by other 'client' computers you will first need

to manually create a Specify Master username and password in MySQL before

running the Specify Wizard. Instrucions for setting up the Specify Master username

and password in MySQL can be found on the Specify website at:

http://specifysoftware.org/content/specify-system-setup.

2. After reading the information on the website and creating the Specify Master username

and password in MySQL, run the Specify Wizard and enter the MySQL information

on the first Wizard screen and click the Create Specify Database button to create the

database and insert the schema (unless you have created a database using the MySQL

tools in procedure #1 above).

3. On the second Specify Wizard window enter the Specify Master credentials, then click

the Test Master Login button to verify that the Specify Master credentials were created

from within MySQL.

III. You wish to create your own database rather than use the Wizard to create the Specify

database and insert the schema.

1. If you wish to create your own Specify database and insert a schema from within

MySQL rather than using the Specify Wizard, the Specify team provides both an
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explanation and script for performing this task from within MySQL on the Specify

website at http://specifysoftware.org/content/creating-specify-database-within-mysql.

2. Once you have read the provided information and created your Specify database and

inserted the schema, run the Specify Wizard.

3. On the first Wizard window, rather than creating the database and inserting the

schema, verify that Specify can access your existing database and schema in the

Advanced section by clicking on the Test IT Login button.

4. When accessing the database locally, the Wizard can be used to create the Specify

Master by clicking the Create Master User on the second Wizard window.

OR

When accessing the database remotely, please follow the steps for #2 found above.

Running the Specify Setup Wizard

Database Information

Enter MySQL IT Username and Password

The first window allows you to either create a Specify database or verify that Specify can

access a database you have already created within MySQL. To create or verify a database,

you must first complete the following information:

• The IT Username and IT Password must be an existing account with full

administrator privileges in the MySQL database manager. This account will be used by

the Specify Setup Wizard to create your Specify database and a Specify Master

account (in the next window) in MySQL. If you do not know the IT administrator
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("root") account username and password for MySQL, or do not have a MySQL

installation, exit now. You can not go further without these.

• The Database Name will be used to name the database that the Setup Wizard is about

to create. If you do not have an existing database but are using the Wizard to create

one, you are creating this name as you type it into the window. Once you name the

database make sure to document it so you can reference it if you need it at a later date.

If you have an existing database you must enter the name of the database in this

text box so that the Wizard may verify that Specify can connect to the database

before continuing with the Wizard. If you are testing an existing database be sure

to click on the Test IT Login button to test the connection to your database.

• The Host Name is the name of the computer that is running MySQL. This is either an

IP Address or name of the computer that is recognized by the server. When running

MySQL on your local machine this is almost always 'localhost' or '127.0.0.1'.

Note: When using an IP Address make sure that the IP is 'static'.

• Database Structure Creation Only should not be checked unless you have received a

conversion database from the Specify team and specific instructions check this box.

• Create a Specify Database
When you click the Create Specify Database button Specify will connect to

MySQL using the information you have entered, create your Specify

database, and insert the Specify schema. If Specify can not connect to

MySQL and build the database for any reason a message will display. To

proceed in the Wizard you will need to verify that the information entered

and your MySQL setup are correct.

• Advanced: Test IT Login
If a Specify database exists withing MySQL you must verify it before

proceeding in the Wizard. Enter your database information, then click the

Test IT Login button in the Advanced section of the window. The Wizard

will verify that Specify can connect to your existing database. If Specify can

not connect to the existing database you may not proceed within the Wizard

using the existing database.

Specify Master Credentials
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Create a Master Username and Password

The security system for Specify 6 uses both a "Master" username and password, which

Specify uses to access the MySQL Database, as well as a User username and password,

which allows a user to run the Specify program. The Master account has SELECT,

INSERT, UPDATE, DELETE and TABLE LOCK privileges on data tables in your Specify

database only and has no other MySQL privileges. Specify uses only one Master username

and password for all users, but encrypts the Master password with the User information,

creating an encrypted string. This allows the Master information to become unique for each

user.

This window either creates the Master username and password for your Specify system, or

verifies that a Master username and password that has already been created within MySQL

is recognized by Specify. Any instance of Specify that does not access MySQL on the local

machine, (uses a remote server), must create the Master username and password using the

MySQL Admin. tool. Instructions for setting up the Specify Master username and password

in MySQL can be found on the Specify website at

http://specifysoftware.org/content/specify-system-setup.

When creating the Master username and password, the word "Master" or "Root" SHOULD

NOT BE USED. Please create a unique Master username and a secure, strong password for

it. This should not be the same as the username and password used for the MySQL IT

account in the previous window. This information should be remembered and secured by

the person installing MySQL and Specify at your institution. The Specify administrator, (a

role and account within Specify), will need the Master username and password to create

new user accounts in Specify.
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Also, the "Master" username and password should not be used as a Specify user account

name within Specify. Whichever username and password you choose for the Master

account, that username and password is never used to log in to Specify. This "Master"

username and password should ALWAYS be unique. Do not use this username and

password for any other accounts in MySQL or Specify.

Create the Master

When you click the Create Master User button Specify will take a moment to

create the Master account in the database. Once this account has been created you

may not change the information on this screen, or any previous screens.

Advanced: Test the Master

Click the Test Master Login button to verify that Specify can connect to the

Specify database using the existing master credentials that you have previously

created in the MySQL command line tool.

Security

Turn Security On/Off

Specify Security refers to the set of permissions and entitlements within Specify which

gives users the rights to see certain data and to use particular functions. If your Specify

database will never have more than one user, (you), then Security (i.e. permissions within

Specify), can be turned off. This will give you total access to all Specify program functions
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and data. Specify will not check your credentials or limit your access to data or Specify

components.

If you will be creating multiple users within Specify it is recommended that you turn

security on.

Security can be turned on or off inside the Specify application.

Manager

Create Specify Manager / Administrator

This account is the first Specify user account for your database, and is created at the level of

Manager, the highest level in the Specify permission model. The account usually represents

the primary user, or administrator, of your collection database. An Administrator account

will also be created within Specify using this information. It is this username and password

that will be used to log in to Specify for the first time, once this Setup Wizard is finished.

At that time additional users can be added within Specify.

Protect the username and make the password strong. This Specify manager level

information will also be used to create a record in the Specify database for an ‘Agent’

representing the same person.

Institution
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Create Institution and Enter Information

The Specify data management levels mimic the common levels of hierarchy within

institutions. Access to information and Specify tools are then set at the various levels both

within the application and through the User Permissions.

The Setup Wizard creates a single entry for each level of the hierarchy (Institution,

Division, Discipline and Collection). This setup window is the first step in that process.

Each of the screens for creating these levels must be completed before the Next button will

become enabled.

• The Name should be the formal name for your institution. It is a field within the

Specify database, is displayed on the Institution form, and can be queried and used in

reports.

• The Code is typically an acronym, codon, abbreviation or short name for your

institution (not your collection), if you don't know of one, put in a placeholder, this can

be edited at a later date. Institution codes are often required for web services such as

DiGIR/TAPIR.

• The Institution Address information, such as City, State, Country, Zip Code and

Phone Number, is also added to fields within the Specify database and displayed on

the Institution form and can be queried and used in reports.

Accessions
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Choose Accession Level

Accessioning is the formal process by which a specimen or object is legally accepted and

recorded as a museum item and differs from cataloging. Some museums and herbaria have

a formal accessioning process, some do not. If your institution does not use the concept of

accessions (typically handled by a registrar or administrative curator), then leave this item

unchecked and simply click the Next button to proceed to the next window.

For organizations that do recognize accessions, the process usually entails documenting

proof of ownership (in the form of a signed deed of gift), and that the material was legally

acquired (in the form of all associated permits - collecting, import and export). An

accession usually covers an entire field trip and multiple catalog items could be included

within a single accession. For the institutions that use it, accessioning and its associated

numbering system is usually set up as a standard museum-wide process, backed by policy.

The accession numbering scheme or sequence can either be recorded at an Institution level

for all collections (Globally) or at a Division level. The way to do this within Specify is

based on whether your institution has staff which manage all accession transactions for your

institution, like a Registrar, or if accessions and accession numbers will be managed and

assigned within one or more separate Divisions within the Institution. Again, if you do not

use accessions, this choice can be ignored. Assigning accessions to be managed "globally"

across the entire organization will ensure that accession numbers and records are unique

across all collections for the entire institution.

Note: If you choose to manage your accessions globally you will be presented

with the following window to choose a format. If you did not choose to manage
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your Accessions globally you will be presented with the window later in the

Wizard process when you create a Collection.

Accession Number Format

Create Accession Number Format

Accession Numbers may require a format or may simply use a number. Choose None to

leave the Accession Number as a text field on the Accession form. Accession Number

formats are not editable once data has been entered into this table in the database.

• Format offers several choices in the drop-down menu list:

None is the default setting, which is a 60 character string field.

Create allows you to create your own format. Choosing Create will open the

Field Formatting Editor. Click HERE for the Field Formatting Editor help

page.

Accession Number (2009-AA-###) The year will appear automatically in

the first section (2009) of the format, and can also be manually edited. The

'AA' section of the format is alphanumeric and accepts both characters a

through z and numbers. The ### section of the format is a number that is

automatically incremented when Auto Numbering is turned on in Specify

and manually entered when Auto Numbering is turned off. This format

offers two alphanumeric characters and three incremented numbers.

AccessionNumberByYear (2009-AA-AAA) The year will appear

automatically in the first section (2009) of the format, and can also be
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manually edited. The 'A' sections of the format are alphanumeric and accept

both characters a through z and numbers. This format offers two

alphanumeric sections, the first is two characters in length and the second is

three characters in length.

AccessionStringFormatter (AAAAAA) This is a single alphanumeric

format that accepts characters a through z and numbers. The Accession

number would be seven characters in length.

• Pattern displays the pattern used to create each format (these are explained in further

detail above).

• Is Auto Incremented displays a 'yes' if the format is automatically incremented.

Storage Tree

Configure the Storage Tree

Specify 6 visually presents some data types in hierarchical tree displays. These data types

include the Taxon, Geography, (Specimen) Storage, Chronostratigraphy and

Lithostratigraphy tables. Each tree is visualy displayed as heirarchical levels. The Levels

must first be defined in a tree definition, then nodes can be added. The Setup Wizard offers

a table for each of the trees (Chronostratigraphy and Lithostratigraphy for paleo collections

only) for creating tree definitions, or levels. These can also be edited at a later date from

within Specify.
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Nodes for the Storage tree can be added within the Specify application. The storage tree

operates at the Institution level and is available and visible to all Collections.

• The Level column displays the available levels. This name can be edited from within

Specify. Click the Include box to place the level in the tree. Therefore, it is important

to include the necessary levels for all collection.

• Include places the Level in the tree definition. Levels that are not included can not be

Enforced or added to the Full Name.

• Is Required is not editable, but an indication of the tree levels that are used by Specify

as a system requirement. These are automatically added to the tree and can not be

deleted on this screen or later from within Specify.

• Is Enforced ensures that the level can not be skipped when adding nodes at lower

levels down the tree. Levels that are Required by the system are also Enforced by the

system and can not be edited.

• Is in Full Name includes the level when building a full name expression, which can be

queried and used in reports. Create the full name by checking the desired boxes. This

is the string that will be displayed in the storage field in the preparation table.

At least one level for Full Name must be checked before the Next button will become

enabled.

• Separator refers to the character that separates the levels when displaying the full

name. This can be any single character, such as a comma (,) or a space. To make the

separator a space simply double click inside the column and delete the comma, then

press your spacebar once.

• Full Name Order will reverse the full name as shown in the Full Name Example.

Create Institution
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Create Institution and the Administrator

Click the Create Institution button to create your institution and add you as Administrator

in your Specify database. Once this information has been created you may not change it on

any of the previous screens and the Back button will become disabled.

The Institution must be created before the Next button will become enabled.

Division

Create a Division
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This window is used to create a single Division within your institutional hierarchy.

Additional divisions can be added later from within Specify.

• The Name will appear on the division form and can be queried and used in reports. A

division is used to collectively name similar collections e.g. the Division of

Peleontology may include Vertebrate Paleontology, Invertebrate Peleontology and

Peleobotany collections. The Name is a field within the Specify database and is

displayed on the Institution form. It can be edited, queried and used in reports.

• The Code can be a short name, acronym, codon or abbreviation. If your Division does

not have a Code, put in a placeholder, this can be edited at a later date. Division codes

are sometimes required for web services.

Discipline

Choose a Discipline Type

• Choose a taxonomic Discipline Type from the drop-down menu. Specify uses this information

to load the correct default data entry Forms, Trees and schema (tables and fields) based on the

predefined disciplines within Specify. If your discipline type does not appear in the list, choose

the closest discipline to yours based on taxonomic qualities.

• The Name is pre-filled with the discipline type name but can be any user specific variation of the

Discipline Type. It can be edited, queried and used in reports. Additional Disciplines can be

added from within Specify.

Taxon Tree
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Configure the Taxon Tree

This table will create the tree definition for the Taxon tree. The Taxon tree operates at the

Discipline level and will be used by all Collections within the Discipline you created in the

last window. Nodes to the Taxon tree can be added later from within Specify.

• The Level column displays the available levels. This name can be edited from within

Specify. Click the Include box to place the Level in the tree.

• Include places the Level in the tree definition. Levels that are not included can not be

Enforced or added to the Full Name.

• Is Required is not editable, but an indication of the tree Levels that are used by

Specify as a system requirement. These are automatically added to the tree and can not

be deleted on this screen or later.

• Is Enforced ensures that the Level can not be skipped when adding nodes lower down

the tree.

• Is in Full Name includes the level when building a full name expression for any

associated Collection Objects (which appears in the Taxon Full Name field of the

taxon table). The Full Name is also displayed in the Preferred Taxon field on the

Determinations form and is useful when running queries and reports when the full

name is desired. The full name generally includes at least the binomial Genus and

Species fields together with any levels below species (if used). Create the full name by

checking the desired boxes.

At least one level for Full Name must be checked before the Next button will become

enabled.
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• Separator refers to the character that separates the levels when displaying the full

name. This can be any single character, such as a comma (,) or a space. To make the

separator a space simply double click inside the column and delete the comma, then

press your spacebar one time.

• Full Name Order will reverse the full name as shown in the Full Name Example.

Taxon Authority File

Preload Taxon Records/Nodes

The Specify Wizard not only defines the Taxon tree but also allows pre-loading of an

authority file for the discipline you are creating. Authority files were created using data

from the Catalog of Life Project for some of the disciplines within Specify. If this window

does not appear, there are no existing authority files for your chosen discipline.

If you choose to load the data into your tree the Taxon tree will be populated with hundreds

of taxon nodes and all associated data. Then, when adding Collection Objects into your

database you can simply choose a taxon from the Taxon field rather than adding each

individually as needed.

Please note that loading the Taxon tree will also affect the tree definition. If you load the

provided Taxon authority file for your discipline the accompanying tree definition may

include Levels that were not defined by you in the previous window, but are necessary to

include all the predefined Taxon information.
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Additional discipline-specific trees can be loaded from within Specify at the time new

disciplines are created.

• Click the Choose button for a list of taxon files for the discipline you are creating. Not all

disciplines offer more than one taxon file. Once the taxon file is chosen, information will display

in the Source, Coverage and Description fields for that file.

Note: Botany and Entomology authority files represent partial trees due to the size of

these files. Contact Specify at specify@ku.edu for additional authority files.

• The Downloadable File section in this window allows you to choose taxon files from your hard

drive. The Setup Wizard can only install files that were downloaded from the Specify website.

The Specify team is currently in the process of creating more of these files.

Geography Tree

Configure and Load Geography Tree

The Geography tree operates at the Discipline level and is used by all Collections within the

Discipline. Nodes to the Geography tree can be added later in the Wizard as well as from

within Specify. The geography tree was created using data from Geonames.
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• The Level column displays the available levels. This name can be edited from within

Specify. Click the Include box to place the level in the tree.

• Include places the Level in the tree definition. Levels that are not included can not be

Enforced or added to the Full Name.

• Is Required is not editable, but an indication of the tree levels that are used by Specify

as a system requirement. These are automatically added to the tree and can not be

deleted on this screen or later.

• Is Enforced ensures that the level can not be skipped when adding nodes lower down

the tree.

• Is in Full Name includes the level when building a full name expression, which can be

queried and used in reports. Create the full name by checking the desired boxes.

At least one level for Full Name must be checked before the Next button will become

enabled.

• Separator refers to the character that separates the levels when displaying the full

name. This can be any single character, such as a comma (,) or a space. To make the

separator a space simply double click inside the column and delete the comma, then

press your spacebar one time.

• Full Name Order will reverse the full name as shown in the Full Name Example.

The Wizard will automatically load data for the Geography tree, including Continents,

Countries, and States throughout the world as well as Counties within the United States.

Data for the Geography tree was converted from the online website of the World Gazetteer.

Collection
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Create a Collection

Enter the Name and internationally recognized Collection Code to create a single

Collection within the Discipline. This is the name that will appear within Specify on the

Collection form and can be queried and used in reports.

The Code should be your standard collections community assigned code for your collection.

This Code will be used in data exports and web interfaces in upcoming releases of Specify.

Additional collections can be added from within Specify.

Catalog Number Format

Create a Catalog Number Format
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Specify is able to accept data for collection objects or observations without assigning a

Catalog Number. But when Catalog Numbers are used, they must be unique for each lot,

specimen or observation. Most collections routinely assign catalog numbers to incoming

materials, perhaps as part of the accessioning process. These numbers may require a format

with specific sections for data such as Institution Code and year or they may simply use an

incrementing number.

Catalog Numbers can either be unique to each Collection, shared by several collections or

be used throughout the Institution. The Catalog Number chosen at this time will not affect

where it is used relative to other collections, this will be configured from within the Specify

application. The Catalog Number format for this collection can not be edited once it is

chosen.

Several formats are available from the drop-down menu list:

• Format offers several choices in the drop-down menu list:

None is the default setting, which is a 60 character string field.

Create allows you to create your own format. Choosing Create will open the

Field Formatting Editor. Click HERE for the Field Formatting Editor help

page.

CatalogNumber (2009-######) The year will appear automatically in the

first section (2009) of the format, and can also be manually edited inside

Specify. The '###' section of the format is a number that is six digits in

length. This section can be automatically incremented when Auto

Numbering is turned on in Specify or manually entered when Auto

Numbering is turned off. These two sections are separated by a dash.

CatalogNumberAlphaNumByYear (2009-######) The year will appear

automatically in the first section (2009) of the format, and can also be

manually edited from within Specify. The '###' section of the format is a

number that is six digits in length. This section can be automatically

incremented when Auto Numbering is turned on in Specify or manually

entered when Auto Numbering is turned off. These two sections are

separated by a dash.

CatalogNumberNumeric (#########) This is a nine digit number that is

automatically incremented when Auto Numbering is turned on in Specify or

manually entered when Auto Numbering is turned off.

CatalogNumberString (XXXXXXXXXX) This is a ten digit string that can

include numbers, alphabet or characters

• Is Numeric will display a 'yes' if the format is numeric.

Specify Help - Specify Setup Wizard

256 / 391



• Pattern displays the pattern used to create each format (these are explained in further

detail above).

• Is Auto Incremented displays a 'yes' if the format is automatically incremented.

Collections that do not use one specific format for their Catalog Number may wish to

choose CatalogNumberString from the list, this will allow any format to be entered.

Accession Number Format

Create an Accession Number Format

Note: If you chose to manage your Accessions globally you will have already

chosen a format for your accession number and will not be presented with this

window again.

Accession Numbers may require a format or may simply use a number. Choose None to

leave the Accession Number as a text field on the Accession form. Accession Number

formats are not editable once data has been entered in the database.

• Format offers several choices in the drop-down menu list:

None is the default setting, which is a 60 character string field.
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Create allows you to create your own format. Choosing Create will open the

Field Formatting Editor. Click HERE for the Field Formatting Editor help

page.

Accession Number (2009-AA-###) The year will appear automatically in

the first section (2009) of the format, and can also be manually edited. The

'AA' section of the format is alphanumeric and accepts both characters a

through z and numbers. The ### section of the format is a number that is

automatically incremented when Auto Numbering is turned on in Specify

and manually entered when Auto Numbering is turned off. This format

offers two alphanumeric characters and three incremented numbers.

AccessionNumberByYear (2009-AA-AAA) The year will appear

automatically in the first section (2009) of the format, and can also be

manually edited. The 'A' sections of the format are alphanumeric and accept

both characters a through z and numbers. This format offers two

alphanumeric sections, the first is two characters in length and the second is

three characters in length.

AccessionStringFormatter (AAAAAA) This is a single alphanumeric

format that accepts characters a through z and numbers. The Accession

number would be seven characters in length.

• Pattern displays the pattern used to create each format (these are explained in further

detail above).

• Is Auto Incremented displays a 'yes' if the format is automatically incremented.

Summary
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Summary Window

Congratulations! You have finished the Specify Setup Wizard. This last screen displays all

the data that has been created using the information provided in the preceding windows. If

edits are required simply click the Back button until the desired window displays and

re-enter the information.

Click the Build Database button to create a blank database with all the necessary

components to begin using your collection. Then, select the Specify application from your

menus and login with your newly created username and password.

Field Formatting Editor

If you have chosen to Create a new Catalog Number or Accession Number format from either the

Specify Setup Wizard or Configuration window in Specify you are now seeing the Field Formatting

Editor.

Field Formatting Editor
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Field Formatting Editor

A format allows a field to include sections for different data, such as static text, a date or an

incremented number.

The table, field and field length information is located on the top left.

• Name is used within the application files. It should be text only and will not be displayed to the

user anywhere else in the application.

• Title will be displayed in any application format lists that are presented to the user.

• Reset Counter Every Year will become enabled when a Numeric section that 'Is Incremented'

is added to the format (this is explained in more detail in the following text). Checking this box

will start a new count each year.

A format can be made up of one or many sections.

1. Begin creating a format by clicking the (add) button on the right side of the editor to

add a section.

2. Next, choose the type of section to add.

Field Format Section Types
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• Numeric may only be numbers and can be auto incremented by checking the 'Is

Incrementer' box and using Auto Numbering when entering data. When auto

numbering Specify will start incrementing from the highest number present for the

section within the database. A numeric section can be set between 1 and 10 characters

in length. To start a new count for each year, check the Restart counter every year box.

It is important to remember that different field formats are implemented at different

levels and that formats that include a section that 'Is Incremented' will include a

numbering scheme that may be shared. For instance, an Accession number can be

implemented at either an Institution or Division level. An Accession number

implemented at a Division level configured with 'Is Incrementer' checked will

increment in all collections and disciplines for that division. In other words, they share

a numbering scheme.

Collection Numbers are implemented at a Collection level and increment

automatically for single collections only. Users that wish to increment Collection

Numbers between more than one collection should contact the Specify team at

specify@ku.edu for help setting that paramater.

• Alphanumeric may use both alphabetic characters a through z and numbers. A length

field will appear which allows the section to be set between 1 and 10 characters in

length.

• Alpha may only be alphabetic characters a through z. A length field will appear which

allows the section to be set between 1 and 10 characters in length.

• Separator refers to a character that separates the various sections. Separator choices

include - . / ' ' _ and are one character in length.

• Year will automatically add the current year on a form, but can be edited.

• Any char(acter) allows any alphabetic characters a through z, any number or any

other keyboard character. A length field will appear which allows the section to be set

between 1 and 10 characters in length.

• Constant refers to any section that will remain constant and is not editable on a form.

This type of section is useful when an institution code is part of a format. Type the

characters for the constant in the text field labeled Text located under the Type box.

3. Once the section information is configured correctly add it to the format by clicking the

button.

The section will appear in the window with the appropriate information in each of the

columns.
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• Type refers to the Type of section that was chosen from the pick list.

• Value shows the character used to represent the segment in the Sample at the bottom

of the window.

• Size refers to the number of characters chosen for the section. This is not applicable to

the Separator or Year section types.

• Is By Year refers only the Year section type.

• Is Incrementer refers only to the Numeric section type that is incremented. On the

Wizard's Collection Number window, it will display in the Is Numeric section.

4. Reorder sections by clicking the (reorder up) and (reorder down) buttons on the

right side of the editor.

5. Delete unwanted sections by clicking the (delete) button.

6. Continue adding sections until the format is complete and displays correctly in the

Sample window at the bottom of the editor.

Note: When manually entering a formatted number field, it is paramount that

numbers be padded with 0's. For example, if 3 numbers are available in a

numbering scheme (###) and the desired number is 1, then 001 must be entered.

If only 1 is entered, then Specify will read this as 100. This will produce incorrect

results in searches, queries and reports.

Once the format is complete click HERE to return to the Catalog Number in the Setup Wizard help.

Once the format is complete click HERE to return to the Catalog Number in the EZDB Setup Wizard

help.

Once the format is complete click HERE to return to the Accession Number in the Setup Wizard help.

Once the format is complete click HERE to return to the Accession Number in the EZDB Setup

Wizard help.
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Specify EZDB Setup Wizard

Welcome to Specify EZDB! You have unpacked the power of Specify without the installation and

maintenance requirement of MySQL. Specify EZDB includes embedded MySQL engine, and is

intended for use by a single collection on a single workstation. If your project requires multiple

collections then you will need to install the full version of Specify.

Note: Specify EZDB can also be used to evaluate Specify. If you are using it for this

purpose, please contact the Specify team at specify@ku.edu. They can provide you with a

test database and the instructions needed to download and install it.

Note: If you are using a test database to evaluate Specify and have received a test database,

DO NOT run the Specify EZDB Setup Wizard.

Note: A compatibility issue exists with Windows 7. If you are running Specify EZDB with

Windows 7 you must run SpecifyEZDB in Compatibility Mode. This can be accomplished

by right-clicking on the SpecifyEZDB.exe file in Windows 7 and choosing: Troubleshoot

Compatibility > Try Recommended Settings.

The Specify EZDB Setup Wizard is required to customize the necessary components in the embedded

MySQL for Specify EZDB. It walks you through the creation of a database including:

• Insertion of a schema within MySQL.

• Creation of an administrative level Specify user.

• Initialization of the database structure.

It also allows you to download Taxon (optional) and Geography authority files.

Note: Java SE Run-time Environment, i.e. JRE 1.7 (=7.0) or later must be installed on the

workstation that will run Specify EZDB.

Running the Specify EZDB Setup Wizard

Database Information
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Enter MySQL IT Username and Password

The first window allows you to create your Specify database or verify that Specify can

access a database you have installed. To create or verify a database, you must first complete

the following information:

Type in values for an IT Username and IT Password. This does not exist but

rather will be created when you click on the Next button on this window. This

account will be created with full administrator privileges within the embedded

MySQL database manager. This account will be used by the Specify Setup

Wizard to create your Specify database and a Specify Master account (in the next

window) in MySQL.

Note: Please make a note of the IT username and password. Other

EZDB Tools associated with Specify EZDB require this IT username

and password to run.

The Database Name is pre-filled with 'Specify' but can be changed by typing in a

new name into the text box. Document the database name used to log in. Once the

Wizard is complete, be sure to make a note of the name.

The Host Name refers to the computer that you are using. Because you are only

accessing the embedded MySQL on your local machine this should remain as

'localhost'.
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Create a Specify Database

When you click the Create Specify Database button Specify will connect to

MySQL using the information you have entered and then create your Specify

database and insert the Specify schema.

Advanced: Test IT Login

Use this button to verify that Specify EZDB can access a database that you have

installed.

Specify Master Credentials

Create a Master Username and Password

The security system for Specify 6 uses both a "Master" username and password, which

Specify uses to access the MySQL Database, as well as a User username and password,

which allows a user to run the Specify program. The Master account has SELECT,

INSERT, UPDATE, DELETE and TABLE LOCK privileges on data tables in your Specify

database only and has no other MySQL privileges. Specify uses only one Master username

and password for all users, but encrypts the Master password with the User information,

creating an encrypted string. This allows the Master information to become unique for each

user.
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Specify EZDB uses the same Master username and password as the IT username and

password in the first EZDB Wizard window. The username and password are filled-in for

you and can not be changed.

Create the Master

When you click the Create Master User button, Specify will take a moment to

create the Master account in the database. Once this account has been created you

may not change the information on this screen, or any previous screens.

Advanced: Test the Master

This button is not applicable to Specify EZDB

Security

Turn Security On/Off

Specify Security refers to the set of permissions and entitlements within Specify which

gives users the rights to see certain data and to use particular functions. If your Specify

database will never have more than one user, (you), then Security (i.e. permissions within

Specify), can be turned off. This will give you total access to all Specify program functions

and data. Specify will not check your credentials or limit your access to data or Specify

components.
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It is not recommend that Specify EZDB be used with multiple users; therefore Security can

be turned off. However, if you are using Specify EZDB to evaluate Specify and wish to

evaluate security also, then simply check the box to turn security on. Security can also be

turned on inside the Specify EZDB application.

Manager

Create Specify Manager / Administrator

This account is the first Specify user account for your database, and it is created at the level

of Manager, the highest level in the Specify permission model. The account usually

represents the primary user, or administrator, of your collection database. An Administrator

account will also be created within Specify using this information. It is this username and

password that will be used to log in to Specify for the first time, once the EZDB Setup

Wizard is finished. At that time additional users can be added within Specify.

Protect the username and make the password strong. This Specify manager level

information will also be used to create a record in the Specify database for an ‘Agent’

representing the same person.

Institution
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Create Institution and Enter Information

The Specify data management levels mimic the common levels of hierarchy within

institutions. Access to information and Specify tools are then set at the various levels both

within the application and through the User Permissions.

The Setup Wizard creates a single entry for each level of the hierarchy (Institution,

Division, Discipline and Collection). This setup window is the first step in that process.

Each of the screens for creating these levels must be completed before the Next button will

become enabled.

The Name should be the formal name for your institution. It is a field within the

Specify database, it is displayed on the Institution form, and can be queried and

used in reports.

The Code is typically an acronym, codon, abbreviation or short name for your

institution (not your collection). If you don't know of one, put in a placeholder,

this can be edited at a later date. Institution codes are often required for web

services such as DiGIR/TAPIR.

The Institution Address information, such as City, State, Country, Zip Code
and Phone Number, is also added to fields within the Specify database and

displayed on the Institution form and can be queried and used in reports.

Accessions
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Choose Accession Level

Accessioning is the formal process by which a specimen or object is legally accepted and

recorded as a museum item and differs from cataloging. Some museums and herbaria have

a formal accessioning process, some do not. If your institution does not use the concept of

accessions (typically handled by a registrar or administrative curator), then leave this item

unchecked and simply click the Next button to proceed to the next window.

For organizations that do recognize accessions, the process usually entails documenting

proof of ownership (in the form of a signed deed of gift), and that the material was legally

acquired (in the form of all associated permits - collecting, import and export). An

accession usually covers an entire field trip and multiple catalog items could be included

within a single accession. For the institutions that use it, accessioning and its associated

numbering system is usually set up as a standard museum-wide process, backed by policy.

The accession numbering scheme or sequence can either be recorded at an Institution level

for all collections (Globally) or at a Division level. Since it is recommended that Specify

EZDB be used with a single collection this is typically managed globally.

Note: If you choose to manage your accessions globally, you will be presented

with the following window to choose a format. If you did not choose to manage

your Accessions globally you will be presented with the window later in the

Wizard process when you create a Collection.

Accession Number Format
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Create Accession Number Format

Accession Numbers may require a format or may simply use a number. Choose None to

leave the Accession Number as a text field on the Accession form. Accession Number

formats are not editable once data has been entered into this table in the database.

• Format offers several choices in the drop-down menu list:

None is the default setting, which is a 60 character string field.

Create allows you to create your own format. Choosing Create will open the

Field Formatting Editor. Click HERE for the Field Formatting Editor help

page.

Accession Number (2009-AA-###) The year will appear automatically in

the first section (2009) of the format, and can also be manually edited. The

'AA' section of the format is alphanumeric and accepts both characters a

through z and numbers. The ### section of the format is a number that is

automatically incremented when Auto Numbering is turned on in Specify

and manually entered when Auto Numbering is turned off. This format

offers two alphanumeric characters and three incremented numbers.

AccessionNumberByYear (2009-AA-AAA) The year will appear

automatically in the first section (2009) of the format, and can also be

manually edited. The 'A' sections of the format are alphanumeric and accept

both characters a through z and numbers. This format offers two

alphanumeric sections, the first is two characters in length and the second is

three characters in length.
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AccessionStringFormatter (AAAAAA) This is a single alphanumeric

format that accepts characters a through z and numbers. The Accession

number would be seven characters in length.

• Pattern displays the pattern used to create each format (these are explained in further

detail above).

• Is Auto Incremented displays a 'yes' if the format is automatically incremented.

Storage Tree

Configure the Storage Tree

Specify 6 visually presents some data types in hierarchical tree displays. These data types

include the Taxon, Geography, (Specimen) Storage, Chronostratigraphy and

Lithostratigraphy tables. Each tree, visually displayed as heirarchical nodes, is backed up by

a tree definition, listing all levels and allowing customization of these levels. The Levels

must first be defined, then nodes can be added. The Setup Wizard offers a table for each of

the trees (Chronostratigraphy and Lithostratigraphy for paleo collections only) for creating

tree definitions, or levels. These can also be edited at a later date from within Specify.

Nodes for the Storage tree can be added within the Specify application. The storage tree

operates at the Institution level and is available and visible to all Collections, therefore, it is

important to include the necessary levels for all collection.

• The Level column displays the available levels. This name can be edited from within

Specify. Click the Include box to place the level in the tree.
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• Include places the Level in the tree definition. Levels that are not included can not be

Enforced or added to the Full Name.

• Is Required is not editable, but an indication of the tree levels that are used by Specify

as a system requirement. These are automatically added to the tree and can not be

deleted on this screen or later from within Specify.

• Is Enforced ensures that the level can not be skipped when adding nodes at lower

levels down the tree. Levels that are Required by the system are also Enforced by the

system and can not be edited.

• Is in Full Name includes the level when building a full name expression, which can be

queried and used in reports. Create the full name by checking the desired boxes. This

is the string that will be displayed in the storage field in the preparation table.

At least one level for Full Name must be checked before the Next button will become

enabled.

• Separator refers to the character that separates the levels when displaying the full

name. This can be any single character, such as a comma (,) or a space. To make the

separator a space, simply double click inside the column and delete the comma, then

press your spacebar once.

• Full Name Order will reverse the full name as shown in the Full Name Example.

Institution

Create Institution and the Administrator
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Click the Create Institution button to create your institution and add you as Administrator

in your Specify database. Once this information has been created you may not change it on

any of the previous screens and the Back button will become disabled.

The Institution must be created before the Next button will become enabled.

Division

Create a Division

This window is used to create a single Division within your institutional hierarchy.

Additional divisions can be added later from within Specify.

The Name will appear on the division form and can be queried and used in reports. A

division is used to collectively name similar collections e.g. the Divsion of Paleontology

may include Vertebrate Paleontology, Invertebrate Paleontology and Paleobotany

collections. The Name is a field within the Specify database and is displayed on the

Division form. It can be edited, queried and used in reports.

The Code can be a short name, acronym, codon or abbreviation. If your Division does not

have a Code, put in a placeholder (this is a required field), this can be edited at a later date.

Division codes are sometimes required for web services.

Discipline
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Choose a Discipline Type

Choose a taxonomic Discipline Type from the drop-down menu. Specify uses this

information to load the correct default data entry Forms, Trees and schema (tables and

fields) based on the predefined disciplines within Specify. If your discipline type does not

appear in the list, choose the closest discipline to yours based on taxonomic qualities.

The Name is pre-filled with the discipline type name but can be any user specific variation

of the Discipline Type by simply editing the pre-filled name. It can be edited, queried and

used in reports. Additional Disciplines can be added from within Specify.

Taxon Tree
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Configure the Taxon Tree

This table will create the tree definition for the Taxon tree. The Taxon tree operates at the

Discipline level and will be used by all Collections within the Discipline you created in the

last window. Nodes to the Taxon tree can be added later in the Wizard as well as from

within Specify.

• The Level column displays the available levels. This name can be edited from within

Specify. Click the Include box to place the Level in the tree.

• Include places the Level in the tree definition. Levels that are not included can not be

Enforced or added to the Full Name.

• Is Required is not editable, but an indication of the tree Levels that are used by

Specify as a system requirement. These are automatically added to the tree and can not

be deleted on this screen or later.

• Is Enforced ensures that the Level can not be skipped when adding nodes lower down

the tree.

• Is in Full Name includes the level when building a full name expression for any

associated Collection Objects (which appears in the Taxon Full Name field of the

taxon table). The Full Name is also displayed in the Preferred Taxon field on the

Determinations form and is useful when running queries and reports when the full

name is desired. The full name generally includes at least the binomial. Genus and

Species fields together with any levels below species (if used). Create the full name by

checking the desired boxes.

At least one level for Full Name must be checked before the Next button will become

enabled.

• Separator refers to the character that separates the levels when displaying the full

name. This can be any single character, such as a comma (,) or a space. To make the

separator a space, simply double click inside the column and delete the comma, then

press your spacebar one time.

• Full Name Order will reverse the full name as shown in the Full Name Example.

Load Taxon Authority File
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Preload Taxon Records/Nodes

The Specify Wizard not only defines the Taxon tree but also allows pre-loading of an

authority file for the discipline you are creating. Authority files were created using data

from the Catalog of Life Project for some of the disciplines within Specify. If this window

does not appear, there are no existing authority files for your chosen discipline.

If you choose to load the data into your tree, the Taxon tree will be populated with hundreds

of taxon nodes and all associated data. Then, when adding Collection Objects into your

database you can simply choose a taxa from the Taxon field rather than adding each

individually as needed.

Please note that loading the Taxon tree will also affect the tree definition. If you load the

provided Taxon authority file for your discipline, the accompanying tree definition may

include Levels that were not defined by you in the previous window, but are necessary to

include all the predefined Taxon information.

Additional discipline-specific trees can be loaded from within Specify at the time new

disciplines are created.

Click the Choose button for a list of taxon files for the discipline you are creating.

Not all disciplines offer more than one taxon file. Once the taxon file is chosen,

information will display in the Source, Coverage and Description fields for that

file.
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Note: Botany and Entomology authority files are partial due to the size

of these files. For additional authority files please contact the Specify

team at specify@ku.edu.

The Downloadable File section in this window allows you to choose taxon files

from your hard drive. The Setup Wizard can only install files that were

downloaded from the Specify website. The Specify team is currently in the

process of creating more of these files.

Load Geography Authority File

Configure and Load Geography Tree

The Geography tree operates at the Discipline level and is used by all Collections within the

Discipline. Nodes to the Geography tree can be added later in the Wizard as well as from

within Specify

• The Level column displays the available levels. This name can be edited from within

Specify. Click the Include box to place the level in the tree.

• Include places the Level in the tree definition. Levels that are not included can not be

Enforced or added to the Full Name.

• Is Required is not editable, but an indication of the tree levels that are used by Specify

as a system requirement. These are automatically added to the tree and can not be

deleted on this screen or later.
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• Is Enforced ensures that the level can not be skipped when adding nodes lower down

the tree.

• Is in Full Name includes the level when building a full name expression, which can be

queried and used in reports. Create the full name by checking the desired boxes.

At least one level for Full Name must be checked before the Next button will become

enabled.

• Separator refers to the character that separates the levels when displaying the full

name. This can be any single character, such as a comma (,) or a space. To make the

separator a space simply double click inside the column and delete the comma, then

press your spacebar one time.

• Full Name Order will reverse the full name as shown in the Full Name Example.

The Wizard will automatically load data for the Geography tree, including Continents,

Countries, and States throughout the world as well as Counties within the United States.

Data for the Geography tree was converted from the online website of the World Gazetteer.

Unwanted or unncessary nodes can be deleted from within the Specify application at a later

date if desired.

Collection

Create a Collection

Enter the Name and internationally recognized Collection Code to create a single

Collection within the Discipline. This is the name that will appear within Specify on the

Collection form and can be queried and used in reports.
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The Code should be your standard collections community assigned code for your collection.

This Code will be used in data exports and web interfaces in upcoming releases of Specify.

Additional collections can be added from within Specify.

Catalog Number

Create a Catalog Number Format

Specify is able to accept data for collection objects or observations without assigning a

Catalog Number. But when Catalog Numbers are used, they must be unique for each lot,

specimen or observation. Most collections routinely assign catalog numbers to incoming

materials, perhaps as part of the accessioning process. These numbers may require a format

with specific sections for data such as Institution Code and year or they may simply use an

incrementing number.

Catalog Numbers can either be unique to each Collection, shared by several collections or

be used throughout the Institution. The Catalog Number chosen at this time will not affect

where it is used relative to other collections, this will be configured from within the Specify

application. The Catalog Number format for this collection can not be edited once it is

chosen.

Several formats are available from the drop-down menu list:

• Format offers several choices in the drop-down menu list:

None is the default setting, which is a 60 character string field.
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Create allows you to create your own format. Choosing Create will open the

Field Formatting Editor. Click HERE for the Field Formatting Editor help

page.

CatalogNumber (2009-######) The year will appear automatically in the

first section (2009) of the format, and can also be manually edited inside

Specify. The '###' section of the format is a number that is six digits in

length. This section can be automatically incremented when Auto

Numbering is turned on in Specify or manually entered when Auto

Numbering is turned off. These two sections are separated by a dash.

CatalogNumberAlphaNumByYear (2009-######) The year will appear

automatically in the first section (2009) of the format, and can also be

manually edited from within Specify. The '###' section of the format is a

number that is six digits in length. This section can be automatically

incremented when Auto Numbering is turned on in Specify or manually

entered when Auto Numbering is turned off. These two sections are

separated by a dash.

CatalogNumberNumeric (#########) This is a nine digit number that is

automatically incremented when Auto Numbering is turned on in Specify or

manually entered when Auto Numbering is turned off.

CatalogNumberString (XXXXXXXXXX) This is a ten digit string that can

include numbers, alphabet or characters

• Is Numeric will display a 'yes' if the format is numeric.

• Pattern displays the pattern used to create each format (these are explained in further

detail above).

• Is Auto Incremented displays a 'yes' if the format is automatically incremented.

Collections that do not use one specific format for their Catalog Number may wish to

choose CatalogNumberString from the list, this will allow any format to be entered as long

as they are all of the character length chosen.
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Accessions

Create an Accession Number Format

Note: If you chose to manage your Accessions globally you will have already

chosen a format for your accession number and will not be presented with this

window again.

Accession Numbers may require a format or may simply use a number. Choose None to

leave the Accession Number as a text field on the Accession form. Accession Number

formats are not editable once data has been entered in the database.

• Format offers several choices in the drop-down menu list:

None is the default setting, which is a 60 character string field.

Create allows you to create your own format. Choosing Create will open the

Field Formatting Editor. Click HERE for the Field Formatting Editor help

page.

Accession Number (2009-AA-###) The year will appear automatically in

the first section (2009) of the format, and can also be manually edited. The

'AA' section of the format is alphanumeric and accepts both characters a

through z and numbers. The ### section of the format is a number that is

automatically incremented when Auto Numbering is turned on in Specify

and manually entered when Auto Numbering is turned off. This format

offers two alphanumeric characters and three incremented numbers.
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AccessionNumberByYear (2009-AA-AAA) The year will appear

automatically in the first section (2009) of the format, and can also be

manually edited. The 'A' sections of the format are alphanumeric and accept

both characters a through z and numbers. This format offers two

alphanumeric sections, the first is two characters in length and the second is

three characters in length.

AccessionStringFormatter (AAAAAA) This is a single alphanumeric

format that accepts characters a through z and numbers. The Accession

number would be seven characters in length.

• Pattern displays the pattern used to create each format (these are explained in further

detail above).

• Is Auto Incremented displays a 'yes' if the format is automatically incremented.

Summary Window

Summary Window

Congratulations! You have finished the Specify EZDB Setup Wizard. This last screen

displays all the data that has been created using the information provided in the preceding

windows. If edits are required, simply click the Back button until the desired window

displays and re-enter the information.

Specify Help - Specify EZDB Setup Wizard

282 / 391



Click the Build Database button to create a blank database with all the necessary

components to begin using your collection. Then, select the Specify application from your

menus and login with your newly created username and password.

Data Exporter

The Data Exporter application is used to build, update and export data files for use by IPT or a web

portal. The term 'build' refers to the process Specify uses to load data into the skeleton, or schema, of

a database. Before a data file can be built, a 'schema map' must first be created using the Schema

Mapping Editor inside Specify. If you have not created a schema map you will need to close the Data

Exporter tool, reopen Specify and create the schema map using the Schema Mapper tool. For

documentation explaining how to create a schema map please refer to Web Publishing.

The Data Exporter tool actually creates a table, or cache, in the database containing all relevant data,

based on the map that was created from inside Specify. This table of data is then indexed and

exported, along with other relevant files, for use in a web portal. Or, the cache is exported as a tab

delimited text file for importing into IPT.

The Data Exporter application is located in the bin directory within the Specify application directory,

which stores the executable files for Specify. Double click DataExporter (or select it from

Start/Program Files/Specify on Windows) to launch the tool. Users are required to login using their

Specify Username and Password.

The Data Exporter application opens as a three column table with action buttons.

Data Exporter Tool

• The Mapping column of the table indicates the name of both the mapping and table.
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• The Last Update column lists the date and time of the last update of the cache.

• The Status column indicates whether the cache has ever been build, up to date, orout of date. If

the cache is out of date, it also indicates the number of rows which require updating. The number

of out of date rows includes the number of rows that have been deleted from the database, edited

in the database and added since the last update. This information reflects the database contents at

the time the exporter was launched; it will not reflect changes to the database that occur while

the exporter is running.

Available Actions

• Show SQL - Click this button for a mapping whose cache has been completed to generate a

dialog showing an SQL select statement that can be copied and used when defining database

connections to the cache for IPT or other data providers.

Note: the SQL is based on the current cache structure. If the cache needs to be rebuilt

and mappings have been changed, the SQL statement generated will not reflect the

changes until the cache is updated.

• Build/Update - This will update the cache. When the cache is built or updated it is writing to the

database; therefore, the username and password for the database is required before Specify can

complete the task.

For caches that do not need to be built, only out-of-date rows are updated. This is

significantly faster than an initial build which can take a long time. Updates are not

allowed for mappings that are being edited or updated by another user; therefore, users

should close all schema mappings before updating.

Note: building/updating the cache will require the IT (MySQL) Username and

Password.

• Export - This exports the current contents of the cache to a tab-delimited text file for IPT.

• Export for Web Portal - Files for Solr and the web portal will be generated and exported.

Cancelling an Operation - You can cancel an update or export by clicking the (close) button to

close the application window. You will be asked to confirm the cancellation. If you cancel, you will

need to start from the beginning the next time you perform the operation.
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Note: If you cancel an update that required a rebuild, the pre-existing cache will have been

deleted.

Specify File Splitter

There are times that users may wish to upload MS Excel files that contain more than the 4000

records, which is the record limit for the Specify Uploader. For user convenience, the Specify project

has created an application, the Specify File Splitter, that will split files that contain more than 4000

records into files that contain only 4000 records.

The Specify File Splitter application is located in the bin directory within the Specify application

directory, which stores the executable files for Specify. Double click Specify File Splitter to launch

the tool. Users are required to login using their Specify Username and Password.

File Splitter

File to Split; click the Choose button and find the desired file using the file directory.

First row contains headers; check this box if the first row of the file contains headers.

Specify will then copy the headers to each 4000 record file. If the files include headers they

will contain 4001 records, but Specify does not count header files when uploading.

Lines per File refers to the number of rows in the CSV file. This defaults to 4000 but can

be any number desired. If a number greater than 4000 is entered a warning message will

appear. If you are splitting the file to import it into the WorkBench you should not exceed

4000 rows, as that is the maximum number of rows allowed in an import.

click the Slice button to start the File Splitter. The new files use the original file name but

add an underscore and consecutive number for each file. The original file remains intact.

For example: A file named "Birds.xls" containing 34002 rows will be split into 17 files

containing 4000 rows and 1 file containing 2 rows. The files will be named "Birds_1.xls"

thru "Birds_18.xls".
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Note: When headers are not used in the MS Excel files each file will need to be

remapped in the template editor inside the WorkBench. If headers are present

then only the first file will need to be mapped and subsequent files are given the

option of using the existing mapping.

Specify DB Security Wizard

New in Specify 6.3! If you are having difficulty logging into Specify utilities that require the IT or

Master username and password you should verify that the username and password you are using is

correct. The Security Wizard provides a quick and easy mechanism to check these. If you have

forgotten the Master username and password, the Security Wizard will allow you to reset them.

Types of Specify credentials include:

• User username and password

• Master username and password

• Master Key, (Encrypted username / password )

• IT username and IT password (used to gain access to the MySQL database manager)

For more information regarding these login types please refer to the Specify Login help page.

The Security Wizard also provides a summary of the databases and users that utilize the current

Master credentials as well as a list of all Specify databases in your current database management

system (MySQL).

The Security Wizard is a separate application that ships with Specify. It is located in the Specify

application directory, in the bin subdirectory, which stores the executable files for Specify. Double

click SpecifyDBSecurityWizard to launch the tool.

Note: The Specify DB Security Wizard is not available for SpecifyEZDB.

Test IT credentials
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Test IT Username and Password

The initial screen verifies the IT username and password. The IT username and password

refer to the credentials required to login into the MySQL database manager. It has full

administrator privileges within the MySQL database manager.

1. Type in the IT Username and Password in the appropriate boxes.

2. Type in the Host Name. The host name is the name of the computer that is running

MySQL. This is either an IP Address or name of the computer that is recognized by

the server. When running MySQL on your local machine this is almost always

'localhost' or '127.0.0.1'.

3. Click on the Test IT Login button.

Correct IT Credentials

If your IT credentials are correct, a message above the button will alert you

that your Login test was successful.

Incorrect IT Credentials

If your IT credentials are incorrect, a red message will alert you that your Login test

was NOT successful. You may try again by typing in different credentials and clicking

the Test IT Login button.

The security wizard requires correct IT credentials in order to progress. If you are

unable to identify your correct IT credentials you may go no further in the Security
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Wizard tool. There are also Specify features that require the IT credentials, including

creating a new Discipline or Division and using the Backup and Restore tool.

• Click the Next button to proceed in the security wizard.

Test Master Username and Password

Test Master Username and Password

This screen verifies the Master username and password. The Master credentials were

created when the Specify Setup Wizard was run to create the Specify database or created by

an IT administrator if a database was created from within MySQL rather than through the

Specify Setup Wizard.

1. Type in the Master credentials.

2. Click the Test Master Login button.

Correct Master Credentials

If the Master credentials are correct, a message will alert you that your

Login test was successful.

Incorrect Master Credentials
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If the Master credentials are incorrect, a message will alert you that your

Login test was NOT successful.You may try again by typing in a different

username and password and clicking the Test Master Login button.

A new button will appear. If you are unsuccessful and wish to recreate the

Master crecentials you can use the Reset your Master Username and
Password button.

Warning: If you reset the Master username and password EVERY
Master Key that was configured using the old Master credentials

will need to be reconfigured. That means that every user for the

database(s) will require a new Master Key to be reconfigured and

sent to them. Users will be required to type in the new Master Key

the next time they login to the Specify database!

Reset the Master Username and Password

Click the Reset your Master Username and Password button to reset the

Master credentials. A dialog will appear listing ALL the Specify databases

available. It is important to note that this is a list of ALL the databases.

Specify Database List

1) Choose the database(s) that will be reset to use the new Master

username and password.

Now you will need to reset the Master credentials.
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Reset the Master using the Username and Password fields

2) Simply type the new Master username and password into the

second screen.

3) Click the Test Master Login button.

3. Click the Next button to continue in the Security Wizard.

Database and User Information
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Specify Databases and Users

The new screen displays three panels of information:

1. Accessible Databases (top left)

2. Inaccessible Databases (top right)

3. Users of 'Current Database' (bottom half)

Accessible Databases displays list of all the databases that are accessible using the current

Master username and password.

Select a database from the list to open a list of users for the database in the bottom panel

(3).

Select a database from the list and click the to remove it from the list of Accessible

Databases and into the Inaccessible Databases list.

Note: The database(s) listed in the Accessible Databases list when the screen

originally opens can not be removed from the list.

Note: The Specify team does not recommend that a database be moved from the

Accessible Databases panel (1) into the Inaccessible Databases panel (2).

Databases moved in this way will not have their Master username and password

and any attempt to login from Specify will fail until the Master is reset. Reset the

master by opening the Specify DB Security Wizard and follow the steps in the

Reset the Master Username and Password section above.
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Non-Accessible Databases displays a list of Specify databases that are not accessible using

the current Master username and password.

Select a database from the list and click on the (move) button to replace the existing

Master user for the database and replace it with the current Master user.

Warning: Moving a database from the Non-Accessible Databases panel to the

Accessible Databases panel will reset the Master username and password for the

database and EVERY user of the database will need to have a new Master Key

reconfigured and sent to them. Users will be required to type in the new Master

Key the next time they login to the Specify database!

Users of 'Current Database' (the name of the current database will be the label for this

panel) displays the users that have access to the currently selected database (in panel 1). If

you have added any databases to panel 1 you will need to reconfigure the Master Key for

each of the users before they can gain access to Specify. Or, if the Master credentials were

reset for a database in the previous screen all the users for that database will need to have

their Master Key reconfigured. This task can be completed using panel 3.

Note: The Master Key can also be reconfigured from within the security tool in

Specify as well during the login process. The user must know the Master

username and password to reconfigure their Master Key during the login process.

Reconfigure the Master Key for a User

The Master credentials will be reset for any databases that are moved from the

Inaccessible Databases panel (2) into the Accessible Databases panel (1). The

users that access the database will need to have a new Master Key configured and

sent to them so they can login to Specify.

1. Be sure that the correct database is selected in Panel 1.

2. Click on the desired username to select the user.

3. Select all the values (text) in the Password text box and delete it. At this time

the column labeled 'Master Key' indicates that the Master Key is on the

user's machine. Master key information is stored on the local machine and
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there is no way for this tool to retrieve this information and show it here;

therefore, the Master Key must be reconfigured.

4. Type in a new password and press the 'tab' key.

5. Click the Copy Master Key button at the bottom of this screen to copy the

master key into the computers clipboard. You can then paste this into an

email and send it to the user. The user will NOT be able to login without this

new master key.

Other Buttons

Click the Show Summary button to show a summary of all the users in the

currently selected database as well as their user information.

Click the Print button to print a summary of all the users in the currently selected

database as well as their user information.

Fix Master Permissions

A Specify Master must include SELECT, INSERT, UPDATE, DELETE and TABLE LOCK

privileges in MySQL. The Security Wizard checks the Master priviledges at the same time that it tests

the Master credentials. If the privileges are not set correctly the Security Wizard will alert you and

offer the ability to fix them.
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Fix Master Priviledges

Simply click the Fix Privileges button to fix the privileges for the Master.

Welcome to the Specify 6 WorkBench

The WorkBench was released to the community as a stand along tool in the Spring of 2007. It was the

result of many interviews and evalutaions that requested a tool for entering and cleaning data before it

was cataloged into Specify. Some collections required such a tool for entering legacy data, others

wanted a small, standalone tool to take in the field and still others needed to manipulate their data

before cataloging it in Specify 6.

The WorkBench was created to meet these specific needs within the community. As a pre-catalog

data manipulation component in Specify 6, the WorkBench offers the following features:

• Import from CSV or MS Excel files

• Link an image to a record

• View and edit in either a grid or form view

• Visualize georeferenced object information on a map or in Google Earth

• Convert and standardize Latitude and Longitude formats

• Georeference

• Export a Data Set and reimport without needing to remap the Data Set

The entire WorkBench is now part of Specify as well as a tool to upload the data within the

WorkBench into Specify. The Upload function is not available from the stand alone WorkBench.

Data Sets created using the stand alone version will need to be exported and reimported into the

Specify 6 WorkBench for uploading. The current version of the stand alone WorkBench is not able to

remember the Data Set mapping. Data Sets imported into the 'embedded' Specify WorkBench from

the stand alone WorkBench will need to be remapped.

This makes the uploader a fast and easy way to transfer data from an MS Excel or CSV file into

Specify by first importing the data into the WorkBench.

The WorkBench has a limit of 4000 records that can be uploaded at one time.

Using the WorkBench
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The WorkBench works inside Specify 6 and takes advantage of the same components; side bar,

dragging and dropping, tabs, etc.

Introducing Data Sets

Data is entered, edited, organized and stored in a Data Set. Data within a Data Set is organized within

column headings. The WorkBench offers many features for manipulating the data within Data Sets

before it is cataloged into Specify 6.

One of the most important of these features is the organization of the data into Specify fields. This is

not only necessary for other features in the WorkBench to function correctly, but also ensures that the

data will upload correctly into Specify 6. The column headings for new Data Sets are chosen from a

list of Specify fields corresponding to the Specify data model. The column headings can be renamed,

but will still maintain a link to the original Specify field. These links are referred to as 'maps'. These

maps can also be edited.

When data is imported from a CSV or MS Excel file, the WorkBench will read the existing column

headings into a Data Set and map them to Specify fields with a built-in 'automapper'. Any column

headings that the WorkBench does not recognize and 'automap' can be manually mapped and edited.

Data Sets can be edited as either a grid or a form.

The WorkBench also enables each record to link to an image within a Data Set. The linked images

display in an image window. This is particularly useful for entering data from scanned catalog cards

or specimen labels.

Getting Started

Data Sets are created using different Actions depending on the Work Flow. The following table lists a

variety of Work Flows and the relevant WorkBench solution:

Work Flow Action

I have data in an Excel

spreadsheet.

The "Import Data" action will import the

data into a Data Set and map the existing

columns to the Specify fields.

I have data in a database

format.

Export the data as a CSV file and use the

"Import Data" action to import the data

into a Data Set and map the existing
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columns to Specify fields.

I have legacy data (cards,

labels, catalog pages) as

images.

The "Import Images" action will create a

Data Set with each card image linked to a

single record.

I have legacy data on

physical cards, labels or

catalog pages.

The "New Data Set" action will allow you

to choose column headings from Specify

fields and create a Data Set for entering

your data.

I have locality

information on field

notes.

The "New Data Set" action will allow you

to choose column headings from Specify

fields and create a Data Set for entering

your data.

I will be visiting a

collaborating Institution

and want to take my data

with me.

Save the entire WorkBench Component

and accompanying Data Sets onto a

portable medium (USB key, CD, etc).

I will be visiting a

collaborating Institution

and want to take my data

with me but they use a

Mac and I use a PC.

No problem! The WorkBench works the

same on systems using Windows, Mac

OS X as well as Linux. Simply save the

entire WorkBench Component and

accompanying Data Sets onto a USB key

and run the WorkBench on your

associate's Macintosh.

I will be visiting a

collaborating Institution

and want to merge our

data but their data is in

Excel.

The "Export Data Set" action will export

your data into an Excel spreadsheet,

which can then be merged with their data.

Thereafter, the file can be imported as a

single Data Set into the WorkBench.

I want to verify my data

that exists in a

non-Specify database.

Export the data as a CSV file from your

database and then use the "Import Data"

action to import the data into a

WorkBench Data Set by mapping the
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existing columns into Specify fields. Then

you can use the reporting features to

verify your data.

Data Set Overview

Data is entered, edited, organized and stored in a Data Set.

The type of data that will be entered into a Data Set determines which action item to use to create the

Data Set.

To enter data from field notes or labels choose the New Data Set action to create an empty Data Set.

Column headings for the new Data Set are chosen from fields within Specify 6, which ensures that

any data entered into the WorkBench will import correctly into Specify 6. The column headings can

be renamed, but will still maintain a link to the original Specify field. These links are referred to as

'maps'.

Use the Import Data action to import data from an MS Excel or CSV file. The WorkBench not only

imports the data, but also helps map the existing column headings to fields in Specify 6 with an

'auto-mapping' feature that reads the import column headings and automatically maps them to any

matching fields. Any remaining, unmapped column headings can be manually mapped. The column

headings can be mapped to different Specify fields later using the Edit Data Set Mapping action.

Data Sets display the imported column headings rather than the field names, as these are more

familiar.

The Import Images action links images to individual records in a new Data Set. This action item is

especially useful when entering data from scanned card images or field notes.

The WorkBench can also link images individually to each row within an existing Data Set.

Data Sets are edited as either a Grid, or a Form. Each view offers unique functionality:

Grid Editing Search Panel

Georefrencing with BioGiomancer

Mapping with Google Earth

Georeference Conversion tool

Export selected records
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Form Editing Rename Columns

Rearrange form layout in the work space

An entire Data Set, or selected rows can be exported to an MS Excel spreadsheet using the Export

Data Set action.

A Data Set can be described, as well as named using the Data Set Properties dialog.

New Data Set

The first step in creating a new Data Set is to select the columns that will be included in the new Data

Set. This is achieved by either reusing the column headings from an existing Data Set or creating one

from the list of fields available in Specify.

If a Data Set exists with the same column headings, or mapping, needed for the new Data Set, simply

drag the Data Set item onto the New Data Set action on the side bar. This eliminates the need to

choose a Data Set from a file dialog.

Notes:

• Data Sets have a limit of 4,000 records.

• Data Sets that are open in the work space are disabled in the side bar. To copy the column

headings from an existing Data Set it must first be closed.

To bypass the drag and drop feature, click the New Data Set button on the side bar. The following

dialog will appear:

New Data Set
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To copy a Data Set map from an existing Data Set select the Use an existing Data Set mapping
button and choose the Data Set from the list provided. The Data Set Properties dialog will then open,

to name and describe the new Data Set.

To choose column headings for the new Data Set, select the Create new Data Set mapping button

and click 'OK'. The Data Set Mapping Editor will appear:

Data Set Mapping Editor

The Data Set Mapping Editor allows columns to be mapped, unmapped and reordered using the

following buttons:

Map Adds the field to the column list.

Unmap Removes the field from the list of columns.

Reorder up Moves the selected field up.

Reorder down Moves the selected field down.

The WorkBench provides a list of fields matching the Specify data model to use as column headings

in the new Data Set. The list is organized by Data Types.

To add a column heading:

1. Select a Data Type, the available fields will appear in the 'Specify Fields' window.

2. Select a field

3. Click the (map) button
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The new column heading will appear under both 'Specify Fields' and 'Data Set Columns' (as shown

below).

A link icon, ( ), icon confirms that the Specify field is mapped to the Data Set column.

Note: A field may only map once. Specify fields that are mapped display a green check

mark next to their name in the Specify field list confirming that they are in use.

Note: When importing Taxon information only use the Taxon Only Table in the mapping

editor.

Note: The Agent table in the mapping editor may only be used for agent information. When

uploading agent information along with collection object information use the Cataloger

Title, First Name, Middle Name and Last Name fields in the Collection Object table.

Data Set Mapping Editor with one column added

Continue adding fields/columns until the 'Data Set Columns' list is complete, then click 'OK'.

Complete the new Data Set by naming and describing it:
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Data Set Properties

To edit the Data Set Mapping, see Edit Data Set Mapping.

Create Data Set from Record Set

New in Specify 6.3, users may now create a WorkBench data set based on an existing Specify record

set. The data set can then be exported as an Excel spreadsheet and imported into other Specify

databases.

Before a record set can be converted to a data set a mapping must exist. You can reuse an existing

data set mapping, in which case you can go directly to Create a Data Set from Record Set. If a data set

with a duplicate mapping does not exist then a mapping must be created by creating an empty data

set.

Create a Mapping/Data Set

1. Click the New Data Set button on the side bar.

New Data Set

2. Click the Create new Data Set mapping button

To choose column headings for the new data set, select the Create new Data Set mapping
button and click the OK button. The Data Set Mapping Editor will appear:
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Data Set Mapping Editor

The Data Set Mapping Editor allows columns to be mapped, unmapped and reordered using

the following buttons:

Map Adds the field to the column list.

Unmap Removes the field from the list of columns.

Reorder up Moves the selected field up.

Reorder down Moves the selected field down.

The WorkBench provides a list of fields matching the Specify data model to use

as column headings in the new data set. The list is organized by Data Types,

sometimes referred to as Tables.

3. Add column headings

1) Select a Data Type. The available fields will appear in the 'Specify Fields' window.

2) Select a field.

3) Click the (map) button.

The new column heading will appear under both 'Specify Fields' and 'Data Set Columns' (as

shown below).

A link icon, ( ), confirms that the Specify field is mapped to the Data Set column.
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Note: A field may only map once. Specify fields that are mapped display a green

check mark next to their name in the Specify field list confirming that they are in

use.

Note: When importing Taxon information only use the Taxon Only Table in the

mapping editor.

Note: The Agent table in the mapping editor may only be used for agent

information. When uploading agent information associated with other tables use

the appropriate table such as Cataloger, Determiner or Collector and their

respective fields.

Data Set Mapping Editor with three columns added

Continue adding fields/columns until the 'Data Set Columns' list is complete, then click

'OK'.

Complete the new Data Set/Mapping by naming and describing it:

Data Set Properties
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Create a Data Set from a Record Set

1. Click the Create Data Set from Record Set button

2. Choose a record set from the dialog and click the OK button

The next dialog lists the available data sets.

1. Choose the data set/mapping that you require.

2. Click the OK button.

In the next dialog name the new data set.

Note: Data contained in all records in the record set will be used to fill the data set

columns. Where necessary all data in one-to-many relationships will be inserted into

the relevant fields. It is important to include these necessary fields in the original

mapping. E.g. if the records in the record set all have two collectors it is important to

include columns for Collector 1 First Name, Last Name and Middle Initial as well as

Collector 2 First Name, Last Name, Middle Initial to ensure that all relevant

information is preserved for all records.

Note: When the data set opens, the validation for invalid fields will be turned on. If the

data set contains catalog number they will be marked as invalid and highlighted in red,

because Specify recognizes them as duplicates. The validation can be turned off by

unchecking the Highlight Invalid Cells checkbox in the validation panel at the bottom

of the work space.

Validation Panel

Note: The mapping of a data set created from a record set may not be edited.

Import Data Overview
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The WorkBench can easily create a Data Set and import data from an MS Excel or CSV (comma

separated value) file.

The WorkBench 'maps' the column headings from the import file to fields in the Specify 6 data

model. This is not only necessary for other features in the WorkBench to function properly, but also

ensures that the data will uploaded correctly into Specify 6. The WorkBench includes an

'auto-mapping' feature that reads the import column headings and attempts to automatically map them

to any matching fields. Any ' unmapped' column headings can be manually mapped. The column

headings could be mapped to different Specify fields at any later stage by editing the Data Set

Mapping.

The Data Set will display the imported column headings rather than the Specify fields, as these are

more familiar.

If data exists on several scanned card images or field notes, it is very helpful to create a Data Set by

importing the images.

The WorkBench can also import images as a batch and link scanned images to individual rows in a

Data Set.

Importing Data from a CSV file

The WorkBench can easily import data from a CSV (comma separated value or comma delimited

text) file into a new Data Set.

Notes:

• Changes made to the data in the WorkBench will not be reflected in the original CSV file.

• The WorkBench has a 4000 record maximum. Files that include more than 4000 rows will not

import.

To begin, click on the Import Data action on the side bar and choose the import file in the file dialog.

The following information dialog will open:
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Import from CSV

This dialog enables the WorkBench to properly import the file by allowing the user to set data import

options.

The Data Preview window reads and displays a sample of the column headings and data from the

import file. If the file does not contain column headings, the columns will be labelled in numerical

order (Column 1, Column 2, etc.).

Incorrect import options will be visible in the Data Preview window and will also have a warning

icon and message displayed.
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Incorrect Import Options

To correct the information displayed, choose different selections in the 'Data Import Options' section

of the dialog. When the 'Data Import Options' are correct, the 'Data Preview' window will display the

CSV file correctly, the warning icon will disappear and the dialog will look like the 'Import from CSV'

dialog above.

The next step in the import process is to 'map' the column headings from the import file to Specify

fields.

File includes Column Headings

The Workbench includes an 'auto-mapping' feature which first identifies column headings and

compares them to existing Data Sets. If the column headings in the import file match those in an

existing Data Set the following dialog will open:
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New Data Set Column Headings

To copy the 'map' from an existing Data Set select the 'Use an existing Data Set mapping' button and

choose the Data Set from the list provided. The Data Set Properties dialog will then open, to name

and describe the new Data Set.

To create a new map for the new Data Set select the 'Create new Data Set mapping' button and click

'OK'.

Note: Mappings can only be reused if the CSV file being imported contains the same or fewer fields

than the mapping. In other words, if you split a CSV file into two smaller files for import, then import

the first CSV file but do not map all the fields, the unmapped fields are discarded. When you then

import the second CSV file you will NOT be given the option to reuse the mapping created for the

first CSV file. To reuse the mapping you must first delete the unmapped/discarded fields from the

CSV file before importing it into the WorkBench.

The 'auto-mapper' then compares the import column headings to the Specify fields and 'maps' the

columns to matching fields.
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Column Headings Automapped in the Data Set Mapping Editor

The column headings from the import file appear under 'Data Set Columns' on the right side of the

dialog and are mapped to 'Specify Fields' on the left.

Column headings that map to Specify fields are identifed by a (linked) icon.

Column headings that have not been automapped will have 'To Be Discarded' displayed under

'Specify fields'. Unmapped column headings will be deleted if they are not mapped to a Specify field

before clicking 'OK'.

The buttons in the dialog enable columns to be mapped, unmapped, added, deleted and reordered.

Icon Name Result

Map Adds the field to the column list.

Unmap Removes the field from the list of columns.

Reorder up Moves the selected field up.

Reorder down Moves the selected field down.

To map an unmapped Data Set column to a Specify field:

1. Click on the column in the right hand window to select it.
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2. Click on the Data Type to display the associated fields in the 'Specify Fields' window.

3. Click on the required Specify field to select it.

4. Click the (map) button.

To unmap a column from a field:

1. Click on the column in the right hand window to select it.

2. Click the (unmap) button.

To add a column

1. Click on the Data Type to show the Specify fields in the 'Fields' window.

2. Click on the Specify field.

3. Click the (map) button.

A (link) icon confirms that the column and field are the same heading.

Note: A field may only map once. Specify fields that are mapped display a green check

mark next to their name in the Specify field list confirming that they are in use.

Note: When importing Taxon information only use the Taxon Only Table in the mapping

editor.

Note: The Agent table in the mapping editor may only be used for agent information. When

uploading agent information along with collection object information use the Cataloger

Title, First Name, Middle Name and Last Name fields in the Collection Object table.

When all the Columns are mapped and ordered correctly click the 'OK' button.

Complete the import process by naming and describing the new Data Set:

Data Set Properties
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File does NOT include Column Headings

Import files that do not contain column headings can not be 'auto-mapped' to fields in Specify.

Columns are labelled according to their numerical order and need to be manually mapped.

Map of Import File with No Column Headings

Columns without headings display 'To Be Discarded' rather than mapping to Specify fields.

Unmapped column headings will be deleted if they are not mapped to a Specify field before clicking

'OK'.

The buttons in the dialog enable columns to be mapped, unmapped, added, deleted and reordered .

The function of each button is described below:

Icon Name Result

Map Adds the field to the column list.

Unmap Removes the field from the list of columns.

Reorder up Moves the selected field up.

Reorder down Moves the selected field down.

To map an unmapped Data Set column to a Specify field:
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1. Click on the column in the right hand window to select it.

2. Click on the Data Type to display the associated fields in the 'Specify Fields' window.

3. Click on the required Specify field to select it.

4. Click the (map) button.

To unmap a column from a field:

1. Click on the column in the right hand window to select it.

2. Click the (unmap) button.

To add a column

1. Click on the Data Type to show the Specify fields in the 'Fields' window.

2. Click on the Specify field.

3. Click the (map) button.

A (link) icon confirms that the column and field are the same heading.

Note: A field may only map once. Specify fields that are mapped display a green check

mark next to their name in the Specify field list confirming that they are in use.

Note: When importing Taxon information only use the Taxon Only Table in the mapping

editor.

Note: The Agent table in the mapping editor may only be used for agent information. When

uploading agent information along with collection object information use the Cataloger

Title, First Name, Middle Name and Last Name fields in the Collection Object table.

When all the columns are mapped and ordered correctly click the 'OK' button.

Complete the import process by naming and describing the new Data Set:

Data Set Properties
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To rename columns headings, see Form Editing.

Note: When the data set opens the validation for invalid fields will be turned on. The

validation can be turned off by unchecking the Highlight Invalid Cells checkbox in the

validation panel at the bottom of the work space.

Validation Panel

Bad Imports

CSV files that are corrupt or have not been saved correctly will not import correctly into the

WorkBench. A bad file may appear in the Data Set Mapping Editor with partial or no column

headings, or display a warning at the bottom of the WorkBench window:

Bad File Warning

Importing Data from an MS Excel file

The WorkBench can easily import data from an MS Excel file into a new Data Set.

The WorkBench uses HSSF as the port for the Microsoft Excel 97(-2003) file format (BIFF8) to pure

Java, which supports read and write capability. (Support for Excel 2007 .xlsx files is in progress).

Please see the HSSF project page for more information.

Notes:

• Changes made to the data in the WorkBench will not be reflected in the original MS Excel file.

• The WorkBench has a 4000 row maximum. Files that include more than 4000 rows will not

import.

• Excel files that contain more than 4000 rows can be split using the Specify File Splitter tool.

To begin, click on the Import Data action on the side bar and choose the import file in the file dialog.
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To properly import the data from an MS Excel file, the WorkBench must first determine if the data

includes column headings. The following information dialog appears after the file dialog:

Import from MS Excel

The Data Preview window reads and displays a sample of the column headings and data from the

import file. If the file does not contain column headings, the columns will be labelled in numerical

order (Column 1, Column 2, etc.). Check the 'First row contains column headings' box according to

how the file displays in the Data Preview window.

The next step in the import process is to 'map' the column headings from the import file to the fields

in the Specify data model.

File includes Column Headings

The Workbench includes an 'auto-mapping' feature which first identifies column headings and

compares them to existing Data Sets. If the column headings in the import file match those in an

existing Data Set the following dialog will open:
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New Data Set Column Headings

To reuse the 'map' from an existing Data Set select the 'Use an existing Data Set mapping' button and

choose the Data Set from the list provided. The Data Set Properties dialog will then open, to name

and describe the new Data Set.

To create a new map for the Data Set select the 'Create new Data Set mapping' button and click 'OK'.

Note: Mappings can only be reused if the XLS file being imported contains the same or fewer

columns than the mapping. In other words, if you split an XLS file into two smaller files for import,

then import the first XLS file but do not map all the columns, the unmapped columns are discarded.

When you then import the second XLS file you will NOT be given the option to reuse the mapping

created for the first XLS file. To reuse the mapping you must first delete the unmapped/discarded

columns from the XLS file before importing it into the WorkBench.

The 'auto-mapper' then compares the imported column headings to the Specify fields and 'maps' the

columns to matching fields.
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Column Headings Automapped in the Data Set Mapping Editor

The column headings from the import file appear under 'Data Set Columns' on the right side of the

dialog and are mapped to 'Specify Fields' on the left.

Column headings that map to Specify fields display a (linked) icon.

Column headings that have not been automapped will have 'To Be Discarded' displayed under

'Specify Fields'. Unmapped column headings will be deleted if they are not mapped to a Specify field

before clicking 'OK'.

The buttons in the dialog enable columns to be mapped, unmapped, added, deleted and reordered.

Icon Name Result

Map Adds the field to the column list.

Unmap Removes the field from the list of columns.

Reorder up Moves the selected field up.

Reorder down Moves the selected field down.

To map an unmapped Data Set column to a Specify field:

1. Click on the column in the right hand window to select it.
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2. Click on the Data Type to display the associated fields in the 'Specify Fields' window.

3. Click on the required Specify field to select it.

4. Click the (map) button.

To unmap a column from a field:

1. Click on the column in the right hand window to select it.

2. Click the (unmap) button.

To add a column

1. Click on the Data Type to show the Specify fields in the 'Fields' window.

2. Click on the Specify field.

3. Click the (map) button.

A (link) icon confirms that the column and field are the same heading.

Note: A field may only map once. Specify fields that are mapped display a green check

mark next to their name in the Specify field list confirming that they are in use.

Note: When importing Taxon information only use the Taxon Only Table in the mapping

editor.

Note: The Agent table in the mapping editor may only be used for agent information. When

uploading agent information along with collection object information use the Cataloger

Title, First Name, Middle Name and Last Name fields in the Collection Object table.

When all the Columns are mapped and ordered correctly click the 'OK' button.

Complete the import process by naming and describing the new Data Set:

Data Set Properties
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File does NOT include Column Headings

Import files that do not contain column headings can not be 'automapped' to fields in Specify.

Columns are labelled according to their numerical order and need to be manually mapped.

Map of Import File with No Column Headings

Columns that do not include headings display 'To Be Discarded' rather than mapping to Specify

fields. Unmapped column headings will be deleted if they are not mapped to a Specify field before

clicking 'OK'.

The buttons in the dialog enable columns to be mapped, unmapped, added, deleted and reordered .

The function of each button is described below:

Map Adds the field to the column list.

Unmap Removes the field from the list of columns.

Reorder up Moves the selected field up.

Reorder down Moves the selected field down.

To map an unmapped Data Set column to a Specify field:

1. Click on the column in the right hand window to select it.

2. Click on the Data Type to display the associated fields in the 'Specify Fields' window.
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3. Click on the required Specify field to select it.

4. Click the (map) button.

To unmap a column from a field:

1. Click on the column in the right hand window to select it.

2. Click the (unmap) button.

To add a column

1. Click on the Data Type to show the Specify fields in the 'Fields' window.

2. Click on the Specify field.

3. Click the (map) button.

A (link) icon will appear identifying that the column and field are the same heading.

Note: A field may only map once. Specify fields that are mapped display a green check

mark next to their name in the Specify field list confirming that they are in use.

Note: When importing Taxon information only use the Taxon Only Table in the mapping

editor.

Note: The Agent table in the mapping editor may only be used for agent information. When

uploading agent information along with collection object information use the Cataloger

Title, First Name, Middle Name and Last Name fields in the Collection Object table.

When all the columns are mapped and ordered correctly click the 'OK' button.

Complete the import process by naming and describing the new Data Set:

Data Set Properties
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To rename columns headings see Form Editing.

Note: When the data set opens the validation for invalid fields will be turned on. The

validation can be turned off by unchecking the Highlight Invalid Cells checkbox in the

validation panel at the bottom of the work space.

Validation Panel

Bad Imports

MS Excel files that are corrupt or have not been saved correctly will not import correctly into the

WorkBench. A bad file may appear in the Data Set Mapping Editor with partial or no column

headings, or display a warning at the bottom of the WorkBench window:

File Warning

Import Images

The Import Images action creates a new Data Set, then reads in a group of images and links each one

to its own record in the new Data Set. Each image can then be viewed while entering data into its

linked record in the Data Set.

Notes:

1. The 'Import Images' action is best used when entering data from scanned cards or field notes.

Single, descriptive images can also be linked to existing Data Set records using the Image

Window.

2. The WorkBench automatically adds a column within the Data Set and names it 'Image'.

3. The 'Image' column is only displayed with the Image Window is open.

The WorkBench links images in jpeg, jpg, gif and png formats.
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Click the 'Import Images' action, a file dialog will appear that allows multiple images to be selected.

Select the images to import and click 'Open'.

Next, choose to reuse a Data Set map from an existing Data Set or create a new one:

Data Set Column Headings

To copy a Data Set map from an existing Data Set, select the 'Use an existing Data Set mapping'

button and choose the Data Set from the list provided. The Data Set Properties dialog will then open

to name and describe the new Data Set.

To choose new column headings to create a map for the Data Set, select the 'Create new Data Set

mapping' button and click 'OK':

Data Set Mapping Editor

The Data Set Mapping Editor allows columns to be mapped, unmapped and reordered using the

following buttons:
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Icon Name Result

map Adds the field to the column list.

unmap Removes the field from the list of columns.

reorder up Moves the selected field up.

reorder down Moves the selected field down.

The WorkBench provides a list of fields matching the Specify data model to use as column headings

in the new Data Set. The list is organized by Data Types.

To add a column heading:

1. Select a Data Type, the available fields will appear in the 'Specify Fields' window.

2. Select a field.

3. Click the (map) button.

4. The new column heading will appear under both Data Set Columns and Specify Fields(as shown

below).

A (link) icon confirmes that the Specify field is mapped to the Data Set column.

Data Set Mapping Editor with one column added

Continue adding fields/columns until the 'Data Set Columns' list is complete, then click 'OK'.

Complete the import process by naming and describing the new Data Set:

Specify Help - Import Images

322 / 391



Data Set Properties

To edit the Data Set Mapping, see Edit Data Set Mapping.

Edit Data Set Mapping

To edit the Data Set Mapping, find the data set on the side bar and right-button click on it. If the data

set is currently open, you will need to close it before editing the maping.

A context menu will appear:

Edit Data Set Mapping Context Menu

Click on 'Edit Data Set Mapping' to display the Data Set Mapping Editor dialog:
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Data Set Mapping Editor

The buttons in the dialog enable columns to be mapped, unmapped, added, deleted and reordered:

Map Adds the field to the column list.

Unmap Removes the field from the list of columns.

Reorder up Moves the selected field up.

Reorder down Moves the selected field down.

To unmap a column:

1. Click on the column to select it.

2. Click the (unmap) button.

To remap a column:

1. Click on the Data Set Column to select it.

2. Click on the Data Type to show the Specify fields in the 'Fields' window.

3. Click on the Specify field.

4. Click the (map) button.
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To add a column:

1. Click on the Data Type to show the Specify fields in the 'Fields' window.

2. Click on the Specify field.

3. Click the (map) button.

A (link) icon will appear identifying that the column and field are the same heading.

To reorder the columns:

1. Click on Data Set Column to select it.

2. Click the (reorder up) or (reorder down) until the column is in the correct position.

Note: A field may only map once. Specify fields that are mapped display a green check mark next to

their name in the Specify field list confirming that they are in use.

Data Set Properties

Data Sets are named and described as part of the Data Set Properties.

To view and/or edit the properties of a Data Set, right click on a Data Set name on the side bar. A

context menu will appear:

Click 'Edit Properties' to display the Data Set Properties dialog:

Data Set Properties
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If a Data Set was created from an imported file, the path to the file will display in the 'Source File'

area of the dialog.

Grid Editing

Grid Editing enables the Data Set to be displayed and edited much like a spreadsheet. Although the

WorkBench is very similar to most spreadsheet applications (i.e. MS Excel), it is not considered a

replacement for users who take advantage of the advanced features offered by these packages. Grid

editing in the WorkBench provides many tools that are more specific to the manipulation of

collections management data.

Values within a Data Set are manipulated using the icons in the work space Item Bar:

Insert a Row Adds one new row under the active row. If no row is

selected a new row is inserted after the last record.

Delete A Row(s) Deletes the selected row and its associated values.

Clear Cells Clears the selected cell or row.

Mapping Plots the locality on a map. The locality is shown

using a pushpin icon. Selecting the icon displays all

the collection object information.

Google Earth Plots the locality using Google Earth. The locality is

shown using a pushpin icon. Selecting the icon

displays all the collection object information.

BioGeomancer Calls BioGeomancer with the current locality string to

geo-reference the entry.

Convert GeoCoordinate

Formats

Converts the Geocoordinate formats within the

Latitude1 and Longitude1 columns of a Data Set.

Export Exports selected rows or all the rows to an MS Excel

file.

Validate Opens a validation panel at the bottom of the work

space.

Upload DataSet to

Specify Database
Uploads the records into the Specify database.

Image Window Toggles the Image Window on and off.
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Carry Forward Opens the 'Carry Forward' configuration dialog, which

allows column values to be copied into new rows. See

Carry Forward.

Save Save Saves the Data Set.

Grid Editing Displays the data in Grid Editing mode. This is the

default view.

Form Editing Displays the data in Form Editing mode.

Editing Cell Values

To edit text in a cell, either double click, or

Click on the cell, then:

• Begin Typing, or

• Press the <esc> or F2 button and type

To complete editing in a cell:

• Press the <esc> or F2 button, or

• Press an arrow key, the <tab> key, or hit the <return> key to move to a different cell, or

• Click on a different cell.

Pick Lists

Cells that are mapped to fields formatted as pick lists in Specify are also available as pick lists in the

WorkBench. Simply double click inside the cell and it will change to a pick list. Then click

(an arrow) to open the pick list and choose a value.

Carry Forward

Carry Forward enables the value in one or more columns to be 'carried forward', or copied to the next

new row(s) of data. To select the columns to be carried forward click the (carry forward) button.

The following configuration window will open:
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Configure Carry Forward

The values in the selected column(s) will 'carry forward' into subsequent new rows, (new rows are

added by clicking the button), until Carry Forward is reset.

Context Menu Controls

In addition to the buttons in the work space the context menu provides additional actions. Simply

select one or more cells and then right click to display the context menu. (On a single button mouse

Ctrl + click):

Clear Cell(s) Clears the selected cell(s).

Delete Row(s) Deletes the selected row(s). Note: one or more cells in the row need to be selected

for the entire row to be deleted.

Fill Up Fills the selected empty cells with the value from the last selection. Use this tool to

copy a value into one or more cells from the bottom cell upward.

Note: Select the cell to copy and targeted cells.

Fill Down Fills the selected empty cells with a value from the top selection. Use this tool to

copy a value from the top cell downward.

Note: Select the cell to copy and the targeted cells.

Cut Deletes the selected text and copies it to the clipboard which allows it to be pasted.

Copy Copies the selected text to the clipboard.

Paste Pastes the text currently held on the clipboard into the selected cell.
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Find Panel

Grid editing provides a Find and Find/Replace functionality. To display the "Find" panel:

• Click on the Edit menu and choose Find, or

• Use the keyboard shortcut for your operating system: Ctrl + F on Windows and Linux;

Command + F on the Mac.

Find Panel

The Panel areas are described below:

Find (top) Text Box The search string.

Replace (bottom) Text Box The replacement string.

Next Finds the next matching string.

Previous Finds the previous matching string.

Replace Replaces the find string with the replace string.

Replace All Replaces all matching strings within the Data Set.

Match Case Matches upper and lower case strings exactly.

Wrap Searches the entire Data Set starting with the

active record and wrapping from the bottom to the

top of the Data Set back to the active record.

Selected Cells Limits the Find (and Replace) to the selected cells

only.

To search for a value:

1. Enter the string in the 'Find' Text Box.

2. Click the 'Next' button.

To replace a value:

1. Enter the search string in the 'Find' Text Box.

2. Enter the replacement string in the 'Replace' Text Box.

3. Click 'Next' to find the string.

4. Click 'Replace' to replace the string in the active cell.

5. Click 'Replace All' to replace all search strings.
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Note: The Find Panel is ONLY availble in Grid Editing mode, it is not available when in Form

Editing mode.

Column Sorting

Click on a Column Heading to sort the column. Click once to sort in ascending order ( ). Click twice

sort in descending order ( ). Click a third time to return to the previous order (stop the sort).

Auto Incrementing of Catalog Numbers

This feature is available in version 6.3 and older and is ONLY AVAILABLE in the Specify 6

WorkBench, not the stand alone, Mobile WorkBench.

This feature is also ONLY available when the Catalog Number of the current collection in Specify is

formatted to include a numeric section that is incremented.

1. Open the Data Set in the Specify 6 WorkBench

2. If Catalog Number is not included as a data set column add it to the data set mapping.

3. Add the starting number/format to the first cell you wish to auto increment.

4. Highlight the rest of the catalog number cells that you wish to auto increment, starting with the

cell you just filled.

5. Right-mouse-click on any of the highlighted cells. A context menu will appear.

6. Choose Fill Down and Increment from the Context Menu.

Note: The format of the starting catalog number must match the format for the catalog number in the

current collection in Specify for the auto incrementing function to be included in the context menu. If

the catalog number of the current collection in Specify does include an auto incremented number and

Fill Down and Increment is not included in the context menu choice check the catalog number format

for the collection and enter a starting catalog number that is the correct format in the data set.

Note: When the data set is validated any catalog numbers that already exist in Specify will alert you

with a red highlight and will not upload with the current catalog number.

Validating Data

See WorkBench Uploading.

Grid Editing Examples
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Delete a Record(s):

1. Select cells within the record(s) to be deleted.

2. Either right click on a cell and choose ‘Delete Row’ from the pop up window, or click the

(delete) button.

Clear a Cell:

1. Click on a cell or sweep multiple cells to select them.

2. Either right-click on a cell and choose ‘Clear Cells' from the pop up window, or click the

(clear) button.

Add a Record(s):

1. To add a row after the active row click the (add) button.

Copy the Same Value into Multiple Cells:

1. Select more than one cell in a column.

2. Right-click to display the context menu.

3. Choose 'Fill up' to fill the bottom value upward, or 'Fill Down' to fill the top value downward.

Add a Record with Preset Values:

1. Click the button.

2. Select the fields to be copied into the new row.

3. Click the 'OK' button at the bottom of the Carry Forward window.

4. Select the row to be copied into the new row.

5. Click the button.

Sort Records by a single Column:

1. Click on a Column Heading to sort the records in ascending order.

2. Click a second time to sort the records in descending order.

3. Click a third time to undo the sort and replace the records in their original order.

Form Editing
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Form Editing enables the Data Set rows to be displayed and edited row by row (record by record).

Column headings are referred to as 'labels' in the Form view. Each label has an accompanying User

Interface (UI) control (text field, text area, or check box) for entering data.

Values within a Data Set are easily manipulated using the icons in the work space Item Bar:

Record Number

Control

l< Go to the first record.

< Go to the previous record.

> Go to the next record.

>l Go to the last record.

Add a record.

Delete a record.

Edit Form Properties Allows the columns to be resized, moved and renamed.

See Edit Form Properties.

Image Window Toggles the Image Window on and off.

Configure Carry

Forward

Opens the 'Carry Forward' configuration dialog. See

Carry Forward.

Grid View Displays the Data Set in a grid view (resembling a

spreadsheet). Data Sets always open in this view.

The labels and UI controls can be moved and repositioned on the form by dragging and dropping.

UI controls can be activated by clicking in them, or using the tab key to navigate between them. The

tab order is top-left to bottom-right by default.

Edit Form Properties

In addition to dragging and dropping the controls, several properties can also be manually updated.

Activate either the column heading or UI control, then click the (edit properties) button. The

following dialog will appear:
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Edit Form Properties

The text fields in the dialog are explained below:

X Sets the X coordinate of UI control.

Y Sets the Y coordinate of UI control.

Label Sets the label. This will change the original column heading in the Data Set

Mapping.

Number of Rows Lists the number of rows the UI control will display. (Limit 25 rows)

Field Type Text Field: limits the text area to one row.

Text Area: allows the text area to expand to more than one row and activates

the Number of Rows field.

Field Length Refers to the length of the value box.

Help This button opens the Help window.

Apply Displays the change without saving it.

Cancel Cancels the changes that have been made in the dialog.

Carry Forward

Carry Forward enables the value in one or more labels to be 'carried forward', or copied to the next

new row(s) of data. To select the label to be carried forward, click the (carry forward) button. The

following configuration window will open:
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Configure Carry Forward

The values in the selected label(s) are 'carried forward' into new rows, (new rows are added by

clicking the button), until Carry Forward is reset.

Form Editing Examples

Delete a Record(s):

1. Click the (delete) button

Add a Record(s):

1. Click the (add) button

Add a Record with Preset Values:

1. Click the button.

2. Select the labels(fields) to be copied into the new row.

3. Click the 'OK' button at the bottom of the Carry Forward window.

4. Select the row to be copied into the new row.

5. Click the button.

Data Format Guidelines
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Consistency in formatting data is crutial to any data management system. Using the same format for

data within the columns of all Data Sets will ensure that the data will import more consistently into

Specify, making it more searchable and usable.

Column Headings

Use the title of the field as an indication of what sort of data that field will accept; e.g. all count and

number fields should contain only numeric data, Yes/No fields should contain only a Yes or Y, No or

N.

Use consistent formats and data standards for one-to-many relationships that are represented by a

cumulative number of the same headings, e.g. Collector1, Collector 2 and PrepType1, PrepType2

etc.

First Name and Last Name fields for agents should ideally contain only this information. If other

information is desired (such as title or middle initials) it can be added but should be positively

identifiable and separated to ensure easy parsing.

Use specialized data entry standards in the required fields below.

Catalog Numbers

Catalog Numbers in the WorkBench need to match the format that is used in the Specify database.

Dates

Dates are accepted as day month year, month day year, year month day or partial varieties of these.

For partial dates, zero’s should be used in the format selected.

Months as 1-12

Months as 01-12

Days as 1-31

Days as 01-31

Years as 00-99

Years as 1900-9999

Allowable separators include a space, / (slash), .(period), or - (dash).

Partial Dates are allowed for Collecting Event Start, Collecting Event End, Cataloged Date,

Determination Date and Preparation Date in both the uploader and in the Specify database. Dates are
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uploaded in the US format (month, day, year) and allow zeros or dashes for unknown month or day.

Any dashes or zeros for month or day are stored as '01' in the Specify database, which is used for

search results.

00 --- 1968 (= 1968 in the form but 01 01 1968 in the database)

00-----1968 (= 1968 in the form but 01/01/1968 in the database)

00 00 1999 (= 1999 in the form but 01/01/1999 in the database)

11.00.1989 (= 11/1999 in the form but 11/01/1989 in the database)

00 11 1989 (this is invalid)

11 12 1989 (= 11/12/1989 on the form and in the database)

00/---/2000 (= 2000 in the form but 01/01/2000 in the database)

00 00 04 (= 2004 in the form but 01/01/2004 in the database)

00-00-04 (= 2004 in the form but 01/01/1968 in the database)

04 00 04 (= 04/2004 in the form but 04/01/1968 in the database)

04-00-04 (= 04/2004 in the form but 04/01/1968 in the database)

1989/00/00 (= 1989 in the form but 01/01/1989 in the database)

1999/01/00 (= 1999 in the form but 01/01/1999 in the database)

1999 00 00 (= 1999 in the form but 01/01/1999 in the database)

1999 02 00 (= 02/1999 in the form but 01/01/1989 in the database)

Valid separators are '.' (period), '/' (forward slash), ' ' (space),and '-' (dash).

Latitude and Longitude

N, S, E, W formats are both accepted as hemisphere information.

Both d and ° are accepted for degrees, while ' and " are accepted for minutes and seconds. A space is

also accepted in place of or together with all of these.

Decimal places for decimal degrees, minutes and seconds are unlimited. However, when using the

Lat Long Converter, these will be truncated to 4 decimals for decimal degrees and two decimals for

minutes and seconds. Therefore make sure that you have included the LatText1 and LongText1 fields

to preserve your original input values.

Some examples of accepted formats follow:

DD.DDDD (32.7619)

DD MMMM (32. 45.714

DD MM SS.SS (32 45 42.84)

DD.DDDD N/S/E/W (32.7619 N)
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DD MM.MM N/S/E/W (32 45.714 N)

DD MM SS.SS N/S/E/W (32 45 42.84 N)

Exporting Data

The WorkBench can export an entire Data Set or select records within a Data Set by choosing action

items from either the Sidebar or the Workspace. The following table describes each of these export

functions:

Button Item Item Location Explanation

Export Data Set side bar Exports an entire Data Set.

Only closed Data Sets can be exported by this method.

Export Excel Template side bar Exports a template for Data Sets to Excel.

Only closed Data Sets can be exported by this method.

Export Data Set works pace Exports select records or the entire Data Set (by selecting all

records).

Only active Data Sets can be exported by this method.

Export Data Set

The WorkBench can export an entire Data Set item from the side bar or select records from an open

Data Set in the work space.

Export an entire Data Set from the side bar

The fastest way to export an entire Data Set is to 'drag and drop' the Data Set item onto the 'Export

Data Set' action in the side bar. This eliminates the need to choose a Data Set from a file dialog.

Or, click 'Export Data Set' in the side bar. The following dialog will appear listing the unopened Data

Sets:
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Export Data Set

Select a Data Set and click 'OK'.

Next, name and save the export file using the following dialog:

Enter Export File Name

Select a location and enter a name for the new MS Excel file and click 'Save'.

Export all or partial records from the work space

To export partial records, choose the records by selecting at least one column in the desired record.

To export all the records in the Data Set, do not select any records.

Click the (Export Data Set) button on the work space Item Bar. The following dialog will appear:
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Enter Export File Name

Select a location and enter a name for the new MS Excel file and click 'Save'.

Export MS Excel Template

The WorkBench is a staging area for pre-cataloged collections data and is not intended as a

replacement for editing MS Excel row and column data. However, when creating MS Excel

spreadsheets, it is recommended that the column headings match the Specify 6 fields. This will ensure

that the data will import correctly into the WorkBench and ultimately into Specify 6. To streamline

this process, the WorkBench allows Data Set column headings to be exported as an MS Excel

Template.

The WorkBench will not allow the export of a template being used by a Data Set. If a Data Set is

disabled (greyed out) in the side bar it must be closed in the work space before it can be exported.

The fastest way to export the Data Set column headings is to 'drag and drop' the Data Set item onto

the 'Export Excel Template' action in the side bar. This eliminates the need to choose a Data Set to

export.

Or, click the 'Export Excel Template' action in the side bar. The following dialog will appear listing

the unopened Data Sets:
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Export MS Excel Template

Choose a Data Set from in the list and click 'OK'.

Next, name and save the export file using the following dialog:

Enter Export File Name

Select a location and enter a name for the new MS Excel file and click 'Save'.

Image Window

The Image Window displays linked images and provides additional functionality for working with the

images.

It is important to understand that the WorkBench does not relocate or store image files within Data

Sets. The WorkBench creates a link to the image location. The WorkBench does create a smaller

version, or thumbnail, of the image, but it is not a replacement for the original image. The original
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image should never be deleted or moved. The WorkBench displays the thumbnail image in the Image

Window by default but the original image can be displayed by using the Image Menu.

Image Toggle

The image window is toggled on and off by clicking the (Image Window) button in the work space

Item Bar. When an image window is toggled 'on' an 'Image' column appears in the Data Set, which

includes the names of the files linked to the Data Set records.

The Image Window will open on the side of the WorkBench window that allows the most space on

the screen. The Image Window may overlap the WorkBench window if the screen does not allow

enough space for both to exist side-by-side. The Image Window default setting is 'always on top'.

This can be changed in the Image Menu.

Link Image(s)

Link one or more images to a single record using the Image Window.

First select a record, then click the (Image Window) button to activate the Image Window.

Image Window

Click on 'Link New Image(s)'.
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Note: Attachments can be uploaded to the Locality, Collecting Information, Accession, Collection

Object and Taxon tables. When these tables include the necessary information for a Data Set to

qualify to be uploaded the WorkBench will present a dialog to choose which table you wish to attach

the image. Choose a table from the list provided in the dialog.

A file dialog will appear:

Image File Dialog

Choose an image file (or files) to link and click 'Open'.

The first image will display in the main image window. Multiple linked images will show as

thumbnails in the 'tray' at the bottom of the image window.
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Linked Images

Click on a thumbnail to change the image on display in the main image window.

The filename of the linked image will be displayed in the status bar at the bottom of the Image

Window.

To link a new image to a new record simply click on the new record. The 'Link New Image(s)' button

will display in the Image Window.

Note: Do not select the Image Window button to link another image, it will close the Image Window

as well as the Image column.

Image Menu

More image controls are available in the Image Window menus, located at the top of the Image

Window.

The menu items available in the Image Window menus are defined in the following table:

Menu Choices Result

File Import Images Imports images into the Data Set, creating a

new, empty row for each image imported.

Close Closes the Image Window.
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View Reduced Size Displays the Image thumbnail.

Original Size Displays the original image in full resolution.

Keep Window on Top Keeps the Image Window displayed on top of

the WorkBench.

Image Add Image Links Opens a dialog to choose new images to link to

the record.

Delete Image Link Unlinks the image from the record.

Replace Image Opens a dialog to choose a new image to link to

the record, replacing the currently selected

image.

Help Image Window Opens the Image Window section of the

WorkBench Help.

Reports

The WorkBench creates the following reports from values in one Data Set column:

Report Description

Data Set Summary Groups, and counts and groups, unique items and displays

them in descending alphanumeric order. This provides an

overview of the values for any given column as well as a

mechanism for checking the integrity of the data.

Chart Creates a bar chart of all the unique values in a single

column. These graphs may not display correctly with

large numbers of unique values.

Top 10 Creates a Pie Chart showing the 10 most common items

by count for a single column in the Data Set.

The WorkBench also creates a Basic Label, similar to those used in Herbaria collections, from the

following fields:

• Family

• CommonName

• Genus 1
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• Determination Species 1

• Determination Variety 1

• Determination Species Author First Name 1

• Determination Species Author Last Name 1

• Start Date

• Collector Last Name 1

• CollectingEvent

• Collector First Name 1

• Latitude 1

• Longitude 1

• Locality Minimum Elevation

• Locality Name

• Remarks

• Field Number

Data Set Summary

The Data Set Summary report groups, and counts unique items and displays them in descending

alphanumeric order. This provides an overview of the values for any given column as well as a

mechanism for checking the integrity of the data.

The easiest way to create a Data Set Summary report is to 'drag and drop' a Data Set onto the Data Set

Summary action on the sidebar. This eliminates the need to choose a Data Set for the report.

Or, click the Data Set Summary action on the side bar. A file dialog will appear to choose a Data Set

for the report.

Next, choose a field for the report:
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Select a Field

Select a column and click 'OK'. The report will open in the work space.

Data Set Summary Report

Buttons at the top of the work space control the display size and allow the report to be saved and

printed.

Specify Help - Data Set Summary

346 / 391



Data Set Summary Button Controls

Basic Label

The WorkBench creates a Basic Label, similar to those used in Herbaria collections, from the

following fields:

• Family

• CommonName

• Genus 1

• Determination Species 1

• Determination Variety 1

• Determination Species Author First Name 1

• Determination Species Author Last Name 1

• Start Date

• Collector Last Name 1

• CollectingEvent

• Collector First Name 1

• Latitude 1

• Longitude 1

• Locality Minimum Elevation

• Locality Name

• Remarks

• Field Number

The Basic Label is designed to give data from each of the above fields a specific space on the label.

Any fields that either do not exist in the Data Set or do not include data within the Data Set will result

in a blank space on the label. In the WorkBench preview release the labels can not be edited, but the

full Specify 6 release will f full editing capabilities.

The easiest way to create the label is to 'drag and drop' a Data Set onto the 'Basic Label' action on the

sidebar. This eliminates the need to choose a Data Set for the Label.

Or, click the 'Basic Label' action. The following dialog will appear:
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Choose Data Set

Select a DataSet and click 'ok'. Fill in the label information using the Label Properties dialog.

Label Properties

The Label Properties dialog will not close until the Title, Subtitle and Footer have information

entered in their text area. To leave the Title, Subtitle or Footer area blank on the label type a space in

the text area.

The labels will displayin the Workspace in two columns.

Sample Labels
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Buttons at the top of the Workspace control the display size and allow the labels to be saved and

printed.

Button controls for the Labels

Chart

The Chart report creates a graphic display of the counts of all the unique values for a single column (a

graphical display of the Data Set Summary report). These graphs may not display correctly when

large numbers of unique values are presented.

The easiest way to create this report is to 'drag and drop' a Data Set onto the Chart action on the

sidebar. This eliminates the need to choose a Data Set for the report.

Or, click the Chart action on the side bar. A file dialog will appear to choose a Data Set for the report.

Next, choose a field for the report:

Select a Field
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Select a column and click 'OK'. The report will open in the work space.

Chart Report

Top 10

Creates a Pie Chart showing the 10 most common items by count for a single column in the Data Set.

The easiest way to create a Top 10 report is to 'drag and drop' a Data Set onto the Top 10 action on

the sidebar. This eliminates the need to choose a Data Set for the report.

Or, click the Top 10 action on the side bar. A file dialog will appear to choose a Data Set for the

report.

Next, choose a field for the report:
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Select a Field

Select a column and click 'OK'. The report will open in the work space.
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Top 10 Report

Special Tools

When editing a Data Set in the Grid view, several special tools are available in the work space Item

Bar. These tools require geographical data from specific columns within a Data Set. The following

list provides a description of each tool and its required column headings.

Icon Tool Description Requirements

Google Earth Generates a Google Earth

KML file from the row data

and loads it into Google

Latitude 1

Longitude 1
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Earth. The rows display as

'push pins' which are

identified by their row

number. Clicking on the

push pin displays the row

information as a pop-up

window.

GEOLocate The WorkBench uses this

web service to calculate the

latitude and longitude

positions from a textual

locality description and

three geography fields. The

WorkBench processes all

the selected rows and caches

the information, and then the

results can be stepped

through one row at a time

and the appropriate Latitude

/ Longitude can be selected,

or skipped.

Note: The WorkBench is

not responsible for any of

the results returned by

BioGeomancer. The

WorkBench is integrated

with the BioGeomancer

service.

LocalityName

Country

State

County

Latitude1

Longitude1

Latitude/Longitude

Converter

The Latitude/Longitude

Converter tool converts

numerous georeference

formats within the Latitude1

and Longitude1 columns of

a Data Set into decimal

degrees (DD.DDDD),

degrees decimal minutes

(DD MM.MM) or degrees

minutes seconds (DD MM

Latitude 1

Longitude 1

(Lat1Text and

Long1Text to

keep original

Lat/Long

formats.)

Specify Help - Special Tools

353 / 391



SS.SS). Original values will

be replaced with the new

converted values. In order to

keep the original format the

Data Set must include the

Lat1Text and Long1Text

columns.

GEOLocate

The GEOLocate project has created software and services for translating textual locality descriptions

associated with biodiversity collections data into geographic coordinates. It uses a description of a

Locality and values in geography fields, such as County, State and Country, to find Latitude and

Longitude coordinate values. This is referred to as georeferencing.

The Specify and GEOLocate teams have collaborated to create a GEOLocate module inside Specify.

In Specify 6.4 and newer GEOLocate has been upgraded to plugin version 2.0.

Notes:

• If GEOLocate results are accepted, they will overwrite any existing data in the corresponding

Data Set columns.

• The WorkBench is not responsible for any of the results returned by GEOLocate, the

WorkBench is integrated with the GEOLocate web service.

Requirements for Georeferencing US localities:

Column Heading Data Needed

Locality Name Yes

Country Yes

State Yes

County No, but will improve results.

Note: County is required when including waterbody and highway

crossing in the GEOLocate search.

Latitude1 No

(this is a results column)
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Longitude1 No

(this is a results column)

Requirements for Georeferencing localities outside of the US:

Column Heading Data Needed

Locality Name Yes

Country Yes

Child Node of Country No, but will improve results.

Latitude1 No

(this is a results column)

Longitude1 No

(this is a results column)

Note: A complete list of acceptable countries is available on the GEOLocate website.

The GEOLocate tool uses the data present in the Locality Name, Country, State and County colunns

to query the GEOLocate service. The service will not work without data in the Locality Name and at

least two other columns. The Latitude 1 and Longitude 1 columns are needed to accept the data

returned by the GEOLocate service. If GEOLocate is able to obtain results for any of the records, the

GEOLocate Results Chooser dialog will display results for each Data Set record.

To use GEOLocate select one or more records in your Data Set and click the button on the Work

Space Item Bar. A message will alert you to the status of the GEOLocate search requirements in

regard to your records.
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GEOLocate Requirement Status

Note: Latitude and Longitude values present in WorkBench data sets will be replaced by

those found in GEOLocate if GEOLocate results are accepted.

Once GEOLocate has finished processing another message will either display the number

of records for which GEOLocate returned results, or state that no results were found.

View GEOLocate Results

Results will display in the GEOLocate Results Chooser tool.
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GEOLocate

Locality Information displays the Locality Description, County, State and Country values in your

current record.

Correction (Green) Marker Properties include the values for the most accurate result among the

GEOLocate results returned. These values are also displayed visually on a map.

GEOLocate results can be edited using either the Correction Marker Properties form or the map

elements. Changes made on the map are automatically recalculated and updated in the corresponding

fields on the form. Updated values in the Correction Marker Properties form are automatically

represented in the corresponding map element.

Note: As you move your mouse within the map the corresponding latituted and longitude

values display in the lower right corner under the map.

Position represents the Latitude and Longitude of the GEOLocate result, visually depicted

on the map as a green marker. These results can be edited.

Edit the Position using the Marker Properties form:

1. Type new values in the Latitude and/or Longitude box.

2. Click the Apply button to accept the changes and update the

location of the green marker on the map.

Edit the Position using the map:

1. Click on the green dot on the map and drag it to a new position.

The latitude and/or longitude values on the form will automatically

update.
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Uncertainty Radius represents the error due to the uncertainty of the locality information

provided. It is shown as a grey circle around the green point marker on the map. The

Uncertainty Radius can also be edited.

Note: At this time in Specify the Uncertainty Radius values are not written in a

Specify database field.

Edit the Uncertainty Radius using the Marker Properties form:

1. Click the Uncertainty Radius button. The text box will change to

accept numeric values, and a large arrow will appear on the map

next to the Uncertaintly Radius point.

2. Type a new numeric value into the box and click the Apply button

to accept the changed value in the GEOLocate tool and update the

Uncertainty Radius on the map.

Note: If GEOLocate does not find an Uncertainty Radius the text box

will open ready to accept numerical values and the Apply button will be

available.

Edit the Uncertaintly Radius using the map:

1. Click the Uncertainty Radius button. The box will change to

accept numeric values, and a large arrow will appear on the map

next to the Uncertaintly Radius point.

2. Click in the center of the arrow and drag to reset the Uncertainty

Radius on the map as well as the numeric value in the form. As

you move your mouse within the map the corresponding

Uncertainty Radius, and latituted and longitude values display in

the lower right corner under the map.

Note: If GEOLocate does not find an Uncertainty Radius the text box

will open ready to accept numerical values and the Apply button will be

available. You must type a value into the text box and click the Apply

button before the arrow will appear on the map.

Error Polygon is a polygon which encompasses the entire area of uncertainty.
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Results which include an Error Polygon will display the vertex values in the form and a red

polygon on the map. Not all results include an Error Polygon. If the results do include an

Error Polygon the vertex values in the form must be cleared by clicking the Clear Polygon

button before the Error Polygon can be edited.

Note: At this time in Specify the Error Polygon values are not written in a Specify

database field.

Edit the Error Polygon using the Marker Properties form:

1. Click the Draw Polygon button. The box will change to accept

numeric values. Type in latitude and longitude values, separated

by a commas.

2. Click the Apply button to accept the values in the GEOLocate tool

and draw the polygon on the map.

Edit the Error Polygon using the map:

1. Click the Draw Polygon button. A blue circle will appear around

your mouse in the map area.

2. Right-Click on the map to add a vertex point.

3. Continue adding points until the polygon is complete.

4. Double click on the last vertex point to finish the polygon and exit

the draw polygon mode. The vertex values will be updated in the

form.

OR, Right-click on the map to cancel the vertex and exit the

draw polygon mode.

Note: If there are vertex values included in the Error Polygon field the values

must be cleared by clicking the Clear Polygon button before new values can be

entered or drawn on the map.

GEOLocate Results displays the GEOLocate results in grid form. If multiple results are returned

they are numbered and sorted with the most accurate listed first. The active result is highlighted in

blue on the form. Other GEOLocate results are represented by red markers on the map.
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Click on either a record in the GEOLocate Results form or a red point on the map to make it

the current, or active result. The fields in the Correction Marker Properties box will be filled

in and the green marker will represent the current result until you manually make

corrections.

• Number represents the order of GEOLocate returns both in the form and in a

corresponding point on the map.

• Latitude represents the latitude to the hundredth degree.

• Longitude represents the longitude to the hundredth degree.

• Pattern, or pattern identifier, is a text description of the pattern or keyword used to

determine a GEOLocate result. Single locality strings often include multiple patterns,

producing multiple GEOLocate results.

• Precision is an indication of the quality of locality information. Each GEOLocate

result is given a score between 0 and 100 which represents the probability of it being a

match. That score is then placed within a 'low', 'medium' and 'high' ranking to indicate

precision. Results are then ordered according to their probability number, which allows

results within the same rank to include the most accurate matches first.

• Error Polygon is a polygon which encompasses the entire area of uncertainty.

• Uncertainty represents the error due to the uncertainty of the locality information

provided.

Other Map Controls

Zoom In/Out

Slide the slider down to zoom in, up to zoom out.

Click the button to zoom in, the button to zoom out.

Turn the wheel on your mouse up to zoom in, down to zoom down.

Double click to zoom in, right-click to zoom out.

GEOLocate Web Button

Click the button to open the web-based version of GEOLocate in your default

browser and plot the current result set on the map.

Other Buttons
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Button Result

Help Opens the Specify Help Window

Accept Stores the latitude and longitude values in the appropriate cells of

the record.

Skip Ignores all results obtained for a given record, and displays the

results for the next record.

Done Accepts the currently selected row and closes the GEOLocate

Results Chooser dialog.

The dialog will close when all the records have been displayed. Results that were accepted will be

written in the Latitude 1 and Longitude 1 columns of the record. Any data already in these columns

will be overwritten.

More information about GEOLocate can be found at http://www.museum.tulane.edu/geolocate/.

Record Mapping Tool

The Record Mapping Tool displays the Latitude and Longitude points as a green dot on a satellite

map. The map includes rivers and political boundary overlays. The maps are obtained from a pair of

map servers, one hosted by NASA and one hosted at the University of Kansas.

Requirements

• Latitude 1

• Longitude 1

To map geocoordinates, sweep records in a Data Set to select them and click the Record Mapping

Tool button ( ). To map an entire Data Set either select all the records or no records.
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Georeference Map

Google Earth

Google Earth is used as a means of visualizing Data Set records from the WorkBench in Google

Earth. The WorkBench can generate a Google Earth KML file from row data in a Data Set and load it

into Google Earth. The rows display as 'push pins' which are identified by their row number. Clicking

on the push pin displays the row information as a pop-up window.

Requirements

• Latitude 1 column heading and data

• Longitude 1 column heading and data

• Google Earth (http://earth.google.com) installed on the hard drive (after installing a reboot is

required)

To display records in Google Earth, sweep records in the Data Set to select them and click the Google

Earth button ( ). To map an entire Data Set either select all the records or no records.
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A dialog appears allowing the information include in the Google Earth push pin to be configured.

Choose one Placemark Title from the left column (Choose Placemark's Title) choices and as many

data Fields as necessary from the right column (Choose Fields for Popup Bubble) choices.

Google Earth will then launch and plot the data from the Data Set.
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Google Earth Results

Record locations are marked with a Specify icon. Click the icon to display the record data from the

Data Set.

Latitude/Longitude Converter Tool

The Latitude/Longitude Converter tool converts numerous georeference formats within the Latitude 1

and Longitude 1 columns of a Data Set into decimal degrees (DD.DDDD), degrees decimal minutes

(DD MM.MM) or degrees minutes seconds (DD MM SS.SS). Original values will be replaced with

the new converted values. To keep the original format the Data Set must include the Lat1Text and

Long1Text columns.

Requirements:

1. The tool is only available in Grid view.

2. The button, , is only enabled when the active Data Set includes the Latitude 1 and Longitude 1

columns.

3. To keep the original formats in the Latitude 1 and Longitude 1 fields the Data Set must also

include Lat1Text and Long1Text columns.

Note: The Lat1Text and Long1Text Columns can only fill once, if a second conversion is performed

the new geo-coordinates will replace the original values in Latitude 1 and Longitude 1.

Convert Geocoordinates:

Select the desired cells in either the Latitude 1 or Longitude 1 column (or both).

Click the (Lat/Long Converter) button and choose the appropriate format.

Georeference Format Converter
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WorkBench Uploader

The WorkBench is both a stand-alone tool and an integrate part of the Specify platform. The Upload

function is only available in the Specify WorkBench, not the stand alone WorkBench. Data sets

created using the stand-alone version will need to be exported and reimported into the (embedded)

Specify 6 WorkBench for uploading. The current version of the stand-alone WorkBench is not able to

export data sets along with their mapping information; therefore, data imported into the embedded

Specify WorkBench from the stand-alone WorkBench will need to be remapped.

Data sets in the Specify WorkBench can be uploaded into Specify 6 with the Uploader tool. This

makes the uploader a fast and easy way to transfer data from an MS Excel or CSV file into Specify by

first importing the data into the WorkBench.

When a data set is uploaded a record set in Specify will be created using the main table. The record

set will be named using the name of the data set as well as the date of the upload.

Guest users are not allowed access to the Upload tool in the default Specify permissions.

Before uploading the data set, please note the following:

• Check the data set mapping and verify that data set fields are being mapped to the correct fields

in Specify 6. When importing MS Excel and CSV files the automapping does not always find the

correct fields (especially when using latitude 1, Genus, Species and Author fields) and may

require some remapping.

• Check existing data in Specify to verify that data being uploaded will not add a duplicate record

because of a typo or abbreviation. One example is Geography. If you have run the Specify Setup

Wizard and uploaded the Geography data the United States exists within the Geography table

(and tree) as 'United States'. If your data set includes the United States as anything other than

'United States' (for example, 'US' or 'USA') the Upload function will create a new Geography

record (and node on the Geography tree).

• Columns in imported files that do not map to a specific Specify field should be mapped to an

existing Text or Number field. These fields will then need to be renamed accordingly within

Specify to display correctly on forms and become searchable in queries. This can be

accomplished by changing the field caption in the Schema Configuration tool. These fields can

also be renamed for use in future mappings using the WorkBench Schema Configuration tool

• The data set must have data in fields that are required by Specify 6. For example, if a data set

column is mapped to a Taxon field in Specify, all required Taxon fields, including enforced
ranks, must be mapped and include data in the data set.

• At this time the Uploader does not update or change data in existing records, it only adds new

records.
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• Any Specify tabs that allow data to be written to the database must be closed when uploading

from the WorkBench. In other words, while uploading no user in the Collection can edit Forms,

Trees, Tree Definitions, System Configuration or the Schema Configuration. Specify will

automatically close any open tabs after prompting the users.

• In a multi-collection database the WorkBench is unable to verify the data sets for an appropriate

collection. It is up to the user to ensure that the data set is being uploaded to the correct

Collection.

• Attachment can be associated with the following tables:

Accession

Agent

Borrow

Collecting Event

Collection Object

Conservation Description

Conservation Event

DNA Sequence

DNA Sequencing Run

Field Notebook

Field Notebook Page

Field Notebook Page Set

Gift

Loan

Locality

Permit

Preparation

Reference Work

Repository

Taxon

If none of these tables are present in the mapping file for the data set an error message will

display informing the user that the image can not be uploaded. Any images not attached to a

table in the WorkBench (at the time they are added) will be attached to the 'main' table that is

present in the data set mapping. The uploader will look for main tables in this order: Collection

Object, Accession, Taxon, Collecting Event and then Locality.When more than one of the

attachment tables is present in the data set a dialog will display to choose which table to

associate with the attachment file.

• The WorkBench has a limit of 4000 records that can be uploaded at one time. MS Excel files

that include more than 4000 records can be separated using the Specify File Slicer application

that ships with Specify.
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Validate Data

The validation tool compares the data in the data set to the required fields and field formats

of the Specify fields to which they are mapped. It then indicates which cells violate

requirements, don't match formats, or will create new data in taxon, geography and agent

tables.

When a dataset is opened the validation panel is not automatically displayed. Simply click

the (validation) icon to show or hide the panel.

Validation Panel

Check the Highlight Invalid Cells to turn the validation off and on. This type of validation

compares the values in each cell of the WorkBench with the values in Specify fields and

highlights cells that contain invalid values in red. The number of invalid cells will be shown

in the validation panel.

A tooltip is available within each cell that offers information about the invalid value.

Simply hold the mouse over the invalid cell for the tooltip to appear. An example of an

invalid value may be a date in an incorrect format or one that does not match the

predetermined terms in a Specify Pick List. A more complete list of invalid values is

offered in the Data Set Requirement section of this document.

Note: The validation tool can only check one level of hierarchical fields per

validation. Column headings that are mapped to trees will be validated from the

top of the tree structure. For example, in the Geography tree the validation tool

will check the Continent field, then Country, then State, then County and finally

City (your geography tree may have a different structure). If your data set

contains new data in both country and state cells the validation tool will only alert

you to the new data in the Country cells.

Note: The validate function will not clean up or detect bad (misspelled or

incorrect) data. For example, it will upload any entry for 'genus' even if the data

includes both genus and species information, is not a valid name or is misspelt.

These should however be highlighted as new data in yellow (see below). The user

is responsible for establishing that the data is clean and correct.

And / Or
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Check the Hightlight New Records to turn the validation on and off. This type of validation

compares the data in each cell of the WorkBench with the data in Specify fields and

highlights cells that contain new data in orange. These cells should be checked for spelling

and other errors as this may be the only reason these are being highlighted. The number of

new data cells will be shown in the validation panel.

An blue highlight indicates that multiple matches have been found in the database e.g. if

there is a Fred Smith and Jack Smith in the database and you have Smith mapped to an

Agent last name field with no first name the validation tool will not know whether Smith

should be matched to Fred or Jack, or be a new Agent.

Note: The WorkBench does not compare the cells within the WorkBench.

Therefore, there may be times when multiple instances of the same new data

occur in the dataset, but the validation tool will count and display each cell as

containing new data. For instance; if the county Douglas is not included in the

Geography tree within Specify but is included in 36 data set records, the

validation tool will display the information: 36 New Cells, even though Douglas

is only one new term.

Note: Validating new cells in large data sets can take some time. If it is necessary

to cancel the Highlight New Cells function during a validation simply double

click on the status bar.

The buttons (up and down) allow you to move between the Invalid or New cells only.

You can navigate through each invalid cell using the up and down arrows.

Data Set Requirement Examples:

Catalog Number

• Collecting Event and Taxon (not the Taxon Only table) data must be associated with a

Catalog Number.

• The Catalog Number format in the data set must match the field format (including the

length) for Catalog Number in Specify.
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• Catalog Numbers that include a numeric sequence that is incremented in Specify can

be left blank in the data set and will be created automatically when Uploading into

Specify. The new numbers will begin their numbering sequence based on the last

number in the database.

• Catalog Numbers that are not formatted as an incremented number must contain data

to upload.

Accession

• The format of the accession number in the data set must match the field format for

Accession Number in Specify.

Locality

• The Latitude and Longitude must be in one of the accepted formats:

DD.DDDD (32.7619)

DD MMMM (32. 45.714)

DD MM SS.SS (32 45 42.84)

DD.DDDD N/S/E/W (32.7619 N)

DD MM.MM N/S/E/W (32 45.714 N)

DD MM SS.SS N/S/E/W (32 45 42.84 N)

Formats can be changed using the Lat/Long Converter.

• Double quotes must be used for seconds (not single quotes).

Taxon, Geography, Lithostratigraphy, Chronostratigraphy and Storage

• All required ranks must be present. If the ranks below the lowest required rank are

present in the data set and contain data, then the lowest required rank must also contain

data. If no data is present for ranks below the lowest required rank, then it does not

require data to upload.

• Tree levels (ranks) being uploaded must be present in the Tree Definition in Specify.

• When uploading only Taxon data (to add to the Taxon tree) use the mapping fields

from the Taxon Only data types (in the data set mapping).
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• When uploading Taxon data along with other data the Genus, Species, Subspecies and

Variety fields need to come from the Determinations data type (in the data set

mapping).

• If the highest rank in the data set does not match with a rank in the taxon tree new

ranks will be created with the name of the data set being uploaded.

Collection Objects, Accessions, Loan

• Any formats used in the data set must match the format specified for the mapped field

in Specify.

• Any preset values for Pick Lists in Specify must match the values (and format) in the

data set or the data will not upload.

Dates

• Dates can be in any format in the data set and will appear in Specify in the system

preference format.

• Partial Dates are only allowed for Collecting Event Start, Collecting Event End,

Cataloged Date, Determination Date and Preparation Date in both the uploader and in

the Specify database. Partial dates are uploaded in the US format (month, day, year)

and allow zeros or dashes for unknown month or day. Any dashes or zeros for month

or day are stored as '01' in the Specify database, which is used for search results.

00 --- 1968 (= 1968 in the form but 01 01 1968 in the database)

00-----1968 (= 1968 in the form but 01/01/1968 in the database)

00 00 1999 (= 1999 in the form but 01/01/1999 in the database)

11.00.1989 (= 11/1989 in the form but 11/01/1989 in the database)

00 11 1989 (this is invalid)

11 12 1989 (= 11/12/1989 on the form and in the database)

00/---/2000 (= 2000 in the form but 01/01/2000 in the database)

00 00 04 (= 2004 in the form but 01/01/2004 in the database)

00-00-04 (= 2004 in the form but 01/01/2004 in the database)

04 00 04 (= 04/2004 in the form but 04/01/2004 in the database)

04-00-04 (= 04/2004 in the form but 04/01/2004 in the database)

1989/00/00 (= 1989 in the form but 01/01/1989 in the database)

1999/01/00 (= 1999 in the form but 01/01/1999 in the database)

1999 00 00 (= 1999 in the form but 01/01/1999 in the database)

1999 02 00 (= 02/1999 in the form but 02/01/1989 in the database)

• Valid separators are '.' (period), '/' (forward slash), ' ' (space), and '-' (dash).
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Preparations

If the data set does not include a Prep Type field one will not be created

automatically.

Pick Lists

Columns in the WorkBench may be mapped to fields that are formatted as pick

lists in Specify. In version 6.3 and older values from the data set can be uploaded

into an existing pick list. The format of the pick list will determine the

requirement for the data being uploaded.

• Read Only pick lists do not allow new values to be added throught the

Uploader -- they must be added manually in the Pick List Editor. Values in

the data set that do not match the values in the existing pick list can not be

uploaded. Cells that do not match the predefined pick list values will

highlight in red when validated. A tool tip will list the first 13 available pick

list values for the field in Specify. To upload the record you must first add

the pick list using the Pick List Editor or edit the cell to include one of the

available value options.

• An Entire Table pick list allows new terms to be added to the existing pick

list. New values can be uploaded from the data set. When validated the cells

containing new values will highlight in yellow.

• A Field From Table pick list allows new terms to be added to the existing

pick list. New values can be uploaded from the data set. When validated the

cells containing new values will highlight in yellow.

• A non-Read Only pick list allows the user to enter new values into the pick

list from within the form. New values can be uploaded from the data set.

When validated the cells containing new values will NOT hightlight in

yellow.

Cells that are mapped to fields formatted as pick lists in Specify are also available

as pick lists. Simply double click inside the cell and it will change to a pick list.

Then click (an arrow) to open the pick list and choose a value.

A tool tip will alert you to the first 13 pick list values for the field in Specify.

Simply hold your mouse over the hightlighted cell to view the tooltip.

Also, double click on a cell to display a list of valid pick list values. You can then

select one of the values from the list.
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Upload a Data Set

1. Open a data set in the Specify 6 WorkBench.

2. Click the (Upload) button found in the Workspace Item Bar. The WorkSpace will split to

include the WorkBench Uploader. The WorkBench Uploader includes 3 areas:

Affected Tables lists the tables included in the data set file to be uploaded.

Messages is used by the Uploader to present progress and other information to the user.

Buttons:

• Validate the data before allowing the upload.

• Upload starts the upload.

• Settings configures the upload for matching records.

• Close will close the Uploader.

3. If you have not used the Validation tool then click the Validate button to validate the data at this

time. This allows the data in the data set to be compared to the required fields and field formats

in the Specify fields to which they are mapped. It also ensures that the necessary related fields

are present to link multiple tables. When validation errors are present the Uploader will split the

Messages window showing validation errors in the top portion and general messages below as

well as a View Report button. Click the button to view and print a report of the validation errors.

The Upload button will remain inactive until all validation errors have been corrected. Some

errors may need to be fixed within the data set and require the user to exit the Uploader tool by

clicking the Close button.

4. Click the Settings button to configure the upload for processing matching records between the

data set and the Specify database. It is important to note that when only one record is found in

the data set that matches a record in the Specify database, the Uploader does not create a new

record, but will use the matched record for any related information. For example, when

uploading a Collection Object with Collecting Event data the Collecting Event may already exist

in Specify. The Uploader matches the Collecting Event data in the data set to the existing record

in Specify, and does not add a new Collecting Event in Specify, but does create a link between

the Collection Object being uploaded and the existing Collecting Event in Specify.

Tables lists the tables that are included in the upload.

Match Action configures the Uploader response when more than one matching record is found.

• Prompt will display the matching records in a dialog and require the user to choose which

of the matching records to use. A choice to add a new record is also provided.

• Add New Record will simply add a new record and not search for matches. This may cause

duplicate records in the database.

• Pick First will choose the first match found and not prompt the user. A message indicating

these will appear in the message portion of the Uploader.

• Skip Row will skip the matching data set record.
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Remember Choices will treat the first record with matches exactly as a 'Prompt' above, but will

remember the choice and automatically use it again when identical values are found for

succeeding records.

Match Empty Cells will search empty fields as part of the search criteria and require a match

when set to True and disregard empty fields when set to False.

5. Click Upload. While the upload is processing, each Table in the Affected Tables window keeps a

tally of the number of records updated. The individual records that are updated are listed in the

Messages window. The Upload can be paused at any time by clicking the Pause button on the

status bar, or stopped by clicking the Pause button and then the Close button. Click the Upload

button to start the upload process again. Any uploaded records can be discarded by clicking the

Undo button on the Workspace.

6. Once the upload is complete the data is still not committed to the database. Both Query and

Simple Searches can be used to examine the uploaded data before committing it. Records opened

in a form from the results window are only available to view and can not be edited. Records in

the results window can not be saved as Record Sets. The following buttons will be enabled on

the Uploader:

View displays the uploaded records in a custom results page, indicating each table that is

affected. These results can be printed, viewed in a form, or exported as an MS Excel file.

Undo removes all uploaded data from the database.

Close will open a dialog to

7. Click the Save button to commit the uploaded records to the database.

Note: If a tree rank is included in an upload that has not been included in the Tree

Definition, Specify will use the name of the file to label the undefined node.

Note: When latitude and longitude values are entered into the WorkBench, the original

value is captured into a hidden field to assist with format conversions. When data is

uploaded into Specify, data from these fields is copied into the Specify (Source) field

and will display on the Locality form.

Specify File Splitter

There are times that users may wish to upload MS Excel files that contain more than the 4000

records, which is the record limit for the Specify Uploader. For user convenience, the Specify project

has created an application, the Specify File Splitter, that will split files that contain more than 4000

records into files that contain only 4000 records.

The Specify File Splitter application is located in the bin directory within the Specify application

directory, which stores the executable files for Specify. Double click Specify File Splitter to launch

the tool. Users are required to login using their Specify Username and Password.
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File Splitter

File to Split; click the Choose button and find the desired file using the file directory.

First row contains headers; check this box if the first row of the file contains headers.

Specify will then copy the headers to each 4000 record file. If the files include headers they

will contain 4001 records, but Specify does not count header files when uploading.

Lines per File refers to the number of rows in the CSV file. This defaults to 4000 but can

be any number desired. If a number greater than 4000 is entered a warning message will

appear. If you are splitting the file to import it into the WorkBench you should not exceed

4000 rows, as that is the maximum number of rows allowed in an import.

click the Slice button to start the File Splitter. The new files use the original file name but

add an underscore and consecutive number for each file. The original file remains intact.

For example: A file named "Birds.xls" containing 34002 rows will be split into 17 files

containing 4000 rows and 1 file containing 2 rows. The files will be named "Birds_1.xls"

thru "Birds_18.xls".

Note: When headers are not used in the MS Excel files each file will need to be

remapped in the template editor inside the WorkBench. If headers are present

then only the first file will need to be mapped and subsequent files are given the

option of using the existing mapping.

WorkBench Schema Configuration

It is often advantageous for users to change the field captions within Specify to match their specific

form/database needs. When these captions are changed within the Specify application the changes are

not reflected in the Data Set Mapping Editor. Specify captions can also be changed in the WorkBench

Schema Configuration tool for captions in the Data Set Mapping Editor to match those created in the

Specify Schema Configuration tool.
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The WorkBench Schema Configuration tool works exactly like the (Specify) Schema Configuration

tool.

Choose System > WorkBench Schema Configuration to open the tool.

Change a label in the WorkBench Schema

Open WorkBench Schema Configuration

1. Choose English from the list of Available Locales.

2. Click the Edit a Schema button.

Change a Caption in the WorkBench Mapping Tool

1. From the resulting screen choose the desired table from the list of Tables.

2. Choose the field you wish to change from the list of Fields.

3. In the Caption text box type in the name you wish to change.
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4. Click the OK button.

Note: The changes made in the WorkBench Schema Configuration will only be

reflected in the Data Set Mapping Editor. Data Set column names can also be changed

by opening the Data Set in form view and double clicking on the caption. For more

information about changing data set coumn names please refer to WorkBench Form

Editing.

Introducing SGR

It is common practice for botanists to collect duplicate voucher specimens of a plant with the

intention of distributing extra specimens to taxonomic specialists as gifts for determination, or in

#exchange# to share unique specimens with other institutions. Plant specimen duplicates are also sent

to multiple institutions to help insure the longevity of unique vouchers in case copies are lost to local

disasters. In international collaborations, deposition of copies of each specimen in host country

institutions can be mandated by law.

As a consequence of this methodology botanical collections contain a non-trivial amount of

redundancy in their holdings, in particular with specimens from prolific field workers. Some botanical

collectors are renowned (and revered) for collecting plant specimens in sets of 40 or 50 for wide

distribution. The frequency of duplicate specimens in large herbaria has been variously estimated to

be 20-30% of total holdings, but the actual level of duplication with respect to other collections in an

institution#s holdings probably varies widely. This redundancy sets up an opportunity for

computerization efforts to take advantage of data records previously entered elsewhere for specimens

which represent duplicates of their own.

In the computerization of entomological collections, numerous insect specimens are often obtained

from the same collection event. Some specimens may be exchanged with other collections, but also

many organisms belonging to different species obtained from one collection event may be inserted

into the source collection in different places as determined by its taxonomic organization. In

entomology this internal duplication and to a lesser extent that caused by exchanges, creates an

opportunity to re-use previously entered collecting event information (locality, geography, dates,

collectors) by linking new specimen data to it.

#Scatter-Gather-Reconcile# or #SGR# refers to this historical methodology whereby specimens are

scattered among multiple institutions or within a collection, and then gathered virtually back together

when their associated data is electronically assembled and then reconciled in the computerization

process. Duplicate botanical specimens once distributed, undergo independent annotation data entry

and validation processes, so that some specimens and their data may be more up-to-date with a

revised determination or include value-added information such as a locality georeference.
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In collaboration with the Lifemapper Project (www.lifemapper.org), the Specify Project serves a copy

of the online specimen data cached by the Global Biodiversity Information Facility (GBIF) from the

world#s collections. Initially, Specify and SGR will support botanical collections, with entomology

and other disciplines to be supported in future releases. The Project indexes the GBIF specimen data

for fast searches and makes the searching facility available through a web service. This network

infrastructure is invisible to the user and is used by the SGR plug-in for comparing specimen data

records to those from other collections. Each time you compare one of your records or a set of them

in a Workbench DataSet to GBIF#s holdings; records are returned from the GBIF/SGR cache

database and sent to your machine. For this reason your machine must be connected to a network to

run SGR.

SGR Algorithm

When using SGR it is useful to understand some basic information about the algorithm used to find

specimen matches. Records returned from an SGR query usually do not completely match your

specimen data. SGR does not work with exact character by character matching but uses a complex

algorithm to identify and rank matches based on several variables.

Because SGR compares your data records, (which may be incomplete) against hundreds of thousands

of records in the GBIF/SGR cache, it uses an algorithm that not only tries to find records that closely

match the contents of your data fields, it also analyzes the GBIF/SGR cache for the level of

uniqueness of potential matching records. For example, if you specify Collector Name as a data field

to use for an SGR query and the particular collector name in your data record is someone whose name

occurs frequently in specimen records in the GBIF/SGR cache, then SGR will rank matches for that

particular Collector Name field at a slightly lower level than if the name was rare or unique within the

GBIF/SGR cache. If the Collector Name is rare in the GBIF/SGR cache, the SGR match score (rank)

will be given a higher value. In the same way, if a Locality you are using matches against a small

number of records in the GBIF database, SGR will recognize that as a higher score match.

The algorithm that SGR utilizes for finding matching specimens is #Solr# an open source, full-text,

search engine from the Apache Lucene Project. Solr gives matching records a score and SGR uses

that score to rank the matching GBIF records from the highest probability matches to the lowest for

every record you use in a query from your own collection. SGR takes that score and creates a color

gradient as a background fill in the GBIF/SGR cache for a quick visual indication of the goodness of

match. Green represents a better match. As colors change to shades of yellow and then red, matches

become increasingly worse. SGR will always return some records, and although in many cases they

may all be red and poor matches, they represent the best matches based on the matching criteria

specified for the record used in the query. In many cases GBIF/SGR cache with red or pink

backgrounds have very little data in common with the record from your collection.
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The SGR numeric matching scores represent the rank or relative goodness of match (and uniqueness)

for GBIF records returned within a single SGR search. It is important to note that SGR matching

scores are not based on a percentage of 100. Do not think of the matching score values as normalized

between searches. SGR match scores are not comparable between searches on each of your individual

specimen (Collection Object) records. A score of 75 for a match record returned from the GBIF/SGR

cache for a particular specimen record from your collection, is not comparable to a matching record

score of 75 on a record returned by SGR from a another search using a different specimen record

from your collection.

The SGR match value from the Solr search engine is calculated by an algorithm which uses a

combination of both the goodness of a match between your record and those in GBIF and the

uniqueness of that records data field values in the GBIF/SGR cache.

Using SGR

In collaboration with the Lifemapper Project (www.lifemapper.org), the Specify Project serves a copy

of the online specimen data cached by the Global Biodiversity Information Facility (GBIF) from the

world’s online collections. Initially, Specify and Scatter, Gather, Reconcile (SGR) support botanical

collections, with entomology and other disciplines to be supported in future releases. The Project

indexes GBIF specimen data for fast searches and makes the searching facility available through a

web service. This network infrastructure is invisible to the user and is used by the SGR plug-in for

comparing specimen data records to those from other collections. Each time you compare one of your

records or a set of them in a Workbench Data Set to GBIF’s holdings; records are returned from the

GBIF database and sent to your machine. For this reason your machine must be connected to a

network to run SGR.

For more information about SGR concepts please refer to the Introduction to SGR help page.

Requirements:

1. To use SGR your machine must be connected to the internet.

2. You must have a Data Set to compare your records against records in the SGR index.

The Data Set does not have to be populated with values -- you can use SGR as you

enter data, but it must include some of the fields SGR uses to find matching records in

the SGR index. The more fields you can match against, the better your results will be.

SGR Search Criteria
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SGR search criteria are the data types which SGR uses to logically organize the data in your

WorkBench records for the purpose of matching on the GBIF database.

Many of the SGR search criteria use data from a combination of fields in the WorkBench.

The following table lists the SGR search criteria and their corresponding fields and

originating tables in the WorkBench:

SGR Search
Criterion

WorkBench Table and Fields
used for searching and matching

Collectors Table: Collecting Event

Fields: Collector First

Name, Collector Middle

Name, Collector Last

Name

Collector /Field
#

Table: Collection Object

Field: Field Number

Table: Collecting

Event Field

Station Field

Number

Location Table: Geography

Fields: Country, State,

County

Table: Locality

Fields: Locality

Name, Named Place

Table: Collecting

Event

Field: Verbatim

Locality

Date Table: Collecting Event

Fields: Verbatim Date,

Start Date, End Date

Taxon Name Table: Determination

Fields: Genus 1, Species 1,

Subspecies 1
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SGR Side Bar Tools

Matchers

Matchers list which criteria and search settings SGR uses to compare your data to the

GBIF/SGR cache. Once created, the settings for Matchers may not be edited. It is a recipe

for the search process. This allows Matchers to be kept as a property of Match Results, but

new matchers can be created and defined at any time.

Create a Matcher

Matchers are created using the Create Matcher dialog. Simply click on the

Create Matcher button to open the dialog.

Create a Matcher

• Name is used to name the Matcher. Use a name that relates to the kind of

matching data being used.

• Index refers to the type Index you wish to search.

• Exclude is used to exclude your institution code and/or collection code. Use

the codes that represent any data that you already have in GBIF to assure

that you exclude your own data from the SGR matches. Normally, you

wouldn't want to match new WorkBench data set records with what you may

have already published to GBIF.

• Match Criteria includes the search criteria.
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Select the criteria you wish to use to compare your data to the GBIF

data indexed by the SGR server by simply clicking on the pick list next

to the field name. You can also choose the amount of emphasis you

wish to place on each field:

Ignore Do not use this criterion for matching .

Low Place a lower emphasis on this criterion.

Normal Place an average amount of emphasis on this criterion.

High Place a greater emphasis on this criterion.

• Remarks is a text field for writing extra information about the Matcher. For

future reference - e.g. what the Matcher was defined to do.

Run a Matcher

Once a Matcher has been created simply click on it in the side bar and choose a

Data Set from the resulting dialog.

Choose a Data Set

Or, drag a Data Set and drop it onto a Matcher on the side bar.

SGR will then use the Solr algorithm to compare the records in your Data Set to

those in the GBIF/SGR cache. The results will appear in a split screen in the

Form View. Your records are located in the left panel and the GBIF/SGR cache

records are displayed in the right panel.

Note: The Data Set and matching GBIF/SGR cache records are not

saved when simply running a matcher. To save entire Data Sets along

with their matching GBIF/SGR cache records use the Process Data Set

button located on the side bar under Match Results.
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Edit a Matcher

Right-click on a matcher and click on the resulting Edit button to edit a Matcher.

Once a matcher has been created only the Name and the Remarks may be edited.

This allows users to reuse matchers and know that they are exactly what have

been used in the past as well as review a matcher to see exactly what criteria were

used on past searches.

Matchers may not be deleted unless there are no Match Results that refer to them.

The Name of the Matcher can be changed, and will be automatically updated in

the properties of Match Results.

Match Results

Create a Match Result if you wish to save your Data Set together with its matching

SGR/GBIF records.

SGR also reorders the Match Result Data Set with the most likely records to have accurate

matches first. These records are also color coded based on the probably accuracy of the

match with green respresenting a good match and red representing an unlikely match.

When a Match Result is open the original Data Set and Match Result will become inactive

on the side bar.

SGR adds an SGR Score field to the Match Result file. This allows you to click on the field

name and return the Match Result to the original, unsorted state.

Create a Match Result

Click on the Process Data Set button, then choose a Data Set in the resulting

dialog.

Choose a Data Set
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Next, you will be asked to choose a Matcher.

Or drag and drop a Data Set from the side bar onto the Process Data Set button

and choose a Matcher in the resulting dialog.

Select Matcher

Next, give the Match Result a name and Remarks.

While SGR is processing the Data Set, the Match Result name will appear in the

side bar with a (system) icon will be displayed next to it. When it is complete

an SGR icon will appear next to it in the side bar.

When the SGR process is complete the Data Set will open in Grid view. It is now

reordered with the records that have the most probably matches at the top and the

least likely at the bottom.

To view the Data Set records along with the resulting GBIF/SGR cache records,

click on the Form View button. The results will appear in a split screen

with your Data Set records editable in the left panel and GBIF/SGR cache records

viewed the right panel.

Context Menu

Right-click on a Match Result for a context menu. The context menu is not

available when Match Results are open in SGR. If the desired Match Result is

inactive simply close it in SGR.

Match Result Context Menu
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• Edit properties

You can rename the batch result and/or add notes or

comments about the batch result in a properties editor. The

properties editor also displays the name of the matcher used

to create the batch result.

Edit Match Result Properties

• Stop Processing

Large Data Sets may take a few minutes to process. You may

choose to stop the process the SGR by clicking the Stop

Processing button.

To view the progress, hold your mouse over the Match Result

on the side bar. If the process was stopped two numbers will

appear separated by a slash ( ). A completed Match

Result will show the number of items ( ).

You may also hold your mouse over a Match Result while it

is processing to view how many records have been processed.

To update, move your mouse off the Match Result, then place

it back over the Match Result, allowing the status to refresh.

• Resume Processing

Resume processing the rest of the Data Set by clicking the

Resume Processing button.

• Show Histogram
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A historgram offers a graphical view of the distribution of

SGR scores. It uses 30 colors to represent the SGR score and

plots the number of rows that fall within a particular score

(color) range. A histogram which displays a bimodal

distribution is often an indication of good results. This type of

histogram includes two peaks with a 'neck' in between them.

The neck represents a threshold that separates data set records

with good matches from those that have poorly matching data

from GBIF.

• Delete

Click the Delete button in the context menu or drag and drop

a Match Result to the garbage can to delete it.

Using SGR Results

There are two basic data acquisition workflows which can be supported with SGR :

1. Search GBIF/SGR cache records as you are entering data into an incomplete WorkBench data

set. This allows you to find and use existing information rather than typing it all in yourself.

2. Augment your existing Specify database records with information found in the GBIF/SGR

records.

Both workflows use SGR results in the same way, but when working with a complete data set a

Match Result can be created before viewing the SGR/GBIF record results. This orders the Data Set

records with the most likely to include a correct GBIF/SGR match to the least likely to include a

correct match.

Matching GBIF/SGR records are only visible in Form View. In Form View, the workspace window is

separated into two panels. Single records in your Data Set are editable in the left panel and matching

GBIF/SGR cache records are viewed in the right panel. The 10 best GBIF/SGR cache matches for

each record in the data set are returned. Use the slider bar at the bottom of the panel to view all 10

results.
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SGR Results in Form View

SGR/GBIF cache matches can be updated while in Form View by using the buttons on the Work

Space Item Bar. When finding matches in an incomplete Data Set simply add values into fields, then

click on the Matcher button to update/refresh the search to include the new values. You may also

change the matcher itself and run a new SGR search by clicking on the button and choosing a new

Matcher from the drop-down list.

Matcher Drop-Down List

When you find a match, simply copy and paste the necessary GBIF/SGR cache values into the

appropriate Data Set fields. Once you save the changes they will be included in your original Data

Set.

When all the records in your Data Set have been compared to GBIF/SGR records and the Data Set

has been uploaded into the Specify database it is a good practice to delete the Match Result.

Work Space Item Bar Tools
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The Work space item bar, located under the work space, offers several tools while in form

view.

Record Number

Control

l< Go to the first record.

< Go to the previous record.

> Go to the next record.

>l Go to the last record.

Add a record.

Delete a record.

Edit Form

Properties

Allows the columns to be resized, moved and renamed. See

Edit Form Properties.

Refresh/Select

Matcher
Refresh the search by clicking on the Matcher button. This

can be used when entering new data. Simply enter values for a

few fields and run the Matcher. If you do not get the expected

results, enter more data, then click on the Matcher button to

update the search with the new values.

Click the arrow to expand the Matcher button and select a

different Matcher. The window will be refreshed with the

results for the new matcher.

Image Window Toggles the Image Window on and off.

Configure Carry

Forward

Opens the 'Carry Forward' configuration dialog. See Carry

Forward.

Grid View Displays the Data Set in a grid view (resembling a

spreadsheet). Matching GBIF records are not displayed in this

view.

Keyboard Shortcuts

Shift + Page_Up will advance to the next record.

Shift = Page_Down will move to the previous record.
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